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Introduction

This is the User Guide for EPiServer Commerce, a state-of-the-art solution for building e-commerce
websites. With EPiServer Commerce you can quickly create and deploy a flexible e-commerce website,
combining powerful content display with advanced back-end online store management.

This is a demo store. Any orders placed through this store will not be honored or fulfilled
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This User Guide provides guidance to the usage of the various functions of EPiServer Commerce, both
within web store administration as well as content management for your website. The purpose of the EPiS-
erver Commerce sample site, which is described here, is to provide an example of how you can work with
EPiServer Commerce, in order to get your web store up and running in as little time as possible.

To find out more about how to integrate and extend the functionality of EPiServer Commerce, please refer
to the EPiServer Commerce Developer Guide.

About This Documentation

Target Groups
The EPiServer Commerce documentation is intended for the target groups as described below.

e The EPiServer Commerce User Guide:

~ Web shop administrators working with online store procedures in EPiServer Commerce.

~— Content editors and system administrators working in EPiServer Commerce.
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e The EPiServer Commerce Developer Guide:

Developers working with development and customization of EPiServer Commerce sites.

~— System architects and others with an interest in the technical features of EPiServer Com-
merce.

References

This documentation describes features in EPiServer Commerce. Features in other EPiServer products
will not be covered here. Therefore, the following documentation available from world.episerver.com, may
be useful for reference purposes:

o User documentation for editors of EPiServer CMS.
e User documentation for administrators of EPiServer CMS.
e User documentation for EPiServer Mail.

e SDK for EPiServer CMS and the EPiServer Framework (for developers).

How to Access EPiServer Help System

You can access the web help from the EPiServer OnlineCenter menu (which is always visible at the top).
Click the ? icon and select the system for which you want to view the help. Browse or search for the topic
where you need guidance.

EPISERVER ®@ 7 -~ A Administrator~ Q

]
OnlineCenter “

License Agreement

About EPiServer

f7) From each view in the user interface with a help icon provided, click the icon to get context-sensitive
help.

You can also access the web help by browsing to webhelp.episerver.com.

Online Community on EPiServer World

EPiServer World is an online community where you can find the latest product information. Itis open to
the public, for partners, customers, and everyone working with EPiServer products, such as editors, web-
masters, site owners and developers. Here you can download material, participate in discussions, read
articles, receive support and much more. Feel free to sign up as a member.

Copyright Notice
Copyright © 1996 — 2011 EPiServer AB. All rights reserved.

Changes to the contents, or partial copying of the contents, may not be done without permission. The doc-
ument may be freely distributed in its entirety, either digitally or in printed format, to all users of EPiServer
Software. We assume no liability or responsibility for any errors or omissions in the content of this doc-
ument. We reserve the right to alter functionality and technical system requirements. EPiServer is a reg-
istered trademark of EPiServer AB.

Terminology

In this section we will describe some of the specific terms used in e-commerce and EPiServer Commerce.

© EPiServer AB
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Editorial Content

Content such as articles or news, created by website editors through the EPiServer CMS editorial inter-
face. Compare this to content that is displayed as pages on the website, but where the contentitself is
data fetched from Commerce Manager. This type of data cannot be only be edited in Commerce Man-
ager.

Modes

You will work with EPiServer Commerce in different modes.
View mode

The content that will be displayed to visitors to the website. A visitor can be anonymous or logged in to a
user accountin View mode.

Edit mode

Editors will work in the EPiServer CMS Edit mode when creating and editing EPiServer CMS content
pages of the website.

Admin mode

System administrators will work in the EPiServer CMS Admin mode to administer the system, for instance
to modify system settings and access rights for the entire website.

Commerce Manager interface

Store administrators will access the Commerce Manager interface to manage online store data and activ-
ities. The Commerce Manager interface can be reached either from inside the EPiServer OnlineCenter, or
directly from View mode when right-clicking in a page.

Roles

EPiServer Commerce has a number of different roles that are active in the editorial and online store man-
agement activities. These are described further in the following.

Visitor

A visitor is someone using a web browser to visit the website and use available functions and services. A
visitor can register an account and become a customer when purchasing a product. Customers can
update information related to their personal account. In EPiServer Commerce, visitors use the same login
procedure to the website as site administrators, without getting access to the back-end functions.

Editor

The editor will work with website content from the EPiServer CMS Edit mode. Working with content here
means create editorial content such as news, company related information, or articles on different sub-
jects.

Store Administrator

The store administrator works in the Commerce Manager interface, with information related to customers,
orders and products. Store administrators may also work with configuration of the Commerce Manager
system settings.

System Administrator

The system administrator works with the administration of the entire EPiServer Commerce platform. This
is done from the EPiServer CMS administration mode and involves setting access rights for pages, web-
site language management and other tasks.

© EPiServer AB
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Commerce Manager roles

The Commerce Manager system has its own set of user roles covering the different tasks that online store
managers work with. Order Supervisor, and Order/Shipping/Receiving Manager are examples of the role

setup.

Roles are described further in the Commerce Manager section under Customer Management.

Commerce Manager Glossary

Application Configuration

Shipping Gateways - under Shipping Providers, a shipping gateway is the specific class that you
select (Generic Gateway or Weight/Jurisdiction Gateway).

Shipping Jurisdictions - an option which allows you to define values for region-specific shipping
rates; this is only used when you select the Weight/Jurisdiction Gateway (i.e. California).

Shipping Jurisdiction Groups - group of jurisdictions; this is a required field when configuring the
Shipping Method parameters (i.e. Southwest region).

Shipping Method - a shipping method manages a set of information and rules that determines the
shipping cost and displays it on the front-end public site while a customer checks out an item from
his/her shopping basket. The shipping fee is added to the total price of the purchase. A shipping
method is mapped to a shipping provider visible to a back-end administrator in Commerce Man-
ager. This allows the public site to display friendly names such as "Ground Shipping" to the cus-
tomer and this is mapped to a provider such as UPS. Therefore, when a customer picks "Ground
Shipping," he/she will be using UPS.

Shipping Providers - a shipping provider is the class(es) that interacts directly with one or more
actual shipping services such as USPS, UPS, or FedEX. It retrieves shipping price information
from the shipping service(s) its associated with. One typical scenario would be to have a provider
that represents a particular service (e.g. USPS). A provider can also represent a particular type of
shipping situation. One example is that you could have a provider for overnight delivery. The pro-
vider could retrieve pricing for that service to determine the lowest price given the location of the
customer. A provider could also represent other specific scenarios with one or more services such
as price by weight or ground shipping.

Business Foundation

Business Foundation Object (BF Object) - similar to a meta class; allows end users to create cus-
tom objects with Ul presentation, business objects, and a database layer without modify code.

Bridge - a "many to many" or N:N relationship between two business objects.

Extension - this allows you to extend an existing meta class with extra properties. For example,
you can have a download class and you can extend it with "imagedownload" which contains width
and height as extra parameters.

Field Type - the type of data that the data field supports. There are multiple types included with
Commerce Manager out of the box:

-~ Boolean
Currency

~- DateTime

~ Dictionary items
~  File

- Guid

© EPiServer AB
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Integer

Referenced Field (read-only)

String

e 1 to Many Relationship - 1 object can be associated or related with multiple object-related data.
For example, one organization can be associated with multiple contracts.

e Many to 1 Relationship - multiple object-related data can be associated or related with a single
object. For example, multiple contacts can be related to a single organization.

e Many to Many Relationship - multiple object-related data can be associated or related with mul-
tiple objects. For example, different SKUs (Store Keeping Unit) can be associated with one or
more Warehouses for tracking and storage.

Catalog Management

e Assets - downloadable contents such as documents, links, videos, and images that can be linked
to specific products.

e Associations - one or more products can be related to or associated to another product so that
these associated products can be displayed or advertised on the public site as a product acces-
sory, or as an upselling/cross-selling item. Associations can be made from any of the individual
products (Product Entries, SKUs, Bundles, Packages, and Dynamic Packages).

e Catalog - a catalog is a top-level container for all catalog entries such as Categories, Products
and SKUs.

e Category - a category is a grouping of purchasable products.

e Node - a node is the same thing as a category.

Product - a product represents various forms of merchandise that you can display and pur-
chase from the public site, including Products, Variations/SKUs, Bundles, Packages and
Dynamic Packages.

Product Entry - a product entry typically contains a product name, part number, descrip-
tion and images.

Variation/SKU - a variation or SKU (Store Keeping Unit) corresponds to a specific type of
product with specific characteristics. For example, a product of Shirts will have an individ-
ual variation/SKU which includes size, color and sleeve length.

Bundle - a bundle is a collection of variations and SKUs allowing customers to purchase
two or more items at once.

Package - a package is comparable to an individual SKU because the package item must
be purchased as a whole (i.e. computer system).

Dynamic Package - a dynamic package is similar to the package definition above with the
added ability to configure the package during checkout.

e Tax Category - the separation of taxes by category allows you to charge a different rate of taxes
depending on whatis being purchased; for example, you can have one rate for "General Sales"
items and another rate for "Luxury Sales" items.

Customer Management

e Account - a user account that can be created under a Contact. Once an Account has been
created, the Contact can be assigned Roles and access the Commerce Manager. A user account
is automatically created for a user who registers from the front-end public website which allows a
customer to login prior to checking out. They default to the "Everyone" and "Registered" roles and
permissions.

© EPiServer AB
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e Contacts - these are users that are created either when an external customer registers on the pub-
lic site or when a Commerce Manager admin creates them directly from the Commerce Manager;
typically, users that are internal to your organization are assigned to organizations or organization
units and assigned varying permissions based on role. By default, new users that are created by
registering from the public site are given the "Registered" and "Everyone" roles.

e Organizations (or organization units) - groups or sub-groups of registered users and customers.
An organizational unitis a "child" or subsidiary of a "parent" organization. Within Commerce Man-
ager, you can assign an organization as a parent of another organization. For example, the parent
company Company X, and the organizational units are Company X West and Company X East.
Organization units include regional branches or departments or you could name them by busi-
ness categories such as "Computer and Electronics" or "Clothing and Accessories." Organizations
can be structured into a tree structure with sub-units with different levels of permissions assigned
to each. So for example, you can set up your company as a parent level organization while your
departments such as Sales & Marketing, IT/Development, and Operations as organization units.
With this scenario, you can allow users in each departments to have access to only relevant sub-
systems, screens and functionality within Commerce Manager.

e Roles - these control the level of access privileges of each user accountin Commerce Manager.
Users can be either granted or restricted access to an entire subsystem or a particular menu item
within a subsystem based on the role assigned to them. Different roles may be added to user
accounts (i.g., store operator or webmaster) so that they can access, edit, or process relevant infor-
mation. By default, a customer who registered his/her account to make a purchase in the front-end
site will have no roles assigned to them, hence giving him/her preventing access to both the edit-
ing feature of the front-end site as well as the back-end Commerce Manager.

Marketing

e Campaigns - a way to organize marketing activities. Campaigns must be associated with Pro-
motions in order to provide customer discounts. Optionally, Campaigns can also be tied to Cus-
tomer Segments for targeted marketing purposes.

For example, you can create a seasonal campaign that will include different Promotions tar-
geted for the Spring season.

e Customer Segments - determine the target audience for the Promotions. Customer Segments
determine the target audience for the Promotions. Within a Campaign, all Promotions will be
applied to whatever Customer Segments associated with the same Campaign. Members of the
Customer Segments can be pre-defined in static groups or you can use the Expressions Engine to
create dynamic groups whenever Promotions are run.

For example, you can have a Customer Segment that targets all users from the Los
Angeles area. You can create an Expression that will include all the customers whose
home city is Los Angeles. Thus, when a user registers on the site he immediately becomes
part of the target Customer Segment.

e Expressions - these are customizable Conditions which allow users to extend different aspects of
the Marketing system -- Promotions, Customer Segments and Policies all rely on Expressions.
There is an Expressions Engine which is a core technology behind the Marketing system.

For example, you want to set a Promotion for "40% off tem X." The Expression or Con-
dition to enable this Promotion would include: Catalog ID for Item X and Reward of 40%.

e Policies - rules that are always executed when Promotions are applied. This allows a Marketing
manager to declare rules just once for the whole site.

An example of a rule is as follows: Do not allow negative orders.

© EPiServer AB



Introduction | 11

e Promotions - a way to apply various discounts to the products, order totals or shipping. A Pro-
motion is a marketing tool used to increase sales of certain products or product lines. Various
incentives such as lowered pricing and other discounts can be employed as part of a Promotion.

Promotions are always tied to Campaigns.

Promotions can be classified into two types: 1) either you can create a Promotion that is vis-
ible prior to checkout or 2) you can configure the Promotion to be displayed during the
checkout process.

~— The most powerful aspect of the Marketing system is the Expression Engine which allows
variable conditions to be applied when creating a Promotion. These conditions vary from
the number of items, the percentage discount, shipping rates and many others.

Order Management

e Browsing and Creating Purchase Orders

~ Purchase Orders - the manual method of generating an order for a customer (rather than
having the customer checkout and complete an order from the front-end website). It allows
Commerce Manager users to generate orders directly from the Commerce Manager.

~ Status - can be set for an order to "NewOrder," "Submitted," "Processing," "Canceled,"
"Rejected," "Shipped".

~ Currency - selecta Currency type from the drop-down menu.
~ Customer - select a Customer from the drop-down list of Contacts.
~ Billing Address - select a Billing Address from the drop-down menu.

~ Affiliate - select an Affiliate from the drop-down list. (Affiliates can be used when inte-
grating with other systems and can only be edited in the database. Users do not have Com-
merce Manager access for managing Affiliates).

~ Tracking Number - used for tracking shipment of orders, enter in a Tracking Number of the
shipment.

~ Expiration Date - enter in an Expiration Date for the order, used if this order is tied to a
recurring payment plan for subscription-based transactions.

~ Parent Order Id - this can be used to relate Purchase Orders to a payment plan or other
order. When creating a Purchase Order from a Recurring Payment Plan, the Parent Order
ID is automatically associated with the Payment Plan ID.

~ Line Items - you can associate actual Products/SKUs/Packages/Bundles to orders or Pur-
chase Orders.

~— ID -itis automatically generated.

~— Display Name - this can be edited and changed.

List Price - enter in the price that will appear for the item.

Discount - enter is the Discount value that will subtract from the List Price.

Shipping Address - This is automatically generated if a Shipping Address has
already been associated with the Purchase Order.

Shipping Method - This is automatically generated if a Shipping Address has

already been associated with the Purchase Order.

e Creating a Recurring Payment Plan

Recurring Payment Plans - payments that are initiated by the Commerce Manageron a
regular cycle (i.e. applicable in a subscription-based scenario).

© EPiServer AB
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~— Plan Cycle - this determines the period of time that a payment plan will be initiated.
Options include: "No Cycle," "Daily Cycle," "Weekly Cycle," "Monthly Cycle," "Yearly Cycle.

~— Cycle Length - Unit of the PlanCycle.
~ Max Cycle - the maximum number of cycles that this payment plan will be initiated.

Completed Cycles - this value displays the number of times that this payment plan has
been initiated.

Reporting
o Best Sellers Report this reportis used to determine which products sold the most in terms of
quantity and total revenue over a period of time.

o Low Stock Report - this report is used to determine which products are running low in inventory. If
a product's inventory is less than its reorder minimum quantity, it will be included in this report.

e Sales Report - this report provides an overview of a site's sales performance over a period of
time.

e Shipping Report - this report provides the shipping method, number of orders and total shipping
cost over a period of time.

© EPiServer AB



About EPiServer Commerce | 13

About EPiServer Commerce

The foundation of the EPiServer Commerce platform is an e-commerce core for web store management,
and EPiServer CMS for content presentation.

The EPiServer Platform

The EPiServer platform contains common functionality shared by all EPiServer products:

e OnlineCenter - "entrance" to the website dashboard and integrated systems, with gadgets and
access to website edit/admin interfaces.

e Website - page types and templates for content display.

e Framework -data storage and global search.

EPiServer Commerce

EPiServer Commerce

EPiServer OnlineCenter Website
Content Edit Website Admin Page Tem plates

EPiServer Framework Global Search ‘

EPiServer Commerce contains the following parts:

e Complete commerce management features:

Business API for integration

~  Workflows based on Windows Workflow Foundation (WWF)
Commerce dashboard for sales monitoring

Order, Catalog, Customer and Asset Management
Marketing & Promotion

Reporting functionality

Administration interface
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e EPiServer CMS providing content management functions such as globalization, personalization
and page providers for product display.

o A setof page templates with examples of how to display content and illustrate e-commerce pro-
cedures for both B2B and B2C businesses.

The EPiServer Commerce Sample Site

EPiServer Commerce comes with a sample site including a complete set of page templates containing all
the necessary functions for setting up a website with an online store. The purpose with the sample site is
to exemplify and illustrate the code behind the templates, and to provide inspiration when building your
own e-commerce solution.

Function Overview

This section provides an overview of the functionality of EPiServer Commerce. The main parts of EPiS-
erver Commerce are Commerce Manager - for administration of back-end online store tasks, and EPiS-
erver CMS - for managing and displaying website content.

Store Management
System Administration and Configuration

System Administration includes various configuration tasks such as setting up shipping and payment gate-
ways, your default language, currency, units, tax configuration, licensing, and search settings.

e System Administration

Administrative Users and Customers

Users and customers are managed by the Customer Management system. Users are internal to your
organization and should not be confused with customers, partners and organizations. Generally, only
your team of internal users will have access to the Commerce Manager and depending on their per-
missions will have varying access to the systems and menu items within each system.

e Customer Management

Catalogs and Product Entries

A Commerce Manager front-end site allows customers to shop for products. Products are arranged into a
particular catalog. Catalogs are independent from one another and you may create as many catalogs as
you need. Catalogs can be structured in a number of ways and organized into Categories, Products,
SKUs, Bundles, Packages and Dynamic Packages.

The Catalog Management system provides users with the ability to manage catalogs, product categories
and products. A default B2C Sample Site along with a default electronics catalog (consisting of a Brands
catalog + Everything catalog) is included giving you a running demo site after you run the installer.

e Catalog Management

Purchase Orders, Shopping Carts, Shipping, and Returns/Exchanges

The Order Management system is where you can monitor, track, change or create new orders, ship out
items, and create returns/exchanges. Orders are highly flexible, giving internal Commerce Manager users
the ability to create Purchase Orders with various options including split payments, split shipping, and
split shipping addresses.

e Order Management
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Customer Campaigns, Promotions, and Discounts

One area handled by the Marketing system is promotions. A Promotion is a marketing tool used to
increase sales of certain products or product lines. Various incentives such as lowered pricing and other
discounts can be employed as part of a promotion.

Promotions can be classified into two types: either you can create a promotion that is visible prior to check-
out or you can configure the promotion to be displayed during the checkout process. The most powerful
aspect of the Marketing system is the Workflow Engine which allows variable conditions to be applied
when creating a Promotion. These conditions vary from the number of items, the percentage discount,
shipping rates and many others.

Creating custom promotions is incredibly powerful; users have many ways in which to configure pro-
motions based on their needs.

Marketing teams also have the ability to target specific customer segments by region, individual cus-
tomers or customer groups.

e Marketing

Assets and Web Files

The Asset Management system allows for Assets including images, MP3s, PDFs, software packages and
other downloadable files to be centrally stored, displayed on either the public site or the Commerce Man-
ager site and ultimately to be shared or purchased.

e Asset Management

Content Management
Editing Content

Web editors will work inside the EPiServer CMS editorial interface to update content of web pages. Per-
haps you want to create news or article content related to the products in your online store. This is most
typically done by web editors creating EPiServer CMS pages.

The EPiServer Commerce page types in the sample site do not require much editorial work, since most of
these are only for display purposes fetching data from elsewhere. Some editorial efforts are often needed
on content pages such as news listings, privacy and shopping policies and similar.

Administering the Website

The EPiServer CMS administration interface is where you will manage the administrative tasks for the
website. These may involve setting access rights for EPiServer CMS web pages in the page tree struc-
ture, configuration of page types, management of scheduled jobs, and globalization settings.

Fore more information on the functionality and how to use EPiServer CMS, refer to the user doc-
umentation for EPiServer CMS.

Roles

E-commerce solutions with online stores can be set up in many different ways, depending on the purpose
they serve. An EPiServer Commerce sample installation is based on a setup of certain roles with specific
tasks and access rights. The description in this documentation reflects these roles in order to make it eas-
ier to understand the underlying work procedures.

Visitor

A visitor in EPiServer Commerce is someone using a web browser to visit the website with purchasing
intentions ("shopper"). In a standard installation of EPiServer Commerce (B2C), purchasing can be done
either anonymously or by registering an account. Registered visitors can also rate and comment on prod-
ucts.
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Store Administrator

The store administrator works in the Commerce Manager interface, with information related to cus-
tomers, orders and products. Store administrators may also work with configuration of the Commerce Man-
ager system settings. Depending on how the organization is set up, the store administrator role may be
sub-divided into sub-roles in Commerce Manager, with specific access rights and tasks:

e Order Supervisor - full permission for the entire order management.

e Order Manager - creates returns and exchanges, edits orders, sends notifications, processes pay-
ments and split shipments.

e Shipping Manager - handles packing and completion of shipments.

e Receiving Manager - handles shipments and returns.

System Administrator

In the Commerce Manager back-end system, this administrator role has extensive administration rights
in areas such as assets, catalogs, core functions, marketing and customer and order management.

Website Administrator

The website administrator is someone responsible for administrative tasks for the website, including the
setting of access rights for editors on the website. Usually has full access to both the editorial and admin-
istrative interfaces in EPiServer CMS.

Website Editor

Someone creating and editing content on the website with access to the editorial interface. Editors can
be either frequent editors or occasional editors, and they may or may not have publishing rights.

Website Owner

The website owner is someone with an overall responsibility for one or more websites. Creates content
occasionally, approves and publishes content created by others, and uses OnlineCenter and gadgets to
monitor website activities . May also be a marketer with a market perspective.

Refer to Access Rights for more information on access rights for different roles in Commerce Manager.

Shopping Workflow
There are many different types of e-commerce websites, however the two most common ones are:
e Business-to-Consumer (B2C) - typically designed for selling goods and services to consumers.

e Business-to-Business (B2B) - used to build strategic relationships with other businesses, and to
ease the supply and procurement processes that characterize trade among those organizations.

Sites can also have multiple roles, and a single EPiServer Commerce site can provide several functions.
EPiServer Commerce is a flexible platform allowing for seamless integration with external systems such
as financial, CRM, inventory, warehouse and customer service systems.
Depending on how you choose to work with editorial content and your online store administration, you
will define your user roles and groups, and give them access rights to the different parts. Example of user
roles in EPiServer Commerce are content editors, marketers, business owners, and store and system
administrators.

Step-by-Step Process

A typical "shopping workflow" involves a number of interactions between a "shopper" on the website,
EPiServer Commerce, and any integrated external system.. Depending on how the system is set up, the
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shopping workflow can be fully automated so that it requires little manual attention. However, a purchase
order can always be monitored, accessed and handled manually from the Order Management part of
Commerce Manager if needed.

In the following we will describe an example of a shopping workflow and the actions and tasks involved.
This example is mainly based on a standard installation of EPiServer Commerce, which is a B2C type of
e-commerce site.

Shopping Process

1. Welcome 2. Address 3. Payment 4. Confirmation

| 2. start 3. Add 4.Add 5. Order !
checkout address payment created |

I

1 ~ \ 7 =y ' ™\ 1

| Financial CRM Payment 1

1 system system gateway(s) : p

: /_\ . 1 6. Order
e —_— -

! shipping Inventory/ Customer 1 ?:nventqlaﬁ

: gateway(s) warercuse services 1 check
(A " )

: System : - Shipment split

1

b e e e e e e e e e e e e e - = -

Packing
Tracking # slip

Picklist

¥

10. Returns/ 9'0'"‘”' 8.Add to 7. Shipment
Exchanges ComBlc icklist released
L 9 | . shipped | | P |

1. Cartcreated
In this example, a shopper does not need to register on the site in order to buy. The order process
actually starts as soon as the shopper selects a product and adds it to a shopping cart. A cart will
be created and saved in the system, and can be viewed in Order Management under "Carts". If the
shopper doesn't complete the checkout procedure, the cart will remain in the system for a spec-
ified time.

When the shopper returns to the website, the cart will be "remembered" and made available for
continued shopping. Already in this early step the system will perform an inventory and pricing
check, to look for availability in the warehouse, as well as discounts for selected products in the
cart. This will be updated if and when the shopper returns to the cart at a later stage.

2. Start checkout
When the shopper decides to complete the purchase and chose to "proceed to checkout", the first
step of the checkout procedure is initiated.

3. Addaddress
In the second step of the checkout procedure, the shipping and billing address information is
added together with the preferred type of delivery (First class/Express etc). The address infor-
mation can be entered manually by an "anonymous" shopper, or automatically if the shopper is
logged in and has a registered user profile with address information. The system can also be set
up so thatitis possible to split shipments in different parts and to different addresses here.
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4. Add payment

10.

In step three of the checkout procedure, the payment is added to the "purchase order to be". The
system will calculate the total sum including the purchase amount and the shipping fee. In this
step the shopper selects a payment method, for instance by credit card or PayPal. The payment
will be registered and verified. This may happen instantly or after a certain specified time, depend-
ing on how the payment process is set up and the type of e-commerce solution (B2C or B2B). In
this step itis also possible to split payments, if the system is configured for this.

Order created

Usually the actual purchase order is created in the system when the payment is settled. In the last
checkout step, a purchase order number is created, the shopper confirms the purchase, and an
order confirmation is sent to the shopper. The shopping cartis now converted to a purchase order
which is visible with status "In Progress" under "Purchase Orders" in Order Management.

Order processing

When the order is created the order processing starts. This consists of steps to check the ware-
house and inventory status for the products in the order, and for creating the actual shipment.
Depending on the inventory status for the products, the order may be split into more than one ship-
ment.

Shipment released - when the shipment is verified, it will be released. The purchase order will
now appear in Order Management, under "Shipping/Receiving" and "Released for Shipping".

Add to picklist

This steps involves the addition of the shipping items to a picklist. The picklistis the list that the
warehouse will use to create the physical shipping of the products in the order. This step will also
produce a packing slip, which is the paper slip that will be attached to the physical package to be
shipped.

Order completed/shipped

When the picklists with the different orders and their respective packing slips have been created,
the order will be set to completed. In the system this involves the creation of a shipment validation
number which is associated with tracking number. The tracking number can be entered manually
or automatically, if such an integration exists. The tracking number connects the physical package
with the shipping provider for the delivery, and is used for tracking the package on its way to the
delivery address. The purchase order will now appear in Order Management under "Purchase
Orders" again, with status "Completed".

Return/Exchanges

Only completed orders can be subject to returns/exchanges. Depending on how the system is
set up, returns can be created automatically or manually. Creating a return usually involves replac-
ing a delivered product with another one in exchange, and/or a payment refund. When the return
is created it will appear in Order Management under "Shipping/Receiving" and "Returns". Order
status can be for instance "Awaiting Exchange".

If the return involves replacement of a new product, the shipping procedure will be initiated again.
The return may also involve receiving a faulty product, in which case a receiving procedure is ini-
tiated involving the acknowledgement of a receiving receipt for the returned product.

Integration with External Systems

EPiServer Commerce is a flexible platform built for integration with other business systems needed in an
e-commerce environment. These systems are typically integrated with various parts of the shopping work-
flow, for exchange of data with EPiServer Commerce.

Examples of such external systems:
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e Financial system - for instance invoice management, payment refunds,and sales reporting.
e CRM system - for management of customer profiles and address information.

e Payment gateways - the setup of different payment solutions for instance credit cards and Pay-
Pal.

e Shipping gateways - the management of shipping providers and exchange of tracking infor-
mation.

¢ Inventory/Warehouse system - exchange of inventory information in connected warehouses.

e Customer Services - exchange of for instance order status information.

Prerequisites

This documentation is intended for website editors, and store and system administrators. The doc-
umentation describes a sample installation based on the sample template package of EPiServer Com-
merce. Please be aware that your specific system may differ from what is described here, since your
website is most likely customized and may be integrated with additional systems.
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Getting Started

In the following sections we will describe how you can access, log in to and navigate an EPiServer Com-
merce website. Note that the login procedures may be slightly different from what is described here,
depending on how your website and infrastructure is set up.

Logging in to the Website

To access the website, open a web browser and enter the address of the website. Most often, Commerce
Manager is accessed through the front-end of the EPiServer CMS site. There are different ways of logging
on as an editor or administrator of an EPiServer Commerce site. Often you add a path such as "epi/ui/edit"
or "epi/ui/admin" to the URL of your website, or there might be a login link as for the EPiServer Commerce
sample site.

On the EPiServer Commerce sample site, clicking Log In in the top menu will take you to the login page of
the website. Enter your user name and password, and click Log In. Note that this login page is the same
for both customers logging on to their account, as well as for web editors and store administrators logging
on to work with content or administer the online store parts. What you are allowed to do after logging on to
the website depends on your access rights.

Register Logn  MyProfle  Engiish (United States} [+  Pound sterling =
Your Local Store
' 1 Park Road
Rickmanswoth
Hertfordshire
WD3 1RE wr Your Basket
enoteca (3~ +44 (0)1923 432¢ Ottem(s)  Total £0.00

Mixed Cases Popular searches | - | Enter Search Here [+]

Log in or create an account

Registered Customer * Required Fields
If you have an account with us, log in using your username.

Username *

Password *

Forgot your password?

Use your Facebook account to log in. | f connect
New Customers
Register on our site and create your personal profile.
New to Enoteca?
Take advantage of Enoteca's fine wine collections, education resources and special events by
registering. Register @

Accessing the Different Modes

When you are logged on to your EPiServer Commerce website, right-clicking on a page will display a
menu with a number of options. What you see here depends on your access rights, here we assume that
you have full permission to the different parts.

From the EPiServer right-click menu you can directly access the Commerce Manager module of EPiS-
erver Commerce. Choosing this option will take you directly to the Commerce Manager administration
interface. Selecting the Edit or Admin mode will take you to the EPiServer CMS editor or administration
interface. If you select Dashboard you will be taken to the Dashboard of the EPiServer OnlineCenter.
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4 On-page Edit
' New Page
E' Quick-edit
'CJ Dashboard
¥ Edit Mode
B Admin Mode

Q Commerce Manager
] Visitor Groups

® Print

=¥ Refresh

E

Dizable Menu

For the other options available, please refer to the EPiServer CMS user documentation.

Logging in to Commerce Manager

You can access Commerce Manager through right-clicking in View mode after logging in to the website,
and then select Commerce Manager in the right-click menu. You can also select Commerce in the top
menu when you are in the EPiServer Online Center or from the EPiServer CMS Edit mode.

O You may be required to provide your logon credentials once more when accessing the Com-
merce Manager module. When you log in you will be taken to the Commerce Manager Dash-
board Home page.

Navigation

EPiServer Commerce has an intuitive navigation. When logged on to EPiServer Commerce, use the right-
click menu to go directly to the Commerce Manager interface to work with web store back-end pro-
cedures. Or, chose the EPiServer CMS Edit or Admin mode to work with content management or system
administrative tasks. See also Accessing the different modes .

Navigating Commerce Manager
Once you firstlogin to Commerce Manager, you are directed to the Dashboard homepage.

e The Dashboard has Controls showing various information, including Alerts, News & Announce-
ments, Help, and a Summary.

e More Controls can be added by clicking on Add.

e On the leftis the Left Menu or Navigation iframe where users can switch between Commerce Man-
ager systems and navigate a folder trees of options.

e On the top-right, you can see your login name, product version, and installed license.
e By clicking on the top-left header, you will be directed back to the front-end site.

e On the menu bar below header, there are additional options available to the user.

~ By clicking Welcome, you can adjust your Settings, Sign In As a Different User, or Sign
Out of Commerce Manager. You can also change the language used to a different one if
your Commerce Manager is configured for multiple languages.

By clicking About, you can Send Feedback using a form, getinformation on the Database
Schema for support purposes, and open up our Online Help repository.
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On the right side of the menu bar, you can click on Get Help For this Page to get help on a
specific page you are in, such as the Catalog Edit page under Catalog Management.

e Rightnextto the Get Help For This Page button is an Up-Down Arrow, which allows you to hide

or display the header above the menu bar to save screen space.

Start CMS Commerce EPISERVER @ ? + L admin~ Q

Commerce Manager Settings

EPISERVER COMMERCE Dashboard Home e

sion: 5.2 (build: 91)
License: ECF G5 Deployment (EpiServer)

Welcome ™ Change Language About ™ 1@ Cet Help For This Page &

Dashboard &

News & ements - X Summary - X

») Home

EPiServer World News o products- 1319 © categories: 64 [

Lazar Gramatikov, consultant at Virtual Affairs, our member no Orders:
7000 0
Thu, 27 Aug 2009 08:43:00 CMT

[ntrocjucmrg thf Nrex-t Releése of EPiserver CM3 Performance - X
Fri, 03 Jul 2009 15:40:00 CMT

Download EPiServer CMS 5 R2 SP2 Today

Thu, 02 Jul 2009 14:55:00 CMT

EPiServer CMS 5 R2 SP2 Release Candidate is now available
Fri, 22 May 2009 16 0 GMT

Cet Started on EPiServer World!

Thu, 14 May 2009 12:0 CMT

Sales Graph

no sales data available

m

Kim Medin developer at NetRelations - our member no 6000!
Wed, 04 Mar 2009 13:30:00 CMT
EPiTrace for EPiServer CMS 5 R2 SP1

Tue, 03 Mar 2009 21:14:00 GMT
ﬁ Dashboard Help - X%

Q Customer Management

Help will appear in a separate window.

=

Catalog Management Find answers to questions about Commerce Manager containin B
the terms

uﬁ Order Management
Examples: Campaigns and Promotions

P marketing a. Howdo | Create a Discount Promation?
b. How do | Create a New Product?

«ﬂ Asset Management c. Where is the release history?

l reporti
S add

Administration

Other Navigation Elements

e The Dashboard Controls can be collapsed, rearranged, and closed by clicking on the Arrow but-
ton, clicking on the X button, and click-dragging the title bar, respectively.

e There are tabs below the left navigation frame that corresponding to a specific system of the Com-
merce Manager. Clicking on each button results in a change of the top side menu.

e A common navigational model is the hierarchical folder/node structure.

e Some systems, such as Customer Management, do not have collapsible nodes. Instead, you click
directly on the menu options to access its contents.
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Access Rights

By default, EPiServer Commerce uses a customized role and membership provider where users are
stored in the Commerce Manager database. Users with Commerce Manager accounts will be available
both from inside Commerce Manager under Customer Management, as well as from the EPiServer CMS
Admin mode. You will administer access rights both for users working with web shop administration in
Commerce Manager, as well as users working with editorial contentin the CMS system. These may or
may not be the same individuals, depending how your organization is set up.

The user administration in Commerce Manager is based on contacts. A contact can have an account
associated with it, which is needed if you want to assign Commerce Manager access rights to that con-
tact. Only contacts with associated accounts will appear in the CMS user administration interface.

O A contact must have an account associated with it to in order to be able to apply roles and set
access rights in Commerce Manager and the CMS system respectively. Users created from
the CMS Admin interface will not appear in Commerce Manager.

When an online shopper decides to register with the website, a contact with an account is created. How-
ever, anonymous shopping is allowed, which means that shoppers are not required to create an account
in order to purchase. Contacts can belong to organizations. The relationship between organizations, con-
tacts, accounts, roles and user groups, is illustrated below.

|. Organization ‘

Contact 1 | | Contact 2 ‘ | Contact..n

| Account |

In Commerce Customer Management: In CMS Admin interface:
Add Role(s) with Commerce Add Account to User Group(s)
permissions to Account with CMS Edit/Admin access rights

Contacts, accounts and organizations are administered from the Customer Management system in Com-
merce Manager. This includes managing user accounts and adding roles to users (contacts). Setting
access rights for editorial content management in the page tree of the website is done from the CMS
administration interface.

The EPiServer Commerce sample site has a number of predefined users, roles and groups both for
administering e-commerce tasks as well as managing editorial content. Remember that these users and
groups are only examples of how you can set up access rights for your website.
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User Access for Commerce Manager

Managing users and roles for store administrators is done in the Customer Management system. EPiS-
erver Commerce is built with flexibility in mind for structuring internal teams and departments as well as
external organizations, partners and customers. The Customer Management system allows for creating
users and groups with either pre-configured Roles or custom Roles which control access to different sys-
tems or individual elements within a system.

When you install EPiServer Commerce, you are provided with an administration account. This account
is given full privileges, meaning itis full access to all systems and all elements within each system. Addi-
tional accounts used by your internal team to access Commerce Manager must have one or more Roles
assigned to them. A role can be for instance "Catalog Viewers", "Marketing Admins" or "Asset Managers".

O Commerce Manager users are internal to your organization and should not be confused with
customers. By default, customers who register from your public site are given the "Everyone"
and "Registered" Roles, but these roles do not allow access to Commerce Manager.

A standard installation of the EPiServer Commerce sample site has a number of predefined roles. These
roles are based on common e-commerce working procedures and provides a suggestion to how you can
work with the system.

Commerce Manager Settings

EPISERVER COMMERCE Role List v (build: 204)
oyment (EpiServer)
Welcome ™ Change Language About ™ €/ Get Help For This Page %
Customer Management 2 || [INew | [ More Actions~
=l Customer Management [ Role Name
g| Organizations B Admins
[g Contacts B
= Order M
2 Roles B % Order Managers
[} )( Order Supervisor
=] )( Shiping Manager
=] )( Receiving Manager
B % Everyone
=] ¥ Registered
[} )( Management Users
B W Administrators
i ]| ¥ WebAdmins
[} W WebEditors
ﬁ Dashboard
Customer Management
o
Catalog Management
lﬁ Order Management
% Marketing
eﬂ Asset Management
{ﬁ Administration Banelaead 20 (11 items) | Page 4 1 ¢

Each role is associated with a range of permissions on different levels, related to the various parts of Com-
merce Manager.

The following roles are available by default, with a set of permissions for each role:
o Admins - default role allowing to fully administer most areas of the Commerce Manager.

e Order Managers - this role can create returns and exchanges, view and edit orders, send noti-
fications, process payments and split shipments. You can also allow order managers to manage
discounts and/or change the line item price.

e Order Supervisors - this role has full permissions for the entire order management procedure,
including the entire Order Managers permissions.
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e Shipping Manager - this role allows for viewing, packing and completing shipments.

¢ Receiving Manager - this role can view shipments and receive returns.

e Everyone - assigned when a customer registers an account from the front-end public site.
e Registered - assigned when you register from an Account from the front-end public site.

e Management Users - this role allows users access to Commerce Manager.

e Administrators - this role has extensive administration rights in areas such as assets, catalogs,
core functions, marketing and customer and order management.

e WebAdmins - this role is EPiServer CMS specific and provides access to the EPiServer CMS
administration interface, needed when administering the content management parts of EPiServer
Commerce.

e WebEditors - this role is EPiServer CMS specific and provides access to the EPiServer CMS edit-
ing interface, needed when working with content on the EPiServer Commerce website.

You can change the detailed permissions for each of these roles, as well as define your own roles and
set permissions, all in order to match the specific working procedures in your organization.

User Access for CMS

Access rights for content editors are managed from the Admin interface in EPiServer CMSsystem. Here
you can view all users and user groups under Search User/Groups. Setting access rights for editorial
content and the page tree structure is done from the Set access rights section, just as you normally do in
EPiServer CMS.

In EPiServer CMS, there are the following default roles:

e Everyone - an anonymous visitor browsing to your website. Can only access the View mode of
the website.

¢ WebAdmins - membership in this group provides access to the EPiServer CMS administration
interface.

e WebEditors - membership in this group provides access to the EPiServer CMS editing interface.

Please refer to the EPiServer CMS user documentation on world.episerver.com, for more information on
how to work with access rights for editorial content.
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[ st ETERN Commerce

Edit Mode Admin Mode Reports Visitor Groups

Admin || Config || Page Type

v

v

4

Product licensed to EFiServer AR Dung Le

As with any EPiServer CMS website, you can work with role and membership providers from Windows or
SQL, or both using the multiplexing setting. You can also build your own user and membership provider.
TheEPiServer Commerce sample site uses a customized role and membership provider in order to store
groups and users in the same place. Find out more about membership and role provide managementin

System Administration
Delete Unused Files
Edit Categories

Access Rights
Set Access Rights
Administer Groups
Search User/Group

Create User

Scheduled Jobs

Publish Delayed Page Versions
Subscription

Automatic Emptying of Recycle Bin
Clear Commerce Cache

Archive Function

Link Validation

Mirroring Service

Remove Permanent Editing
Change Log Auto Truncate

Remove Autosaved Page Drafts

Tools

Export Data
Import Data

File Management
Content Channels
Workflows

Search Users/Groups

Type

Name

Number of hits per page

TBEBBBEBBBEBBEBES

Groups

Name

Administrators
Admins

Everyone
Management Users
Order Manager
Order Supervisor
Receiving Manager
Registered

Shiping Manager
WebAdmins

WebEditors

Provider
CMSRoleProvider

CMSRoleProvider

CMSRoleProvider

CMSRoleProvider

CMSRoleProvider

CMSRoleProvider

CMSRoleProvider

CMSRoleProvider

CMSRoleProvider

CMSRoleProvider

CMSRoleProvider

the technical documentation for EPiServer CMS on world.episerver.com.
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Globalization

With "globalization" we mean the possibility to display content in different languages to website visitor
groups with different language preferences. When a visitor to the website selects a language option, the
content for that language will be displayed. If content doesn't exist in a selected language, a fallback pro-
cedure may be applied if this has been configured. Another dimension of globalization is the possibility
for users to select different language options for the user interface inside EPiServer Commerce.

Find out more about globalization and language managementin general on a website in the doc-
umentation for EPiServer CMS on world.episerver.com. In this section we will describe in more detail how
you work with the different language settings in EPiServer Commerce.

Language Settings

Specific Language Settings

In EPiServer CMS there are three different language concepts, two which are defined by ASP.NET (Cul-
ture and Ul Culture), and one which is the EPiServer content language. The ASP.NET Culture is referred
to as "System Language", and Ul Culture as "User Interface Language". A typical culture is "en-US" which
defines the language as English (en) with the culturally defined specifics for United States (US).

O In EPiServer Commerce, "Ul Culture" is used and "English (United States)" is the default lan-
guage used by the system. This is due to the Commerce Manager database which uses "Ul
culture" in the matching. In order for EPiServer Commerce to work properly, it is therefore
essential that you are using the "Ul Culture" setting on your website to make the different lan-
guages display correctly.

Make sure this is set up right from the start to avoid problems later on. Itis recommended that only
"Ul Culture" languages, i.e. "en-US", "en-GB", "nl-BE" etc., are enabled on the website.

Content Language

To display contentin the desired language on your EPiServer Commerce website, you may apply the lan-
guage management options available in EPiServer CMS Edit mode, to create pages in different lan-
guages. Available languages for CMS pages are enabled from the EPiServer CMS Admin mode under
Config and Manage Website Languages. For more detailed information on how the language settings
work, please refer to the user documentation for EPiServer CMS.
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[ st ETERN Commerce EPISERVER @ ? ~ & admin~ Q
Edit Mode Admin Mode Reports Visitor Gro
Admin || Config || Page Type .
Manage Website Languages @
¥ System Configuration
System Sewings Define the languages that should be available to visitors on your website.
Site Information
Edit Frames = Add Language
Manage Website Languzges Move Up | Move Down | Name Language Code | Enabled | System lcon | Template Icon
Remote Websites I English on " = =
¥ Security . . — —
Permisaions for Functions & L English (United Kingdom) ~ en-GB 2] 2]
. & o English (New Zealand) en-NZ =] =]
Plug-in Manager L &3 English (South Africa) en-ZA = =
Sinnge ey & o Deutsch de = =
Rebuild Name for Web Addresses
Wiaries 4 3 francais fr ] [ |
Register Web Parts & 3 espafiol es = =
Search Configuration
& n svenska s ” = =
iy 5 norsk no 0= =
& n dansk da = =
@ L3 suomi fi =
i 5 Nederlands nl = =
& I Nederlands (Belgié) nl-BE [¥] [¥]
iy 5 Portugués (Brasil) pt-BR = =
Y ;8 English (United States) en-US v = =
4t 5 Deutsch (Deutschland) de-DE [v4 =
& espaiiol (Espafia) es-ES v =

Languages for Product Catalogs

For products in the product catalog, the language information is setin the product database. EPiServer
Commerce will display the product information in the language selected by the website visitor. Lan-
guages for the content of a product catalog is set when you create the product catalog. Find out more
about this under Create a Catalog in the Catalog Management section.

User Interface Language

To set the user interface language for EPiServer CMS, click your user profile name in the upper right
corner. Select My Settings and then the Display Options tab. Select the language of your choice in the
list, and click Save. Note that you may need to refresh the browser window for the changes to apply.
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To set the user interface language for Commerce Manager, select Change Language in the upper menu
of Commerce Manager. Choose the language of your choice in the list and click OK to save you changes.

Commerce Manager Semuings

€EPISERVER COMMERCE

Welcome ™ Change l;anguage About ¥

Dashboard Home

6 cet Help For This Page s

Dashboard h Pl <

4 - %

Performance

-

x| =

| ;‘u Home
&5 Products: 1319 3 categories: 64
£ orders' 7 &7 customers-4

“F Promotions- 1

Help - X

Help will appear in a separate window.

Find answers to questions about Commerce Manager

containing the terms
Search Help

Examples: Campaigns and Promaotions

a. How do | Create a Discount Promotion?
b. How do | Create a Mew Product?

€. Where is the release history?

Add
Dashboard

Customer Management

Catalog Management

Order Management

Marketing

Asset Management

Reporting

Administration

Sales Graph

no sales data available

Total Sales (this year)

mn

no sales data available
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File Management

In EPiServer Commerce, there are two places to store content files (assets):
e In the File Manager of EPiServer CMS.
e Inthe Asset Management sub-system of Commerce Manager in EPiServer Commerce.

However, files can be managed entirely from the File Manager in EPiServer CMS. Using the Virtual Path
Provider (VPP) technique, the two storage areas are "synchronized" meaning that when you create fold-
ers and add files in one place, the same content will be available in the other location. Assets can be
created, updated, moved and deleted from the File Manager, and changes will be reflected in the Asset
Manager as well.

When installing the EPiServer Commerce sample site, the Asset Management sub-systemwill be auto-
matically configured and available in the File Manager as the Commerce Assets starting point. In the fol-
lowing we will briefly describe how files are managed in EPiServer Commerce.

Working With Files

The File Manager

Files such as images and documents, that are used in the editorial parts of the sample website, are stored
in the File Manager of EPiServer CMS, just as for any other EPiServer CMS site. With editorial content, we
hereby mean web pages with content that is created from the EPiServer CMS Edit mode. For instance,
this could be a news section with news items, or articles related to products on the e-commerce website.

The Asset Manager sub-system is made available in the File Manager of the sample site as the Com-
merce Assets starting point, making it possible to work with all files on the website from one place.

m [« "3 Commerce Mail EPISERVER @ 7 - A admin- Q
Edit Mode Admin Mode Reports Visitor Groups
0O % 4% @ v B | @ @@

Qur Services Page View Action Window

Page Type: [WineStore] Standard = English (United States) - Folders

Page Status: Published Version Compare With

anu(lure Favorites || My Tasks

B Root folder

>

] Commerce Assets

il Recyclesn (d Page Files Path: Commerce Assets
g""’”’“”" Preview H Edit H Versions H EPiServer Mail H Workflow | Starting Points 4
[::::w This is & demo store. Any orders placed through this store will not be honored or [RICFRECENIES [7] Show thumbnails
[ch[;mal — | Eremrrs Name Size | Modified
Your Local Store €] Dowrloads

e
[Footer Container] 14 [d Commerce
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AboutUs Wi Add fold. '] Specificati
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You work with folders and files in the Commerce Assets folder structure just as you do with other parts of
the File Manager. You can copy and move folders from Commerce Assets to other starting points such as
Global Files. However you cannot move or copy folders and files from other starting points to Commerce
Assets, since versioning is not supported. Also, metadata is not supported for the files under Commerce
Assets structure, so these fields need not to be filled in when adding new files to the structure.

To find out more about general file managementin EPiServer CMS, please refer to the EPiServer CMS
user documentation.

The Asset Manager

Files can also be managed from the Asset Management sub-system in Commerce Manager. The Asset
Manager folder structure can be used for storing documents related to products in the product catalog.
This can be for instance user guides, software downloads or product sheets. Each asset file can then be
related to a productin the product catalog.

Start cMS Commerce EPISERVER @ ? - L admin- Q

Commerce Manager Settings

. elco i

EPRPISERVER COMMERCE Asset List oduct Versian: 5.2 (buld: 204)
cense: ECF G5 Deployment (EpiServer)
Welcome ™ Change Language About 7 @ et Help For This Page %
Asset Management .::_—”’ ‘Dcrea(e New" ﬁMoreAcnons'

=3 Root [ New Folder Size Created

([OVideo [ MewFile

BT ETS |D Upload Multipe Filgs |

(] Specifications R

(] Software

(-] Dawnloads

[Z] User Cuides

[*]Images

A

ﬁ Dashboard

Customer Management
a

=

Catalog Management
lﬁ Order Management
E Marketing

/ﬂ Asset Management
Reporting 4 . »

. 1 it P 1
m Administration Page Size: 20 [=] (1 items) | Page 4 1+

For more information about asset management, please refer to the Asset Management section.

File Formats

Files stored in EPiServer Commerce are often image files in different formats such as .jpg or .png, or doc-
uments in .pdf formats. However, files stored in EPiServer Commerce can be of almost any type since a
wide selection of file formats are supported. Depending on how your website is configured, files will also
be indexed and appear in the global search for the website.
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Searching

Introduction

The EPiServer platform has a sophisticated search functionality which allows you to search through dif-
ferent types content on your entire website. You can search for web pages, blocks, document files and
community objects. The same search function is used in the global search available in the top global
menu of the EPiServer platform, as well as for sample search page templates and the file managerin
EPiServer CMS. The search can be extended to include results from external systems integrated with
your website.

The search results will automatically be filtered based on access rights so that users will only see content
they have access to. The search service in EPiServer is based on the open source search engine
Lucene. The service is plug-able which means that Lucene can be replaced by another search indexing
provider.

Accessing Search

The underlying search functionality is used by the different EPiServer products, and the description here
applies to standard installations of EPiServer products with their respective sample templates. Visitors to
the site will usually access the search through a website search page with a search field. The search
field is also available in the top menu of the website. Below is an example of the EPiServer CMS search
page. Checking the Search in files option in this page will also include files in the search, otherwise only
web page contentis searched.
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AllOQY Technologies

Home How to buy Products Company Mews and Events Contact Us

Search

The search page enables vou to search pages and files. You can

at return results from ditferent

Search result:

1. Venue (6/30,/2011)
Venue Located adjacent to Liverpoo] Strest Station, the
Andaz Hotel housed in a beautiful red brick Victorian

building will be our venue for the..

2. Alloy Plan (5/23/2011)
Project management has never been easier! Work with an
Alloy Technology partner to define and plan your project

using a methodology that decompose...

3. Alloy Track (5/23/2011)

Project mar agement has never been eazier! Work with ar
Alloy Technology partner to define and plan your project

using a methodology that decomposes..

From the top global menu, editors and administrators can access the global search option in the upper
right corner of the page when logged on to the website.
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L epiuser -

Allay Plan

Fages . Alloy Man - Project management has never been
'_ Allay Plan - Szate of the art praject planning 1o
__ Allay Plan Enhances Risk Management - Mew Ve
Alloy Plan White Paper = Scientific project
Alloy Plan viNext - Welcome to join if you would
._\"EHUE— Venue Located adjacent to Liver
__ Alloy Track - act management has r
Become a reseller - Interested in being a reselle

Contact - Community Manager Fiona Miller fiona

:_1|D3H{§!—' ve never had a meeting like th
5

Page Type [AllayTech] Standard page
Link URL /en Products Alloy-Meet

Changed
Created
Prewiew

/23720011 23243 FM
2/22/2010 3:05:00 PM
You've never had & meeting like this

before! Participants from remote
locations appear in your meeting room,
around your table, or presenting at your
white board. All discussion points,...

| Languwage English {United States)

When hovering over a link in the search hit list, information about the page will be displayed, helping you
identifying the correct item. Clicking on a link will take you to the item, for instance an web page or a doc-
umentfile.

How to Search

You can search for web pages with a certain name, and you can also search for pages that contain a cer-
tain text string. This means that if you cannot remember what the page is called but remember the first
lines of the text, then the page can easily be retrieved. It is also possible to search for a page using its ID
number, if you know this.

Search Tips

Enter a sufficient number of search keywords, usually around 6-8 carefully selected words, sep-
arated with a space. Start with fewer keywords and if needed narrow your search by extending the
number of words. Example: episerver product project.

When searching for specific phrases, you can combine keywords using quotation marks. Exam-
ple: "episerver search tips".

The search function is case insensitive, meaning that you can use both upper and lowercase
letters. Example: New York and new york will both return the same result.

You can restrict the search by placing a plus sign (+) in front of the words that must be found to
consider the page a match. Example: +episerver +search +tips.

Similarly you can restrict the search by placing a minus sign (-) in front of the words that must not
occur to consider the page a match, for example -episerver -search -tips.

To match part of a word, place an asterisk(*) at the end of the word. Example: word1* word2 will
return content with the words word123 and word2, but not word123 and word234.

The boolean operators AND and OR can be used. AND means "l only want documents that con-
tain both/all words", OR means "l want documents that contain either word, regardless of which
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one". Example: episerver AND search returns documents with both words, episerver OR search
returns documents with either episerver or search.

Displaying Search Results

The items in the search result listing will appear based on the ranking they received from the search algo-
rithm.The display of the search results depends on how this is set up on your website, since this can be
customized in many ways. Often some kind of filtering is applied which can be based for instance on cat-
egorization of content.

Administering and Configuring Search

The search feature has some administration and configuration options which are managed from the
administration interface in EPiServer CMS. Refer to the administration part of the EPiServer CMS user
documentation for more information.

Refer to the EPiServer Framework SDK for a technical description of the search functionality, con-
figuration possibilities and the integration interface.

Search in EPiServer Commerce

EPiServer Commerce features a provider model for the search index for both indexing and search que-
ries. This provision allows the development of additional custom search provider to other search systems.

When installing the sample site, Lucene will be the default search provider installed. To find out more
about Lucene, please visit the official Lucene website. The sample site also features faceted navigation,
a features allowing for advanced filtering of products in the product catalog.

Itis possible to replace the Lucene search engine with other search providers such as Solr. Refer to the
EPiServer Commerce Developer Guide for more information on how to set up and configure Solr as
search provider.

Related Information

Refer to the sections listed below for more information on related topics.
e Searching for product catalog entries
e Indexing product catalogs

e Faceted navigation
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Commerce Manager

This section explains how end users can administer e-commerce tasks through the EPiServer Commerce
back-end Commerce Manager e-commerce system. Commerce Manager includes a number of sub-sys-
tems for managing the different parts of an online store. The sub-systems are configurable, the setup
described here is that of the EPiServer Commerce sample site.

Dashboard

Customer Management

Catalog Management

Order Management

Marketing

Asset Management

| oL B[R B2

Reporting

e

Administration

=
M

Dashboard

Introduction

The dashboard is the area within Commerce Manager where you will find general status information
about your EPiServer Commerce application. The purpose of this area is to give administrators an "at a
glance" view of updates and status of the site or sites that are running on that particular instance of EPiS-
erver Commerce.

Dashboard View

The dashboard is an aggregated view of a site's status. Typically, the dashboard is the first screen seen
that a user sees when he/she logs into Commerce Manager. This is the area where a user can geta
quick overall snapshot of e-commerce site, including notifications and alerts, an overall summary of prod-
ucts, categories, orders, customers, and promotions, sales performance graphs, customizable news and
announcements, and a search field for help.

Customizing the Dashboard

The user can customize the dashboard by re-arraging the layout of the controls (or widgets) on the page.
The user has the ability not only to place the controls but also to adjust the page template that is used the
dashboard. The five available controls are: Help, Summary, News & Announcements, Alerts, and Per-

formance.
Corol ——owserpon
Help Allows users to search for help topics that links directly to the Mediachase
documentation site. Enter key terms into the Search field and then click on
Search Help. Other frequenly asked questions (FAQs) are listed under-
neath the Search field.
Summary Displays the total number of Products, Categories, Orders, Customers,

and Promotions .
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News & Announcements Displays a feed of the latest blogs from EPiServer World.

Alerts

Performance

Displays warnings about each site that may hinder performance and
sales, such as the lack of site analytics installed on the site .

Displays a Sales Graph and a graph for the Total Sales of the year.

Adding Controls and Adjusting the Page Template
Click on Add on the Dashboard page. The Information form pops up above the Dashboard page.

Information

Controls Set

EOEE

]

Page Template
Help
News & Announcements
Performance
Summary

| gsato default || E]Add and cI%H X Cancel |

The Controls Set tab allows you to select which Controls you want to add to the Dashboard. Check the
boxes and then click on Add and Close. The Controls you selected will appear on the Dashboard.

To reset the Dashboard back to the default state before any customizations were made, click on Set to

Default.

On the Page Template tab, you can adjust the Dashboard page layout to a One column template, Two
columns template (first twice bigger than the second), Two columns template (2nd twice bigger than
the 1st), and Two equal columns template. Click on the layout you want and then click on Add and

close.

Information

Controls Set Page Template

One column template

Two columns template (first twice bigger than the secand)

Two columns template (2nd twice bigger than the 1st)

Two equal columns template

]

| gsato default || E]Add and closeh” A Cancel |

The screen below is an example of how a One column template looks.
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‘ News & Announcements v X

Summary X

& Products- 1320 (O categories: 64 [ Orders:17 &1 customers: 10 = promotions: 1

Help - x

Help will appear in a separate window.

Find answers to questions about Commerce Manager containing the terms
Examples: Campaigns and Promations

a. Howdo | Create a Discount Promotion?

b. How do | Create a New Product?

¢. Whereis the release history?

Wadd

Rearranging, Collapsing, and Removing Controls

To rearrange Controls, hover the mouse cursor over the title bar and drag the Control to another space in
the Dashboard.

1ERCE Dashboard Home

News & Announcements - x ‘

Help - X

Help will appear in a separate window.

Find answers to questions about Commerce Manager containing the terms..
earch Help

Examples: Campaigns and Promotions

a. Howdo | Create a Discount Promotion?

b. How do | Create a New Product?

<. Where is the release history?

¥ Summary

& products: 1320 3 Categories: 64  [E] Orders: 17 &1

%3 promotions: 1

To collapse Controls, click on the Up-arrow icon. To expand a collapsed Control, click on the Down-
arrow.

Summary - X

4 Products: 1320 © categories- 64 (2] Orders: 17 &1 custamers: 10
%3 promotions: 1

News & Announcements - X |

Help J\ebx_

Help will appear in a separate window.

Find answers to questions about Commerce Manager containing the terms...
earch Help

Examples: Campaigns and Promotions

a. How dol Create a Discount Promotion?

b. How do | Create a New Product?

<. Where is the release history?

v
s dd

To remove a Control, click on the Xicon.

Customer Management

The Customer Management system is where you can add individual organizations, contacts, and Com-
merce Manager users. You can also create purchase orders for each individual customer account.

e Organizations - groups or sub-groups of Contacts

e Contacts - individuals with a certain set of personalized information (name, address, email, etc.).
Contacts can be customers or users with Commerce Manager permissions to manage one or
more systems.
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e Commerce Manager User - this is a user with an assigned role which provides access to the Com-
merce Manager site.

This is also from where Gift Cards are administered on the EPiServer Commerce sample site. Gift Cards
are described in more detail under Payment Methods.

Organizations

In the Organizations section, Commerce Manager users can create new organizations or organization
units, which are basically groups or sub-groups of assigned contacts.

Organizations can be categorized into different types such as organization or organization units (i.e.,
regional branches, departments) and also business categories such as "Computer and Electronics" or
"Clothing and Accessories." Organizations can be structured into a tree structure with sub-units with dif-
ferent levels of permissions assigned to each. For example, you can set up your company as a parent
level organization while your departments such as Sales & Marketing, IT/Development, and operations as
organization units. With this scenario, you can allow users in each departments to have access to only rel-
evant systems, screens and functionality within Commerce Manager.

The Organizations section also comes with a new customizable filtering feature to display organizations
and sub-units based on any of their attributes such as name, organization types, business categories, etc.

Browsing Organizations

Organizations are one of the major function areas of the Customer Management system. You can browse
and view existing Organizations.

To browse Organizations, go to Customer Management > Organization on the left menu.

Customer Management e

:Iﬂl Customer Management

:ﬂ Organizations

{m
Lgi Contacts AW,
é,‘:l Roles
B Gift Cards

This will open the Organization List page.

Viewing Organization Details

Organization details are separated by four columns:

Field Description

Name Name of the organization
Description Additional details of the organization
Type The kind of organization itis

Business Category Under which category the organization falls

JERCE Organization List

| |,J View: | All organizations E‘
y[:EINew Organization EﬁPrinterVersion 'X Delete

|:| Marme Description Type Eusiness Category

|:| Company X West  Online software applications Organization Computers & Electronics

|:| Company X Dn[tge software applications Organization Computers & Electronics
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You can click through the name of the Organization to view more details about it.

Organization Info

P
License:

0 Cet Help For This Page %

Edit Organizations

Name: Company X West Parent: Company X
Infor i Information
Information Or
Contacts Name: Company X West Type: Organization
Organizations
Addresses Description: Online software applications Business Category-Computers & Electronics

Credit Cards

Searching for Organizations

You can also use the search field on the Organization List to find specific Organizations by name. To con-
duct a search, enter in your search terms and click on the Search button.

To conduct a new search, click on the Reset button to reset the form and enter your new search terms.
Printing a List of Organizations

If you want to generate a printer-friendly list of Organizations, click on Printer Version. A new window will
pop-up and render a simple table suitable for printing. Click on the Print button on the upper right corner
of the page.

Creating or Customizing Views for Browsing Organizations

As an Organization List gets longer, users can create and customize views to filter the list.

To create a new view, click on the View drop-down menu and select "New View."

ERCE Organization List

| |,.J View: | All organizations E‘
” N I[ System Views |

“= New Organization | (5) Printer Version | % Delete All organizations

|:| Marre Description Type

|:| Company X East Online software application Organization Computers & Electronics

|:| Company X West  Online software applications Organization Computers & Electronics

|:| = CompanyX Online software applications Organization Computers & Electronics

A pop-up form appears above the Organization ListThis form gives users the ability to customize which
columns appear and apply a variety of filters.
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New Yiew ®

General || Fields || Filters

Enter Title

Everything is ready
1O Create a new view

[Tl show this view for all users for entities list.
Please, type view
name.

| Save | | Close |

The default tab is General. Enter in a Title for the custom View. Click the check-box Show this view for all
users, if you want other users to see this custom View.

New View *
General || Fields || Filters |
Enter Title
Professional Services Companies Ewverything is ready
to create a new view
[¥] Show this view for all users for entities list.

Please, type view
nare.

| Save | | Close

Click on the Fields tab to select which columns you want to appear in the custom View. Select the col-
umns you want to have appear by clicking and highlighting the column name and moving it over to the
Visible columns list by clicking on the Right Arrow icon.
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MNew View 4
Ceneral || Fields || Filters
Available columns: Wisible columns:
Description n Creator
Id h Business Category
Modified

Modifier

MName |I|
Parent (ref)

Primary Contact

Primary Contact (ref)

Type hi

m

=
[]

| Sawve | | Close |

To deselect a column, click and highlight a column name from the Visible columns list and then click on
the Left Arrow icon.

To change the ordering of the Visible columns list, click and highlight a column name and click on the Up
and Down Arrow icons on the right of the list to reposition the column.

Click on the Filters tab to set the View filters. Users are given precise controls over filters for setting up
rules for their custom View. Clicking on the + icon allows you add an additional filter.

New View *

Ceneral || Fields || Filters

_And
= Business Category Equals Arts & Entertainment
: Or

Please choose -

’ Please choose
And

Or

Business Category
Created
Description

Id

Madified

Parent

Parent (Reference)

Primary Contact

Primary Contact (Reference)
Type

| Save | | Close |

Click on Save to save the settings and return to the Organization List screen.
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To edit an existing View or a View you just created, select the View from the drop-down menu and click
on the Edit icon next to it. The View Editing form pops up and you are able to edit all properties.

ERCE Organization List

| |,J View: Professional Services Companies [+] %}(
ﬁ:EI New Organization 55 Printer Version x Delete Edit h
|:| Creatar Eusiness Categary Marne

]

To delete a custom View, click on the X icon next to the Edit icon.

There are a multitude of options available for customization, but here are some examples to get you
started.

Example View Filter Setups

The examples here will start off with the following list of sample Organizations, Organization Units, and
Divisional Units:

ERCE Organization List

| |,J View: | All organizations lz‘

= New Organization | =3 Printer Version | #< Delete

|:| Marme Description Type Eusiness Categary

|:| =¥ Company X East Online software application Organization Unit Computers & Electronics h
|:| = Company X West Online software applications Organization Unit Computers & Electronics

|:| Company X ITW... Online software application IT s... Divisional Unit Computers & Electronics

|:| = CompanyX Online software applications Organization Computers & Electronics

Example 1: Creating a View to Only Show Organizations that Match a Business Category and Organization Name

1. In this example, we will create a filter condition that display Organizations with a Business Cat-
egory that equals "Business & Professional Services" and an Organization Name that equals
"Company X."

2. Click on the +icon and from the drop-down select "Business Category." Two fields, which default
to "Equals" and "Arts & Entertainment," automatically appear. Click on "Equals" and a drop-down
appears. Keep the field as "Equals." Click the field to the right of it and select a "Business Cat-
egory" name (such as "Business and Professional Services").

3. Since we want to add another filter so that the Organization not only matches this "Business Cat-
egory," but also a specified name, click on the following + icon and then on the drop-down select
"Name."

4. Inthe nextfield, select "Equals" and then on the field that says "Text" enter in the name of the
Organization (such as "Mediachase").

5. Once done, click Save to save the View.
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New View
Ceneral || Fields || I-'ilter5|
' > Business Category Equals Business & Professional Services

Mame Equals Cnmpangx

Applying and Editing a View

Once a View is created and saved, it appears in the View drop-down box.

View: | Professional Services Companies - }(
[ System Views ] —
All organizations

patl User views ]
Professional Services Companies k
[ New Wiew ]

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the cus-
tom View, your Organization List will reflect those options.

ERCE A Organization List

| |,> View:| Professional Services Companies Iz‘ = )(
y[:El New Organization éﬁ Printer Wersion X Delete

|:| Eusiness Categary Mame Description Type

|:| Computers & Electronics Company X Online software applications Organization

Example 2: Creating a View to Display Companies with Specific Business Category or Organization Name

In this example, we will create a filter condition that display Organizations with a Business Category that
equals "Computer & Electronics" or an Organization Name that contains "X."

New View

Ceneral || Fields || Filters

Or
MName Equals X

Business Category Equals Computers & Electronics
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ERCE Organization List

| |,) View: | Professional Services Companies E w
’i{_§| Mew Organization ﬁ Printer Version X Delete

|:| Business Category Marrme Description Type

|:| =¥ Computers & Electronics Company X East Online software application Organization Unit o
|:| =¥ Computers & Electronics Company X West Online software applications Organization Unit

D =¥ Computers & Electronics Company X IT West Online software application IT... Divisional Unit

|:| =¥ Computers & Electronics Company X Online software applications Organization

Example 3: Creating a View to Display Companies with Specific Business Category and/or Name

In this example, we will create a filter condition that displays Organizations with a "Business Category"
that equals "Computer & Electronics" and/or an Organization Name that contains "X."

New View b4

Ceneral || Fields || Filters

, D or
> Mame  Equals X

Business Category Equals Computers & Electronics

MName Contains X

ERCE Organization List

| |,) View: | Professional Services Companies Iz‘ = )(
;I:El Mew Organization 5 Printer Version X Delete

|:| Business Category Marne Description Type

|:| Computers & Electronics Company X East Online software application Organization Unit

|:| Computers & Electronics Company X West Online software applications Organization Unit

|:| Computers & Electronics Company X IT West Online software application [T... Divisianal Unit

|:| %ﬂmputers & Electranics Company X Online software applications Organization

Creating an Organization

To create an Organization, click on New Organization.

Organization List

| |,.) View: | All organizations

;II:EI Mew Organization ﬁ Printer Version X Delete

|:| Marre U Description Type Business Category

]
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The Organization Edit page appears.

Field Description

Name Enter in the organization name (this is the only required field).
Description For additional details about the organization.

Type Select from the drop-down menu to assign a type to the organization. More
types can be added to the drop-down by clicking on the icon.

Business Cat- Select from the drop-down menu to assign a category to the organization.
egory You can add more categories by clicking on the icon.

Parent You can assign a parent organization to an organization. If the organization
you are creating is a sub-unit of a larger organization, then select the par-
entin the drop-down menu. If you do not see the Organization listed on the
drop-down menu, click on "More..."

Once you have entered all relevant information, click on OK. The Organization Info window of the organ-
ization appears.

From here, you can view Information about the Organization you just created. Out of the box, you can
also see associated Contracts, Organizations, Addresses, and Credit Cards. You can further edit the
Organization by clicking the Edit button. To go back to the Organization List, click on Organizations on
the menu bar next to Edit.

Welcome, admin

Organization Info Praduct Version: 5.1 (buid: 24)
License: ECF G5 Deployment (EpiServer)

@ cet Help For This Page ‘7

Edit a Organizations

Name: Company X West Parent: Company X

Information Information
Information Or
Contacts Name: Company X West Type: Organization
Organizations
Addresses Description: Online software applications Business Category-Computers & Electronics
Credit Cards

Creating an Organization Unit

An Organizational Unitis a "child" or subsidiary of a Parent organization. Within Commerce Manager, you
can assign an Organization as a Parent of another Organization. For example, the Parent company "Com-
pany X," and the Organizational Units are "Company X West" and "Company X East."

To create an Organization Unit, either create a New Organization or Edit an existing one.

1. Enterin a Name and Description.

2. From the drop-down, select the Type as "Organization Unit."
3. Selecta Business Category.
4

Select a Parent Organization from the drop-down menu. Selecting a Parent Organization will des-
ignate this Organization as a unit (or in other words, a division, sub-organization, subsidiary, etc.)

5. Click OK to save the changes.
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Overview
Name: Company X North
Description: COnline software applications :
Type: Organization Unit EI ﬁl
Business Category: Business & Professional Services lz‘ ﬁl
Parent: | Company X |j
Farent Organization

You will see in the Organization Info View form that the Organization is now a child or Organization Unit
of the Parent Organization you selected.

Organization Info

Em( Organizations

Name: Company X North Parent: Company X

Information Information
Informatian Or
Contacts Name: Company X North Type: Organization Unit
Organizations
Addresses Description: Online software applications Business Category:Business & Professional Services
Credit Cards

Creating an Organizational Hierarchy

You can create Organization Hierarchies by assigning a Parent Organization to a "child" Organization

and then another Organization to the child. Permissions can be set to determine which users can view cer-
tain Organizations in the hierarchy.

Create an Organization Unit by assigning a Parent with a child Organization. For example, "Company X"
is the Parent Organization and "Company X West" is the Organization Unit.

Assign another Organization with the child Organization ("Company X West"). Click OK.

ERCE Organization Edit

Overview

Name: Company X West

Description: Online software applications n

Type: Organization Unit =] 5

Business Category: Computers & Electronics IE' [

Parent: |C|:|rr1par'|‘,r)( |v|
F N.Dz Set o

QK || Cancel | Company X %—
More__.

In the Organization Info page, the Organization becomes the child to the Organization Unit you selected.
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ERCE Organization Info

Edit a Organizations

MName: Company X West Parent: Company X

Information Information
Information Organization
Contacts Name: Company X West Type:
Organizations
Addresses Description: Online software applications Business Categi
Credit Cards

[ Edit ][ cancel |

Repeat the steps above to create further subunits of the Parent Organization.
Creating and Editing Dictionary Entries

By default, when creating or editing an Organization, there is a default list of Types and Business Cat-
egories available to the user. More options can be created by editing the Dictionary within the Organ-
ization Edit page.

Adding New Dictionaries for Organization Type
1. To edit the Dictionary, open the Organization Edit page by creating a new organization or editing
an existing one. Click on the icon next to the Type drop-down menu.

2. The new window appears allowing you to edit the existing organization Type dictionary . To add a
new item to the dictionary, click on New ltem.

3. Selectthe order of the item from the drop-down on the left.

4. Enterin a name of the item on the field next to the drop-down.
5. Click Save to save the dictionary item.
6

The dictionary item is now available in the Type drop-down.
Adding New Business Categories

Out of the box, there is a list of categories you can assign to an organization. You can add more cat-
egories the same way you add organization types.

1. Click on the dictionary icon next to the Business Category drop-down menu.

2. Click on New Item to add a new category.

3. Enterin a category name and then click . You can change the order the category is on the list by
clicking on number drop-down menu.

4. The category now appears in the drop-down menu.

Contacts
Contacts are individuals with a certain set of personalized information (name, address, email, etc.).

e Contacts with Accounts - a customer who registers on the public site. If this customer chooses,
he/she can login to histher Account from the public site and access his/her order history and other
personalized information. He/she cannot access the Commerce Manager.

e Contacts with User Permissions - someone internal to your team who has varying levels of
access to the systems within Commerce Manager.
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Contacts consisting of users who will be accessing the Commerce Manager can be assigned Roles
based on varying permissions. For example, a user with the "Cms Admins" role will have full access to
only the Content Management system. In addition, notes regarding the Contact's registration source can
be recorded.

The Contact section also comes with a new customizable filtering feature to display contacts based on
any of their attributes such as Name, Last Order Date and Customer Group.

Browsing Contacts

To browse Contacts, go to Customer Management > Contacts.

Customer Management Q—“‘

:Im Customer Management
:ﬂ Organizations
:E Contacts [fe
&7 Roles J

B Gift Cards

Viewing Detailed Contact Information

The Contact List page shows a list of existing Contacts.

ERCE List

-

| |,J View: | All contacts Iz‘
8 New Contact | =3 Printer Version | P Delete Selected

|:| FullName2 FirstName2 Last Name Middle Name
|:| =¥ Receiving Manager Receiving Manager

|:| =¥ Order Manager Order Manager

|:| =¢ lennifer Browne Jennifer Browne

[ ="' MarySmith Mary Smith

|:| =¥ Shipping Manager Shipping Manager

[0 = zdmin admin

|:| Y Order Supervisor Order Supervisor

|:| =¥ Carlos Mevada Carlos Mevada

|:| =¥ LisaPrescott Lisa Prescott

You can click through the name an existing Contact to view more information.
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, admin

Emt ¥ Delete Contact Contacts D New Order
Full Name: admin Parent Organization:
Infor Infor i |
Information _ Contact
Addresses Full N 5 4 c c ~
Credit Cards ull Name: admin ustomer Group:
Security First Name: admin Preferred Currency:
Roles
Middle Name: Preferred Language:
Orders
Order History Last Name: Registration Source:
Shopping Lists Parent Organization: Last Order Date:
Wish Lists
Shopping Carts Preferred Shipping
Address:
i Preferred Billing
Address:
~— Account Edit Account | Change Password | Remove Account —,
User Name: admin Is Locked Out: none
Description: Last Activity: Today, 2:49 PM
Email: admin@yourcompany.com Last Login: Today, 2:48 PM
Last Password 7/7/2011 9:34:45 AM
Changed:

From within the Contact Info form, you can view other recorded information about the Contact. For exam-
ple, you can view Addresses and Order History related to this Contact.

O More objects or metadata can be added to the default View Form via Business Foundation.

Searching for Contacts

On the Contact Info page, you can use the search form above to search for a particular Contact using key
terms. Conduct the search by clicking on the Search icon (magnifying glass). Contacts that match the
search terms will appear on the list.

&

|vi sitor |

G=|Mew Contact | S Printer Version | ¥ Delete Selected

(]
(]

Full Marme First Marne

EPiserver Commerce Visitor Visitor

To clear the search and revert back to show all Contacts, click on the Reset icon (eraser) next to the
Search icon.

Generating a Printer Friendly List of Contacts

To generate a printer friendly layout of the Contact List, click on Printer Version from the menu bar on
the Contact List page.
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List

v
| |,) View:  All contacts
8= New Contact | (S Printer Version| | 3 Delete Selected
|:| FullName2 A" FirstName2 Last Mame
|:| ¢ Receiving Manager Receiving Manager
|:| = Order Manager Order Manager
|:| B¢ lennifer Browne Jennifer Browne
0 Mary Smith Mary Srith
|:| =¥ Shipping Manager Shipping Manager
[ ="' admin admin
|:| Qrder Supervisor Order Supervisor
|:| =¥ Carlos Nevada Carlos Nevada
|:| ¢ Lisa Prescott Lisa Prescott

A new browser window opens showing a printer-friendly version of the Contact List. Click on Print on the
far right corner of the browser window.

Contact

Full Name First Name Last Name Middle Name Last Order Date|Customer Group
Receiving Manager|Receiving |Manager

Order Manager Order Manager

Jennifer Browne  [Jennifer Browne

Mary Smith Mary Smith

Shipping Manager |Shipping Manager

admin admin

Order Supervisor |Order Supervisor

Carlos Mevada Carloz Nevada

Lisa Prescott Lisa Prescott

Creating or Customizing Views for Browsing Contacts
Llke Organizations, users can create or customize Views when browsing objects.

Creating a New View

On the Contact List page, click on the View drop-down menu and select New View.

ERCE Contact List

| |,) View: | All contacts E‘
— I[ System Views |

|8 New Contact | £ Printer Version | 3¢ Delete Selected All contacts

|:| Full Marme First Mame

[ Mats Hellstrém Mats Hellstrom

[ admin admin
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A pop-up appears, very similar to the one found in Organizations. This form gives users the ability to cus-
tomize which columns appear and apply a variety of filters.

New View #

Ceneral || Fields || Filters

Enter Title

Everything is ready
to create a new view
far entities list.

Please, type view
narme.

DShnw this view for all users

The default tab is General. Enter in a Title for the custom View. Check the box Show this view for all
users if you want other users to see this custom View.

New View *

Ceneral || Fields || Filters

Enter Title

Only in Company X Everything is ready
to Ccreate a new view

[¥] Show this view for all users for entities list.
Please, type view
name.

Click on the Fields tab to select which columns you want to appear in the custom View. Select the col-
umns you want to have appear by clicking and highlighting the column name and moving it over to the
Visible columns list by clicking on the Right Arrow icon.

New View *

Ceneral || Fields || Filters

Available columns: Visible columns:
Code First Name
Created Full Name
Creator Email

Customer Group D
Date OF Birth EL%

. |

Last Name

Last Order Date

Middle Name
Modified k7

*

m

| Save | | Close |

To deselect a column, click and highlight a column name from the Visible columns list and then click on
the Left Arrow icon.
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To change the ordering of the Visible column list, click and highlight a column name and click on the Up

and Down Arrows on the right of the list to reposition the column.

Click on the Filters tab to set the view filters. Users are given precise controls over filters for setting up

rules for their custom View. Clicking on the + icon allows you add an additional filter.

Mew View

Ceneral || Fields || Filters

e And

Parent Organization Equals Company X

Please choose

Please choose

And

Or

Code

Created

Customer Croup

Date Of Birth

Email

First Name

Full Mame

Id

Last Name

Last Order Date

Middle Mame

Modified

Parent Organization
Parent Organization (Reference)
Preferred Billing Address

I

Preferred Billing Address (Reference)
Preferred Currency

Preferred Language

Preferred Shipping Address

Preferred Shipping Address (Reference)
Registration Source

There are a multitude of options available for customization.
Applying and Editing a View

Once a View is created and saved, it appears in the View drop-down box.

JERCE Contact List

| |I) View: | Only in Company X =
N [ System Wiews ]
|S=|New Contact | = Printer Version | # Delete Selected All contacts
[ Ernail Full Mame Firdl User views ]
Only in Company X k‘
[ &' mats@episerver.com Mats Hellstram Ma|[ New View ]
|:| F¢y mary.smtih®@comopanyx.... Mary Smith Mary
|:| =¥ peter.sunna@episerver.com Peter Sunna Peter

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the cus-
tom View, your Contact List will reflect those options.

To edit an existing View or a View you just created, select the View from the drop-down menu and click
on the Edit icon next to it. The View Editing form pops up and you are able to edit all properties.
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View:| Only in Company X E ﬁ by

[t}

First Mame

Creating a Contact

To create a new Contact, from the Contact List page, click on New Contact.

ERCE Contact List

jo)

MNEWCDntaCE ﬁPrinter‘u"ersion XDEIEte Selected

[

Fullﬁz}me First Mame

The Contact Edit page appears where you can enter all relevantinformation about the contact. The only
required fields to complete are Full Name, First Name, Last Name, and Email. The rest of the fields are
optional but are recommended.

1.

@

Select a Parent Organization from the drop-down menu to associate the Contact with a single Par-
ent Organization.

Assign the Contact to a Customer Group. More Customer Groups can be added by editing the
Customer Group Dictionaries. Customer Groups become useful when setting specific permissions
and targeted Marketing Campaigns. (For more information, see "How to Assign a Customer Group
Sales Price for a Particular Item" section below.)

Select a Preferred Currency for the contact. If the Contactis in France, you may want to associate
the Euro currency. Available currency options are based on settings in Administration > System
Settings > Dictionaries > Currencies.

Select a Preferred Language to associate with the Contact. Languages are populated based on
the languages set under Administration > System Settings > Dictionaries > Languages.

The Registration Source field is a text field for entering in notes about the Contact. For instance,
you may want to reference which website the Contactis currently registered under.

The Registration Source field is automatically filled when a user creates a new Account from
the public website.
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ERCE Contact Edit

Overview
Full Name: Mary Smith
First Name: Mary
Middle Mame:
Last Name: Smith

Email: mary.smtin@comopanyx.com

Contact Email Description

Parent Organization: Company X | o |

Cantact Organization

Customer Group: Customer E .ﬁ?
Preferred Currency: us dollar IE'
Preferred Language: English (United States) IE‘
Registration Source: companyx

| oK || Cancel

Click OK to save the Contact. The Contact Info View Form, where you can enter in additional information
about the Contact as well as go back and edit the Contact again.

O The screenshot below shows the default layout of the Contact Info form. This can be cus-
tomized using Business Foundation.

Contact Info

=/ Edit | ¥ Delete Contacts
Full Name: Mary Smith Parent Organization: Company X
Information Information
Information Contact
Addresses Full Name: Mary Smith Customer Group: Customer
Credit Cards
Orders First Name: Mary Preferred Currency:  USD
Order History Middle Name: Preferred Language: en-us
Shopping Lists Last Name: Smith Registration Source: companyx
Wish Lists
Shnppmmms Parent Organization:  Company X Last Order Date:
Account Create account
Account not found:-

To go back to the Contact List, click Cancel or the Contacts button next to the Right Arrow icon.
Creating an Account

An Account can be created with a Contact. Once an Account has been created, the Contact can be
assigned permissions using Roles and access the Commerce Manager.
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O A customer Account is automatically created for a customer who registers from the front-end
public website, allowing them to login and view personalized information.

To create an Account for an existing Contact, click on a Contact name from the Contact List. On the Con-
tact Info page, click on Create Account.

W e, admin
ERCE Contact Info Product Version: 5.1 (build

License: ECF GS Deployme!
@ Get Help For This Page

4

=/ Edit | ¥ Delete | [EJ Contacts

Full Name: Mary Smith Parent Organization: Company X
Information Information
Information Contact
Addresses Full Name: Mary Smith Customer Group: Customer
Credit Cards
Orders First Name: Mary Preferred Currency:  USD
Order Histary Middle Name: Preferred Language: en-US

Shopping Lists
Wish Lists
Shopping Carts

Last Name: Smith Registration Source:  companyx

Parent Organization:  Company X Last Order Date:

Account

Create accn{}_'mjt
Account not found-

A pop-up appears to enter in their user account credentials. A User Name and Password are required to
create the Account.

1. Enterin a User Name, which can include spaces and special characters.
Enter in a Password, which must be four or more characters.

Enter in a Description and Email Address, which are both optional.

B DN

To enable the account, select "Yes" under Approved. Otherwise, select "No" to keep the account
inactive and inaccessible by the user.

5. Click OK to save the account.

Create account *

User Name:  Mary
Password: TYTTTIT ]

Description: mary.smith®companyx.com

Email: mary.smtih@companyx.com

Approved:  @Yes (Mo

| n OK | | a Cancel

User account information appears under the Account section of the Contact Information form.
Fields Explained:

e Last Activity - last time the user logged in or made any changes to the site
e Last Lockout - last time a user was locked out due to too many failed login attempts
e Last Login - last time the user logged into his or her account

e Last Password Changed - last time the user account password changed
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ERCE

Contact Info

1@ Get Help For This Page +
=/ Edit | ¥ Delete Contacts
Full Name: Mary Smith Parent Organization- Company X
Information
Information Contact
Addresses Full Name: Mary Smith Customer Group: Customer
Credit Cards
Security First Name: Mary Preferred Currency:  USD
Roles Middle Name: Preferred Language:  en-US
Orders Last Name: Smith Registration Source:  companyx
Order Histary
Shopping Lists Parent Organization:  Company X Last Order Dare:
Wish Lists
Shopping Carts Account Ed\[ACEDqE; | Change Password | Remove Account
User Name- Mary Last Activity: 5/1/2010 817:44 AM
Description: mary smith@companyx com Last Lockout: none
Email: mary.smtih@companyx.com Last Login: 6/1/2010 8:17:44 AM
Last Password o !
Changea: 6/1/2010 8:17:44 AM

Editing an Account, Changing an Account Password, and Removing Accounts

To edit an Account, click on Edit Account. The same pop-up will appear. You cannot change the User

Name unless you remove the Account and recreate the same Account.

To change the password, click on Change Password. A password pop-up appears with an editable field

that allows you to enter in the new password.

To delete or remote the account, click on Remove Account.

Create an Order Within a Contact

For customer accounts, you can create purchase orders.

1.

Click on a contact name. You will see the contact details.

2. Click on New Order on the menu bar.

3. The New Order form appears to generate an order for the customer.

EPISERVER COMMERCE

Welcome ™ Change Language About

1@ Get Help For This Page *

[

Cust M T =
Tt edit | % Delete Contact contacts | | NDrdEr
S customer Management
5] Organizations Full Name- Carlos Santana Parent Organization:
[g contacts -
B Roles Information Information |
@ Gift Cards Information || -~ contact
Addresses il Caros s c c
Credit Cards ull Name: arlos Santana ustomer Group:
Security First Name: Carlos Preferred Currency:
Rol
oles Middle Name: Preferred Language:
Orders
Order History Registration enoteca episerver.com, |
Shopping Lists Last Name: Santana Source: 5;30’930’&?3333?0’
Wish Lists 000000000000
Shapping Carts
Parent Organization- Last Order Date:
! Preferred Shipping Home
Address:
Preferred Billing Home
ﬁ‘ P Address:
@ Customer Management ~ Account ——— Edit Account | Change Password | Remove Account —
= - .
- e —— User Name- Carlos Is Locked Out- none
Description: Last Activity- Today, 2:29 PM
? Order Management
Email: carlos@somemail.com  Last Login: Today, 2:02 PM
mp T Last Password
% 2/15/2012 12:49:10 PM
= Changed:-
o= Asset Management

e
—
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Roles and Permissions

In the Roles section, Commerce Manager users can be either granted or restricted access to an entire sys-
tem or a particular menu item within a system. Each Role is defined by a set of Permissions that can be
added or changed based on user selection. Existing Roles can be customized; new Roles can also be
created to suit your unique business needs.

Roles control the level of access permissions of each user accountin Commerce Manager. Different
Roles may be added to user accounts (i.e., store operator or webmaster) so that they can access, edit, or
process relevant information.

There are three main categories that determine the different levels of permissions: Admin, Manager, and
Schema Manager.

e Admin Role - allows users to fully access and administer a particular Commerce Manager system.

o Manager Role - allows users to manage (View/Create/Edit/Delete) existing aspects of a particular
Commerce Manager system .

e Schema Manager - allows users to access only the administrative side of an Commerce Manager
system (e.g. setting up Meta Data).
Definitions of Roles

Selecting Roles in the left menu opens a Roles List page with the default Roles shown below. The Roles
List page allows Commerce Manager administrative users to add new, edit or delete these existing roles.

Here is a listing of the roles available out-of-the-box followed by a brief high-level description of what a
user with this role can access:

e Admins - allows users to fully administer most areas of the Commerce Manager.

e Everyone - one of the default roles which is assigned when a customer registers an account from
the front-end public site.

e Management Users - allows users access to the Commerce Manager.
e Order Supervisor - allows users to fully administer the Order Management system.

e Order Managers - allows users to manage (View/Create/Edit/Delete/Others) elements within the
Order Management system.

e Registered - one of the default roles which is assigned when you register from an account from
the front-end public site.

e Shipping Manager - has the ability to view, pack, and complete shipments.

e Receiving Manager - has the ability to view shipments and receive returns.

O You can easily modify these existing roles or consolidate roles. In addition, custom roles can
be created depending on your business needs.

See also the User Access and Roles section, to find out more about access rights and role management
in EPiServer CMS.
Creating, Editing, and Deleting Roles

Out of the box, Commerce Manager includes a list of pre-existing Roles that can be assigned to Accounts.
Users can also create their own Roles based on a set of Permissions. Roles allow Administrators to
restrict users from accessing different systems or folders depending on their needs.

Creating a Role

To create a new Role, go to Customer Management > Roles to see the Role List.
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EPISERVER COMMERCE Role List

Welcome ¥ Change Language About ™

Shipping Manager

Customer Management = I3 New ¥ More Actions ™
)
:Im Customer Management [ Role Name
@ Organizations | admins
& Contacts
l-_:i O Order Managers
&7 Roles
B Cift Cards [ Order Supervisor
(&l
(&

Receiving Manager

il

1L
MM M X

Click on New to open up the Role Edit page.

ERCE Role Edit

Overview

Role Name:

Permissions: »
2 g Asset i

h [[Manage

[z [[lAdministration
= [*g catalog

h [|catalogs

g [C]Administration
=l m Content

g [C]Sites

'z [[lAdministration
= m Core

h [[Management

g [ClAdministration
= [*g Customer

‘g [C|Roles
= [*3 Marketing

h [[|€ampaigns

[*z [[]Promations

h [[|Customer Segments

m

There is a wealth of Permissions options Administrators can set for a Role.
Enter a Role Name.

Checkmark the boxes to give Permissions to the Account for this particular function or action. For exam-
ple, if you want an Account to only View and Edit Assets, you will need to expand Assets > Manage and
checkmark View and Edit.
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ERCE Role Edit

Owverview

Role Name: | accet view/Edit

Permissions: ;
= b Asset

= [*g [[|Manage
[ View
[|Create
U

Once done defining the Role, click on OK. The new Role will appear on the Role List.

O ¥ Customer Managers

[l ¥ Everyone

O % Registered

] ¥ Asset View/Edit

Page Size: | 100 IE‘

elete

Editing Existing Roles

All existing Roles, including the ones included out of the box with Commerce Manager, can edited and
customized. ltis also a recommended reference to how each pre-existing Role works.

To edit a Role, click on the Edit icon.
Catalog Managers
Catalog Schema Managers

Order Admins

P IE|

Order Managers

Marketing Viewers

il

Customer Viewars

Bl

OO0O0OOO o
Al [
XX X XXX

The Role Edit page appears. You can customize the Permissions settings for the Role. Once done, click
OK.

Deleting Roles

To delete any Role on the list, there are two ways:

Click on the X button next to the name of the Role to delete one at a time.

>( Cms Viewers

>( Markeating Admins

T i A i R
El
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To delete multiple Roles, checkmark each box and on the menu bar, click on More Actions > Delete
Selected. Click OK when the pop-up appears.

ERCE Role List

Maore Actions~

L
®
2

Delete Selected

Asset Admins

fl

Asset Managers

il

Catalog Viewers

Cms Admins

il

Cms Managers

Cms Viewers

Al

Cms Editors

fl

4
b A b b 8b ab g G (Ve Y

Management Users

Al

DEEEEEEC
Bl

Assigning Roles to Individual Accounts
Roles are designed to allow and disallow certain functionality and folders to individual accounts. When a
Contactlogs into his or her account, that Account is bound by the Roles it was assigned.

To assign one or more Roles to an account, go to Customer Management > Contacts and click on an
existing Contact with an Account.

ERCE Contact Info

& Get Help For This Page %

&=/ Edit | ¥ Delete Contacts

Full Name: Mary Smith Parent Organization: Company X
Information Information
Information Contact
Addresses Full Name: Mary Smith Customer Group: Customer
Credit Cards
Security First Name:- Mary Preferred Currency:  USD
Rm% Middle Name: Preferred Language:  en-US
Orde Last Name: Smith Registration Source: Companyx

Order History

Shopping Lists Parent Organization: Company X Last Order Date:
Wish Lists .
Shopping Carts Account Edit Account | Change Password | Remove Account
User Name: Mary Last Activity: 6/1/2010 2:17:44 AM
Description: mary.smith@companyx.com Last Lockout: none
Email- mary.smtih@companyx.com Last Login: 6/1/2010 91744 AM

Last Password

Changed: B/1/20109:17.44 AM

Under Security, click on Roles. The Security section only appears after an Account was created for the
Contact.

The Roles form appear, allowing you to assign Roles to the Account. By default, an Accountis already
assigned to the "Registered" and "Everyone" roles.
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Contact Info

i@ Get Help For This Page &

= Edit | X Delete Contacts

Full Name: Mary Smith

Parent Organization:

Company X

Information
Information
Addresses
Credit Cards

Security
Roles I:

Orders
Order History

Shopping Lists
Wish Lists
Shopping Carts

Roles

L |

5 Assign Role | ¥ Remove Roles

Eale Name

]

] Registered
() Everyone

nane
none

Organization Inheritance

[ Undefined ]
[ Undefined ]

Page size: 20 []

(2 iterns) | Page < 1 »

Click on Assign Role to assign a new Role to the Account. A pop-up appears allowing you to assign a
specific Role from the drop-down menu.

Assign Role

Security Role:

Organization:

Inheritance:

Cms Admins

Company X

Inherit From Parent

Save | Cancel

Select a Security Role from the drop-down to assign to the Account.

Optionally, you can assign an Organization to the Account, which enables the Inheritance drop-down
menu below. If specific permissions are set for an Organization, you can set to "Inherit from Parent"
(inherit permissions from the Parent organization) or "Overwrite parent."

Click Save to assign the role. Repeat these steps to assign more roles to the Account.

ERCE Contact Info
EF Edit | % Delete Contacts
Full Name: Mary Smith Parent Organization: Company X
Information Roles
Information "= Assign Role | 3 Remove Roles
Addresses
Credit Cards F Role Narne Qrganizatian Inheritance
Security | Registered none [ Undefined ]
Roles \ ] Everyone none [ Undefined ]
Orders ] a_f Cms Admins Company X Overwrite parent
Order History
Shopping Lists Page Size:| 20 (3 iterns) | Paged 1 b
Wish Lists
Shopping Carts
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Catalog Management

The Catalog Management system provides full complement of tools and capabilities to create and man-
age a diverse range of products, variations, pricing strategies, languages, and related website functions.

To manage products, you can go to the back-end Commerce Manager and you will notice that products
are arranged into one or more catalog(s). Catalogs are independent from one another and you may
create as many catalogs as you need. Catalogs can be structured in a number of ways. For example,
you may have various brands or product lines. Each brand or product line can have its own catalog. Or,
a retailer may have multiple suppliers, in which case, you can segment each supplier into its own catalog.
A default B2C Sample Site along with a default electronics catalog (consisting of a Brands catalog + an
Everything catalog) is included giving you a running demo site after you run the installer.

EPiServer Commerce allows you to easily and flexibly organize and categorize your products. All prod-
ucts referenced on a front-end site reside in a catalog created in Commerce Manager. Multiple catalogs
can be created and assigned to one or more sites. The dates that each catalog will be available to the cus-
tomer can also be defined. In this way, future revisions to items and pricing can be prepared easily and
reviewed in advance of the release date to the site.

Catalogs can be organized into Categories, Products, SKUs, Bundles, Packages and Dynamic Packages.

Catalog and Catalog Entries

e Catalogs - a catalog is a top-level container for all catalog entries such as Categories, Products
and SKUs.

e Categories - a Category is a grouping of purchasable products.

e Products - a Product represents various forms of merchandise that you can display and purchase
from the front-end site, including Products, Variations/SKUs, Bundles, Packages and Dynamic
Packages.

Product Entries - a Product Entry typically contains a product name, part number, descrip-
tion and images.

Variations/SKUs - a Variation or SKU corresponds to a specific type of product with spe-
cific characteristics. For example, a shirt product will have an individual Variation/SKU
which includes size, color and sleeve length.

Bundles - a Bundle is a collection of Variations and SKUs allowing customers to purchase
two or more items at once.

Packages - a Package is comparable to an individual SKU because the Package item
must be purchased as a whole (i.e. computer system).

Dynamic Packages - a Dynamic Package is similar to the Package definition above with
the added ability to configure the Package during checkout.

Woorking with Catalogs

A catalog is a top-level container for all catalog entries such as Categories, Products and SKUs. In this
section, you will learn how to browse, create, and delete catalogs. We recommend that you start with the
catalog that came with the EPiServer Commerce sample site, which contains the Wine sample

catalog. You can also use the export/import functionality to get catalogs into a different environment.
Also, you are given the flexibility to use a .csv file to rapidly create a new catalog from scratch.

Browsing Catalogs

All Catalogs are managed under the Catalog Management system.

© EPiServer AB



64 | User Guide for EPiServer Commerce 1 R2 SP2

To browse the Catalog, click on Catalog Management on the left menu. Click on Catalogs to browse the
list of Catalogs.

Catalog Management .:f"

= = Catalog Management
-5 Catalog Entry Search
E (Catalog Batch Update

| =l Catalogs T
=i Wine

H [ Accessories

4[] Imported

4 || Mixed Cases

4[| Wine Region
=] Templates

The Catalog List page shows the Wine sample node by default, together with associated sub-categories:
e Accessories
e Imported
e Mixed Cases
e Wine Region

Clicking on the Edit icon, located between the check box and the folder icon, will display more infor-
mation and settings of the particular Catalog in the Catalog Edit page.

Clicking on the Catalog name ("Wine") will take you to the Node List page, which is the list of Sub-Cat-
egories under the selected Catalog.

. lelcome, admin
MERCE Catalog List oduct Version: 5.2 (b
icense: ECF G5 Deploy
& Get Help F
L4 Mew Catalog ﬁ Import/Export™ ﬂ Maore Actions ¥
|:| Mame Available from Expires Available
[} !l‘éi] Wine 9/12/2011 11:11:00 AM 9/12/2021 11:11:00 AM True

Creating a Catalog

The Catalog List page, used to organize and manage catalogs, contains information regarding brands
and sales items. These sets of information will either be displayed on the front-end site, or used for other
purposes such as for pricing and Promotions.

To create a new Catalog, click on New Catalog.

MERCE Catalog List

L New Caﬁﬁl_ng ﬁ Import/Export ™ ﬂ Maore Actions ™
|:| ';i_”;' MName

[ ﬂ‘é‘] Wine
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e Catalog Name - this name will appear in the Catalog List Page ("Wine").
e Catalog Owner - designate an existing user as the Catalog owner.
e Available from - select the date to which the Catalog is activated.

e Expires on - select the expiration date; once the expiration date passes, the Product will no longer
appear on the front-end site.

e Default Currency - this setting will set the Default Currency for the relevant Catalog contents.
e Default Language - this will set the Default Language for the contents.

o Base Weight - this assigns the weight units for the contents of the Catalog (e.g. pounds or kil-
ograms). More units may be added.

e Other Languages - you can also select other available Languages other than your default Lan-
guage.

o Sites - this determines the site/sites that the relevant Products will be displayed in, if you have mul-
tiple sites.

e Sort Order - the Sort Order determines the order to which the Catalog appears in the Catalog List
page.

e Available - select "Yes" to make the Catalog contents appear on the front end site; select "No" to

hide the Catalog from the front-end site.

Once done setting up your catalog attributes, select OK to save the catalog. You will be brought back to
the Catalog List with the new catalog. Select Cancel to cancel out of the Catalog Edit page and back to
the Catalog List.

ERCE Catalog Edit

Overview
Catalog Name: Wine
catalog name description
Catalog owner: @ Mot Set hd
Available from: 9/12/2011 B 1111 AM
Expires on: 9/12/2021 o am
Default Currency: Pound sterling hd

DefaultLanguade:  gpglish (United States) +

Base Weight: in kilograms ~

Other Languages: | ppglish (United States)
Cerman (Cermany)
Spanish (Spain)
French (France)

Sites:

Sort Order: 0
Available: @ Yes © No
| QK || Cancel

Importing and Exporting Catalogs

Preexisting catalog data can be imported or exported quickly to and from Commerce Manager.
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Accessing the Import & Export Functions
1. Access the Catalog List page in the Catalog Management subsystem. The Import/Export menu is
located in the upper left corner of the main window.
2. Forexporting catalogs, click on the check box for the appropriate catalog nodes.

3. Click on the Import/Export pull-down menu to choose either import or export. The corresponding
page will appear in the main window.

MERCE Catalog List

|4 New Catalog ﬁ Import/Export ™ ﬂ More Actions ¥

O N ﬂg CSV Import Catalog '\I'__")J
[ ﬂﬂ W ﬂg Impaort Catalog

ﬂﬁ Export Catalog

Importing Catalogs

1. Browse and select the file to upload.

2. Click on the Upload file button. The files upload will appear in the list below.

3. Click on the Start Import button. The progress window will show that the import is taking place.
4

When the importis 100% complete, close the progress window.

It is strongly recommmended that you back up your ECF database before performing import.

To import catalog, please pick up an existing file from the grid below or upload a new one. Then click the button "Start Import' to start importing.

Add Mew File

Files Available For Import:

Actions File Name Size

Created Last Updated
Download | Delete CatalogExport_Catalog_Wine_Sample.zip 74290 KB Today, 2:35 PM Today, 2:34 PM
1 Page 1 of 1 {1 items)

Exporting Catalogs
There are two ways to export catalogs in the Export Catalogs page.
1. Export everything included in the catalog node that you've selected.

e To do this, click on the Start Export button. The progress window appears and shows the status of
the export.

e When the exportis 100% complete, click on Close to close the progress window

2. Export only the desired files.
e To do this, click on the Download links highlighted in blue.
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Welcome, admin
ER C E E)(pOl't Catalog Product Version: 5.2 (build: 377)

License: ECF C5 Deployment (EpiSel
0 Get Help For This Page

Export

You're about to export a catalog. Click the button to start.

Exported Files List
Actions File Name Size Created Last Updated
Download | Delete CatalogExport_Catalog_Wine_Sample zip 74290 KB Today, 10:31 AM Today, 10:31 AM

1 Page 1 of 1 (1 items)

Using CSV Files to Quickly Create Custom Catalogs

Why Should | Use a CSV File?

The CSV catalog importis a feature in the Catalog Management system that enables you to import and
manage catalog entries (such as Products, Variations/SKUs, Packages) in bulk using an excel spread-

sheet (.csv format). It is an alternative to manually creating catalog entries directly in Commerce Manager,
which can be tedious when dealing with a large amount of catalog data.

This feature enables you to accomplish these key tasks:
e Import your .csv spreadsheets and create new catalog entries in Commerce Manager.
e Setyour catalog items into a desired category structure of your choosing

e Create entry relations to associate one entry with others (e.g., variation/SKUs will appear within a
product or a package)

e Editor delete existing catalog items..
The CSV catalog import feature can be used for your entire catalog data, or just portions of them.

Import Overview

Here are the basic steps you can take to import and set up a new catalog using the CSV import feature.
Before you start, choose an existing catalog folder or create a new one (in the Catalog Management sys-
tem) to import the CSV files to.

1. Create CSV data files (using Excel Spreadsheet, Notepad, etc.) with information about your cat-
egories, entries, and entry relations.

2. Create necessary meta fields for the new catalog entries (in the Administration system).

3. Upload the CSV data files to the CSV Import page.

4. Create a mapping file for each CSV file. A mapping file is needed to link each column of data in a
CSV file to the correct attributes in Commerce Manager.

5. Importthe CSV files and their corresponding mapping files into a specific catalog.

6. Create entry relations to associate one entry with another (e.g., a Package and a Product, a Prod-
uct and a Variation/SKU, etc.).

Format for CSV Files

CSYV files you create and importinto Commerce Manager need to have a particular format.

e The first row should have headers that correspond to different attributes of the data you want to
import (e.g., product name, price, description, image file location, etc.).

e There are a few attributes that are in your CSV file to correctly structure your catalog:

e Code: A unique code to identify each category or entry
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Name: A unique name for each row of data

Entry Type (for entries only): Each row must contain one of the following five words in order for
the Commerce Manager to correctly recognize its entry type --"Variation", "Product”, "Package”",
"Bundle" or "Dynamic Package"

Parent & Child Entry Code (for entry relations only): A CSV file containing these codes can spec-
ify relationships between entries (e.g., display different Variations within a Product).
Although , the following attribute is useful in creating a hierarchy in your catalog:

Action: A command to specify the action that will be taken during the import. Choose one of the
three options: Insert/Update/Delete or I/U/D.

Note: Please make sure to specify an appropriate command for each line of the CSV files. Enter-
ing "Insert" when that data already exist, or "Update" when no data exist will give an error during
import and those line of data will not get successfully imported.

Category Code (by comma): By assigning a category code to an entry, you can specify the cat-
egory that you want to place your entry in.
Also please note this rule:

SEO URL: By design, this attribute that is presentin both categories and entries must be unique
for each item in your catalog. Importing files that contain more than one identical url will resultin
an error.

Mapping Types

Different mapping types are used to create the mapping files mentioned in step 4 above.

Category w/ Meta Data — select this type to create a mapping file for your category files.

Entry w/ Meta Data — select this type to create a mapping file for all the entry files (i.e., Packages,
Products, Variation/SKUs, Bundles, and Dynamic Packages).

Entry Relation — select this type to create a mapping file for your entry relation file that specifies
the relationships between entries such as many SKUs to one Product, or SKUs and Products to a
Package.

Entry Association — select this type when creating a mapping file for entry associations (Adver-
tizing other items under titles such as "You may also be interested in...

Variation w/ Inventory — select this type to create a mapping file to import your Pricing/Inventory
data located in your Variation/SKU Edit screen.

Sale Price — Select this type to create a mapping file for Sale Price file, which specifies different
currencies for each item.

By selecting these options, the Commerce Manager will display different sets of Fields and Attributes for
you to manually assign to each data column of your CSV file. Figure 8 and 9 below shows the display of
the mapping files with the Category w/ Meta and Entry Relations Data type respectively. The items under
Fields and Attributes with superscripts 1 and/or 2 are headers that are required attributes that must exist
in the CSV files you are importing (1- required field for Insert, 2 — required field for Update).

Example: Importing and Setting up a New Catalog

The example below demonstrates how to use CSV import using the guidelines provided above.

Let's say you want to set up a "Baby Stuff' catalog with categories and entries as shown here in Figure 1.
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(Example Catalog)
Catalog Categories & Subcategories Products Variation/SKiLls Packages
Baby Stuff Infants — Diapering Supplies - Diapers ————  Newborn size Package NB
Size 1 “-Package 30 &
——  Sizel
Size 3
_Wipes— Portable
——  100shests ———
300 sheets

Toddlers Potty Training Pants Blue Pants
Pink Pants
Yellow Pants

Figure 1
Prerequisite: Create a new catalog

First, create a new catalog called "Baby Stuff" in the Catalog Management system.

Step 1: Create CSV files containing data for your new entries

The example below is based on an a set of sample .csv files.
These files provide the base for the discussion in the following section.

The sample files contain the following:
e BabyStuffCategories.csv
e BabyProducts.csv
e BabyPackages.csv
e BabyVariations.csv
e BabyVariationInventoryPricing.csv
e BabyEntryRelations.csv
e BabyAssociations.csv
e BabySalePrice.csv
CSV File Type 1 - Category File
This file specifies data for categories and/or subcategories within a Catalog.

The top line has column headers that will be matched with the Meta fields in the later steps. The headers
can also have different names. As you will see in later steps, Category Code in column 1 is important

since it specifies where the entry data will be stored. The code entered in under Parent Code in column 2
can be used to create subcategories. If the Parent Code is set to "null" or "root," then that category will be
created in the root level of a catalog. In this example, the "Infants" and "Toddlers" category will be created
at the root level, while the "Diapering Supplies" category will be located under "Infants" as a subcategory.

A B C D E F G
1 Action Category Code Parent Code Category Mame Available from Expires on Available (True/False
2 |Insert Catl null Infants 1/1/2009 /172009 TRUE
3 |Insert Cat2 null Toddlers 1/1/2009 /172009 TRUE
4 |Insert Catll Catl Diapering Supplies 1/1/2009 5/1/2009 TRUE
3
Figure 2
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CSV File Type 2 — Entry Files

These files specifies data for Catalog Entries. The Products, Variation/SKUS, and Packages CSV files for
this example are shown in Figure 3, 4, and 5 respectively.

yil B C D E F ]
1 |Action Product Code Product Name Entry Type Category Code Available from Expires on Awvail:
2 |Insert frodl Diapers Product Catl0 1/1/2009 6/1/2009
3 |Insert orod2 Wipes Product Catl0 1/1/2009 5/1/2009
4 |Insert orod3 Paotty Training Pants Product Cat2 1/1/2009 6/1/2009
=
Figure 3
A B C D E F G
Variation Category
1 |Action Code Variation Mame Entry Type  Code Available from Expireson |
2 |Insert Varl Diapers - Newborn size Variation Catlo 1/1/2009 6:00 10/1/2012 18:00
3 Insert Var2 Diapers - size 1 Variation Catl0 1/1/2009 6:00 10/1/2012 18:00
4 |Insert Var3 Diapers - size 2 Variation Catl0 1/1/2009 6:00 10/1/2012 18:00
5 |Insert Vard Diapers - size 3 Variation Catlo 1/1/2009 6:00 10/1/2012 18:00
& Insert Vars Diapers - size 4 Variation Catl0 1/1/2009 6:00 10/1/2012 18:00
7 Insert VarG Training Pants - Blue Variation Cat2 1/2/2009 11:00 10/1,/2012 18:00
g8 |Insert Var7 Training Pants - Pink Variation Cat2 1/2/2009 11:00 10/1/2012 18:00
9 Insert Varg Training Pants - Yellow Variation Cat2 1/2/2009 11:00 10/1/2012 18:00
10 | Insert War9 Baby Wipes - Portable 80 ¢t Variation Catl0 1/2/2009 11:00 10,/1/2012 18:00
11 Insert Varl0 Baby Wipes - 300 ct Variation Catl0 1/2/2009 11:00 10/1/2012 18:00
12 [Insert Warll Baby Wipes - 700 ct Variation Catlo 1/2/2009 11:00 10/1/2012 18:00
13
14
Figure 4
A B C D E F G
1 |Action Package Code Package Mame Entry Type Category Code Available from Expires on  Availa
2 |Insert Package NB  Mewborn Package Package  Catll 1/1/2009 12/31/2010
3 |Insert Package3tof 3 to6mo Package Package  Catll 1/1/2009 12/31/2010
4
Figure 5

CSV File Type 3 — Entry Relations File

This file is used to link one entry to others. In this example, Var1 ~ Var5 (different diaper sizes) are asso-
ciated to Prod1 "Diapers," Var9 ~ Var11 (different quantity for wipes) are associated with Prod2 "Wipes"
and so forth. Also some variations are assigned to packages. Please note that the Prod, Var and Package
codes MUST BE the codes from the entry CSV files (Figure 3, 4, and 5). If you include codes that are not
defined in the entry CSV files, you will get an error while importing them into Commerce Manager in Step
4.
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A
Action
Insert
Insert
Insert
Insert
Insert
Insert
Insert
Insert
Insert
Insert
Insert
Insert
Insert
Insert
Insert

Figure 6

C

B

Parent Entry Code Child Entry Code
Prodl Varl
Prodl War2
Prodl Var3
Prodl Vard
Prodl Vars
Prod2 Varg
Prod2 Varld
Prod2 Varll
Prod3 Varg
Prod3 Var7
Prod3 Vard
Package MNB Varl
Package MB Varld
Package3tos Var2
Package3ton Varlo

CSV file type 4 - Associations file

This file is used to create associations between different entries. In this example, Var 10 is associated to

Var 1 as an Accessory, and Var 2 to Var 1 as a cross-sell item.
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1
2
2

a

A
Action
Insert
Insert

Figure 7

B

Baby Catalog Association Mame
Accessories

C

Parent Entry Code Child Entry Code Sort Order
Warld
War2

Varl

Customers Who Bought This Item Also Bought Varl

CSV file type 5 - Pricing/Inventory file

This file is used to specify the information for the Pricing/Inventory tab of each individual entry.

ESTR- ', T S T O

o m

(=)

[y
[y

12
13

i
A

Acticn

Update
Update
Update
Update
Update
Update
Update
Update
Update
Update
Update

Figure 8

CSV file type 6 - Sale Price file

L]

Entry Code Price

Varl
Varl
Var3
Vard
Vars
Vark
Var?
Vark
Vars
Varlo
Varll

16

[y
-

[
A

o N N s N e Y =)

(e N R e B Vs A Y Y )

Tax Category

Genera
Genera
Genera
Genera
Genera
Genera
Genera
Genera
Genera
Genera

Sales
Sales
Sales
Sales
Sales
Sales
Sales
Sales
Sales
Sales
Sales

E
Track Inventory
[True/False)
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
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This file is used to specify the information for the Pricing section of the Pricing/Inventory page.

A B C D E F 5 H
1 Action Entry Code Sale Type Sale Code Unit Price Currency Start Date End Date
2 |Insert Varl BEBV1 16.99 UsD 1/1/2009 6:00 10/1/2009 18:00
3 |lnsert Var2 BEV2 17.99 UsD 1,/1/2009 6:00 10/1/2009 18:00
4 Insert Var3 BBV3 17.99 UsD 1/1/2009 6:00 10/1/2009 18:00
5 |Insert Vard BEvV4 18.99 UsD 1/1/2009 6:00 10/1/2009 18:00
6 |Insert Vars BBVS 18.99 UsD 1/1/2009 6:00 10/1/2009 18:00
7 |Insert Varb BBVE 25.99 UsD 1/2/2009 11:00 6/3,/2009 23:00
& |Insert Var7 BBVT 25.99 UsD 1/2/2009 11:00  6/2/2009 22:00
9 |Insert Var3 BBVSE 25.99 UsD 1/2/2009 11:00 6/1/2009 19:00
10 |[Insert Var9 BBV 4.49 UsD 1/2/2009 11:00 6/2/2009 22:00
11 |Insert VarlO EBV10 15.99 UsD 1/2/200911:00 6/2/2009 22:00
12 |Insert Varll BEV11 25.99 UsD 1/2/2009 11:00 6/2/2009 22:00
13

Figure 9

Step 2: Create necessary meta fields for the new catalog entries

For this example, no additional meta fields need to be created because the sample spreadsheet uses
only the default attributes.
To create new meta fields follow these steps here.

Go to the Administration system in Commerce Manager.

Sele
fram

Sele

ct the "Catalog System" folder and then "Meta Classes" node located in the left navigation
e.

ct Create New, then New Meta Class from its pull-down menu.

e Enterin a Name, Friendly Name (e.g., Baby Catalog), and some description
(optional) for the meta class, and choose "Catalog Entry" for Entry Type.

e Click OK to save the new class.

Next Select Create New, then New Meta Field from its pull-down menu.

e Enterin a Name, Friendly Name (e.g., Baby Diaper Size), and some optional
description.

e Also Choose the data type for this meta field and other properties by clicking on the
checkboxes.

o Click OK to save the new field.

e Repeat the steps to create all the necessary fields.

e Associate the new meta fields to the meta class you created.

e Selectto "Meta Classes" node on the left navigation frame again.

e For "Element" choose "Catalog Entry" in the pull-down menu.

e Under "Type" choose your meta class (e.g., Baby Catalog) you created earlier.
e Selectthe desired meta fields from the list displayed at the bottom of the screen.

o Select OK to save the new meta class to fields association.
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e You are done with setting up your meta fields.
Step 3: Upload the CSV data files to the CSV Import page

Follow these steps to prepare the CSV files for import:
e Selectthe Catalog Management system.

e In the upper-left detail area, click on Catalogs folder and you will see the Catalog List view in the
main area.

e In the action area above the main view, click the Import/Export drop-down button and select CSV
Import Catalog.

e You will now see the CSV Import Catalog page in the main screen. The screen contains two tabs
1) CSV Import and 2) Mapping File, which we will be talking about next.

CSV Import Tab
e Inthe "CSV Import" tab in the main view, click "Add New File."
e Browse for the CSV file you wish to import, then click "Upload File."
e When you get the "Uploaded File:" confirmation, click "Save the file."
e The CSYV file you uploaded will be added to the "Files available for import:" list.

o Repeatthe previous four steps for each CSV file you wish to upload.
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CSV Import Mapping file

It is strongly recommended that you back up your ECF database before performing import.

To import catalog, please pick up an existing file from the grid below or upload a new one, Then dick the button 'Start Impart’ to start impo

Add Mew File

Files Available For Import:

Actions File Mame Size Creas
Download | Delete BabySalePrice.csv 151 bytes Todan
Download | Delete BabyAssociations.csv 215 bytes Todan
Download | Delete BabyEntryRelations.csv 254 bytes Todan
Download | Delete BabyVariationInventoryPricing.csv 1.52 KB Todan
Download | Delete BabyVariations.csv 1.20 KB Todan
Cownload | Delete BabyPackages 259 bytes Todan
Cownload | Delete BabyProducts.csv 269 bytes Todan
Cownload | Delete BabyStuffCategories.csv 274 bytes Todan
1
Choose mapping file.

Actions File Name Size Creat

Choose catalog for import.

Catalog: | Erands

| Start Import

Figure 10

Step 4: Create a mapping file for each CSV file

Now create a mapping file that will specify the data in the CSV file to its corresponding attributes in the

Commerce Manager.

Mapping file tab

e Click the "Mapping file" tab in the main view. You will now see the "Mapping file" tab view of the
CSV Import Catalog view as shown in Figure 11.
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CSV Import Mapping file

Edit existing mapping file.

g file. [Babyproducts xml v
MetaClass, Language Data File And C5V Adjustment
Mapping Type: Category wf Meta Data v Data File: BabyStuffCategories.csv ha
Meta Class: Default Catzlog Node v Delimiter: . -
Language: English {United States) ~ Text Qualifier: " -
Encoding: Default v

Column headers in the data file Custom values
TU/0) | column 1 - Action v

Column 2 - Category Code e

Column 3 - Parent Code v

Column 4 - Category Name A

Column 5 - Available from ha

<Custom value>

Column 1 - Action

Column 2 - Category Code
Column 3 - Parent Code

Column 4 - Category Name
Column 5 - Available from

Column 6 - Expires on
Column 7 - Available (TruefFalse)
Column 8 - Sort Order

Sawve mapping file.

Figure 11
Edit existing mapping file section
e Load mapping file: This section is used to retrieve previously created and saved mapping files.
Since there is no existing mapping file in this example, leave this section blank.
Meta Class, Language section
e Mapping Type*: Select "Category w/ Meta Data"
e Meta Class*: Select "Default Catalog Node"
e Language™: English
Data fle and CSV adjustment section

e Data File*: The drop down values presented here are dependent on the different CSV data files
you uploaded on the "CSV Import" tab in step 2.
e Forthis example, first choose "BabyStuffCategory.csv."Leave the rest of the field as default and
move on to the next section.
Fields and Attributes, Column headers in the data file, and Selected values section
The values presented under the "Fields and Attributes" column are representative of the "Meta Class"
selected in the "MetaClass, Language" section above (which were either previously imported or created
within Commerce Manager).
The values presented in the drop-down menus under the "Column headers in the data file" column are
representative of the "Data file" selected in the "Data file and CSV adjustment" section above (which were
previously imported above).
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Select the appropriate "Column header" drop-down value to "map" with the MetaClass "Fields and
Attributes" to the left; the value selected will be reflected in the "Selected values" column to the
right.

Save mapping file section

e Enter a file name for the "Enter file name" textbox. For this example, save the mapping files using
the same CSYV file names.

e Click the "Save" button. The browser returns to the CSV Import tab, and the mapping file in XML
format will be added to the listin the "Choose mapping file" section.

e Repeat Step 3 to create and save a mapping file for each CSV files you wish to import.

e For CSV Entry files, select the "Entry w/ Meta Data" option under "Mapping Type."

e For CSV Entry Relations file, select "Entry Relation".

e For CSV Associations file, select "Entry Association."

e For CSV Pricing/Inventory file, select "Variation w/ Inventory."

e For CSV Sale Pricing file, select "Sale Price."

e When all the mapping files are saved, your CSV Import tab screen should look something like this.

CSV Import || Mapping fil

Tt is strongly recommended that you back up your ECF database before performing import.

Toimpert catalog, please pick up an existing fle from the grid below or upload @ new one. Then dlck the button 'Start Impart’ te start importing,

Add New File

Files Available For Import:

Actions File Mame Size Created Last Updated
Dovnlozd | Delste EzbySzlefrice. 138 bytez  Yesterday, 4:35 PM Yesterday, 5:14 FM
Delete EzbyAssocistio 215 bytes  Yesterday, 4:33 PM Yesterday, 4:33 PM
Dslsts EzbyEntryRelation: 354 bytes  Yesterday, 4:33 PM Yesterday, 4:33 PM
Delete EzbyVariationlnventoryPricing.csv 1.54 KB Yesterday, 4:23 P Yesterday, 4145 PM
Delete Ezbyvariatio 1.20 KB Yesterday, 4:23 PM Yesterday, 4:21 PM
Dslsts EzbyPackag 255 bytes  Yesterday, 4:21 FM Yesterday, 4:21 FM
Delete BabyProdud 363 bytes  Yesterday, 4:21 PM Yesterday, 4:21 PM
Dovnlozd | Delste EzbyStuffCategorias.cv 274 bytes  Yesterday, 4:21 PM Yesterday, 4:21 PM
1 Page 1 of 1 (& items)
Choose mapping file.
Actions File Marne Size Created Last Updated
Dovnload | EzbySzlePrice.xml 2.82 KB Yesterday, 4:43 PM Yesterday, 4:55 PM
EzbyAssocistions.xml 2.05 KB Yesterday, 4:42 FM Yesterday, 4:42 PM
BabyEntryRelations.xml 1.97 K8 Yesterday, 4:42 P Yesterday, 4:42 PM
EzbyVariationInventeryPricing.xm| 5.22 KB Yesterday, 4:41 FM Yesterday, 4:50 FM
EabyVariations.ml 4.12 KB Yesterday, 4:40 P Yesterday, 4:40 PM
EzbyPackages.xml 4.11 KB Yesterday, 4:38 PM Yesterday, 4:32 PM
EabyProducts.xml 4.14 KB Yesterday, 4:358 FM Yesterday, 4:38 FM
Dovnload | Delete EabyStuffCategory.cml 4.63 KB Yesterday, 4:37 PM Yesterday, 437 PM
1 Page 1 of 1 (& items)

Choose catalog for import.

[Babvswf®

Start Import

Figure 12

Step 5. Import the CSV files and their corresponding mapping files into a specific catalog

Atthe "CSV Import" tab view (Figure 12), do the following:

Select and highlight the CSV file you wish to import in the "Files available for import" section. For
this example, select BabyStuffCategories.csv.

Select and highlight the mapping file that corresponds to the selected CSV file in the "Choose
mapping file for import" section. For this example, select BabyStuffCategories.xml.

Select the catalog in the "Catalog" drop-down into which you would like to import your CSV data.
In this example choose "Baby Stuff".

© EPiServer AB



Commerce Manager | 77

e Click the "Startimport" button. You will see the "Importing catalog" modal dialog box which will
notify you of the percentage of completion as well as logging messages.

e Click "Close Window" at the bottom of the modal dialog to complete the operation.
e Repeat Step 4 to import all the remaining CSV & Mapping pairs.
Step 6. Verify Your Import
In the Catalog Management system, expand the "Baby Stuff" folder under Catalog and verify that the con-
tents of your CSV file were imported into the appropriate catalog.
Deleting a Catalog

1. Atthe Catalog List page, check off the box to the respective Catalog you wish delete.
2. Select More Actions and then Delete Selected from its pull-down menu, located in the menu bar.

3. A pop up will appear to confirm your action. Select OK to delete it. The chosen catalog will be deleted
from the list.

ERCE Catalog List

| New Catalog ilj Import/Export ™ ﬁ More Actions ™

D Name )( Delete Selected

ﬂﬁ Wine hlf
Message from webpage @

:I Areyou sure you want to delete selected iterns?

Ok ] ’ Cancel

Categories and Nodes
A Category or Node is a grouping of products available for purchasing. In this section, you will learn how
to browse, create, clone, move, link, and delete categories and sub-categories.

Browsing Categories

The Node List (aka the Category List) is used to organize and manage nodes/categories, subcategories
created within a Catalog.

The "Wine" catalog for example, which is available in the EPiServer Commerce sample site, includes
nodes "Accessories", "Imported”, "Mixed Cases" and "Wine Regions". Additional nodes or subcategories
may be created in the Node List page.

1. Clicking on the Editicon, located between the check box and the folder icon, will display the Cat-
alog Node Edit page, which contains more information and settings of that particular node. Here
you can setup the information and status that are common for all it's subcategories.

2. Clicking on any node names (highlighted in blue) will take you to the next sublevel, which shows
the list of categories under the selected node.
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Node List

D Create New ¥ ﬁ More Actions

[l Mame

O E\" = Accessories
D E\f E' Imported
D E\f E' Mixed Cases
O A= Wine Region

Menu Bar Functions

e Create New
This dropdown allows users to create different types of Categories/Nodes or Product entries as
shown below.

e Category/Node
e Product

e Variation/SKU
e Package

e Bundle

e Dynamic Package
e More Actions

o Delete Selected
e Clone Selected

e Move/Link to Folder

Under More Actions, cloning creates a duplicates with a unique ID that you can place in any loca-
tion/hierarchy that you choose. Move/Link to Folder allows you either to move a category/productto a
new location/hierarchy or to link one category/product to another category/product. You can for example
create a category called "Featured Products" and link it to items across various other categories. This
way, if you make changes to content on the original product page and that same product is part of the
"Featured Products" category as a linked product, the changes will be displayed in both locations. In
other words, changes are bi-directional. Links can be broken if either of the two are deleted.
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Mode List

DCreat& Mew ;-E‘]I"--'Inu-rva,\!'u:tiuu-ns1Ir

IC) Mew Category/Mode
O Mew Product

il MNew Variation /Sku
B Mew Package

% Mew Bundle

Lns
ﬂ% MNew Dynamic Package

Node List

D Create New ™ ﬁ Maore Actions ¥

Name )( Delete Selected

EfE'AEE |y Clone Selected

= = Imp{| [} Mowve/Link to folder \rt#
o
@’ [El Mixed Cases
@’ [h Wine Region

OO o oo

Creating a Category

1. To create a new category, click on Create New and then click on New Category/Node.

ERCE Node List

DCreate Mew Q]Murehctiunsv

) Mew Category/Mode ‘\”'_"J

) New Product

=i New Variation /Sku
B4 MNew Package
45 New Bundle

LS

f&, Mew Dynamic Package

This page will appear when creating a new category or editing an existing one. The Catalog Node Edit
page will contain information of a Node selected from the Node List page.
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Catalog Node Edit

(7] Cet Help

J Overview H SEQ |

Assets |

Name Accessories
carafog node name description
Available from 9/27/2011 [ [12:53PM
Expires on 9/27/2014 f [12:53PM
Display Template: -
Code: Accessories
Sort Order: 0
Awailable: @) Yes ) No
Meta Class Region Catalog -
Display Name (en-us) | accecsaries
Primary Image {en-us):

Description (en-us):

Primary Image

CssClass » | Paragraph - Default Font ~+  Size =

F Vb GaB]9 (’-‘ww
S=si#rriaaagod0

BIUEE=EFA-¥.| =}

Our best selling accessories to go with vour wine___

EIHTML ChPreview Words:9 Characters:51

Enter description here

Overview Fields

Name - enter a name for the product.
Available from - the date to which the productis activated.

Expires on - the date on which the product expires; once the expiration date passes, the product
will no longer appear on the public site.

Display Template - if applicable, chose a display template used to show the products in the public
site from this dropdown box.

Code - enter a product code here (e.g. Accessories)
Sort Order - determines the order to which the product is sorted in the Node List page

Available - select Yes to make the product appear on the public site; select No to hide the product
from the public site

Meta Class - the choice here dictates which of the meta-fields or product attributes will appear on
the site.

Display Name - enter a name the way you like to use on the public site.
Primary Image - use the browse button to select and upload an image here.

Description - enter a description of a product.

Once done, click OK on the bottom of the page.
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SEO

Search Engine Optimization (SEO) can be achieved by entering the following information for the product.
e Title - this is the friendly name that appears in your browser's title area.
e URL - this is what gets displayed in the browser URL window.
e Description - this is the meta description that is used for SEO purposes by search engines.

o Keywords - keywords used for SEO purposes by search engines.

RCE Catalog Node Edit

Chverview ‘ SEO Assets

Title {en-us): Wine Accessaries

Url (en-us): Accessories.aspx
Description (en-us): |Arcessories for the finest selections 5
Keywords (en-us):  |glass cases I
DK || Cancel
Assets

Under Assets, you can associate additional files such as images, pdf, and video files all stored in the
Asset Management system.

ERCE Catalog Node Edit o

Lic

Cverview SEOQ Assets

Find Assets: Root/Videa/ -

Croup Name: |default

Edit Command 1D Type Mame Group Sart Order
=
| >< z folder Root/Video/ default 0
1 Page 1 of 1 {1 itermns)
| (14 || Cancel |

Follow these three simple steps to add an asset file to the current entry.

1. Click on the Find Assets pull-down menu to display all files available in the Asset system.

2. Choose one file at a time and type in an appropriate Group Name (see table below), depending
now how you would like it to be displayed.

3. Click on Add Asset. The asset associated to this entry will appear in the lower section of the
screen.

e You can editthe Group Name or sort order by clicking on the Editicon to the left of an existing
asset. After making any changes, make sure to click Update (Clicking OK at the bottom of the
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screen during the editing mode will not save the changes made).

e You can delete any existing asset by clicking on the "X" icon.

File type Group Names | How it gets displayed in the public site

mage Files (jpg, pgn, etc.) image Thumbnail icon will appear on the product details page
Downloadable Files (docs, Downloads A "Downloads" tab will appear towards the bottom of the
pdf, mp3s) details page

Specification Files (docs, pdf) | Specifications ' A "Specifications" tab will appear towards the bottom of
the details page

Deleting a Category
1. To delete a category/node, go to the Node List.
2. Checkmark the box next to the node.

3. Click on More Actions and then click on Delete Selected to delete the Category/Node.

Node List

i
D Create New ™ <] More Actions ™

Name ¢ Delete Selected

E'ﬁ'u:':ﬁ 53 Clone Selected

o Impy [} Move/Link to folder

E' Mixed Cases
E' Wine Region

ODoOoREE

Organizing Categories

To organize a category, enter a number in the Sort Order field within the Catalog Node Edit page. Cat-
egories and node will sort based on numerical order.
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Catalog Node Edit

J Overview SEQ

Assets

Name:

Available from:
Expires on:

Display Template:

Accessories
caralog node name description

i
i

/272011 12:53 FM

972772014 12:53 PM

-

Code: Accessaries
Sort Order: E
Available: _ I:} _
@ Yes 1 No
Meta Class:

Region Catalog

Display Name (en-us): Accessories

Primary Image (en-us):

Primary Image

Creating a Sub-Category

Creating a sub-category is similar to creating a high-level category.

1. Go to Node List and click through an existing Catalog

2. Click on Create New and click on Category Node. Specify the information under Catalog Edit
(refer to Creating a Category) and click OK to save changes.

Node List

=l
D Create New ™ #1 More Actions ™

Name

IE' Accessnri%
IE' Imported

IE' Mixed Cases
IE' Wine Region

ODEOOb
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Node List

=, -
D Create New ™ :ﬂ More Actions ™

| I Mew Category/MNode '\{bj

) Mew Product

| New Variation /Sku
Mew Package
Mew Bundle

Mew Dynamic Package

= " Engteca Decanter 1000m

= " Engteca Decanter magnum

= E':"' Enoteca Waiters' Friend Double Lever Corkscrew Blue
= E':"' Enoteca Waiters' Friend Double Lever Corkscrew Red
= E':"' Enoteca Waiters' Friend Double Lever Corkscrew Yellow

= " Enoteca Wine Glass Large

DO 000E s

= " Enoteca Wine Glass Small

Cloning, Moving or Linking a Category
Cloning creates a duplicate with a unique ID that you can place in any location/hierarchy of your choice.

Move/Link to Folder allows you either to move a category/product to a new location/hierarchy or to link
one category/product to another category/product. You can for example create a category called "Fea-
tured Products" and link it to items across various other categories.

This way, if you make changes to content on the original product page and that same product is part of
the "Featured Products" category as a linked product, the changes will be displayed in both locations. In
other words, changes are bi-directional. Links can be broken if either of the two are deleted.

1. Tolink to a category, go to the Node List and select the category you want to link back to.

2. Click More Actions and then click on the Move/Link to folder option.

3. Selectlink to folder and select the link destination from the drop-down menu. Click OK to create
the link to that category under that directory.

ERCE Node List

=
D Create New ™ ] More Actions ™

Name X Delete Selected

BA:: 53 Clone Selected

@ Impy| 23 Maove/Link to folder \”__"i
(=i Mixed Cases

E' Wine Region

O@Oo =
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Move/Link to Folder *

mave or (@) i Wine/Mixed Cases w7

[ ok ] | close

Products, Variations and SKUs, Bundles, Packages, Dynamic Packages and
Associations

A Product represents various forms of merchandise that you can display and purchase from the public
site, including Variations/SKUs, Bundles, Packages and Dynamic Packages.

e Product Entries
A product entry typically contains a product name, part number, description and images.

e Variations/SKUs
A variation or SKU corresponds to a specific type of product with specific characteristics. For
example, a product of Shirts will have an individual variation/SKU which includes size, color and
sleeve length.

e Bundles
a bundle is a collection of Variations and SKUs allowing customers to purchase two or more items
atonce (all pricing is SKU specific and separate, unlike a package which is multiple SKUs put
together in a single unified price).
Refer to "Mixed Cases" on the EPiServer Commerce sample site, for an example of a product bun-
dle.

e Packages
A package is comparable to an individual SKU because the package item must be purchased as
a whole (i.e. computer system).ltems can be put within a package and package can have its own
unique pricing.

e Dynamic Packages
A dynamic package is similar to the package definition above with the added ability to configure
the package during checkout.

e Associations
One or more products can be associated to a product so that they can be displayed advertised on
the public site as product accessories, or upselling/cross-selling item. Associations can be made
from any of the individual products (Product Entries, SKUs, Bundles, Packages, and Dynamic
Packages).

Browsing Products

Products are created within a catalog. Products can be placed one level beneath the root of a catalog
and further down into sub-folders.

To browse products, click on a Catalog and drill down in the categories until you see the products.
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Catalog List Product Version: 5.2 (build:
) License: ECF G5 Deployment (EpiServer)

(7] Cet Help For This Page %

b MNew Catalug| éj Import/Export ™ 5}1 More Actions ™

|:| Name Available from Expires Available

D !g Wine 9/12/2011 11:11:00 AM 5/12/2021 11:11:00 AM True

admin
Node List rer
r)
© CetHelp For This Page &

D Create New ™ 2] More Actions ™

D Name [»] Available from Exp

EAS!

B © Decanter Decanter 1/1/2011 1:00:00 AM 1/1
B @ waiters Friend WaitersFriend 1/1/2011 1:00:00 AM 171
B © Wine Cla WineGlass 1/1/2011 1:00:00 AM 1/1
[m=aC Enotecagiantermwml FOD146 1/1/2011 1:00:00 AM 11
[ & " Enoteca Decanter magnum 35373 1/1/2011 1:00:00 AM 1/1
[ & M Enoteca Waiters' Friend Double Lever Corkscrew Blue 70831 1/1/2011 1:00:00 AM 1/1
] = ™" Enateca Waiters' Friend Double Lever Corkscrew Red 70632 1/1/2011 1:00:00 AM 1/1
[ = MW Enoteca waiters' Friend Double Lever Carkscrew Yellow 70833 1/1/2011 1:00:00 AM 1/1
= MM Enoteca Wine Glass Large 35368 1/1/2011 1:00:00 AM 1/1
[ = M Encteca Wine Class Small 35367 1/1/2011 1:00:00 AM 1/1

Creating a Product

To create a product, click through an existing catalog and click on Create New and then select New Prod-
uct.

ERCE Node List

Dl:reate New~| |& More Actions~

IS Mew Category/MNode

) MNew Product

=i New Variation [ Sku
£ Mew Package
AL New Bundle

Lns

g4 MNew Dynamic Package

Overview Tab

This is where you enter basic information about a product.
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ERCE Product Edit

J Overview Variations /SKUs SEOQ Associations Assets Relations

MName:

Wine Class
Available from: 17172017 HH | 01:00 AM
Expires on: 1/1/2020 :ﬁ 01:00 AM
Display Template: Wine Template -
Code: WineGlass
Sart Order: 0

The sort arder for the category entry.
Available: @ Yes 1 No
Meta Class: Wine SKU hd

Display Name (en-us):

Primary Image (en-us):

Primary Image

Field Description

Name Enter a friendly name, which can include spaces and special characters.
Available from | Enter the date and time the product will be available and active.
Expires On Enter the date and time the product will be unavailable and deactivated.

Display Tem- Chose a display template used to display the productin the public site from this drop-
plate down menu.

Code Enter a value without special characters or spaces, such as "BlueShirtXL."
Sort Order Enter a numerical value to determine the product sort order on the node list page.
Available Set"Yes" to activate the product. Set "No" to keep the proudct inactive and unsearchable

on the front-end site.

Meta Class Select a Meta Class from the drop-down menu. Depending on the meta class you select,
additional fields will appear in the Overview tab. The values entered within the fields of the
meta class you selected will be shown on the front-end public site.

Depending on the meta class selected, more fields may become available. For instance, selecting the
Wine SKU meta class will yield wine related meta fields and attributes.
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Description (en-us): .
CssClass « || Mormal  + | TimesMNewRoman « Size « | oF w0 & S ]9 | ey o4

ES—plEx|Naasgean

BIUESEE=E/FA - W, =

Style (en-us):

The style of the wine
Closure (en-us):

The closure mechanism of the wine
Crape mix (en-us):

The grape varieties in the wine
Alcohal (en-us): o

Alcohol by volume measurement
Taste (en-us):

The taste rating of the wine.

Vegetarians (en-us) True @ False

Suitable for vegetarians

Vegans (en-us): True @ False

Switable for vegans

Vintage (en-us)

Vintage
Size (en-us): 0
Size
Marturity (en-us):
Maturity
Variations/SKU Tab

Variations/SKUs are subcategories of a Product, which represents different "variations" of the particular
product (colors, sizes, different editions for example). Such Variations/SKUs can be grouped a chosen
product from this tabbed page. Follow these steps to group variations/SKUs.

1. Select the Variations/SKUs tab

2. Within the drop-down menu next to Find Item, select from the list variations or SKUs to associate
with the product.

3. Clickon Add Item.

You can add multiple associations to the product and they will appear in a list under the column headers

below.
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ERCE Product Edit

Overview Variations [SKUs H SEQ ” Associations H Azzets H Relations ‘

Find Item:

A Add Item

" Chateau d'¥quem
Edit Com{ ! Chateau d"Yquem
7 " Chateau d'vquem
7 M Chateau d'vquem
1 1 Chateau d'Yquem
1 Chateau Suduiraut

"l chateau Climens
" Bonneau Du Martray
M Sylvain Leichet

1 Chandon de Briailles

Oty | Croup Sort Order
1 default 0
1 default 0

Page 1 of 1 (2 items)

JERCE Product Edit

Overview Variations [5KUs ” SEO H Associations H Aszets H Relations ‘

Find Item: | |Bonneau Du Martray

Edit Command | 1D Name

X 2762 Enoteca Wine Glass Small
X 2763 Enaoteca Wine Glass Large
1
| oK || Cancel
SEO Tab

v
&

Oty | GCroup Sort Order
1 default 0
1 default 0

Fage 1 of 1 (2 items)

Search Engine Optimization can be achieved by entering the following information for the product.

e Title - this is the friendly name that appears in your browser's title area

e URL - this is what gets displayed in the browser URL window

e Description - this is the meta description thatis used for SEO purposes by search engines

e Keywords - keywords used for SEO purposes by search engines

O If the URL field is left empty, it will be automatically filled in with a generated url (which
depends on the entry name). If the URL field is not empty (you entered some url), it will be
saved as itis, and w will not be changed automatically even if you change an entry name. If

you need the url to change, leave it blank.
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ERCE Product Edit

Dverview Variations /SKUs SEO Associations Assets Relations

Title (en-us): Wine Glass

Url (en-us): Wine-Class.aspx
Description (en-us): ywine Glass of finest selection for the best tasting experience -
KEWD rds (en-u 5:]: wine glass Esﬁng o

Ok || Cancel

Associations Tab

Different products or variations/SKUs can be linked to this product. Follow these steps to create product
associations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Information.

Product Edit

| Overview || Variations /SKUs | SEO || Associations || Assets | Relations

Add an association

Maodify Existing Association: o |EditDetaiI5| |Modivassuciation| |Delete|

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order. Once
you're done, click on Save Changes.

" N ] N f——
Edit Association Information X
MName: cts
Enter association name.
Description: a
Enter association description.
Sort Order: ]
Enter sort order.
Save Changes

3. The new association will appear in the drop-down list.
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| Overview H Pricing /Inventory || SEO || Associations || Assets || Relations ‘

Add an association

Maodify Existing Association: | CTS

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick Item drop-

down appears below Modify Existing Association.

o ||Edit Demil5| |Modivassocwatiun| |Delete|

me, admin
Versio

Product Edit

@ Get Help For This |

|Over\r|ew H Variations /SKUs || SEQ || Associations || Assets || Relations |

Add an association

Modify Existing Association: | CTS - | ‘ Edit Details | | Maodify Association | I Delete I
CTs
CTs
Pick Item: | Sylvain Loichet - | Add ltem
Edit Command Name Sort Order Type

Page 1 of O (0 items)

5. Click on Modify Association and you can edit the name, description, and sort order of an existing asso-

ciation.

Edit Association Information

Mame: cts
Enter association name.

Description:

Enter association description.

Sort Order: |]
Enter sort order.

You can also Delete an association if needed.

‘ Overview || Pricing/Inventory || SEQ || Associations || Assets || Relations |

Add an association

Maodify Existing Association: ‘ CrossSell

v | |Edit Details] [Modify Association| [Delete]

6. Pick an item or items to add to the association. Click Add Item to do so.
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Product Edit

Cherview Variations /5KUs SEQ Associations Assets Relations

Add an association

Modify Existing Association: || CTS -
CTS
CTS
Pick Item: > | | Add Item
1 \ -
Editcg - Chateau d'Yquem = Sart Order
i .
= Chateau d“vquem 0

" Chateau dvquem
" Chateau dvquem
oK " chateau d'Yquem
" chateau Suduiraut
! Chateau Climens I}
M Bonneau Du Martray
M Syhvain Loichet

" chandon de Briailles -

7. Once you click on Add ltem, the item will appear in a list just below. You can have more than one item
tied to an association.

CTs
CTs
Pick Item: | | Chateau Climens - Add ltem
Edit Command Name Sort Order Type
X Sylvain Loichet 0 OPTIONAL
X Chateau Climens 0 OPTIONAL
1 Page 1 of 1 (2 items)
| (o]8 || Cancel |

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done mod-
ifying the values, click on Update to save your changes. Otherwise select Cancel to navigate away with-
out saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management system.

1. Under Find Assets, select from the drop-down list and click Add Asset.
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|[ERCE Product Edit

‘O\.rerview H Variations /SKUs H SEO H Associations ” Assets H Relations ‘

Find Assets: | - Add Asset

-

Croup Name: © Root/ —
= Root/ideo/

Edit Commd E' Root/Presentations/ [}‘ Group Sort Order
= Root/Specifications/

m

Page 1 of O (0 items)
E' Root/Software/

|: = Root/Downloads/

E' Root/User Guides/

= Root/Images/

E' Root/Images/Package0d/

= Root/Images/Package00/726678/

E' Root/Images/Package00/726678/Small/
= Root/Images/Package00/ 726678/ Medium/
E' Root/Images/Package00/726498/

= Root/Images/Package00/726456/Small/
E' Root/Images/Package00/726498/Medium/
= Root/Images/Package00/726448/

E' Root/Images/Package00/72644B/Small/
= Root/Images/Package00/ 726448/ Medium/

E' Root/Images/Package00/659308/

[ElRootf’Imageaf'PacI-cageDDfﬁSBSDBmeaII.f’ o

2. Enter a Group Name.

By default EPiServer Commerce offers three options with names that will allow the associated assets to
be correctly displayed on the product details page of the public site.

e Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page
e Downloads - a "Downloads" tab will appear towards the bottom of the details page

o Specifications - a "Specifications" tab will appear towards the bottom of the details page

Owverview || Pricing/Inventory || SEQ || Associations || Assets || Relations |

Find Assets: Root/Presentations/ ¥ | |Add Asset

Croup Name: PowerPoint

Edit Command o] Type Mame Croup Sort Order

Page 1 of 0 (0 items)

| OK || Cancel |

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.
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| Overview || Pricing /Inventory || SEOQ || Associations || Assers || Relations

Find Assets: Root/Presentations / Presentation Powerpoint.pptx A

Croup Name: |default

Edit Command 1D Type Name Croup Sort Order
bt 1 file Root/Presentati.... default 0

1 Page 1 of 1 (1 items)

| OK || Cancel |

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node
List. Otherwise, select Cancel to go back to the Node List without saving any changes.

Relations Tab

Here the relations for a product will be displayed, and you can manage the categories a product is linked
to. This is useful in order to get an overview of all the different categories (nodes) where a product will
occur. This shows the full catalog path of the variation/SKU. Here the relations for a product will be dis-
played, and you can manage the categories a product is linked to. This is useful in order to get an over-
view of all the different categories (nodes) where a product will occur. A product can for instance appear
in the "French Market" category, as well as under "Daily Specials" and "Mixed Cases".

Browse to a product and open it for editing. The relations for the product will be displayed under the Rela-
tions tab.

Product Edit

| Relations

| Overview || Variations /SKUs | SEQ H Associations | Assets
1D Name Catalog Full Path
¥ Accessaries Accessories Wine| Accessories

1 Page 1 of 1 (1 items)

Creating a Variation or a SKU

To create a product variation/SKU, click through an existing catalog and click on Create New and then
select New Variation/SKU.

Node List

-."' .
D Create New ™ ﬂ More Actions ™

|| D) New Category/Node

) MNew Product

i New Variation [Sku '\[bj

4 Mew Package

% Mew Bundle

&f} Mew Dynamic Package 1 000ml

O " Enoteca Decanter magnum
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Overview Tab

This is where you enter basic information about the Variation/SKU.

ERCE Variation/SKU Edit

J Overview Pricing/ Inventory SEQ Associations Assets Relations
Mame: Enoteca Wine Glass Large
Available from: 17172011 HH01:00 AM
Expires an: 1/1/2020 HH | 01:00 AM
Display Template: Wine Template -
Code: 153658
Sort Order: 0
The sart arder for the category entry.
Available: @ Yes ) No
Meta Class: Default Catalog Entry

Display Name (en-us): Enoteca Wine Glass Large

Primary lmage (en-us):

Primary lmage

Field Description

Name Enter a friendly name, which can include spaces and special characters.
Available from | Enter the date and time the SKU will be available and active.
Expires On Enter the date and time the SKU will be unavailable and deactivated.

Display Tem- Chose a display template used to display the Variation/SKU in the public site from this
plate drop-down menu.

Code Enter a value without special characters or spaces, such as "BlueShirtXL."
Sort Order Enter a numerical value to determine the SKU's sort order on the node list page.
Available Set "Yes" to activate the SKU. Set "No" to keep the SKU inactive and unsearchable on the

front-end site.

Meta Class Select a Meta Class from the drop-down menu. Depending on the meta class you select,
additional fields will appear in the Overview tab. The values entered within the fields of the
meta class you selected will be shown on the front-end public site.

Depending on the meta class selected, more fields may become available. For instance, selecting the
Wine SKU meta class will yield wine related meta fields and attributes.

Pricing/Inventory Tab

Under this tab, you can set specific pricing and inventory settings for the variation/SKU.
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Overview Pricing/Inventory H SEQ H Associations H Assets H Relations ‘

Display Price: (ghp)
Min. E%antitv:
Max. Quantity:

Merchant:
Weight:
Package:

Tax Category:

3.60

1.0000

200.0000

select merchant
0.75

select package -

select tax category

Warehouse: select warehouse v
Track Inventory: @ Yes ® No
Inventory Status: Enabled -

Pricing

Add ltem

Edit Command | Sale Type Sale Code Currency Price Min. Quantity
X All Custamers 1235555 CEP 0.00 0
1

| OK. ” Cancel ‘

In Stock:

Reserved:

1000

o

Reorder Min. Oty: 0

Allow Prearder:

Preorder Oty
Preorder Avail.:

Allow Backorder:

Backorder Qty:

Backaorder Avail.:

Start Date

Today, 2:55 PM

Clicking on Add item will open the Edit Sale Price Information dialog for adding pricing information.

Edit Sale Price Information

Sale Type:

Min. Quantity. g oo
Start Date:

End Date:

All Customers -
Sale Code:
Unit Price: 0.00
Currency: Paund sterling -

2/22/2012

2/22/2013

| |pzissem

| |pzssem

Field ‘ Description

Display Price
Min Quantity

Max Quantity

Merchant

Enter the price that will be displayed on the public site.

This sets the minimum quantity the customer is able to purchase the var-
iation/SKUs product page.

This is the maximum allowable number of items that can be purchased at one time

(this number gets displayed as the upper range in the drop-down during
out process).

Optional: if you use many merchants on your site, this provides another way to
add more information for a product; this can only be added/edited directly in the
database so please contact your site administrator/developer to make any

changes.

the check-
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Field Description

Weight

Package

Tax Category

Warehouse

Track Inventory

Inventory Status

In Stock
Reserved
Reorder Min Qty
Allow Pre-

order/Backorder

Preorder/Backorder
Avail

Backorder Qty

Pricing

Based on your shipping configuration, the weight you enter here will affect the
total shipping cost.

This value is based on width/length/height dimensions; the options for this drop-
down are configured in the Administration area.

This separation of taxes by category allows you to charge a different rate of taxes
depending on whatis being purchased; for example, you can have one rate for
"General Sales" items and another rate for "Luxury Sales" items.

The details on the available selections are maintained in the Administration sys-
tem.

Yes/No. If this is set to "Yes," then the quantity value of In Stock, Preorder, and
Backorder fields will be deducted each time a purchase is made. If this is set to
"No," then those values will not change.

Enable/Disable. If this is Enabled, then the number of units of a product being pur-
chased cannot exceed the inventory value. In other words, the check out pro-
cedure cannot be completed if you exceed the number in the inventory -- instead
the quantity you can purchase will default to the actual number of remaining units.
For instance, if you have Tracking Inventory = Yes, and Inventory Status = Dis-
abled/Ignored, then the available quantity will be monitored, but it will not limit the
number of units that can be checked out. If you only have a quantity of 5 and you
order 6 items, the checkout will still complete and the inventory number will
become -1.

You can enter the quantity of a particular product available for sale.

The quantity you set here allows you to reserve a specified number of inventory "In
Stock™" and prevent them from being used. So for instance, if you set the In Stock =
10 and Reserved = 5, then the In Stock count will not go below 5.

If the inventory falls below the value specified here, then this item will appear in
the "Low Stock Report" in the Dashboard or Reporting system.

Yes or No; you need to set Allow Preorder/Backorder status to Yes to turn either of
these features On.

When you turn on either of the two and specify a quantity, the count will begin to
decrease after the In Stock count reaches its limit. For example, if you set In Stock
=10, Reserved =3, and Backorder =10, then the Backorder qty will start to
decrease after In Stock count reaches 3. So if you place an order for 10 units, then
the final count will be In Stock = 3, Reserved =3, and Backorder = 7.

The quantity you set here will determine the backorders that can be made by cus-
tomers even when the item is out of stock.

Sale Type - you can select All Customers, a single Customer or a Customer Price
Group (the Customer Price Group gives you the ability to create tiered pricing).
Sale Code - This is an optional setting. The Sale Code field is used for assigning
a price to a specific group of customers. For instance, when you add a new price
and select "Customer Price Group" as the Sale Type, you need to put the name of
the customer group in the Sale Code field. The name of the group that you putin
the Sale Code field needs to match one of the group names found under Cus-
tomer Management > Contacts > (Name of Contact). If your entry into the Sale
Code field matches one of the Customer Groups, any member of that group will
receive the specified price.

Unit Price - discounted price per unit *Currency * enter currency using the correct
currency code (i.e. GBP); you can create different prices depending on the cur-
rency thatis selected.
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Description

Min. Quantity - minimum number of units you must purchase to get the discounted
bulk rate.

SEO Tab

Search Engine Optimization can be achieved by entering the following information for the product.

Owerview Pricing /Inventory SEO Associations Assets Relations

Title (en-us): Large Wine Class

Url (en-us): Enoteca-Wine-Glass-Large.aspx

Description (2n-Us): For the exceptional tasting experience. -

Keywords (en-us)  wine glass tasting large -

014 Cancel
R Deserptor

Title This is the friendly name that appears in your browser's title area.
URL This is what gets displayed in the browser URL window.
Description This is the meta description that is used for SEO purposes by search engines.
Keywords Keywords used for SEO purposes by search engines.

O If the URL field is left empty, it will be automatically filled in with a generated url (which
depends on the entry name). If the Url field is not empty (you entered some url), it will be saved
as itis, and will not be changed automatically even if you change an entry name. If you need
the url to change, leave it blank.

Associations Tab

Different products or variations/SKUs can be linked to this Variation/SKU.

| Overview H Pricing/Inventory H SEQ || Assocations ” Assets ” Relations
Modify Existing Association: | | Accessories - |EditDet,aiI5| |ModifyA55crciatior1| |De|ete|
Ok || Cancel

Steps to Create an Association
1. Click on Add an Association. A pop-up window will appear that says Edit Association Infor-
mation.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order.
Once you're done, click on Save Changes.

3. The new association will appear in the drop-down list.

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick ltem
drop-down appears below Modify Existing Association.
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5. Click on Modify Association and you can edit the name, description, and sort order of an existing
association.

You can also Delete an association if needed.
6. Pick anitem or items to add to the association. Click Add Item to do so.
7. Once you click on Add Item, the item will appear in a list just below. You can have more than one

item tied to an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done mod-
ifying the values, click on Update to save your changes. Otherwise select Cancel to navigate away with-
out saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management system.

Overview || Pricing/Inventory || SEOQ || Aszociations || Assets || Relations |
Find Assets: Root/Presentations /Presentation Powerpoint.pptx ¥ | |Add Asset

Croup Name: |default

Edit Command 10 Type Name Croup Sort Order
X 1 file Root/Presentati... default 0
1 Page 1 of 1 (1 items)
| (o]8 || Cancel |

Steps to Add Assets to a Variation/SKU

1. Under Find Assets, select from the drop-down list and click Add Asset.
2. Enter a Group Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be
correctly displayed on the product details page of the public site.

Image (Type as "image," all lowercase), thumbnail icon(s) will appear on the product details page.
Downloads A "Downloads" tab will appear towards the bottom of the details page.
Specifications A "Specifications" tab will appear towards the bottom of the details page.

3. Once an assetis added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node
List. Otherwise, select Cancel to go back to the Node List without saving any changes.

Relations Tab

This shows the full catalog path of the variation/SKU. Here the relations for a product will be displayed,
and you can manage the categories a productis linked to. This is useful in order to get an overview of all
the different categories (nodes) where a product will occur. A product can for instance appear in the
"French Market" category, as well as under "Daily Specials" and "Mixed Cases".

Browse to a product and open it for editing. The relations for the product will be displayed under the Rela-
tions tab.
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Overview H Pricing /Inventory H SEQ || Associations H Assets H Relations

In} MName Catalog Full Path
>< Accessories Accessories Wine' Accessories
1
| oK || Cancel

Creating a Package

1.

2
3.
4

Click on Catalogs. The Catalog List appears in the main window.
Click on an existing catalog name highlighted in blue. The Node List window appears.
Click on Create New pull-down menu located in the upper left part of the main window.

On the drop-down menu, select New Product Package. The Product Package Edit page appears.

Overview Tab

This is where you enter basic information about the Product Package.

Name - a name for the Product Package
Available from - the date to which the Product Package is activated

Expires on - the date on which the Product Package expires; once the expiration date passes, the
Product Package will no longer appear on the public site

Display Template - choose a display template used to show the Product Package in the public
site from this dropdown box.

Code - enter a Product Package code here.
Sort Order - determines the order to which the Product Package is sorted in the Node List page.

Available - select Yes to make the Product Package appear on the public site; select No to hide
the product from the public site

Meta Class - the choice made here dictates which the meta-fields or Product Package attributes
will appear on the public site or Commerce Manager site

Pricing/Inventory Tab

Display Price - the price that will be displayed in public site
Min Quantity - this forces your customer to purchase a minimum number of items as set here (this

number gets displayed as the lower range in the dropdown during the checkout process)

Max Quantity - this is the maximum allowable number of items that can be purchased at one time
(this number gets displayed as the upper range in the dropdown during the checkout process)

Merchant - (optional) if you use many merchants on your site, this provides another way to add
more information for a product; this can only be added/edited directly in the database so please
contact your site administratior/developer to make any changes

Weight - based on your shipping configuration, the weight you enter here will affect the total ship-
ping cost

Package - this value is based on width/length/height dimensions; the options for this dropdown
are configured in the Administration area

Tax Category - this separation of taxes by category allows you to charge a different rate of taxes
depending on what is being purchased; for example, you can have one rate for "General Sales"
items and another rate for "Luxury Sales" items
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o Warehouse - the details on the available selections are maintained in the Administration Sub-
system

e Track Inventory - Yes/No. If this is set to "Yes," then the quantity value of In Stock, Preorder, and
Backorder fields will be deducted each time a purchase is made. [fthis is setto "No," then those
values will not change.

e Inventory Status - Enable/Disable. If this is Enabled, then the number of units of a product being
purchased cannot exceed the inventory value. In other words, the check out procedure cannot be
completed if you exceed the number in the inventory -- instead the quantity you can purchase will
default to the actual number of remaining units. For instance, if you have Tracking Inventory = Yes,
and Inventory Status = Disabled/Ignored, then the available quantity will be monitored, but it will
not limit the number of units that can be checked out. If you only have a quantity of 5 and you order
6 items, the checkout will still complete and the inventory number will become -1.

e In Stock - you can enter the quantity of a particular product available for sale

e Reserved - The quantity you set here allows you to reserve a specified number of inventory "In
Stock" and prevent them from being used. So for instance, if you set the In Stock = 10 and
Reserved = 5, then the In Stock count will not go below 5.

e Reorder Min Qty - If the inventory falls below the value specified here, then this item will appear in
the "Low Stock Report" in the Dashboard or Reporting subsystem.

e Allow Preorder/Backorder - Yes or No; you need to set Allow Preorder/Backorder status to Yes to
turn either of these features On.

e Preorder/Backorder Avail - When you turn on either of the two and specify a quantity, the count
will begin to decrease after the In Stock count reaches its limit. For example, if you set In Stock =
10, Reserved =3, and Backorder =10, then the Backorder qty will start to decrease after In Stock
countreaches 3. So if you place an order for 10 units, then the final count will be In Stock = 3,
Reserved =3, and Backorder = 7.

o Backorder Qty - The quantity you set here will determine the backorders that can be made by cus-
tomers even when the item is out of stock.
Pricing .

e Sale Type - you can select All Customers, a single Customer or a Customer Price
Group (the Customer Price Group gives you the ability to create tiered pricing).

e Sale Code - (optional) enter code to give special pricing for a group of Customers
(i.e. Dealers).

e Unit Price - discounted price per unit.

e Currency - enter currency using the correct currency code (i.e. USD); you can
create different prices depending on the currency thatis selected.

e Min. Quantity - minimum number of units you must purchase to get the discounted
bulk rate.

For more information regarding Sales Type, Sales Code and tiered pricing, please read
Creating a Contact.

Package Items Tab

In the dropdown, you can search through your entire inventory and select items to add to your Package
by clicking Add Item. Clicking the Edit icon beside the item you just added will allow you to specify the
Quantity, the Group Name and the Sort Order.

SEO Tab

Search Engine Optimization can be achieved by entering the following information for the product.
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e Title - this is the friendly name that appears in your browser's title area
e URL - this is what gets displayed in the browser URL window
e Description - this is the meta description thatis used for SEO purposes by search engines

e Keywords - keywords used for SEO purposes by search engines

O If the Urlfield is left empty, it will be automatically filled in with a generated url (which depends
on the entry name). If the Url field is not empty (you entered some url), it will be saved as itis,
and w will not be changed automatically even if you change an entry name. If you need the url
to change, leave it blank.

Associations Tab

Different products or variations/SKUs can be linked to this Product Package. Follow these steps to create
associations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Infor-
mation.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order.
Once you're done, click on Save Changes.

3. The new association will appear in the drop-down list.

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick ltem
drop-down appears below Modify Existing Association.

5. Click on Modify Association and you can edit the name, description, and sort order of an existing
association.

You can also Delete an association if needed.
6. Pick anitem or items to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one
item tied to an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done mod-
ifying the values, click on Update to save your changes. Otherwise select Cancel to navigate away with-
out saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.
2. Enter a Group Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be
correctly displayed on the product details page of the public site.

e Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page
e Downloads - a "Downloads" tab will appear towards the bottom of the details page
e Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node
List. Otherwise, select Cancel to go back to the Node List without saving any changes.
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Relations Tab

This shows the full catalog path of the variation/SKU. Here the relations for a product will be displayed,
and you can manage the categories a product is linked to. This is useful in order to get an overview of all
the different categories (nodes) where a product will occur. This shows the full catalog path of the var-
iation/SKU. Here the relations for a product will be displayed, and you can manage the categories a prod-
uctis linked to. This is useful in order to get an overview of all the different categories (nodes) where a
product will occur. A product can for instance appear in the "French Market" category, as well as under
"Daily Specials" and "Mixed Cases".

Browse to a product and open it for editing. The relations for the product will be displayed under the Rela-
tions tab.

Creating a Bundle

1. Click on Catalogs. The Catalog List appears on the main window.

2. Click on an existing catalog name highlighted in blue. The Node List window appears.
3. Click on Create New pull-down menu located in the upper left part of the main window.
4

On the drop-down menu, select New Bundle. The Bundle Edit page appears.
Overview Tab

This is where you enter basic information about the Product Package.
e Name - a name for the Bundle
e Available from - the date to which the Bundle is activated

e Expires on - the date on which the Bundle expires; once the expiration date passes, the Bundle
will no longer appear on the public site

e Display Template - choose a display template used to show the Bundle in the public site from this
dropdown box.

e Code - enter a Bundle code here.
e Sort Order - determines the order to which the Bundle is sorted in the Node List page.

e Available - select Yes to make the Bundle appear on the public site; select No to hide the product
from the public site

e Meta Class - the choice made here dictates which the meta-fields or Bundle attributes will appear
on the public site or Commerce Manager site

Bundle Items Tab

In the dropdown, you can search through your entire inventory and select items to add to your Bundle by
clicking Add Item. Clicking the Edit icon beside the item you just added will allow you to specify the
Quantity, the Group Name and the Sort Order.

SEO Tab

Search Engine Optimization can be achieved by entering the following information for the product.
e Title - this is the friendly name that appears in your browser's title area
e URL - this is what gets displayed in the browser URL window
e Description - this is the meta description that is used for SEO purposes by search engines

o Keywords - keywords used for SEO purposes by search engines
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O If the URL field is left empty, it will be automatically filled in with a generated URL (which
depends on the entry name). If the URL field is not empty (you entered some URL), it will be
saved as itis, and will not be changed automatically even if you change an entry name. If you
need the URL to change, leave it blank.

Associations Tab

Different products or variations/SKUs can be linked to this Bundle. Follow these steps to create asso-
ciations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Infor-
mation.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order.
Once you're done, click on Save Changes.

3. The new association will appear in the drop-down list.

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick ltem
drop-down appears below Modify Existing Association.

5. Click on Modify Association and you can edit the name, description, and sort order of an existing
association.

You can also Delete an association if needed.
6. Pick an item oritems to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one
item tied to an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done mod-
ifying the values, click on Update to save your changes. Otherwise select Cancel to navigate away with-
out saving.

Assets Tab
Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management subsystem.
1. Under Find Assets, select from the drop-down list and click Add Asset.
2. Enter a Group Name.
By default Commerce Manager offers three options with names that will allow the associated assets to be
correctly displayed on the product details page of the public site.
e Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page
e Downloads - a "Downloads" tab will appear towards the bottom of the details page
e Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node
List. Otherwise, select Cancel to go back to the Node List without saving any changes.

Relations Tab

Here the relations for a product will be displayed, and you can manage the categories a product is linked
to. This is useful in order to get an overview of all the different categories (nodes) where a product will
occur. This shows the full catalog path of the variation/SKU. Here the relations for a product will be dis-
played, and you can manage the categories a product is linked to. This is useful in order to get an
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overview of all the different categories (nodes) where a product will occur. A product can for instance
appear in the "French Market" category, as well as under "Daily Specials" and "Mixed Cases".

Browse to a product and open it for editing. The relations for the product will be displayed under the Rela-
tions tab.

Creating a Dynamic Package

1. Click on Catalogs. The Catalog List appears on the main window.

2. Click on an existing catalog name highlighted in blue. The Node List window appears.

3. Click on Create New pull-down menu located in the upper left part of the main window.

4. On the drop-down menu, select New Dynamic Package. The Product Dynamic Package Edit
page appears.

Overview Tab

This is where you enter basic information about the Product Package.
e Name - a name for the Dynamic Package
e Available from - the date to which the Dynamic Package is activated

e Expires on - the date on which the Dynamic Package expires; once the expiration date passes,
the Product Package will no longer appear on the public site

o Display Template - choose a display template used to show the Dynamic Package in the public
site from this dropdown box.

e Code - enter a Dynamic Package code here.
e Sort Order - determines the order to which the Dynamic Package is sorted in the Node List page.

e Available - select Yes to make the Dynamic Package appear on the public site; select No to hide
the product from the public site

e Meta Class - the choice made here dictates which the meta-fields or Dynamic Package attributes
will appear on the public site or Commerce Manager site

Package Items Tab

In the dropdown, you can search through your entire inventory and select items to add to your Dynamic
Package by clicking Add ltem. Clicking the Editicon beside the item you just added will allow you to
specify the Quantity, the Group Name and the Sort Order.

SEO Tab

Search Engine Optimization can be achieved by entering the following information for the product.
e Title - this is the friendly name that appears in your browser's title area
e URL - this is what gets displayed in the browser URL window
e Description - this is the meta description that is used for SEO purposes by search engines

e Keywords - keywords used for SEO purposes by search engines

O If the URL field is left empty, it will be automatically filled in with a generated URL (which
depends on the entry name). If the URL field is not empty (you entered some URL), it will be
saved as itis, and will not be changed automatically even if you change an entry name. If you
need the URL to change, leave it blank.

Associations Tab

Different products or variations/SKUs can be linked to this Dynamic Package. Follow these steps to create
associations:
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1. Click on Add an Association. A pop-up window will appear that says Edit Association Infor-
mation.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order.
Once you're done, click on Save Changes.
3. The new association will appear in the drop-down list.

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick ltem
drop-down appears below Modify Existing Association.

5. Click on Modify Association and you can edit the name, description, and sort order of an existing
association.

You can also Delete an association if needed.
6. Pick anitem or items to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one
item tied to an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done mod-
ifying the values, click on Update to save your changes. Otherwise select Cancel to navigate away with-
out saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.
2. Enter a Group Name.
By default Commerce Manager offers three options with names that will allow the associated assets to be
correctly displayed on the product details page of the public site.
e Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page
e Downloads - a "Downloads" tab will appear towards the bottom of the details page
¢ Specifications - a "Specifications" tab will appear towards the bottom of the details page
3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.
4. Once done, click OK and the new category/node will be created. You will be redirected to the Node

List. Otherwise, select Cancel to go back to the Node List without saving any changes.

Relations Tab

Here the relations for a product will be displayed, and you can manage the categories a productis linked
to. This is useful in order to get an overview of all the different categories (nodes) where a product will
occur. This shows the full catalog path of the variation/SKU. Here the relations for a product will be dis-
played, and you can manage the categories a product is linked to. This is useful in order to get an over-
view of all the different categories (nodes) where a product will occur. A product can for instance appear
in the "French Market" category, as well as under "Daily Specials" and "Mixed Cases".

Browse to a product and open it for editing. The relations for the product will be displayed under the Rela-
tions tab.

Creating Product Associations

Product Associations help you to highlight certain products in your public site. For example, one or more
products can be related to or associated to another product so that these associated products can be dis-
played or advertised on the public site as a product accessory, or as an up-selling/cross-selling item.
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Associations can be made from any of the individual products (Product Entries, SKUs, Bundles, Pack-
ages, and Dynamic Packages).

To create Product Associations, go to the edit screen of any type of product entry listed above and select
the Associations tab. Out of the box, you can associate related products or accessories or cross-sell dif-
ferent kinds of products ("You May Also Like").

CrossSelling Other Products - "What You May Like"

1. Click on the Add an association button to enter the name "CrossSell" (without the quotes), an
optional description and sort order number. Click Save Changes to save and exit the screen.
CrossSell should appear in the dropdown menu.

2. Nextselectthe new association that you just created from the drop-down menu and click on Edit
Details.

3. Use the drop-down menu to add one or more products and select Add Item to save the asso-
ciation. The items you have added to this association will render on the product detail page under
"You May Also Like" on the default template.

min

ERCE Product Edit Product Version: 5.2 (build: 377)

License: ECF G5 Deployment (E(
©) Cet Help For This Pi

|0verviaw || Variations /SKUs || SEQ H Associations H Assets H Relations ‘

Add an association

Modify Existing Association: || CrossSell - | Edit Details || Modify Association | |De|ete|

CrossSell
Cross-selling of items

Pick ltem: || Chateau d'Ygquem -
Edit Command Name Sort Order Type
X Chandon de Eriailles 0 OPTIONAL
1 Page 1 of 1 (1 items)

Associating Related Products and Accessories

1. Click on the Add an association button to enter the name "Accessories" (without the quotes), an
optional description and sort order number. Click Save Changes to save and exit the screen.
Accessories should appear in the drop-down menu.

2. Nextselect the Accessories product association that you just created from the drop-down menu
and click on Edit Details.

3. Use the drop-down menu to add one or more products and select Add Item to save the asso-
ciation. The items you have added to this association will render on the product detail page under
"Related Products and Accessories" on the default template.

Managing Assets

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management system and then these
Assets can be associated with Catalog entries.

In order for the Asset files to correctly display in catalogs, you'll need to configure your Internet Information
Services (lIS). Find out more Displaying Assets section of the Developer Guide for EPiServer Commerce.
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Associating Additional Digital Materials with Catalog Entries

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management system.

1. Under Find Assets, select from the drop-down list and click Add Asset.

EPiISERVER COMMERCE Variation/SKU Edit

Welcome ¥ Change Language About™

Cartalog Management el
Overview || Pricing/Inventory || SEO || Associations || Assets || Relations
= E' Catalog Management
4 Catalog Entry Search Find Assets Root/Images/LargeWineGlassCrystal jpg - Add Asset
@ Catalog Batch Update
553 Catalogs Croup Name: |default
= I wine
(] Accessaries Edit Command | ID Type Name Group Sort Order

4 [_JMixed Cases
# (] wine Region

] Templates

Page 1 of O (0 items)

2. Enter a Group Name.

By default Commerce Manager offers three options with names that will allow the associated
assets to be correctly displayed on the product details page of the public site.

e Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product
details page.

¢ Downloads - a "Downloads" tab will appear towards the bottom of the details page.
e Specifications - a "Specifications" tab will appear towards the bottom of the details page.

3. Once an assetis added to the list below, you can chose to edit specific assets, such as their
Group name and Sort Order.

‘O\.rer\.riew H Pricing /Inventory H SEO ” Associations H Assets H Relations ‘

Find Assets: Root/Images/LargeWineGlassCrystal jpg - Add Asset

Croup Name: |image

Edit Command (o] Type Marme Croup Sort Order
X 5397 file Root/Images/LargeWineClassCrystal jpg image 0

1 Page 1 of 1 (1 items)

4. Once done, click OK and the new category/node will be created. You will be redirected to the
Node List. Otherwise, select Cancel to go back to the Node List without saving any changes.

Searching for Catalog Entries
The Catalog Search function enables you look for specific sales items stored in EPiServer Commerce.

Click on Catalog Management and then Catalog Entry Search.
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Catalog Management

&

= a_' Catalog Management

| % Catalog Entry Search

B (Catalog Batch Update
=1 Catalogs

= [ wine
=] Templates

To do a basic search for catalog entries, enter a one keyword or more into the Search by Keywords(s)
field, such as "white bordeaux”. The search will return entries that match either of those keywords.

If you enter keywords inside quotation marks ("white bordeaux"), then search will only fetch entries that
have those exact three keywords.

== Entry Search
Search By Keyword(s): hite bordeaux search l:

Additional Filters

Filter By Language: English (United States) h
Filter By Catalog(s): Wine

Search By Code/Id:

Catalog Search Filters

To narrow entry search results, there are Additional Filters available. Click search once those filters are
set.

e Filter by language: Pull-down menu will show the available language choices
o Filter by catalog(s): Pull-down menu will show the available catalog choices

e Search by codelid: Instead of text, you can search by code or ID

Search By Keyword(s): | Search [
Additional Filters

Filter By Language: English (United States) ||
Filter By Catalog(s): all catalogs E
Search By Code/Id: 30958

Deleting and Cloning Entries

Users can Delete and Clone entries. To delete or clone an entry:

1. Selectan entry or entries by selecting the box next to it.
2. Click on More Actions.

3. Click on Delete Selected or Clone Selected .

The entry will either be deleted or a clone (copy) of it appears.
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Search By Keyword(s): .hite bordeaux Search

Additional Filters

Filter By Language: English {(United States) -

Filter By Catalog(s): Wine v

Search By Code/ld:

e

More Actions ™

Delete Selected Code

b4

23 Clone Selected '{ﬂ s201z2B
[T ™M Chateau d'Yquem1 616088
" Chateau d'Yquem 232288
" Chateau d'Yquem 234708
[ M chateau dYquem 65987E
[ " chateau Suduiraut 57149H

Paging and Sorting Results

Users can sort results by clicking on Name, Code, Available From, Expires, and Status in either ascend-
ing or descending order.

;ﬂ More Actions ™

[[] Mame Code- Available from Expires Status
I:‘ L”,‘"U.LTEI’HEI’& C. Collovray DDDD{‘.‘:\ECEnding 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
I:‘ .I_”:I“J.LTEI’I’iEI’& C. Collovray 0ooo0gH 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
1 [ )L Terrier & C. Collovray 000038 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
I:‘ ‘I_”:"I Domaine des Deux Roches 00012H 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
I:‘ ‘I_”:"I Seifried 000428 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True

The Page Size (number of items to be displayed on a page) can be set at the bottom of the search result
page, where there is also a paging function for browsing the search result.

D ‘IL‘\“\ Chateau Lafite Rothschild 22851B 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
F] (i ner 229548 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True
E] i cpa lon-Longueville Earon 234168 1/1/2011 1:00:00 AM 1/1/2020 1:00:00 AM True

(1548 items) | Page 412345 ...b

Page Size: 20 '

Updating Multiple Catalog Entries at Once

The Catalog Batch Update option gives you the ability to quickly make multiple changes to your catalog.
You can sort by Entry Type, Meta Class, Field, Language, Catalog and Keyword(s). Once you apply
one or more of these filters, the search results will appear in the bottom half of the screen.

If you make changes to the entry, click Save All to save all of your catalog updates.

Clicking on a result, such as the example below, will direct you to the entry's edit page.
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Batch Update

Welcome ¥ Change Language About™

Caralog Management Z Main Adjustment Filters
2= catalog Management Entry TyPe:  variarion Sku v  language: English (United States) -
4 Catalog Entry Search N
Meta Class!  pefault Catalog Entry - Catalog/Category: 4| caralogs -
& Catalog Batch Update
27 Catalogs Field: Entry : Name »  Keyword(s): Apply Filter
(] Wine
2] Templates '8 save anl
Name Entry : Name

1 Enoteca Wine Glass Small

I Enoteca Wine Glass Large
Elue

Red

W Enoteca Waiters’ Friend Double Lever Corkscrew
Yellow

i Enoteca Decanter 1000mI

W Engteca Decanter magnum

" Enoteca Waiters' Friend Double Lever Corkscrew

1M Engteca Waiters' Friend Double Lever Corkscrew

Enoteca Wine Class Small

Enoteca Wine Glass Large

Encteca Waiters' Friend Double Lever Corkscrew Elue

Encteca Waiters' Friend Double Lever Corkscrew Red

Enoteca Waiters® Friend Double Lever Corkscrew Yellow

Enoteca Decanter 1000ml

Enoteca Decanter magnum

Order Management

The Order Management system provides shopping carts, order capture, order fulfillment, and payment
function support. Features and functionality include return merchandise authorization (RMA), support for
item exchanges, and Ul enhancements. In this section the order workflow is described, as well as ship-
ping and receiving, shopping carts and payment plans.

Refer to the Shopping Workflow section for a general description of the shopping procedure in EPiServer
Commerce.

Order Workflow

The order workflow consists of the following main parts and tasks:

e Creating an Order

Fulfilling an order

Splitting shipments
e Viewing, editing and searching for orders
The order workflow is explained in more detail in this section.

Refer also to the Working Procedure section for more information on how orders are created and proc-
essed in EPiServer Commerce.

Creating an Order

Option 1: Creating an Order Within a Contact

1. Go to Customer Management > Contacts and create or click on an existing contact. The contact
details appear.
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2. Click on New Order.

€EPISERVER COMMERCE (buie
ECF G5 Deployment (EpiServer)
Welcome ¥ Change Language About ™ @ Get Help For This Page +
Customer Management 2 || [ earr | X Detete contact | B3 comtacts | [ New order]
S Customer Management ) o
e Full Name: admin Parent Organization:
[@ comtacts = ‘
&2 Roles >
o CiftCards l|| - contace
Addresses
Crectn cands Full Name: admin Customer Group:
Security First Name: admin Preferred Currency:
Ral
oles Middle Name: Preferred Language:
Orders
Order History Last Name: Registration Source:
Shopping Lists Parent Organization: Last Order Dare:
Wish Lists
Shopping Carts preterea snipping
Preferred Billing
Address:
i ~ Account Edit Account | Change Password | Remove Account —
User Name: admin Is Locked Out: none
Description: Last Activity: Today, 9:59 AM
Email: admin@yourcompany.com Last Login: Today, 9:35 AM
Last Password
Changed, Yesterday, 3:58 AM
ﬁ Dashboard
B customer Il e

3. The New Order pop-up window appears. Select the site to apply the order to and click OK. The
Purchase Order New form appears, allowing users to enter basic information about the order.

Filling Out the New Purchase Order

1. Enter basic order information.

—Basic Order Info -

Customer: admin

Currency: |US dollar E

Coupon Code: 1234567 | " Apply

Description

Customer This is the name of the contact.
Currency  Select from the drop-down list the currency to associate with the Purchase Order.

Coupon | Coupon codes created with a promotions can be applied here to associate with the Pur-
chase Order. Click Apply once code is entered.

2. Click New Item to select the items in the site catalog to associate with the Purchase Order. A pop-up
windows appears allowing you select items from a site catalog.

New Item | # Delete
|:| D Name

Page Size: | 20 |E|

3. Search for items by entering your search terms (e.g. "iphone") into the search field and click Find. You
can sort your search results alphabetically by clicking the Name column. Select an item from the list and
click on Configure Selected Entry.
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Mew Line ltem X
bardeaux w ol
Picture Name b Catalog Type Price In Stock
-
Mixed Cases France WVariation £8,546.05 1000
Ch. Plantey Canteloup France Variation £6.95 1000 L4
Chateau Langoa-Bartan France Variation £47.00 1000 =
Chateau Bellevue France Variation £43.00 1000
Chateau Pichon-Longueville Lalande France Variation £215.00 1000
Page Size: 20 - (584 items) | Page 112345 ...} i
Cancel | | Configure Selected Entry

Advanced Search

You can apply three filters to refine your item search results.

MNew Lineltemn

Adwvanced Search

Select catalog |E| Select language E Select entry type IE'

Description

Select catalog Select which specific catalog to search
Selectlanguage ' Select a specific language (such as German) for items described in German

Select entry type | Select a specific type of entry, such as variation/sku or bundle

Configuring the Selected Entry

1. Before you add the item to the order, you can configure the actual price, the quantity, and apply a per-
centage or discount based discount.
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New Line lterm *

4

Selected Entry: Chateau Langoa-Barton i

»

»

Display Price: £47.00

Price: 47.00

Quantity: |1

m

In Stock: 1000, Reserved: 0.

Discount:  enter descr here 0 Percentage Based ~

m

Discount description  amount

Total: £47.00

T | 3

Back I | Add item to the order |

Required Fields

e Price
e Quantity
Display This is the price seen on the public website. This is set at the catalog entry level.
Price
Price This is the actual cost of the item that will be charged when the item is added to the order.

Quantity Set how many of the item to add to the order.
Discount | You can apply a discount to the item, either Value or Percentage based.

Total The total is automatically calculated, factoring in the actual price, quantity, and any dis-

counts applied.

2. Once the item is configured, click Add item to the order. The item will appear on the Purchase Order

form.
Newltem ¥ Delete
D [[s] Name Quantity List Price Total Discount
D ELCBOOOSOVTFS6E Nextware iPhone Screen Protector 2-phk. 1 £19.99 $19.99 £0.00
Page size: |20 [v] (1 items) ||

Completing the Rest of the Purchase Order Form

1. Enter a Billing and a Shipping Address.

When entering the Shipping or Billing Address, you can select an existing address associated
with the contact, if any.
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Billing Addre: ~Shipping Addre:
Address Add new address hd Address |Add new address hd
[Clsame as Billing Address
Name
Name:
First Name:
First Name:
Last Name:
Last Name:
Line 1:
Line 1
Line 2: .
Line 2:
City:
v City.
Country Name: United States
v [=] Country Name United States [=]
State: Alabama [+] state: Alabama =
Postal Code Postal Code:
Day Phone: Day Phone:
Evening Phone Fvening Phone:
Email Email:
[T] Add to customer's address book [7] Add to customer's address book

Checkmark Add to customer's address book if you want to save the address to the contact.

If the Shipping Address is the same as the Billing Address, click on Same as Billing Address. The
Shipping Address form is autopopulated with the information entered in the Billing Address form.

2. Selectthe kind of shipping to use for the order under Shipment Details. Select from the drop-
down the shipping methods (add link) available.

3. Click on Recalculate to generate the cost summary.

~—Shipment Details: -

Shipping method: |Fixed Shipping Rate IE'

|33 Recalgulate

~Summary -

Item Subtotal: 31999
Shipping Cost: 310.00
Less Shipment Discount;  50.00
Total Before Tax: 513.99
Itermn Taxes: 50.00

Shipment Total: %2999

4. Click OK.
Option 2: Creating an Order from Purchase Order List

1. Go to Order Management > Purchase Orders.

2. Click on New Order. A pop-up appears, allowing you to select the site and contact to apply the new
order to.
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(b
ECF G5 Deployme;

EPISERVER COMMERCE Order List

Welcoma ™ Change Language About © Get Help For This Page *

Order Management @

New Order X

=288 Order Management
), Order Search

S[5] Purchase Orders Site: [ [0 sies avaianie
@ Today
@ This Week Customer. /(@ Not et =
@ This Month
@ Al

] Purchase Orders By Status

@ cans |

] Payment Plans (recurring)

=[] shipping/Receiving

0K {}J [ X cancel

ﬁ Dashboard

Customer Management

Catalog Management

3. Click OK.
4. Follow the steps above to complete the Purchase Order.

The Order Form

Once the Purchase Order form is completed, the order fulfillment process begins.

E Add Nate ﬁ send Matifications ﬁ' Add Order Address

Order No: PO13698 Customer: admin
Order Total: £41.99 Status: [nProgress
J Summary | | Details | | Payments | | Returns | | Notes

— Owerview

| Edit Information | Status: In Progress
Order #: PO15698 Coupon code: none
Created Date: 12/14/2011 10:14:22 AM Site mame:

Order Total: £41.39

Balance Due: 541.99 Cancel Order
Currency: USD Place On Haold

Release Order

Hold
- Customer Information
Customer: admin Open Customer Profile
Email Address: admin@&yourcompany.com
~ Billimg Address
Name: Admin Edit Billing Address

Address: 111 First Street, Ceorgetown, Alabama, 123456, United
States

Phone Number:

~— Meta Data
Tracking Number {(en-US): PO19633
Expiration Date (en-US): <notset>

Parent Order Id {en-US): ©

The order form consists of five sections:
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Tab Name Description

Summary Displays an overview of the order, including the customer infor-
mation, billing address, and other data. From here you can cancel
orders, edit information, and place an order on hold.

Details Displays the shipment details, including shipment status, items to
be shipped, and a list of applied discounts/coupons. Returns/Ex-
changes are also created here.

Payments You can create and assign payments to the order here. Payments
are automatically processed when saved.

Returns Displays the details of a return, if made.

Notes Displays the notes attached to the order. Notes are automatically
logged when certain events occur within the order (e.g. the ship-
ment status changed).

Fulfilling an Order

Commerce Manager | 117

Once the Purchase Order form is completed, the order fulfillment process begins. This means that the

payment will be cleared and the order will be released for packing and shipping.

The order form consists of five sections:

Tab Name Description

Summary Displays an overview of the order, including the customer information,
billing address, and other data. From here you can cancel orders, edit
information, and place an order on hold.

Details Displays the shipment details, including shipment status, items to be
shipped, and a list of applied discounts/coupons. Returns/Exchanges
are also created here.

Payments You can create and assign payments to the order here. Payments are
automatically processed when saved.

Returns Displays the details of a return, if made.

Notes Displays the notes attached to the order. Notes are automatically
logged when certain events occur within the order (e.g. the shipment
status changed)

Processing the Order, Submitting a Payment, and Releasing to Shipping

The basic workflow from purchase order to shipping is done this way.
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1.

Add a payment to the order.

Order

[Add Note §-)Send Notifications = Add Order Address

Order No: POOS50 Customer: Mary Smith
Order Total: 559.93 Status: InProgress

| summary | | Details | | Payments | | Returns | | Notes
Create Pa‘,rmnﬁr’\j

|:| Nan?\_—l'| Transaction Type Amount Status
[

Page Size: | 100[x|

Enter the amount of the payment. The Amount field auto-populates the value of the total order,

including shipping costs. However, you can change the value of the payment (useful for splitting
payments between two or more payment methods at the request of the customer).

Select the Payment Method from the drop-down list.
Click OK. The order goes into Edit Mode.

The Order is in Edit Mode. Save changes before exiting. | ' Save | | X Cancel
[ Add Note J Send Notifications =] Add Order Address
Order No: PO2427 Customer: Mary Smith
Order Total: £536.00 Status: InProgress
| Summary | | Details | | Payments | | Returns | | Notes
Create Payment
D Name Transaction Type Amount Status
[[1 %  PayByPhone 56.00 Pending

Page 5ize: 1gp -

Note: When in Edit Mode, you can add more payments to the order. However, once you click

Save, you finalize the payment. This means that you cannot add or delete any further payments.
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Once you have finished adding one or more payments, click Save to exit Edit Mode and save your
changes. The payment gets automatically processed for the amount specified.

RCE Order

[ AAdd Note [ Send Notifications = Add Order Address

Order No: PO0330 Customer: Mary Smith

Order Total: 55598 Status: InProgress

| summary | | Details || Payments || Returns || Notes
|:| Name Transaction Type Amount Status

|:| Pay By Phone Sale 59.9800 Processed
Page 5ize: | 100 El

6. Check the Details tab. You will see that the Shipment Status has changed to "Awaiting Inven-

tory." Once the availability of the item has been determined, click on Release Shipment to release
the order to your shipping department.

| Summary ‘ | Details | | Payments ‘ |

Returns || Notes
Shipment # 1
=/ New Line Item X Delete
[l ] Name Quantity List Price Placed Price  Total Discount Discount Description Total
B & sm7e Chateau Bellevue 2.00 £43.00 £43.00 £0.00

£86.00

Page Size: 1gp -

~— Shipping Information

Shipping Address:

1 First Street, Hometown, Alabama, 81818, United States Edit Shipping Address

Shipping Method:

Free delivery (2-3 days) Edit Shipping Method

. i
~S S ry

Status

Returns/Exchanges
tom uprowal fhe S Mg ST —
Shipping Cost: £0.00

Shipment Total: £86.00
Release Shipment k

|

Promotions

Type Name Coupon Code

7. By clicking on Release shipment, the status changes to "Released." For further processing of the
order, your shipping department will go to Order Management > Shipment.

O If you click Cancel shipment, you will end up canceling the entire order. (At the moment, there
is no way to undo the cancellation, so you must be careful.)

Canceling an Order

Under the Summary tab, click on Cancel Order. This will completely cancel the order. The status of the
order changes to "Canceled."

The cancellation of the order will be logged under the Notes tab.
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Order No: PO0350 Customer: Mary Smith

Order Total: 359938 Status: Cancelled

| Summary | | Details | | Payments | | Returns | | Notes

New Itemn

|:| Originated By Date/Time Mote Text

|:| 5 admin 2/21/2011 94943 AM MNew order placed by admin in ConsaoleManager

|:| ] admin 20212011 100116 AM MNew Other payment in the amount of $59.98 added to order
|:| 7 admin 2/21/2011 100810 AM Shipment 10 status changes to Released

|:| 3 admin 2/21/2001 111:21 AM Order status changed to Cancelled

< | I T

Page Size: 100@

Splitting Shipments

If there are two or more items within an order, they can be split into separate shipments. This is useful for

expediting items within the order that are immediately ready for shipment, while other items have extra
shipping lead time.

Go to an existing purchase order or create a new one. The order must have two or more items.

2. Go to the Details tab in the order form. Look for Shipment # 1.

m Add Note ﬂ Send Notifications ?Add Order Address

Order No: PO0663 Customer: John Browne

Order Total: 2225]:30 Status: [nProgress

| Summary ‘ | Details | ‘ Payments || Returns ||

Shipment # 1

Notes

=/ New Line Item * Delete

D [[s] Name Quantity List Price Placed Price  Total Discount Discount Description  Total
0 @ 74s218 Domaine de Montille 2.00 £69.00 £69.00 £0.00 £138.00
= Eﬁ' 748388 Maison Camille Giroud 4.00 £22.00 £22.00 £0.00 £88.00
Page Size: 1pp *

3. Select the item you want to move by clicking on the Move icon.

Shipment # 1

Mew Line ltem }‘: Delete
|:| 1D Name
] & 745218 Domain

748386 Maison

Page Size: 7o *

4. The pop-up appears, which allows you to choose to move the item(s) to an existing shipment or
create a new shipment. You can also select the quantity of the item to move. Each new shipment
within the order can have its own separate shipping address and shipping method. Select a ship-
ping address and shipping method from their respective drop-down lists. Click OK to save your
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changes.

Mowve Line ltemn

*

EEuantit\.r to move:
i) Move to existing shipment

@ Create new shipment

Address: 123 Sunset Avenue, Suntown, Marshall Islands, 765432, lv;
United States

Shipping ]

Method: Free delivery (2-3 days) -

W 0K | | # Cancel

5. After splitting the shipments, the order form goes into Edit Mode. The Details page shows the new

shipment, which can be processed completely separate from one another, but tied to a single pur-
chase order.

The Order is in Edit Mode. Save changes before exiting. ‘ + Save | | A Cancel
mAdd Note @ Send Notifications ETAM Order Address
Order No: PO0B63 Customer:- John Erowne
Order Total: £226.00 Status: InProgress
‘ Summary | ‘ Details ‘ | Payments ‘ | Returns | ‘ Notes
Shipment # 1
B New Line ltem | |)( De\em| |
D D Name Quantity List Price Placed Price  Total Discount Discount Description  Total
B E@ 74s21e Domaine de Montille 2.00 £69.00 £69.00 £0.00 £138.00
Page Size 199 ¥
~ Shipping Information
Shipping Address:
123 Sunset Avenue, Suntown, Marshall Islands, 765432, United States Edit Shipping Address
Shipping Method-
Free delivery (2-3 days) Edit Shipping Method
— Shi 5 ' i Status Returns/Exchanges
Item Subtotal: £138.00 Status:  Inventory Assigned ( -
Create Return
Shipping Cost:  £0.00 Complete Shipment
Shipment Total- £138.00
Release Shipment
Cancel Shipment
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6. Click Save to save your changes.

Searching for Orders

Shipment # 2
New Line Item | % Delete
= (b Name Quantity List Price Placed Price  Total Discount Discount Description Total
] & 7as3se Maison Camille Ciroud 4.00 £22.00 £22.00 £0.00 £88.00
PageSize: 1qgp *
— Shipping Information
Shipping Address:
123 Sunset Avenue, Suntown, Marshall Islands, 765432, United States Edit Shipping Address
Shipping Method:
Free delivery (2-3 days) Edit Shipping Method
— Shi 5 y Shij Status Returns/Exchanges
Itern Subtotal- £88.00 Status: Inventory Assigned ( —
Shipping Cost- £0.00
Shipment Total: £88 00

The Catalog Search function enables you look for specific sales items stored in EPiServer Commerce.

Click on Order Management and then Order Search

i

Order Management

= -E Order Management
) Order Search
= @ Purchase Orders

E Today

B This Week

B This Month

= Al
# ] Purchase Orders By Status
H( ] carts

E=N Payment Plans (recurring)
# ] Shipping/Receiving

Using Order Search to Find Existing Purchase Orders

Order Search allows you to find existing orders, giving you six different search filters to help refine your
search results. You can click on the ID number of the order to view it.

EPISERVER COMMERCE Order Search

Welcome ¥ Change Language About ™

Description

Order Management %‘ Class Type: |Purchase Order lz‘ Return £
d'ﬁ Order Management Status [Any] lz‘ 1D
(), Order Search Date Range: | All [=] Customer

= Purchase Orders

= ﬁ D s} Customer Total Status Last Modified
@ Today
I [[] PO0485 Mary Smith $39.98  InPrograss  Today, 11:46 AM
@ This Month [F] PO08SD  Mary Smith $59.98 Cancellad Today, 10:45 AM
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Class Select "Purchase Orders" on the drop-down list. Otherwise, if you want to
Type search for a specific shopping cart or payment plan, select those.
Status You can filter results by their statuses. For example, if you want to find only

completed purchase orders, select from the drop-down list "Completed".
Available status options are:

e OnHold

e PartiallyShipped

e InProgress

e Completed

e Cancelled

e AwaitingExchange

Date You can select from date ranges from "today," "last week," or "this month."
Range

Return# | Enter the return number of a purchase order if a return was created for that par-
ticular order.

ID You can specify the order ID. Orders created out of the box with EPiServer
Commerce are typically numbered as PO####.

Customer | Enter a customer name and the search results will return only orders filtered
by the specified name.

Click on Search to being your search query. The desired results appear below. The results are broken
down by five column fields:

e ID
e Customer (name)
e Total (cost of order)
e Status
e Modified (date)
You can sortresults by ID, Customer, Total, or Status.

Viewing Purchase Orders by Date or Status

In the left navigation menu, you can click on the nodes below Purchase Orders and Purchase Orders
by Status. For example, clicking on Purchase Orders > Today will show the orders created today only
on the right window.

EPISERVER COMMERCE Order List

Welcome ™ Change Language About ™

Order Management -‘3‘ D MNew Order )( Delete Selected

j‘g Order Management B |io Customer Tortal Status Last Modified

o EIEAEATED ] PoD48S Mary Smith £39.98 In Progress Today, 11:46 AM
@[] Purchase Orders

= Today
= This Week
@ This Month

[ PO0SS0 Mary Smith $59.98 Cancelled Today. 10:43 AM

[ Po7657 Hiep Khuc $459,93 In Progress Today. 10:26 AM

= All

Moreover, you can view orders within the Order List by status. For example, click on Purchase Orders
by Status > InProgress to view orders with that status.
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EPISERVER COMMERCE Orders by Status

Total

Status

Last Madified

Order Management 2 || [INew Order X Delete Selected
j'g Order Management F o Customer
) QLT [ Poo4ss Mary Smith
@[] Purchase Orders

[ Po7657 Hiep Khuc

g Purchase Orders By Status
~ Ontold [ Possst Hiep Khuc
(] PartiallyShipped [F] PO1537 Hiep Khuc

| [_]InProgress
] Completed
(=] Cancelled

(] AwaitingExchange

$39.98

$433.98

$957.44

$451.99

Shipping and Receiving Workflow

In Prograss
In Prograss
In Progress

In Prograss

Today, 11:46 AM
Today, 10:26 AM
2/18/2011 11:48:36 AM

2/18/2011 9:58:27 AM

The shipping and receiving workflow consists of the following main parts and tasks:

e Processing shipments

e Creating picklists

e Processing returns and exchanges

The shipping and receiving workflow is explained in more detail in the following sections.

Refer also to the Working Procedure section for more information on how orders are created and proc-

essed in EPiServer Commerce.

Processing Shipments and Creating Picklists

Once an order has been released for shipment, the order then goes through shipment processing, where
you can add the shipment to a Picklist and select the warehouse where the item will be packed and

shipped from.

1. Go to Order Management > Shipping/Receiving > Shipments > Released for Shipping. This
shows the Released Shipments screen.

EPISERVER COMMERCE

Released Shipments

Welcome ™ Change Language About ¥

Order Management =

= 'g Order Management

% Add shipment to Picklist

Warehouse: | Default Warehouse |Z|

() Order Search

H @ Purchase Orders
@[] Purchase Orders By 5tatus
] Carts
] Payment Plans (recurring)
=15 Shipping/Receiving

2[P Shipments {""J

| B Released for Shipping

@ Pick Lists

E’B Returns

] Order Created Last Modified #
D 0 2/18/2011 9:58:27 AM 2/18/2011 9:58:27 AM PO1537-2
D o Today, 11:45 AM Today, 11:45 AM POO485-11

2. Selecta Warehouse from the drop-down list to determine where the item ship be packed and

shipped from.
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3. Checkmark which orders you want to add to the Picklist and click Add Shipment to Picklist.

EPISERVER COMMERCE

Welcome ¥ Change Language

Released Shipments

About T

Order Management

e‘ Warehouse: Default Warehouse lz‘

= 'g Order Management
(Z), Order Search
e @ Purchase Orders
@[] Purchase Orders By Status
&[] Carts
&[] Payment Plans (recurring)
=13 Shipping/Receiving
= Shipments

P%Add Shipment to Picklnfd
| Order Created—

I:‘ & 2/18/2011 3:58:27 AM

Last Modified z

2/18/2011 3:38:27 AM PO1537-2

&) Today, 11:46 AM Today, 11:46 AM PO0485-11

| B Released for Shipping

@ Pick Lists

E:'Q Returns

The Add Shipments to Pick List pop-up appears. You can choose to create a New Pick List (by
default, the List Name shows the date and time the Pick List was generated) or add the chosen
shipment(s) to an existing Pick List you can select from the List Name drop-down list. Click OK to

save your changes.

Add Shipments to Pick List

@ Create New Pick List

List Name:|2011-06-16 16:36
()Add to Pick List

List Name:

[=]

| 0K | |

A Cancel

O Note that it is currently not possible to change the pick list name. It defaults to date and time.

Printing Picklists and Printing Packing Slips

1.

Go to Order Management > Pick Lists. You can see existing Pick lists; you can filter the view by

choosing which warehouse the pick list was generated in.

EPISERVER COMMERCE

Welcome ¥ Change Language About 7

Pick Lists

Order Manage: i ent @

= 'g Order Manalﬁ\gmem
c]’ Order Search
x| @ Purchase Orders
&[] Purchase Orders By Status
H[ ] Carts
# ] Payment Plans (recurring)
=13 Shipping/Receiving
QP Shipments
B Released for Shipping

Warehouse: Default Warehouse lz‘

X Delete Selected

D Name Packing Shipments Warehouse Created By

| & Pick Lists

E’q Returns

[ 2011-02-21 12:35 i Default Warehouse admin

You can also sort existing pick lists by Name, Packing Shipments, Warehouse, and Created By.

Click on an existing pick list. The Packing Shipments window appears. You can choose to printa
packing slip and/or a picklist. Checkmark one or more purchase orders. Click on Print Picklist to
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generated a printable and exportable (Excel or PDF) pick list.

4 4 of1 [kl 100% - Select a format  ~ Export =
Shipment Id: 6
Customer Name  Product Code Product Name Qty
Mary Smith 83017B Chateau Bellevue 2.00
Shipment Id: 9
Customer Name  Product Code Product Name Qrty
John Browne 74521B Domaine de Montille 2.00

To generate a packing slip, checkmark one or more purchase orders to include in the packing slip
and then click on Print Packing Slip.

Finalizing a Package for Shipment

There are two ways to complete a shipment.

Method 1

1. Selectthe box next to the shipment and then click Complete:

Packing Shipments

;EICDmpIEtE %Print Picklist Prir‘lt Packing Slip ?‘.’ Remove from Picklist

|:| Last Modified E Customer Shipping Method
|:| i | ;E] 6/16/2011 12:09:53 PM PO4563-4 Carlos Nevada Fixed Shipping Rate
|:| i | ;E] 6/16/2011 12:14:41 PM POB90E-B Jennifer Browne Fixed Shipping Rate
@ | Today. 1:40 PM PO10728-9 Lisa Prescott Ground Shipping

2. The Complete shipment pop-up appears. The default shipment number is based on the number
after the purchase order number. For example, in the screenshot above, the PO number for the
selected order is "PO10728-9". The last number after the dash is the number you want to enter
into the text field, in this case itis "9".
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Packing Shipments

Complete shipment

Shipment #: g

| " | | # Cancel |

3. Click Validate. Once validated, you will see the customer name, shipping address, shipping
method, and a field to enter in the tracking number provided by the shipping provider. Enterin a
tracking number and click OK. The shipment is sent out and completed. The purchase order status
will change to "Completed."

Complete shipment *
Shipment £: 9
Customer: Lisa Prescott

Shipping Address: 111 Palm Street, Sun City, Florida, 333445, United States
Shipping Methad: Cround Shipping

Tracking Number: 1234567

| " 0K | | » Cancel

Currently, the Complete shipment pop-up is rendered over the purchase order number. So to
reference the shipment number without closing the pop-up, you can move and drag the pop-
up so you can see the PO number by hovering your mouse cursor over the Complete ship-
ment title bar.

Method 2

1. To complete a shipment, click on the complete shipmenticon highlighted in the screenshot below:

Packing Shipments

;ﬂCumplete =5 Print Picklist Print Packing Slip >( Remowe from Picklist

[ Last Modified kS Customer Shipping Method
[ @ [ s/16/2011 12:09:53 PM POASES-4 Carlos Nevada Fixced Shipping Rate
= o %6}'16;"2011 iz:i4:41 PM POGA0E-6 Jennifer Brovne Fixed Shipping Rate
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2. The Complete shipment pop-up appears. The shipment# is already validated with the last
number of the PO number.

Complete shipment *
Shipmlnt & B
Custamer: Jennifer Brawne

Shipping Address: 75 Sun Street, Sunshine Valley, South Wales, 333567, Australia
Shipping Method: Fixed Shipping Rate
Tracking Number: 1234566

| " OK | | X Cancel |

3. Enter a tracking number provided by the shipping provider and then click OK to complete the ship-
ment and complete the order.

Processing Returns and Exchanges

Initiating a Return

Once a package has been finalized and shipped out, EPiServer Commerce enables you to process
returns and exchanges directly in the order.

O Returns and exchanges can only be processed once a purchase order status is tagged as
"Completed."

1. Go to purchase order that has been finalized and shipped. Go to the Details tab and you will see
that the Create Return is available under Returns/Exchanges. Click on it to begin the return
and/or exchange process.

Shipment Summary — Shipment Status

Itern Subtotal: £55.00 Status: Shipped

Shipping Cost: £0.00 | |

Shipment Total: £36.00

2. The Create/Edit Return form appears. Click on New Item to add associate the items to be
returned.

3. The Line Item drop-down menu defaults to the items that were in the original purchase order. You
can set the Return Quantity and the Return Reason from the drop-down list (Faulty, Unwanted
Gift, Incorrect ltem). You can also add additional information to the return. Click OK to save your
changes.
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Create[Edit Return

Mame Quantity

List Price

Total

Reason

]

830178

Chateau Bellevue 2.00

£43.00

£86.00

Faulty

Page Size: 20 ¥

(1 items) | Page <1

~—Total Informatio

Tax Total
Shipping Total
Handling Total

Discount Total

Sub Total:

Total Return Amount:

86.00

0.00

Comments:

Infor

Strange taste in batch 12345, -

0.00

86.00

86.00

\ « 0K

| | X Cancel

4. The purchase order will go into Edit Mode. Click Save to continue the return process. Otherwise,
click Cancel to cancel the return.

5. Inthe Order Llst, the order will now appear with status Completed/Awaiting Return Completion.

MERCE Order List

-

Return Completing Actions

D MNew Order D New Payment Plan # Delete Selected

] 1D Customer Total Status Last Modified

I:‘ POOEES John Browne £226.00 Partially Shipped Today, 11:34 AM

I:‘ PO10564 Carlos Santana £1,290.00 In Progress Today, 11:30 AM

D POO7S1 Carlos Santana £180.85 In Progress Today, 10:27 AM
Completed

D PO2427 Mary Smith £86.00 (Awaiting Return Today, 10:23 AM
Completion)

1. Click on the Returns tab to process the return further. Once you get a notice from the shipping
department, for example, that they have received the returned item, click on Acknowledge

Receipt Items.
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MERCE Order e, admin

ECF G5 Deploy (EpiServer)
© Get Help For This Page =

mAdd Note ﬂ Send Notifications ?Am} Order Address

Order No: PO2427 Customer: Mary Smith
Order Total: £56.00 Status: Completed
Summary ‘ | Details ‘ | Payments ‘ | Returns || Notes

Return # RMA8980

Date/Time Initiated: Today, 12:50 PM Notes: Returns Actions Exchange Actions ——
Created By: admin Strange taste in batch 12345 ‘ e | | T ‘
Status: Awaiting Stock Return
‘ Cancel Return | | Create Exchange ‘
ReturnTotal: £36.00
‘Acknowledge Receipt tems
D Name Quantity List Price Total Reason
B3017B Chateau Bellevue 2.00 43.00 86.0000 Faulty
Page Size: 1pp ¥

You can also choose to edit the return or cancel the return completely.

2. Once you click on Acknowledge Receipt ltems, the Complete Return becomes available.

~— Returns actions ——— Ex

| Cancel Return |

| Complete Return hj

3. Click on Complete Return to open the Create Refund form.

Create Refund

Amount: 2F.0000

Existing Payments @ Pay By Phone (Sale) - £86.00

=

New Credit

Payment Method: Pay By Phaon

| " OK | | # Cancel

a. The Amount value defaults to the invoice cost of the item (not including the shipping costs).

For example, if the item cost $49.99 and the shipping cost was $2, then the Amount text
box will show $49.99.
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However, you can specify a different amount to refund to the customer, including the full
cost of the order, item(s) + shipping cost. By default, the refund will be deposited based on
the payment method the customer used to make the order.

b. Ifthe customer wants the refund processed and deposited to a different credit card or pay-
ment method (such as cash, money order, or electronic transfer), click on the New Credit
radio button and you can enter their alternate credit card information or other refund pay-

ment information.

4. Once done, click OK to create and process the refund. The status of the purchase order changes

to Completed.

i:!Add Note ﬁsand Matifications E?Add Order Address

Order No- PD2427 Customer: Mary Smith

Order Total: £86.00 Status: Completed

Summary | ‘ Details ‘ | Payments ‘ | Returns

H Notes

Return # RMAB980

Date/Time Initiated: Today, 12:50 PM Notes:

Created By: admin Strange taste in batch 12345,
Status: Complete

RewrnTotal: £86.00

Returns Actions

\ |
\ |
[T -]
(eelmeniedoeRecsinsliens]

Exchange Actions

D Name

Quantity List Price Total Reason

830178 Chateau Bellevue

2.00 43.00 86.0000 Faulty

Page Size: 1pp ~

Initiating an Exchange Order

Generating an exchange creates a separate Exchange Order (denoted by "EQ", instead of "PQ") tied to
the original Purchase Order. An Exchange Order is similar to processing a Purchase Order, as itinvolves
payment processing and releasing packages for shipment.

1.
2,

Go to a Purchase Order, click on the Details tab, and then click on Create Return.

Add the items for exchange.

Click on the Returns tab and click on Acknowledge Receipt ltems. Click Create Exchange to

open the Create Exchange Order form.

Click on New Item and then select the item to be exchanged by clicking Configure Selected
Entry. You can adjust the price, quantity, and applicable discounts before you add the item to the
Exchange Order by clicking Add items to the order.
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Create Exchange Order
New Line Item X
Advanced Search k=
Picture  MName Catalog Type Price In Stock
-
Chandon de Erizilles France Variation £55.00 1000
Louis Jadot France Variation £125.00 1000
Dujzc Fils & Pere France Variation £36.60 1000 =
Domaine Sylvie Esmonin France Variation £72.00 1000
Maizon Joseph Drouhin France Variation £165.00 1000
Page Size: 20 ¥ (2779 items) | Page4112345 ...¥ |
Cancel ‘ | Configure Selected Entry

Create Exchange Order

New Line ltem b

Selected Entry. Domaine Sylvie Esmonin i

Display Price: £72.00

Price: |72.00

Quantity: |1

m

In Stock: 1000, Reserved: 0.

Discount:  |lenter descr here (v] Percentage Based -

m

Discount description  amount

Total: £72.00

< T | » I

Back || Add item to the order |

5. Enter a shipping and billing address. Select the shipping method to use for the Exchange Order.
Click on Recalculate to adjust the Summary total.

6. Click OK once done.
Viewing an Exchange

1. Once an Exchange Order (EO) has been created, click on View Exchange to view the details of
the EO. An EO is similar to how a Purchase Order is set up.
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" Exchange actions

| View Exchange d?

turn | |

dfi

eturn

2. Click on the Payments tab to add a payment to the Exchange Order. Select a payment method for

processing the EO. You can adjust the amount if needed (the amount default value is based the
item cost + shipping).

MERCE Order

-

The Order is in Edit Mode_ Save changes before exiting. | ' Save | | X Cancel |

mhdd MNote ﬂ 5end Notifications E?'Add Order Address

| Order Mo: EOQO0335 | Customer: Carlos Santana Original Order: PO0791
Order Total: £72.00 Status: AwaitingExchange
| Summary | | Details | | Payments | | Returns | | Notes
Create Payment
|:| MName Transaction Type Amount Status
[[] % PayByPhone 72.00 Pending

Page Size: 1gg -

3. The Exchange Order goes into Edit Mode. Click on Save to process the payment and the order.
The payment Transaction Type changes to "Authorization."

4. In the Order Llst, the there will be an exchange order with prefix EO instead of PO, and with status
Awaiting Exchange.

MERCE Order List

v

D Mew Order D Mew Payment Plan >< Delete Selected

| o Customer Total Status Last Maodified

D EO0335 Carlos Santana £72.00 Awaiting Exchange Today, 1:22 PM
[F] Ppoosss John Brovme £226.00 Partially Shipped Today, 11:34 AM
[[] Poloses Carlos Santana £1,280.00 In Prograss Today, 11:20 AM
[F] poo7sn Carlos Santana $180.85 Mwa'.rf.f_f‘gr‘;f‘liiegemm} Today, 10:27 AM
D PO2427 Mary Smith £86.00 Completed Today. 10:23 AM

5. Go back to the original Purchase Order and click on the Returns tab. Click on Complete Return
to enable the Customer Service Representative (CSR) to release the EO shipment. Optionally,
you can cancel the shipment to cancel the Exchange Order. Once you release shipment, the CSR
repeats the same process as he would when shipping a Purchase Order.
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Shopping Cart

On the EPiServer Commerce sample site a shopping cart (or basket) is created in the system as soon as
a visitor selects the Add to basket option on any page. Registered and anonymous customer carts can
be viewed in detail and manually converted into a purchase order. In this section the shopping cart func-
tionality is described in more detail.

Refer to the Shopping Workflow section for a general description of the shopping procedure in EPiServer
Commerce.

Converting a Shopping Cart to a Purchase Order

Customer shopping carts can be manually converted over to Purchase Orders, rather than have them
process the order via the front-end site.

1. Go to Order Management > Carts. You will see the Shopping Carts List. You can also click on
"Today," "This Week," or "This Month" to filter by date range.

EPISERVER COMMERCE Shopping Carts List

Welcome ” Change Language About

Order Management @ || [)New Order X Delete Selected

j'g Order Management - |F 1 Customer Toral Status Last Modified

() Order Search

[/ 14 Carlos £418.99 [undefined] Today, 2:27 PM
j@:“_’;’;‘:“ Erez= B Jennifer Browne $32.41 [undefined] 6/16/2011 4:25:13 PM
= This Week M| 3 Anonymous %$0.00 [undefined] 6/16/2011 12:07:01 PM
@ This Month
@ Al
(] Purchase Orders By Status £
o5 Carts
@ Today
@ This Week
@ This Month
a Al

2. Click on the ID number of the shopping cart you want to convert over to a Purchase Order.

3. You will see the Cart View window and details of the customer's shopping cart.

Cart View

;‘A More Actions v

— Overview

Edit Information

Cart#: 14

Created Date:
Cart Total:

Currency:

6/23/2011 1:27:46 PM
418.99
usD

Customer:

Customer ID:

Email Address:

Carlos
fled5deB-5f95-43f6-abd2-e4348ccadd2e

carlos@somemail.com

Open Custamer Profile

J Line Items | | Notes
0 o Name Quantity  List Price Total
D ELCEQODOWMZVAIE 1.00 319.99 31999
D ELCBOOOJNYWBCE 1.00 £399.00 £399.00

Page Size: | 100 El

An anonymous user Cart View will look like this:
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;‘AMO{}"f‘ctians'

~— Owverview

Edit Information

Cart#: 3

Created Date: 6/16/2011 10:07:01 AM

Cart Total: 0.00
Currency: USD
Customer: Anonymaous
Email Address:
J Line Items | | Notes
F o Name Quantity List Price Total
[[1  ELCBODOTGQHAWE 1.00 59.99 59.99

Page Size: | 100[]

a. Edit Information - You can change the currency to be used for the Purchase Order.

b. Open Customer Profile - You can view the profile of the registered customer (this option is
not available for anonymous shopping carts).

c. Line ltems - This is the list of items currently in the customer's shopping cart, displaying the
Quantity of each item, List Price, and Total.

d. Notes - You can add, edit, or delete notes about the shopping cart.

4. Click on More Actions and click on Convert to Purchase Order.

Cart View
|;21M0re Actions ¥
| Convert to Purchase Ci’r%
Create Payment Plan

14

Edit Information

Cart #:

Created Date:
Cart Total:

Currency:

6/23/2011 1:27:46 PM
418.99
usD

Customer: Carlos

Customer ID: fied5de8-5f35-43f6-abd2-e4348cca%d2e | Open Customer Profile |

Email Address: carlos@somemail.com

The page refreshes and shows the Order view page for further processing of the purchase order.

For information about how to create a recurring payment plan using Authorize.Net, refer to Creating a
Recurring Payment Plan Using Authorize.Net.

Payment Plans

This section describes how to work with payment plans and recurring payment plans in EPiServer Com-
merce. A payment plan or recurring payment can be for instance a subscription with associated pay-
ments, which are renewed on a regular basis until canceled.
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Refer to the Payment Methods section for more information on payment methods in EPiServer Com-
merce.

Setting up a Payment Plan

Payment plans can be setup by the Customer Service Representative (CSR) to generate recurring pay-
ments. An example recurring payment would be for magazine or grocery subscriptions.

Payment plans are handled in the background by a scheduled Quartz job which should be configured by
your IT team based on your business needs. Ideally, the payment plan job should run once per day.

Creating a Payment Plan
1. Go to Order Management > Payment Plans (recurring). You will open up the Payment Plans
List. To create a new payment plan, click on New Payment Plan.
2. Select a customer contact to attach the payment plan to.

3. The Payment Plan New page appears. Complete the form as you would when creating a new
order.

4. Under Payment Plan Details, you will set the cycles and parameters of the payment plan.

—Payment Plan Details -

Plan Cycle (en-US): Mo cycle hd
Cycles mode is vsed to define period for recurring payiments.
Can be day, week, month, year or cusicm.

Cycle Length (en-
usy: Cycle length in units of cycle mode.

Max Cycles (en-U5):
Number of maximuir cycles fo process

Completed Cycles

(en-Us): Number of completed cycles

Start Date (en-U5): 22372012 E 02:19 PM
Flan start date

End Date (en-US): 272372012 :ﬁ 02:19 PM

Flan end date

) ) True @ False
Is Plan Active (en-

Us): Ser to true if plam (s active
Last Transaction 2/23r2mz :E 02:19 PM
Date (en-U5): The dare of fast transaction

5. Once the payment plan is configured, click OK.
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Fos——ossrpion

Plan Cycle You can choose from the following plan cycles, which determine how often the customer is
(Cycle Mode) charged.

- No Cycle: No recurring payment is created. The customer is charged once when the initial
purchase order is created.

- Daily Cycle: recurring payment happens daily from start date.
- Weekly Cycle: recurring payment happens weekly from start date.
- Monthly Cycle: recurring payment happens monthly from start date.

- Custom1/Custom2: these are placeholders for developers to create custom cycles within the
Mediachase.Commerce.Orders.PaymentPlanCycle class.

Cycle Length Entering a value of 1 or higher determines the unit of time for the Plan Cycle. For example, if

the Plan Cycle is set to "Daily," and the Cycle Length is "3," then a transaction occurs every
three days. If the Plan Cycle is setto "Monthly" and the Cycle Length is "1," then a transaction
occurs once every month. If "2," every two months, etc.

Max Cycles Determines the maximum number of cycles to run for this payment plan. For example, if the

Max Cycles is setto "2," then the maximum number of transactions cycles is two and then the
payment plan stops. Set the Max Cycles to "0" if you wish to run the payment plan indefinitely.

Completed Cycles | This tallies the number of completed cycles so far after the payment plan was created. When

initially creating the payment plan, set this field to "0".

Start Date Set the start date and time to determine when the payment plan should begin (beginning recur-
ring transactions).

End Date Set the end date and time when the payment plan should end (ending recurring transactions).

Is Plan Active Set "True" to enable the payment plan. Set "False" to create the payment plan but keep itinac-
tive.

Last Transaction  |ogs the last transaction date. The date and time already in those two fields when first creating

Date

the payment plan should be kept as is.

Payment Plan Order Detail Page Explained

The payment plan begins once the first purchase order is generated. The purchase order can be created
manually (by clicking on Create First Purchase Order) or automatically by the payment plans quartz job.

After creating a new payment plan, a new Order page appears. This is slightly altered from the original
Order detail page that appears after creating a new order. The changes include:

Inability to manage shipments (i.e. release shipments for further processing)
An Orders tab that shows a history of processed purchase orders from this payment plan

A "Create First Purchase Order" button thata CSR can manually click on to create the first pur-
chase order related to this payment plan. The button disappears after creating the first purchase
order manually or when the payment plan quartz job runs and generates the first purchase order.
Once that first purchase is generated, the payment plan goes into effect.

The purchase order number that is generated includes the parent ID of the payment plan. For
example, if the payment plan parent ID is 35, the subsequent purchase orders are numbered as
"PO35XXX."

When a payment is added to a payment plan, the customer is not charged. The customer is
charged once the purchase order is generated for the first time (and through subsequent pur-
chase orders). The payment plan simply collects the payment information until converted to a pur-
chase order.
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Editing and Canceling a Payment Plan

1. To editan existing payment plan, go to Order Management > Payment Plans (Recurring) or
Today/This Week/This Month/All. Click on the payment plan ID number to open the payment
plans order details page and make edits.

2. To cancel a payment plan, when editing a payment plan, click on the Summary tab and then click
on Cancel Payment Plan.
Creating a Recurring Payment Plan Using Authorize.Net

Out of the box, EPiServer Commerce supports Authorize.net as a recurring payment plan gateway.

For more information on how to setup payment methods, refer to the Payment Gateways section.

1. Go to Administration > Order System > Payments > (Language) and create a new payment
method or click on an existing payment method (such as "Pay by Credit Card").

2. When setting up the parameters of the payment method, select this class name:

Class Mame: Mediachase.Commerce.Plugins. Payment. Authorize AuthorizePaymentGateway -

Select "Yes" for Supports Recurring.
Click OK.

Click on the name of the payment method again and click on the Parameters tab.

o o K~ w

Configure your Authorize.net account for both regular payments and recurring payments.

Ohverview Parameters

Configure Authorize Net Account

Cet an Authorize Met account at wwew.authorizenet.com.

APl Userld: 4ySBEfUWTjm

Transaction Key. | 4cAmwW927n8ulfs)8
Regular Payments

Processing Url: https: [ /testauthorize.net/gateway transact.dll

P t Opti : L
ayment Lptions @ suthorization

T Sale

Recurring Payments

Processing Url: https:/ /apitest.authorize.net/xml/v1 /request.api

Recurring Method:  |nrarnal -

Cancel Status: OrHald -

OK Cancel

Marketing

The Marketing system consists of the following components:
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e Campaigns - a way to organize marketing activities. Campaigns must be associated with Pro-
motions in order to provide customer discounts. Optionally, Campaigns can also be tied
to Customer Segments for targeted marketing purposes.

e For example, you can create a seasonal campaign that will include different Pro-
motions targeted for the Spring season.

e Promotions - a way to apply various discounts to the products, order totals or shipping. A Pro-
motion is a marketing tool used to increase sales of certain products or productlines. Various
incentives such as lowered pricing and other discounts can be employed as part of a Promotion.

e Promotions are always tied to Campaigns.

e Promotions can be classified into two types: 1) either you can create a Promotion
that s visible prior to checkout or 2) you can configure the Promotion to be dis-
played during the checkout process.

e The most powerful aspect of the Marketing system is the Expression Engine which
allows variable conditions to be applied when creating a Promotion. These con-
ditions vary from the number of items, the percentage discount, shipping rates and
many others.

e Customer Segments - these determine the target audience for the Promotions. Customer Seg-
ments determine the target audience for the Promotions. Within a Campaign, all Promotions will
be applied to whatever Customer Segments associated with the same Campaign. Members of
the Customer Segments can be pre-defined in static groups or you can use the Expressions
Engine to create dynamic groups whenever Promotions are run.

e Forexample, you can have a Customer Segment that targets all users from the Los
Angeles area. You can create an Expression that will include all the customers
whose home city is Los Angeles. Thus, when a user registers on the site he imme-
diately becomes part of the target Customer Segment.

e Expressions - these are customizable Conditions which allow users to extend different aspects of
the Marketing system -- Promotions, Customer Segments and Policies all rely on Expressions.
There is an Expressions Engine which is a core technology behind the Marketing system.

e For example, you want to set a Promotion for "40% off Item X." The Expression or
Condition to enable this Promotion would include: Catalog ID for ltem X and
Reward of 40%.

e Policies - rules that are always executed when Promotions are applied. This allows a Marketing
manager to declare rules just once for the whole site.

e An example of a rule is as follows: "Do not allow negative orders".

Campaigns

Campaigns provide a way to organize marketing activities. Campaigns must be associated with Pro-
motions in order to provide customer discounts. Optionally, Campaigns can also be tied to Customer
Segments for targeted marketing purposes. For example, you can create a seasonal campaign that will
include different Promotions targeted for the spring season.

The various campaign options are described in more details in the following sections of this doc-
umentation.
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Browsing Campaigns

To browse Campaigns, go to Marketing > Campaigns to open the Campaign List.

Marketing EE‘

w4 Campaigns
@ Promaotions

Egll Customer Segments
+ [ Policies
o] Expressions

From the Campaign List, you can create a New Campaign or edit existing ones.

MERCE Campaign List

r

=
D MNew Campaign ' More Actions ™

E Name Starts Ends Is Active  Last Modified Created

I:‘ Wine campaign 10/7/2008 2:00:00 AM 11/7/2020 1:00:00 AM True 10/8/2008 12:14:13 AM

Creating a Marketing Campaign

Sales promotions are tied to specific Campaigns. A Campaign could be related to seasonal sales, such
as Easter or Christmas. Campaigns are the first step to deploying targeted marketing efforts.

To create a new Campaign, click on New Campaign on the Campaign List page.

MERCE Campaign List

D Mew Campaign 1 More Actions ™
|-Il'r
D Name ':-{ ] Starts End

|:| Wine campaign 10/7/2008 2:00:00 AM 11/

This opens up the Campaign Edit page.

1. Enter a Campaign Name, such as "Graduation Special."
2. Enter any Comments as notes about the Campaign.

3. Enter a date directly (or click on the Calendar icon to select a date) and time into the Available
From field. This will indicate when the Campaign is expected to start.

4. Enter a date and time in the Expires On field.

5. Selectthe Target Segments from the list. Target segments are created under the Customer Seg-
ments section

6. Indicate whether or not the Campaign is Active, "Yes" or "No."

7. Indicate whether or not to Archive the Campaign, "Yes" or "No. NOTE This feature has not been
implemented and switching its status from "No" to "Yes" will not change anything.

8. Once done, click on OK.
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Campaign Edit

Overview

Campaign Name: GCraduation Special

enter campaign name

Comments: Spedial offers for the graduation occassion -
Available from: (5,53 ,5072 | 02:31 PM
Expires on: 3/23/2012 £ |02:31 PM

Target Segments

Active: . .
cHvE @ Yes ) No
Archived:; . _
i7) Yes @ Mo
0K Cancel
Promotions

Promotions provide a way to apply various discounts to the products, order totals or shipping. A pro-
motion is a marketing tool used to increase sales of certain products or product lines. Various incentives
such as lowered pricing and other discounts can be employed as part of a promotion.

Promotions are always tied to Campaigns. In addition, promotions can be classified into two types: 1)
either you can create a promotion that is visible prior to checkout or 2) you can configure the promotion to
be displayed during the checkout process. The most powerful aspect of the Marketing system is the
Expressions Engine which allows variable conditions to be applied when creating a promotion. These
conditions vary from the number of items, the percentage discount, shipping rates and many others.

Browsing Promotions

To view and browse Promotions, click on Promotions on the left navigation bar.

Marketing pe"

s Campaigns
@ Promaotions

Sef| Customer Segments

] Policies
] Expressions

The Promotion List page opens, displaying a list of existing Promotions.
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Promotion List

= .
D Mew Promation | |« More Actions ~

D Name Croup Priority  Starts

[[] Exclusive Glasses 25% entry 1 Today, 2:41 PM

You can click on the name of a Promotion to view its properties.

MERCE Promotion Edit

Overview

Promotion Type: motaloa Entre Build Your Chwn Diceo

Promation Name: Exclusive Glasses 25%

enter promation name
Display Name:
English (United States)

Exclusive Glasses

Cerman (Cermany)
Spanish (Spain)
French (France)

Promotion Properties:

Campaign: Craduation Special -

Promotion Croup: o I PR

Combination with other promotions: Combine with other promations

select the degree fo which multiple promotions can be combined
Priority: 1

promaotions with higher pricrity will be evaluated first
Coupon Code:

will reguire code if entered
Status: Active -

starus of the promaotion

Deleting a Promotion

On the Promotion List page, checkmark the box next to the name of the Promotion and then click on
More Actions > Delete Selected on the menu bar.

Promotion List

=
D Mew Promotion :d More Actions ™
|:| Name

Croup Priority | Starts

| )( Delete Selected

Exclusive Glass entry 1 Today, 2:41 PM

Flip Status (activeinactive)

Creating an Entry Level Promotion

Out of the box, you can build these Catalog Entry Promotion Types:
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Catalog Entry: Build Your Own Discount
Catalog Entry: Buy Catalog entry X, get catalog entry Y at a discount
Catalog Entry: Buy X Get $ Off Discount

The options above are available in the Promotion Type field when creating a new promotion. The fol-

lowing are examples of how to create each type of promotion.

Example: Build Your Own Discount - "40% Off Wine Decanter”

Once you have selected "Build Your Own Discount" from the Promotion Type drop-down menu, enter in
a Promotion Name, such as "40 % Off Wine Decanter”

Under the Display Name section, enter in the display name for each language type.

ERCE Promotion Edit

Overniew
Promotion Type: Catalog Entry: Build Your Own Discount -
Promotion Name: 40% OFff Wine Decanter
enter promaolion name
Display Name:
English (United States) 40% OFF Wine Decanter

Cerman (Cermany)

Spanish (Spain)

French (France)

Promotion Properties:

Under the Campaign drop-down, select an existing Campaign created earlier
Promotion Group is grayed out because the Promotion Type is specified

From the Combination with other promotions drop-down, select the degree to which multiple pro-
motions can be combined. There are three options: "Combine with other promotions", "Exclusive
within select groups", and "Exclusive within all groups."
~— Combine with other Promotions - The selected promotion will be combined with all other
promotion types that may be in use

~ Exclusive within Selected Groups - If the selected promotion is applied, no other pro-
motions within that group will be applied (but other promotions in other groups may be
applied)

~ Exclusive within all Groups - If the selected promotion is applied, no other promotions will
be applied.

Enter a numerical value into the Priority field (promotions with a higher priority will be evaluated
first)

Optionally, enter in a Coupon Code that customers can redeem from the front-end public site to
getreceive the discount. Otherwise, leave the field blank.

Set the Status of the Promotion either as "Active", "Inactive," "Suspended," or "Deleted" from the
drop-down menu. Select Active to enable the promotion.

© EPiServer AB



144 | User Guide for EPiServer Commerce 1 R2 SP2

Promotion Properties:

Campaign: Craduation Special -
Promotion Group:

Combination with other promaotions: Combine with other promations ¥
select the degree to which multiple promotions can be combined

Priority: 1
promeotions with higher priority will be evaluated first
Coupon Code: Test
will require code if entered
Status: Active -

status of the promotion

Purchase Condition and Reward:
Here you can set your own Purchase Condition to receive the discount Rewards. To apply a 40% dis-
count for a wine decanter, use the following settings in the screenshot.

Purchase Condition and Reward:

?}is Iype of promotion alfows you o create your own custom promotion.

Use the condition below to restrict how the promaotion will be applied.

Purchase Condition:

~ And
TargetLineltem.CatalogEntryld Equals (Text) FOO146

Use the actions below to assign rewards.

Rewards:

: .;!md

get % off item reward

Redemption Limits:
Under this section, you can specify the redemption limits of this promotion.
o Nextto Max. Total Redemption, enter in the maximum number of times the promotion can be
redeemed.
e Nextto Max. Redemptions Per Order, enter in the maximum number of times the promotion can
be redeemed per customer order.
o Nextto Max. Redemptions Per Customer, enter in the number of times a promotion can be by a
single customer.

Redemption Limits:

Max. Total Redemptions: 300 (Redeemed:)
number of times the promaotion can be used by all customers, enter O for uniimited

Max. Redemptions Per Order: 1
number of times the promotion can be used in a single order, enter O for uvnlimited

Max. Redemptions Per Customer: 1
number of times the promotion can be used by a single customer, enter O for uniimited
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Schedule:
Enter the date and time when the Promotion is Available and when it Expires.

Click OK to save the promotion. The promotion will appear in the Promotion List.

Welcome, a

Promotion List Product Ver:

License: ECI

=
D Mew Promotion 1 Mare Actions ™
D MName Croup Priority  Starts Ends 51

|:| 4 0% OFf Wine Eecaqt% entry 1 Today, =:02 PM 2/23/2012 2:02:00 PM ac

I:l Exclusive Glasses 25% entry i Today. 2:41 PM 3/23/2012 2:41:00 PM ac

When the promotion is applied, the price on the front-end should change.
Buy catalog entry X, get catalog entry Y at a discount

The steps to create this discount are similar to creating a custom discount. The difference is the Purchase
Condition and Reward.

1. Under the Select catalog entry X drop-down menu, select a specific catalog entry.

2. Under the Select catalog entry Y drop-down menu, select another specific catalog entry.

3. Enter a value for the Quantity of "X" needed to qualify for the promotion. For example, the cus-
tomer must purchase 2 of Catalog Entry X as a prerequisite for the discount.

4. Enter a value for the Quantity of "Y" needed to quality for the promotion. For example, the cus-
tomer must purchase 3 of Catalog Entry Y as a prerequisite for the discount.

5. Inthe Amountfield, enter in a number and select from the drop-down to indicate that the Pro-
motion is Percentage Based or Value Based. For example, if you enter 40 and select Percentage
Based, the Promotion will take off 40%. If Value based, it will be 40 off the total price.

Purchase Condition and Reward:

This type of pr ion makes iti SKUs i ar a perc discount when an order includes some required
amount of the specified SKU

Select catalog entry X:

Enoteca Wine Glass Large [35368] -
Select catalog entry Y. Enoteca Decanter 1000ml [FOO146] -
Quantity of ' needed to qualify for the promotion: 4
Quantity of "' needed to qualify for the promotion: 1
Amount: 25 Percentage Based v

Buy X Get $ Off Discount

This type of promotion gives a discount per item by purchasing the minimum quantity specified under
these Purchase Conditions.
1. Enter a Minimum quantity that the customer needs to purchase in order to receive the discount.
2. Enter the Amount of the Promotional discount, whether Percentage Based or Value Based.

3. Select any number of Variations from the drop-down menu and click on "add variation." Repeat to
add more Variations to this Promotion. Click on the red X button next to the Variation to delete it.
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Purchase Condition and Reward:

This type of promotion gives § off discount per item for the minimum guantity.

Minimum quantity: 2
Amount: 20 Percentage Based ~
Variations: Chateau Haut-Batailley [81725M] (5) more...

Creating an Order Level Promotion

Order Level Promotions are discounts applied if the overall order satisfies the conditions specified by
the promotion.
Out of the box, you can build these Order Entry Promotion Types:

e Order: Buy X, get N quantity of Y at a discount

o Order: Sub Total Volume Discount - if the order subtotal minimum is met, then the customer
receives the discount.

e Build Your Own Discount - you can create a custom order level promotion based on a range of
purchase conditions and rewards (similar to creating a custom catalog entry discount).

The options above are available in the Promotion Type field when creating a new promotion. The fol-
lowing are examples of how to create each type of promotion.

Buy X, get N quantity of Y at a discount
This type of promotion allows a customer to be eligible to buy a designated number of items at a reduced
price.

1. Selectan Entry X variation from the drop-down menu and click on "add variation.

2. Select catalog entry Y from the drop-down menu. A certain number of "Y" entries will be dis-
counted based on the Purchase Conditions.

3. Enter a Max quantity Y for the maximum number of Y entries eligible for a discount.

4. Enter the Amount of the promotional discount, whether Percentage or Value based.

Purchase Condition and Reward:

This type of promotion is eligible to buy designated number of item at a reduced price.

Entry X variation:

Chateau Guiraud [B0758H] (2) more... Exclude
Select catal oy Y.
Flect catalog entry Domaine Sautereaw [761518] -
Max quantity Y 1
Amount: 20 Percentage Based +

Order Sub Total Volume Discount

Enter in the Minimum order amount into the field. For example, if the order amount was set to $200, then
the customer must have $200 or more in his shopping cart to qualify for the discount.

Enter in the Amount of the discount. It can either be "Percentage Based" or "Value Based." If Percentage
Based, then the customer gets a percentage off the price. If Value Based, the customer gets a fixed
amount discounted off.
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Purchase Condition and Reward:

This type of promotion discounts the order subtotal if minimum order amount is met.

Minimum order amount: 0

Amount: 0 Percentage Basedlz‘

Example: Build Your Own Discount - "20% Off for a Shopping Cart Subtotal of $100 or More"

Like a custom Catalog Entry discount (add link here), users can create their own custom Order Level dis-
count based on a list of Purchase Conditions and Rewards. This means that there is a wide range of
Order Level discount possibilities.

The follow Condition and Reward example shows how to create a Promotion that gives 20% off for a
shopping cart subtotal of $100 or more.

Purchase Condition and Reward:

This fype of promotion allows you [0 createé your own cusiom promotion.

Use the condition below to restrict how the promaotion will be applied.
Purchase Condition:

- And
: ShoppingCart.5ubTotal Equals

[

Use the actions below to assign rewards.
Rewards:

- And

o get % off whole order  reward 20.00%

.

The discount should reflect on the shopping cart on front-end public site.
Creating a Shipping Level Promotion

Shipping Level Promotions are promotions that give discounts based on the overall shipment. The dis-
count will appear on the order page just before you submit the order.

Out of the box, you can build these Order Entry Promotion Types:

e Shipping: Build Your Own Discount - you can create a custom shipping promotion based on a
range of purchase conditions and rewards (similar to creating a custom catalog or order entry dis-
count).

The option above is available in the Promotion Type field when creating a new promotion. The following
are examples of how to create each type of promotion.

Example: Buy N quantity Get % Off Shipment Discount

This Promotion type applies shipping discount if the specified Variations total the Minimum Quantity set
or more.

1. Enter a Minimum Quantity, for example "5".

2. Enter an Amount of the discount Reward, and select from the drop-down whether itis "Per-
centage Based" or "Value Based, for instance "20%".
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Purchase Condition and Reward:

This type of promotion allows you o create your own custom promotion.

Use the condition below to restrict how the promaotion will be applied.
Purchase Condition:

- And

P Shipment.ShipmentTotal Equals 5.00

Use the actions below to assign rewards.
Rewards:

- And

get % off shipment reward 20.00%

Creating Custom Promotions

You can create custom promotions instead of using the built-in ones. It is possible to create custom pro-
motions on a catalog, order, or shipping level.

How to Use "Or" When Building Your Own Promotions

EPiServer Commerce has a powerful discounting engine and can be used to build all types of promotions
without writing custom code. In most cases these discounts can be built using one of the builtin "Build
Your Own Discount" options.

Building the Discount

In this case we want to build a promotion that will give a $10 discount on certain items in our catalog. We
want products with "Bordeaux" OR "Sauternes" in the display name to receive $10 off the item. In this
case we are using a Promotion Type of "Catalog Entry:Build Your Own Discount". Constructing the pur-
chase condition can be a confusing when using the Or operator. The firstitem we must add to the con-
dition is the Or operator since And is the default. The Or will have the effect we desire if added first which
is And (Or (DisplayName = Bordeaux, DisplayName = Sauternes)) which is translated by the rules engine
to And (DisplayName = Bordeaux Or DisplayName = Sauternes). If the Or is not added first the results
will not be as desired as the DisplayName would have to contain Bordeaux And Sauternes.

The Reward is setto $10 Off.

© EPiServer AB



Commerce Manager | 149

Purchase Condition and Reward:

This type of promotion allows you o create your own custiom promoiion.

Use the condition below to restrict how the promotion will be applied.

Purchase Condition:

- And

TargetLineltem.DisplayMame Contains Bordeaux

TargetLineltem.DisplayMame Contains Sauternes

Use the actions below to assign rewards.
Rewards:

, And

get 5 off item reward 10.

Seeing the Discount Applied

We have added three items to our shopping cart. As you can see two of the items (containing "Bordeaux"
and "Sauternes") have been given the $10 off discount and the name of the promotion is shown with the
item. The third item in our cart did not meet the criteria we set so no discount was applied.

Your Basket - you have 5 item(s) in your basket

Barolo, Le Vigne, Az Agr. Luciano Sandrone, Piedmont Quantity Price Total Remove
5 £117.00 £585.00 o
Do you have a promo code? Enter Code Apply ©
Subtotal £585.00 (exc. Tax)
£0.00 discount awarded in this basket.
Order Discount -£0.00 (exc. Tax)
. . . . Company Discount -£0.00 (exc. Tax)
0 loyalty points recieved with this purchase.
Total Order £585.00 (exc. Tax)

Update Basket © [l Goto Checkout ©

Back

Customer Segments

Customer Segments determine the target audience for Promotions or Campaigns. Within a campaign,
all promotions will be applied to whatever customer segments associated with the same campaign.
Members of the customer segments can be pre-defined in static groups or you can use the Expressions
Engine to create dynamic groups whenever promotions are run.

For example you can have a customer segment that targets all users from the Los Angeles area. You can
create an expression that will include all the customers whose home city is Los Angeles. Thus, when a
user registers on the site he or she immediately becomes part of the target customer segment.

Creating a Customer Segment

Customer Segments defines a specific groups of customers to be targeted by Promotions or Campaigns.
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Creating a Customer Segment Assigned to Contacts

Go to Marketing > Customer Segments.

Marketing @

4 Campaigns
@ Promaotions

e Customer Segments
[ Policies
# [ ] Expressions

Click on New Segment on the menu bar to open the Segment Edit page.

Customer Segment List

.ﬂNEWSEgmaﬁ]}r ﬂMnr&Actinns'
& Name

[l GCraduation

[] Los Angeles Customers

1. Enter a Segment Name, such as "Los Angeles Customers."

2. Enterin a Display Name, which will appear to users when associating this customer segment
when Creating a Marketing Campaign.

3. Enter a Description.

4. Selectfrom a list of contacts from the Members drop-down to assign them to this customer seg-
ment. Select the name from the drop-down and then click add member. You can choose to
Exclude member by clicking on the checkbox and then clicking add member.

5. Once done, click OK to save the customer segment.
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=@ Segment Edit P

Overview

Segment Name: Los Angeles Customers

enter SEQMENt name
Display Name: ) o2 Angeles Customers
Description: Offers targeted to customers in the city of Los Angeles. -
Members:

DEchude member
add member

K Mary Smith
x John Erowne

Conditions: —

The above conditions will be evaluated in runtime and i any are true, the custamer will be part of this segrment.

QK || Cancel |

Creating a Customer Segment with Conditions
Instead of assigning members manually to a customer segment, you can use Conditions to apply rules. If
a customer satisfies the conditions, then the customer is part of the customer segment.

To add conditions to the customer segment, click on New Condition on the Segment Edit page. This
example will show how to specify "Company X" or "Winearts" emails as part of this customer segment.

Enter an Expression Name, such as "Company X or Email Addresses."

Setup the conditions based on the image below.

Condition Dialog

Expression Name: \company X or Winearts Email
ENITEF EXPIESSION NAME

Expression Xml:

And
: Email Equals (Text) Company X
Email Equals (Text) Winearts

Click OK to save the Conditions.

Conditions: .

x Campany X ar Winearts Email

The above conditions will be evaluated in runtime and if any are true, the customer will be part of this segment.

OK || Cancel |
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Expressions

Expressions are customizable conditions which allow users to extend different aspects of the marketing
system -- Promotions, Customer Segments and Policies all rely on expressions. The expressions engine
constitutes the core technology behind the marketing system.

Expressions are created from the Marketing system under Promotion, Segment, or Policy.

To access and create expressions, click on Expand Expressions and Promotions/Segment/Policy to
view the Expression List page.

Marketing .,{?

s Campaigns
@ Promaotions
@ Customer Segments |
[ Palicies

=9+ 5 Expressions

q.,. |

[ Promation o
] Segment
[~ Palicy

Expression List 5.2 (build: 377)
5 Deployment (Ep

@ Ger Help For This Pa

D New Expression 21 Mare Actions ™

D Name Description Modified Created

[F] EntryCustomDiscount {MarketingStrings:Promotion_Custom_Descrif 2/23/2012 2:42:50 PM 2/23/2012 2:42:50 PM
[F] EntryCustomDiscount {MarketingStrings:Promotion_Custom_Descrip 2/23/2012 2:13:48 PM 2/23/2012 3:13:48 PM
[[] BuyXCetYDiscounted {MarketingStrings:Promation_Buy_X_Get_Y_Al 2/23/2012 3:30:24 PM
D BuyXCetNofvatReducedPrice {MarketingStrings:Promotion_Buy_X_Get N_Al 2/23/2012 3:40:42 PM
[[] BuyXCetOffDiscount {MarketingStrings:Pramotion_Buy_X_Get_Dall 3/23/2012 3:47:33 PM
[F] EntryCustomDiscount {MarketingStrings:Promotion_Custom_Descrif Today, 10:10 AM Today, 10:07 AM

O In order to create an Expression, knowledge of XML is required. For more information on
expressions, refer to the examples in the sample site.

To create a new Expression, click on New Expression. The Expression Edit page appears.

1. Enter an Expression Name, such as "EntryCustomDiscount.”

2. Enter a Description of the Expression.

3. Enter the Expression XML.

4. Under Category, select from the drop-down whether this Expression is for a "Promotion," "Seg-

ment," or "Policy." Depending on your selection, the expression will appear under those respec-
tive folders.
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ERCE Expression Edit

Overview

Expression Name:

EATer eXpression name

Description:

enter expression description
Expression ¥ml:

enter expression xml

Category: Promotion

| oK |

pm caregory

Segment

Policy ]

5. Click OK to save changes.
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me, admin

Expression Edit Ve 2 (build: :
icense: ECF G5 Deployment (EpiServe

9 Get Help For This Page =

Expression Name: | gpprecystombiscount
enter expression name
Description MarketingStrings:Promotion_Custom_Description} P

enter expression description

Expression Xml: g leSet Name="PromotionCondition-0-CustomerRuleSet” Description="{p1:Null}" ChainingBehavior="None"
xmins:p 1="http:/fschemas. microsoft. comfwinfx/2006 xaml”™ xmins="http://schemas.microsoft. com/winfx 2006 fxaml fworkflow™ >
<Ruleset.Rules>
<Rule Mame="0" Description="{p 1:Null}" ReevaluationBehavior ="Never" Active ="True" Priority="3929">
<Rule. ThenActions >
<RuleStatementAction =
<RuleStatementAction.CodeDomStatement >
<ns0:CodeAssignStatement LinePragma="{p 1:Mull}" xmins:ns0="clr-
namespace:System.CodeDom;Assembly=System, Version=2.0,0.0, Culture=neutral, PublickeyToken=b77a5c56 19342089">
<ns0:CodeAssignStatement. Right >
<ns0:CodePrimitiveExpression >

[m] »

«<ns0:CodePrimitiveExpression, Value >
«ns1:Boolean

xmins:ns1="dr-namespace:System;Assembly=mscorlib, Version=2.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089 "> true</ns1:Boolean >

«fns0:CodePrimitiveExpression. Value >
<fns0:CodePrimitiveExpression
<Insi:CodeAssinnStatement. Rinht =
enter expression xmi

Policies

Policies are rules that are always executed when Promotions are applied. Promotion policies determine
whether a conflict situation will arise when a particular promotion is applied in addition to any previously
applied promotions. If no conflict is detected, this promotion is added to the list of applicable promotions;
otherwise itis eliminated and will not be applied to the order.

Policies are business rules on how to eliminate similar promotions for the same order or same prod-
uct. Policies are pre-configured for each store. Policies can be optionally associated with one or more pro-
motion groups.

e Local Policy - If a policy is associated with a promotion group, itis considered a local policy, and
applies only to those promotions in the group to which this policy is associated. If a policy is not
associated with a promotion group, it is considered a global policy which applies to all pro-
motions.

This allows a marketing manager to declare rules just once for the whole site. For example, you can
create a policy such as this: "Do not allow negative orders".

O Creating policies is meant for advanced users.

To create a new Policy, go to Marketing > Policies to open the Policy List.

Policy List

DNEW Policy ﬂMDrE Actions

[ mMame

Click on New Policy to open the Policy Edit page.
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ERCE Policy Edit

Overview
Policy Name:

enter Policy name
Status:

enter Policy status
Is Local: 7 Yes @ Ma

Expression: E

select policy expression

Groups: Order
Catalog Entry
Shipping

select policy group, alfows you to logically group policies

| Ok || Cancel |

O Policy Status and Policy Is Local has not been fully implemented. Therefore, all policies will
be global (meaning it cannot be limited to a Promotion Group) until this feature becomes avail-
able in a future release.

Enter in a Policy Name.
Enter the Status of the policy.
Select"Yes" or "No" to set the Policy Is Local.
e Policy Is Local is No - this is the default behavior. This means that this Policy is not part of a Pro-
motion Group and is available for all Promotions.
e Policy Is Local is Yes - this means this Policy is part of a Promotion Group and is applicable only
for that Promotion Group
Select an existing Policy Expression from the drop-down menu.
Select from the Groups list to place the Policy under.
Click OK when done.

Asset Management
The Asset Management system allows for assets including images, MP3s, PDFs, software packages and
other downloadable files to be centrally stored and displayed on the website.

Refer also to the File Management section in this documentation to find out more about file management
in EPiServer Commerce.

Browsing, Editing, and Deleting Folders and Assets

The Asset List page categorizes and manages downloadable Asset files. The default list of Asset folders
are: Video, Presentations, Specifications, Software, Downloads, User Guides, and Images. These
folder names can be changed.

To access the Asset List, click on Asset Management > Root or any other folder below Root.
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Asset Management P

| =7 Root hﬂ'rh |
[ video o
[ Presentations
[ Specifications
[ 1 Software
[ ] Downloads
[ User Guides
] Images

ERCE Asset List

D Create New™ | = More Actions ™

D Mame Size Created

[ - Video 2/22/2012 4:03:05 AM
[ - Presentations 2/22/2012 4:03:05 AM
[ (J specifications 2/22/2012 4:02:05 AM
[ & soRware 2/22/2012 4:02:05 AM
[ (] Downloads 2/22/2012 4:03:05 AM
[ (3 user Guides 2/22/2012 4:03:05 AM
O - Images 2/22/2012 4:032:05 AM

The Asset List shows folders and assets. The Asset List shows the total Size of the Assets and the
Created date.

Folder and Asset names can be edited by clicking on the Edit icon next to the Name.

D Create New ™ i] Maore Actions ™

Mame

O video
- Presentations

- Specifications
O Software

& Downloads
[ User Guides

%D Images

This brings you to the Folder Item page, allowing you to edit the Name.

[
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Folder ltem

J Folder ltem

Mame | Images

OK Cancel

If you are editing an Asset such as an image, the File Iltem page appears, allowing you to edit the name
as well.

ERCE File Item
File ltem

ImageFolderElement

Name: LargewineGClassCrystal jpg

014 | | Cancel

Copying/Moving and Deleting Folders and Assets
Users can also copy/move and delete Folders and Assets.

To copy or move an Asset or Folder to another location, place a check mark in the box next to the Folder
or Asset name and then click on More Actions > Move/Copy.

ERCE Asset List

D Create Mew ™ Q] Mare Actions ™

[ Name )( Delete Selected 1
[-] [y Move/Copy ’{bJ

|:| - Package00 ‘

D - Package(1

D - Package(2

D - Package(3

D - Package(4

D - Package05

@LargEWinECIasststal.jpg
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The Move/Copy to Folder pop-up appears. You can select to "move" or "copy to folder." From the drop-
down menu, select the destination. Click on OK to confirm.

Move/Copy to Folder b4

i@ move or ") copy to folder: Ru:u:ut_."Presentaticun5| v|

| 0K | | cClose |

To delete a Folder or Asset, place a check mark in the box and click on More Actions > Delete Selected.

ERCE Asset List

=
D Create New ™ :d Maore Actions ™

[ Name ¥ Delete Selected J\bj

=[] [y Maove/Copy

= - Package00
= - Packagell
= - Packagel2
= - Packagel3
= - Packageld4

= - Packagels

] T o R O R

= @ LargeWineClassCrystal.jpg

Creating Folders and Uploading Assets
Creating Folders

To create a new folder, go to the Asset List by clicking Asset Management > Root (or any folder under-
neath Root). Then click on Create New > New Folder.
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ERCE Asset List

Dl:reate New~|| | More Actions~

|D MNew Folder E

MNew File

Upload Multiple Files

=¥ = Specifications

=¥ IEISanI.rare
= = Downloads

= IE' User Guides

O 000 0O|Q

=¥ IE' Images

Enter in a name for the folder and click Create.

New Folder b4

Mame Audio Create|

The folder will be created in whichever folder you are currently in. In this example, the folder "Audio” was
created underneath Root.

DCre,ate MNew~ éjMoreActionsv

Mame Size Created

= Evidm 5/11/2010 3:34:57 PM
= h Presentations 5/11/2010 3:34:57 PM
= D specifications 5/11/2010 2:34:57 PM
ESD&W’EM 5/11/2010 3:34:57 PM
= O @nluads 5/11/2010 3:34:57 PM
= E User Guides 5/11/2010 2:34:57 PM

B D images 5/11/2010 3:34:57 BM

oo ooooool
g

= 3 avdio Today, 3:15 PM

To see the folder in the left navigation frame, click on the Refresh icon and the new folder"Audio" will
appear. You can create additional sub-folders underneath Audio (or any other existing folder).
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Ascset Management %
== Root
[ Video
[ 7] Presentations
[ Specifications
7] Software
7] Downloads
[ User Cuides
-] lmages
[ Audio

Uploading Individual Files

To upload a single File, navigate to the Folder you want to upload the File to and then click on Create
New > New File.

ERCE Asset List

D Create New ™ 2] Maore Actions ™

[y MNew Folder

] wewFile

[ J upload Muttiple Files
] Packagel]
- Packagel2
- Package(3

- Package(4
= Packagel5

EO0O0OOO

v @LargeWineClasststal.jpg

Click on Browse or enter in the file path into the field. Once done, click on Upload.
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Welcome, admin

FI Ie |tern Product Version: 5.2 (build:
License: ECF G5 Deployment (

ey
(7] Cet Help For This Page +

Click Browse and =elect file, or type file path:
C:\Transfer\SmallwineGlass.jpg

[ ]
I

| Ok || Cancel |

A progress bar appears below. Once the upload is complete, the Folder Element form appears, allowing
you to edit the name of the file, if you wish. Once done, click OK.

File Item

ImageFolderElement

Name: SmallWineClass.jpg

oK Cancel

The File is now visible on the Asset List of the destination folder.
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ERCE Asset List

D Create New ™ 2] More Actions ™

|:| Mame

= [..]

= - Packagel0
= - Packagell
- Package(2
- Package(3
- Package(4
= - Package(s

= @ LargeWineGlassCrystal jpg

Oo0OoOoOoOoOoo

= @ SmallWineGlass jpg

Uploading Multiple Files at One Time

To upload multiple files to a folder, click on Create New > Upload Multiple Files.

ERCE Asset List

DCraate New Q]Mureﬁ.ctiuns'

[y Mew Folder

] NewFile

| ] upload Multiple Files

o

The Add Files pop-up window appears. Click on Browse to add files. An additional field will appear
below, allowing you to add more. You can upload up to five files at one time. One done adding files, click

Upload.
Add Files ¥
C:\ Transfer\5mallWineClass. jpg Browse...
C:\ Transfer\ MediumWineGlass.jpg Browse...
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A progress bar window will pop-up, showing you the progress of the uploads. Once complete, the files
will appear in the Asset List.

EPISERVER COMMERCE Asset List e

License: ECF
Welcome ™ Change Language About ™ (7]

Asset Management .—G‘ D Create New ™ 21 More Actions ™
=] Root m Name Size Created
[IVideo ]

| Presentations

()Specifications ] B MediumWineClass g 12.04 KB Today, 2:51 PM

|_]Software = @Smal\‘.\-‘ineclass.jpg 14.22 KB Today, 2:51 PM
|_]Downloads
[_JUser Guides
= JImages
# ] Package00
+ (] Package01
+ ] Package02
# ] Package03
# ] Package0D4
# ] Package05
| [IGlasses

Reporting
Through the Reporting system, various reports are included out-of-the-box to help management and
other personnel to make informed decisions. The default reports include:

e Sales Report - this report provides an overview of a site's sales performance over a period of time

e Shipping Report - this report provides the shipping method, number of orders and total shipping
costover a period of time

o Best Sellers Report this reportis used to determine which products sold the mostin terms of
quantity and total revenue over a period of time

e Low Stock Report - this report is used to determine which products are running low in inventory.
If a product's inventory is less than its reorder minimum quantity, it will be included in this report.

The display of these reports can be generated by Start and End date/time and filtered by
Day/Month/Year. In addition, they can be exported to Excel or PDF format, or printed.

SQL Reporting Services

Since the Commerce Manager utilizes SQL databases, custom reports can be created using Microsoft
SQL Server Reporting Services. Reporting Services provides a complete, server-based platform
designed to support a wide variety of reporting needs enabling organizations to deliver relevantinfor-
mation where needed across the entire enterprise. Read through the resources below to get familiarized
with Reporting Services and how you can create custom SQL reports to display data from your EPiServer
Commerce site.

e Reporting Services Features

e Using SQL 2008 Reporting Services and Report Builder 2.0 to Create Custom SQL Reports
e Download Report Builder 2.0

e Reporting Services and ReportViewer Controls in Visual Studio

e Reporting Services Components and Tools

e Reporting Services Configuration How-To Topics
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Generating and Customizing Reports
By default, users can generate Sales, Shipping, Best Sellers, and Low Stock Reports about the site.
Reports can be customized/filtered and exported to suit the needs of the user.

To generate a report, click on Reporting > Sales > Sales Report/Shipping Report or Reporting > Prod-
ucts > Best Sellers Report/Low Stock Report.

MERCE Sales Report
out T
Start Date:[5/7,2010 Efl[12:48 M | End Date:57/2010 F2:48pm |CroupBy: Day  [+|[ ApplyFiler |
4 4 I oft Pl 100% [+] Select a format  [w] Export & = |
Sales Report (05/08/2010 - 06/07/2010)
Period HNum. Of Items Ordered Sub Total Tax Shipping Discounts Total Invoiced
Orders
05/08/2010 0 0 0 0 0 0 0 0
05/09/2010 0 0 0 0 0 0 0 0
05/10/2010 0 0 0 0 0 0 0 0
05/11/2010 0 0 0 0 0 0 0 0
05/12/2010 0 0 0 0 0 0 0 0
05/13/2010 0 0 0 0 0 0 0 0
0 0 0 0 0 0 0 0

[o5/1472010

Customizing/Filtering and Exporting Reports

Users can select the Start Date and End Date ranges and time as well as group the Report data by "Day,
"Month" or "Year." Once done, click on Apply Filter.

An example Sales Report with a date range from 5/1/2010 at 6am to 6/7/2010 at 12pm Grouped By
Month is in the image below.

MERCE Sales Report
ut T
Start Date: 51,2010 m 06:00 AM | End Date: g/7/2010 m 12:00 PM |Croup By: Monthlz‘
4 4 1 oft [ Pkl 100% [=] Select a format  [=] Export = =
Sales Report (May, 2010 - June, 2010)
Period HNum. Of Items Ordered Sub Total Tax Shipping Discounts Total Invoiced
Orders
May, 2010 0 0 0 0 0 0 0 0
une, 2010 5 10 41,318.61 0.00 52.00 0.00 41,370.61 41,370.61
5 10 41,318.61 0.00 52.00 0.00 41,370.61 41,370.61

Users can also change the zoom size of the report by clicking on the drop-down menu with "100%." Also,
paging controls are available next to the zoom drop-down menu. Users can also reload the report by click-
ing on the Refresh icon.

To Export a report to a file format for sharing with others, click on the drop-down that says "Select a for-
mat." Select a format from the drop-down menu, such as Excel or PDF. Click on Export and Open or Save
the file once the prompt appears.

System Administration

In the System Administration part you will configure and administer many of the settings used in EPiS-
erver Commerce. This guide includes various configuration tasks such as setting up shipping and pay-
ment gateways, your default language, currency, units, tax configuration, licensing, and search settings.
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Most often, these settings are configured from the Administration area of Commerce Manager. This sec-
tion provides a brief overview of the various configuration options. Refer to the EPiServer Commerce
Developer Guide for more detailed technical information about configuration.

System Settings

System Settings includes functionality for setting up payment methods using built-in payment gateways
as well as default language, currency, units and meta data fields and classes.

Setting up Meta Fields and Classes

Using meta fields and meta classes, it is possible to extend the meta data of catalog items and order
forms. Meta fields are used for adding specific data about an item. For instance, if you create a meta
class called "Wine" you will want to add meta fields that are specific details related to wines, for instance
color, taste, vintage and maturity.

Adding Meta Fields to a Meta Class

1. Go to Administration > Catalog System > Meta Fields.

2. Click on New Meta Field to create a new meta field.

Commerce Manager Settings

EPISERVER COMMERCE Meta Fields

Welcome ™ Change Language About ™ @ Get Help For This Page
Administration = ‘ ¥ New Meta F\e\d‘
= Administration D Name Type Multi-Language  Compare Search  History  Friendly Name
=[] System Settings 167 DisplayName ShortString True True True False Display Name
=3 caralog System 168 Primarylmage ImageFile False False  False  False  Primary Image
B Warehouses 169 Description LongHtmiString  True False  True False  Description
B Tax Categories 170 Region ShortString True True True True Region
B Meta Classes 171 ExtendedDesription LongHtmiString  True False  True False  Extended Desription
B Meta Fields 172 Type ShertString True True True True Typ=
@ Order System 173 Margin Decimal False True False  True Margin Percentage
174 RecommendEoost Integer False False  False  True Recommendstion Boost
175 Color ShortString True True True True Color
176 Style ShortString True True True True Style
4177 Closure ShortString True True True True Closure
@ R 178 Varieties ShortString True True True True Grape mix
179 ABV Decimal False True True True Alcohal
m Customer Managemeant 180 Taste ShortString False True True True Taste
|2 181 Vegetarians Boolean False True False  True Vegetarians
il Catalog Management 182 Vegans Boolean False True False True Vegans
‘g Order Management 183 Vintage ShortString True True True True Vintage
184 Size Float False True True True Size
E Marketing 185 Maturity ShertString True True True True Maturity
zﬂ Asset Management
: Reporting
@ B Page Size: 20 ~ (19 items) | Page 11"

3. The Meta Field Edit page appears. There is a wide variety of parameters you can set for the meta field
depending on the type you select.
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ERCE Meta Field Edit

Mame :
Friendly Name ; Maturity
Maturity -
Description ;
Type :
Suppor‘ts Multiple Languages
Use in comparing
[¥] save History
|:| Use Encryption
Search Properties: Allow Search
[V] stare the value
Indexing Option: Tokenized hd
| OK || Cancel |
Field Description
Name Enter a system name without spaces or special characters (e.g. "NumberMegapixels," without the quotes).
Friendly Enter a user-friendly name seen by end-users on the back and front-end (e.g. "Number of Megapixels," with-
Name out the quotes).

Description  Enter any additional information about the meta field.

Type The drop-down menu shows the field types you can use for the meta field. The types available are:
- datetime
- decimal
- float
- money
- Integer
- Boolean
- Date
- Email
- URL
- Short String
- Long String
- Long Html String
- String Dictionary
- File

- Image File

- Dictionary
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Search Depending on the data field type selected, you may have the option to set the search properties of the data
Properties  fio|q. The options are:

- Allow search (Determines whether the field is searchable after a search query) .

- Store the value (Specifies whether the actual value of the field needs to be stored in the search index or it
can be discarded after itis indexed) .

- Indexing option (tokenized or non-tokenized) .

Adding Meta Field to a Catalog Meta Class
1. Go to Administration > Catalog System > Meta Classes or Administration > Order System >
Meta Classes.

2. The meta field you created will appear in the list of meta fields. Select a meta class, checkmark the
meta field you want to add to the meta class, and then click OK.

Business Foundation

Business Foundation is where you define and customize many of the settings used in EPiServer Com-
merce. The meta data engine and data model makes it possible to create meta objects, add customized
fields and define relations between objects. The form is fully customizable so you can control the layout
and specify which fields you want to display.

Customizing Existing Business Objects

Out of the box, Commerce Manager includes Business Objects that can edited and customized. Cus-
tomizing existing business objects is a good starting point for end users to model business objects for
their needs. However, pre-existing business objects such as "Address" and "Organization" cannot be
deleted, only edited.

O The current implementation of Business Foundation only supports the Customer and Asset
Management subsystems. Support for other subsystems such as Order and Catalog are
planned for future releases.

Fields in Business Foundation

This section covers how to add or edit different types of data fields within an existing business object.
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Adding Fields to Business Objects

Existing Business Foundation Objects can be customized to have additional data entry fields. For exam-
ple, you can add fields to the New Credit Card form built-in to Commerce Manager.

To add new fields to a Business Object, click on Administration, expand System Settings, and click on
Business Foundation to access the list of Business Foundation Objects.

Administration e

:IE Administration
=] System Settings
4[] Dictionaries
=[] Logs
B Common 5ettings

Business Foundation
Workflow

Search Index
Left Menu

=[] Catalog System
=[] Order System

HE @B | &

In this example, the CreditCard Business Object is used.

e, admin

ERCE Configuration _ duct version: 5.2 (build. 377)

ECF G5 Deployment (EpiServer)

e
@ Get Help For This Page +

DCrEatE Mew ﬁExDurb’ImDurtv
Show: Al -

System Name Friendly Name Plural Name Type
4% Address Address Address Info
4% Contact Contact Contact Info
3 CrediCard Credit Card CreditCard Info
43 Customizationitem Customization Item Customization ltems Info
-33 CustomizationltemArgument Customization ltem Argument Customization ltem Arguments Info
33 CustomPage Custom Page Custom Pages Info
53 Folder Folder Folder Info
43 FolderElement FolderElement FolderElement Info
“13 GiftCard Gift Card Gift Cards Info =
8 ImageFolderElement ImageFolderElement ImageFolderElement Card
jg Organization Organization Organization Info
&l PdfFolderElement PdfFolderElement PdfFolderElement Card
-ngecentReferenceHistory User Recent Reference User Recent References Info

Click on the business object in the list to open it for editing. To add a new field to the CreditCard Busi-
ness Object (or any other Business Object), click on New Field.
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Busi Object C izati = New Field | =/ Edit 22l publish | £ Back To List
System Name: 33 CreditCard Friendly Name: U Credit Card
Type: Business Object Plural Name: CreditCard
| Fields || 1:M Relations || MN:1 Relations || MN:N Relations || Forms H System Views |
System Name Friendly Name Type
3\; Address Address Text (ReferencedField)
== Addressid Address Reference
4 CardType Type CreditCardType
jv Contact Contact Text (ReferencedField)
# Contactld Contact Reference
5 Created Created DateTime
& Creatorld Creator Cuid
4" CreditCardid Id Cuid
2% CreditCardNumber Card Number Text
av ExpirationMonth Expiration Month Integer
av ExpirationYear Expiration Year Integer
av LastFourDigits Last Four Digits Text
av Modified Modified DateTime
av Modifierld Modifier Cuid
jv Organization Organization Text (ReferencedField)
e Organizationld Organization Reference
aY SecurityCode Security Code Text

The New Field form allows you to specify the type of data field you want created for the Business Object.

New Field B Back
Business Object: Credit Card Field Type: String
Field Name: CustomerServicePhoneNumber Format: Text E|
Friendly Name: CustoemerServicePhoneNumber @ Maximum Length: 100
Description: -

D Unique value

9] Avtow Nunis [ wsawe [ [ Xcance

Add Field To: Edit Form
View Form
Short Info Form

1. Enter a Field Name, which is the system ID or name of the field. The Field Name that is entered
autopopulates the Friendly Name field.

2. Since the Friendly Name is autopopulated based on the Field Name, you can either keep the
name the same or change it. The Friendly Name is what appears on a form (such as the Credit
Card form)

3. You can optionally enter in a Description that appears below the data entry field to explain the
field to the user.

4. Checkmark on or off to Allow Nulls for this field
5. You can choose to Add Field To an existing Form. Checkmark all that apply.

6. Enter a Field Type. For further explanation of each Field Type, refer to the Reference Section on
the bottom of this page. In this example, a String field type is used.
a. The Format drop down menu and options depend on your Field Type selection. In this exam-
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ple, Text is selected as the field format, with a Maximum Length of 100. Unique value is left
unchecked.

7. Once done, click Save. The new field appears on the list of fields.

¥ CreditCardid Id Guid
¥ CreditCardNumber Card Number Text

W CustomerServicePhoneNumber Customer Service Phone Number Text = O
av ExpirationMonth I}, Expiration Month Integer

To verify if the new field appears, check the form associated with that new field. Since this example cus-
tomized the New Credit Card form, you will see that the new field appears.

MNew Credit Card *

~— Overview

Type: Visa [=] =
Last Four Digits: Expiration Month: [ No value ] El
Card Number: Expiration Year: [Nowvalue] [+]

Security Code:

Customer Service
Phone Number:

‘ + 0K || A Cancel
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Editing Fields of Business Objects

Fields created by the user can be edited. To edit a field, click on the Edit icon.

O Fields that are locked cannot be edited.

5" CreditCardNumber Card Number Text

¥ CustomerServicePhoneNumber Customer Service Phone Number Text 3—-‘“ Y
av ExpirationMonth Expiration Month Integer
av ExpirationYear Expiration Year Integer

The only attributes that can be changed are Friendly Names and Descriptions. Once those changes are
made, click Save.

Edit Field EJ Back
Business Object: Credit Card Field Type: String
Field Name: Format: Text
Friendly Name:- Customer Service Phone Number @ Maximum Length:-
Description: Phone # found on back of card

 Save RA [ % cancel

Relations in Business Foundation

In order to track and record relevant data, business objects must be related to other objects, whether they
are "1 to many," "many to 1","many to many." Currently, business objects only affect the customer and
asset management systems.

e 1 to Many Relationship - 1 object can be associated or related with multiple object-related data.
For example, one organization can be associated with multiple contracts.

e Many to 1 Relationship - Multiple object-related data can be associated or related with a single
object. For example, multiple contacts can be related to a single organization.

e Many to Many Relationship - Multiple object-related data can be associated or related with mul-
tiple objects. For example, different SKUs can be associated with one or more Warehouses for
tracking and storage.
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Adding a | to Many Relation

Business Foundation objects allows you to specify 1 to Many Relationships. For example, if you have
one organization, you can relate many types of data to that organization, such as multiple contacts,
addresses, or organizational units or divisions within an organization. Within a 1:N relationship, the busi-
ness object you selected will be "1."

In the example below, 1 = Organization and N = related objects such as Address, Contact, CreditCard,

etc.

To add a 1 to many relationship to a business object, you will need to create a new business object or
use an existing one. On the Business Object Customization page, click on 1:N Relations.

- . ne, Manager
ERCE Configuration fersion: 5.1 (buil

5 C5 Deployment (EpiServ|
& Get Help For This Page °

B: Object C izati = New Field Edit _;ﬂJJ Publish | £ Back To List
System Name: 33 CreditCard Friendly Name: Credit Card
Type: Business Object Plural Name: CreditCard
| Fields || 1:N Relatiorwg.L || N:1 Relations || N:N Relations H Forms H System Views
System MName Friendly Name Type
:y Address Address Text (ReferencedField)
&7 Addressid Address Reference
&% CardType Type CreditCardType
:,v Contact Contact Text (ReferencedField)
@2 Contactld Contact Reference
@¥ Created Created DateTime

Click on New Relation "one to many" to create a new relation.

Object C izati 5 New Field Edit | 2 Publish | [ Back To List
System Name: gg Organization Friendly Name: Organization
Type: Business Object Plural Name:- Organization
‘ Fields || 1:N i H MN:1 Relations || N:N Relations || Forms || System Views

E MNew Rglation “one to many”|
MName Primary Object Related Object %

iz Address Organization Address =
=8 Contact Organization Contact
g CreditCard Organization Credit Card
gk Organization Qrganization Organization =

Under General Info, the Primary Object Organization is automatically set to Organization.

Select a Related Object to relate an the Organization object in the dropdown.

The Object section below General Info will have a different title based on Related Object you
selected. For example, if you selected "Address," the title would be "Object 'Address™.

Enter in a Field Name and Friendly Name. They are autopopulated already using the system
name of the business object.

Both names must be unique and not be the same as an existing field. The Field Name cannot con-
tact spaces or special characters, only letters, numbers, and underscores.

Checkmark the box Allow Nulls if you do not want this to be a required field the user fill in while
editing a form. Otherwise, uncheck the box to make it a required field.

Under Add Field To, checkmark the Forms you want the field to render in, such as the Edit Form
(to enter and submit information) or View Form (read information only).
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6. Under the Object "Name of Primary Object" section, select a Display region in the dropdown box.
Additional options such as Display Text and Display Order will appear based on your dropdown
menu selection.

7. Once all the relevant information is entered, click on Save.

Relation 1:N

— General Info

Primary Object: Organization

Related Object: Address El

~— Object "Address”

Field Name: Organization
Friendly Name: Organization

Allow Nulls
Add Field To: Edit Form

View Form
Short Info Form

~— Object "Orgamnization™

Display Region: [ Not Set ] El

| + Save | | ¥ Cancel

O The Related Object will have the Primary Object appear under the opposite relationship (N:1)
on its configuration form. For instance, if organization is the Primary Object and the Related
Object is Address, the relationship is automatically generated under the N:1 tab in Address.

Configuration 5.2 (build
ECF G5 Deployment (EpiServer)

@ Get Help For This Page %

Business Object Customization 43 New Field | &= Edit | 23 Publish | £ Back To List|
System Name: 4z Address Friendly Name: Address

Type: Business Object Plural Name: Address
[ Fietds ][ 1:NRelations || n:l Relations || N-NRefations |[ Forms || system Views

"5 New Relation "ane to many’

Name Primary Object Related Object

. Contact Address Contact =
s =
i Contact Address Contact =
i@ CreditCard Address Credit Card E
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Adding a Many to | Relation

You can relate business objects via a Many to 1 Relationship. For example, you can relate multiple con-
tacts to a single organization or unit.

In the example below, N = Organization and 1 = related objects such as Parentld, PrimaryContactld etc.

To create Many to 1 relationships, click on a business object and click on the N:1 Relations tab.

ERCE

Configuration

Welcome, Manager
ersion: 5.1 (build: 24)

License: ECF G5 Deployment (EpiServer)
18 Get Help For This Page

Object C

= New Field | = Edit | 23 Publish | [£ Back To List

System Name:

Type:

4% Organization

Business Object

Friendly Name:

Plural Name-

|Field5 || 1:M Relations H N:1 Relations || N:N Relations || Forms || System Views

Organization

Organization

System Name

5" Created

#"¥ Creatorld

5" BusinessCategory

Friendly Name
Business Category
Created

Creator

Type
BusinessCategory
DateTime

Cuid

Click on New Relation "Many to one" to create a new relationship.

Busi Object C = New Field Edit | 22y Publish | [£3 Back To List|
System Name: ;3 Organization Friendly Name: Organization

Type: Business Object Plural Name: Organization
| Fields H 1:M Relations || N:1 || N:N Relations || Forms || System Views

;El Mew Relation “many to one”
System Name Name Primary Object Related Object @
;-p Parentld Parent Organization Organization =
e PrimaryContactld Primary Contact Contact Organization

The Relation N:1 form is very similar to the Relation 1:N form, except you can select the Primary Object
from the dropdown, whereas the Related Object defaults to the name of the Business Object.

Under General Info, the Primary Object Organization is automatically set to Organization.

1. Selecta Primary Object to relate an the Organization object in the dropdown.The Object section
below General Info will have a different title based on the Related Object name.

2. Enterin a Field Name and Friendly Name. They are autopopulated already using the system
name of the business object.
Both names must be unique and not be the same as an existing field. The Field Name cannot con-
tact spaces or special characters, only letters, numbers, and underscores.

3. Checkmark the box Allow Nulls if you do not want this to be a required field the user fill in while
editing a form. Otherwise, uncheck the box to make it a required field.

4. Under Add Field To, checkmark the Forms you want the field to render in, such as the Edit Form
(to enter and submit information) or View Form (read information only).

5. Under the Object "Name of Primary Object" section, select a Display region in the dropdown box.
Additional options such as Display Text and Display Order will appear based on your dropdown
menu selection.

6. Once all the relevant information is entered, click on Save.
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Relation MN:1

~— General Info

Primary Object: Address El

Related Object: Organization

— Object "Organization”

Field Name: Address

Friendly Name: Address
Allaw Nulls

Add Field To: Edit Farm

View Form
Short Info Form
System View (All arganizations)

— Object "Address”

Display Region: [ Mot Set ] E|

| " Save | | ¥ Cancel

Like an 1:N relationship, if you create a N:1 relationship with a Primary and Related Object, a
1:N relationship is automatically generated for the Primary Object under the 1:N tab.

© EPiServer AB



176 | User Guide for EPiServer Commerce 1 R2 SP2

Adding a Many to Many Relation

You can also create Many to Many Relationships with business objects. For example, many to many rela-
tionships help to track different SKUs and their inventory levels with different warehouse locations.
Another example is multiple contacts a part of multiple organizations. A Many to Many relationship
between two objects is also referred to as a Bridge.

In the example both Organization and Organization_Contact = N.

To create a Many to Many relationship, click on a business object and then click on the N:N Relations
tab.

Welcome, Manager

CDI"Iﬁg uration ersion: 5.1 (build: 24)
License: ECF G5 Deployment (EpiServer)

@ cer Help For This Page ‘?

Object C izati =) New Field Edit | 23l Publish | £ Back To List

System Name- 53 Organization Friendly Name: Organization
Type: Business Object Plural Name: Organization
‘ Fields H 1:N Relations || N:1 Relations || MN:N Relatinnsnh” Forms H System Views

System Name Frie ﬂ\‘en-‘l Name Type
2" BusinessCategory Business Categary BusinessCategory
¥ Created Created DateTime
&Y Creatorld Creator Guid
2" Description Description LongText
57 Modified Maodified DateTime

Click on New Relation "many to many" to create a new N:N relationship.

Busi Object C izati = New Field Edit | £ Publish | [£] Back To List
System Name: ;3 Organization Friendly Name: Organization
Type: Business Object Plural Name: Organization
Fields H 1:N Relations || N:1 Relations H N:N Relations || Forms || System Views
E New Relation "ﬁlnaﬂytu many”;

The Relation N:N is much different compared to the Relation 1:N/N:1 forms.

1. The Current Object defaults to the name of the Business Object you are editing
2. Select a Related Object from the dropdown menu

3. The Relation Name is autopopulated by (Current Object Name_Related Object Name). Change
this name if you wish, but you cannot have spaces or special characters, only letters, numbers,
and underscores.

4. Enterin a Friendly Name, which can have special characters and spaces. Make sure both Rela-
tion and Friendly Names are unique do not already exist.

5. Under Current Object, select a Display Region where the field will appear.

6. Under Related Object, select a Display Region where the field will appear.

Once all the relevant information is entered, click on Save.
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Relation N:M

Ceneral Info

Current Object: SKUs

Related Object: SKU_Warehouse El
Relation Name: SKUs_Warehouse

Friendly Name: SkKUsS5KU= Warehouses

Current Object (SKUs)

Display Region: Information El
Display Text: SkUs Warehouses
Display Order: 10000

Related Object (SKU_Warehouse)

Display Region: Information El
Display Text: SKU=s
Display Order: 10000

| " Save | | ¥ Cancel |

O A many to many relationship is automatically generated for the related object when you click
on its N:N tab under its configuration form.

Forms in Business Foundation

Forms dictate how fields are presented to the user when view and editing information. This section
explains how you can customize forms for viewing and editing by end users.
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Customizing an Existing Form

Every field is associated with a Form, and each Business Object is associated with one or more types of
forms. The common types of forms found in Commerce Manager are the Edit Forms, Short Info Forms,

and View Forms. For example, the New Credit Card form looks like this:

New Credit Card

— Overview
Type: Visa [=] 5

Last Four Digits: Expiration Month: [ No value ]
Card Number: Expiration Year: [ No value ]

Security Code:

Customer Service
Phone Number:

=
=]

| n 0K | | ﬂ Cancel

By editing the form, you can change the layout, add new fields and sections, and more.

To edit an existing form, click on a Business Object and click on the Forms tab to see the list of asso-

ciated forms.

Busi Object C izati = New Field | =/ Edit | 22 Publish | [ Back To List
System Name: _;3 CreditCard Friendly Name: Credit Card
Type: Business Object Plural Name:- CreditCard

Fields || 1:N Relations H N:1 Relations H N:N Relations H Faorms || System Views

Name

Edit Form

Short Info Form

View Form

Click on the Edit icon next to the form you want to make changes to. The form customization window pops

up.

Common Tasks = Rereate Form

Table: Credit Card Form: Edit Form

feditForm | [save +

Addv | ft 4 4@ o | @fEdt | XK Remove

Overview
Type:
Last Four Digits. Expiration Month
Card Number: Expiration Year:
Security Code

Customer Service
Phone Number:

There are various functions available to edit and customize a form.

Editing the Layout of a Form

You can change the layout and the fields that appear on the form.
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1. Click on Edit Form.
a. Select a View Type (or the layout of the form). You have a choice between a Two Column (1:1,
1:2,2:1), or Three Column (1:1:1) layout.
b. Enter in a pixel value for the Cell Padding, or spaces between each cell.

2. Click Save to confirm your changes.

This example uses a Two Column (1:1) layout.

EOTEE ’i:ElRecreahe Form dit Form) nSave -
, e
I7- salagl = 1 =
Table: Credit Card & eCommerceFramework - Windows Intern... l e 3

Add = + ¥ & =2 E|§‘ http:--ch.episerver.(om-;ppz-l'.leteDeteBeze-l'.lete'JI-Pegez-| |

- Edit Form
— Owerview

‘You can edit form.
Type:
Last Four Digits: Table: Credit Card
Card Number:

Form: Edit Form
Security Code:
Customer Service View Type:
Phone Number:

° Two Columns (1:1)

) Two Columns (1:2)

) Two Columns (2:1)

(©) Three Columns (1:1:1)

Cell Padding: 5

Save Cancel

@ Internet | Protected Mode: On dy v H100% ~

Adding Sections and Fields

Once your layout is set, you can add additional sections and/or additional fields.
1. Click on Add --> Add Section to add a new section. Adding sections allows you to separate and
divide groups of fields on a form with their own header and border.
2. Enterin a Title for the section.

3. Checkmark the box next to "Show border line for this section" if you want to show the border
around section. Otherwise, uncheck the box to hide the border.

4. Checkmark "Show the name of this section on the form" if you want to show the title of the section
on the form. Otherwise, uncheck the box to hide the title.

5. Selecta View Type or layout of the section: One Column, Two Columns (1:1), Two Columns (1:2),
Two Columns (2:1)

6. Enter a numeric pixel value for Cell Padding or amount of space between each cell in the section.

7. Click Save to save your changes.
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Common Tasks Recreate Form | [z&Edit Form Hsave ~
[ i o)
& eCommerceFramework - Windows Intern... .= | = )

Table: Credit Card

Add * 4+ 4 & = | FEdt | XRem |g, http://ecf.episerver.com/Apps/MetaDataBase/MetaUl/Pages;
=K 3

Add Section G
¥ Add Field S Add a new section to the form.

Last Four Digits: Title: Credit Card 2|

Card Number:

Security Code: Show border line for this section.

Customer Service
Phone Number:

Show the name of this section on the form.

View Type: | EESSSSSssssssssssssssnag

@ One Column = =| I | SEEEEEEECEELEEEELLEEE :

) Two Columns (1:1) |

©) Two Columns (1:2) _'

) Two Columns (2:1

Cell Padding: o

Save Cancel
0 Internet | Protected Mode: On v H100% v

You can edit a section by clicking on a section and click on Edit.

Common Tasks 5 Recreate Form [ZpEdit Form Hsave -
Table: Credit Card Form: Edit Form

Add + 3 & = @w ¥ Remove |

Type:
Last Four Digits: Expiration Month:
Card Number: Expiration Year:

Security Code:

Customer Service
Phone Number:

( Credit Card 2

Within each section are fields. You can add new fields to a specific section by highlighting the section and
then by clicking Add --> Edit.
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Table: Credit Card

Form: Edit Form

E Recreate Form

Customizing an Existing Form | 181

ZépEdit Form Hsave ~

E2| Add Section

4+ ¥ 4« = | =fedt | X Remove

| @ Add Field &l

Last Four Digits

Card Number:
Security Code:

Customer Service
Phone Number:

Expiration Month:

Expiration Year:

Credit Card 2

(Last Four Digits

Select an existing associated field in the dropdown menu.
a. Checkmark the "Field is Read Only" box if you want the field to be unavailable for edit. When you see
the rendered form, the field will be grayed out.

1. Selectthe "ltem label showing on the form."

2. e Hide Label: No label appears next to the text box

e System Label: Shows the system name next text box

e Custom Label: Enter in a custom label

3. Enterin a Label Width numerical value. Defaultis 120px.

4. Tab Index: enter an index for the tab.

5. Selecta View Type, either a One Column or Two Column. In the dropdown, enter in the number of

text box rows, up to 3.

6. Click Save to add the field to the section.
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Common Tasks ‘= Recreate Form [FéfEdit Form Hsave
g
Table: Credit Card & eCommerceFramework - Windows Intern... Elilg
Add * 4+ 4 4= = | @2Eedt | XRem | £ | http://ecf.episerver.com/Apps/MetaDataBase/MetalUl/Pages/ |
| [~ Overview Add Field
| Add a new form item to the form.
Type:
Last Four Digits: Field:  Organization -
Cardtumber: [ Field Is Read Only
Security Code:
E Customer Service Eem label showing on the form.
i | Phone Number: ) Hide Label
E -3 @ system Label -
! ( Credit Card 2 (Z) Custom Label l
Label width: 120 px T
Tab Index: o sirzzzzszzzszzzizaaiss
e | g
View Type:

@ One Column | == ——

@ Two Column |

Rows: 1 -

Save | Cancel

0 Internet | Protected Mode: On dh v W10% -

To edit a field, click and highlight the field and click on Edit to change your previous settings.

Common Tasks ‘5 Recreate Form [#pEdit Form EHsave ~

Table: Credit Card Form: Edit Form

Type:
Last Four Digits: Expiration Month:
Card Number: Expiration Year:

Security Code:

Customer Service
Phone Number:

1 Credit Card 2
: (Drganization:

You can re-arrange fields on a form but using the arrow controls on menu bar. Highlight the field and then
click on the directional arrow you want the field to move to.
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Table: Credit Card Form: Edit Form

’E Recreate Form
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[Z&Edit Form Hsave ~

Add ~ 4 4 &= = | @edit | ¥ Remove

Type:

Last Four Digits: Expiration Month:
Card Number: Expiration Year:
Security Codp:

Customer Service
Phone Number:

|~ Credit Card 2
i (Organizat\on:

In this example, the "Security Code" field is moved to the right where the "Customer Service Phone
Number" field is placed by clicking on the right directional arrow. Fields are moved from cell to cell within

a section.

Common Tasks

Table: Credit Card Form: Edit Form

’i?_§| Recreate Form

[ZEdit Form Hsave ~

Add~ | ¢ 4 = = Edit | % Remove

Type:
Last Four Digits:
Card Number: Expiration Year:

Security Code:

Customer Service
Phone Number:

Expiration Month:

|~ Credit Card 2
i (Organizat\on:

Deleting Sections and Fields

To delete a section or field, highlight either one and click on Remove. A popup will appear. Click OK to

confirm deletion. Otherwise, click Cancel.

Common Tasks

Table:- Credit Card Form:- Edit Form

’i% Recreate Form

[#fEdit Form Esave ~

Type:

Last Four Digits:
Card Number: Expiration Year:
Security Code:

Customer 5ervice
Phone Number:

Expiration Month:

' |~ Credit Card 2
i (Drganiza:ion:
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i -
Meszage from webpage L&J

I Do you really want to delete selected section?

[ ok || Concel

Recreating a Form

Recreating a form allows a user to create a form from scratch with a single field rather than customize a
form with all fields already in place. Click on Recreate Form on the upper right corner of the window.

Common Tasks = Recreate Form pEdit Form Hsave +

Table: Credit Card Form: Edit Form

add~ | 4 4 & = | SEdt | ¥ Remove ‘

Overview
Type
Last Four Digits: Expiration Month
Card Number: Expiration Year:
Security Code

Customer Service
Phone Number:

A popup will appear. Click on OK to recreate the form. Otherwise, click Cancel. Once you confirm, the
fields will clear from the form except for the required field.

Common Tasks ‘EIRecreate Form [#pEdit Form Hsave ~

Table: Credit Card Form: Edit Form

Adv | ¢ § & = | Fedt X Remove ‘

Credit Card
Card Number: w
( [

Saving a Customized Form

Once you are done with your changes, click on Save on the upper right corner of the window. To save
and close the window at the same time, click the down-arrow next on the Save button and on the drop-

down click Save and close.
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*5 Recreate Form

Table: Credit Card Form: Edit Form
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pedit Form | ([ save I v

Overview

Add ~ 4+ 3 & = | =Edt | X Remove

EI Save and cloze

_—

Type:

Last Four Digits:
Card Number:
Security Code:

Customer 5ervice
Phone Number:

Expiration Month:

Expiration Year:

Once those changes are saved, the form you edited will render based on your configuration. For exam-
ple, here is the customized Credit Card edit form an end user sees.

New Credit Card

— Owerview

Type:

Last Four Digits:

Card Number:

Customer Service
Phane Number:

Wisa [=] ff‘l
Expiration Manth: [ Mo wvalue ]

Expiration Year: [ Mo walue ]

Security Code:

[ [

~— Credit Card 2

Organization:

{Customer.CreditCard_mf Qrganization_Description)

Creating a New Business Object

Creating new business objects allows users to extend customer and asset forms for tracking and relating
different types of data. Business Objects can be related in a "one to many," "many to one," or "many to
many" relationship. Find out more about this in the Relations in Business Foundation section.

This section covers an example of how to create and publish a contract business object using a "many to
one" relationship. In the following steps you will learn how to create and publish a simple contract busi-
ness object for relating multiple contracts to a single organization:

e Creating a new contract object

e Connecting the contract to an organization

e Publishing the contract

Creating a New Contract Object

New Business Objects can be created to suits a multitude of business purposes. This example shows you
how to create a Contract business object.

To add new fields to Business Object, click on Administration, expand System Settings, and click on
Business Foundation to access the Business Foundation Configuration page.
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r@‘

:IE Administration
=143 System Settings
4[] Dictionaries
=[] Logs

B Common Settings

Business Foundation

Waorkflow
Search Index
Left Menu
] Catalog System
= ] Order System

B B @ &

Click on Create New and on the dropdown click on New Business Object. The New Business Object
form page appears. Enter all relevant information.

Configuration

ion: 5.2 (build.
G5 Deployment (EpiServer)

wt T

@ et Help For This Page %

New Business Object

Back To L\st|

Base Info

System Name: Contract

Friendly Name: Contract Name
Plural Name: Contract

D Supports Extensions

Field Info
System Name: Contract

Friendly Name: Contract Name

Maximum Length: 100

Base Info

+ Save |

# Cancel

e System Name: name of the Business Object (once you input a name, the Friendly Name and Plu-
ral Name fields are autopopulated)

e Friendly Name: alternative to the System Name

e Plural Name: plural version of the system/friendly name (e.g. inventories)

e Supports Extensions: this allows you to extend an existing meta class with extra properties. For
example, you can have a download class and you can extend it with "imagedownload" which con-
tains width and height as extra parameters.

Field Info

o System Name: enter in a system name

e Friendly Name: enter in a friendly, front-end name

¢ Maximum Length: maximum number of characters allowed in this field

Click Save to save changes.

Object C

5 New Field | &= Edit | 23 Publish | [£] Back Ta List

System Name: v?[g Contract

Friendly Name:

Contract Name

Contract

2" Contractld

Type: Business Object (Public) Plural Name:
| Fields || 1:N Relations || MN:1 Relations || M:N Relations || Forms || System Views
System Name Friendly Name Type
¥ Contract Contract Name Text
Id Cuid
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Add fields to the Contract business object as needed. Refer to Adding New Fields to Business Object
section for instructions on how to add new fields to a business object.

Click Save to save changes.

Connecting a Contract to an Organization

The next step is to create a relationship between this contract with an organization. In this example, the
"Many to one" relationship will be used because multiple contracts can be tied to a single organization.

1. To add a relationship, click on the N:1 tab and click New Relation "Many to one" .

Welcome, Manager
Product Version: 5.1 (build: 24)
License: ECF C5 Deployment (EpiServer)

v & Get Help For This Page %

Configuration

Business Object Customization E MNew Field Edit E;ﬂJJ Publish ﬂ Back To List

System Name: “I§ Contract Friendly Name: Contract Name

Type: Business Object (Public) Plural Name: Contract
| Fields || 1:M Relations || N:1 Relationsn || MN:N Relations || Forms || System Views
I
System Name Friendly Name Type
&" Contract Contract Name Text
2" Contractld Id Guid

2. On the Relation N:1 form, select the primary object as "Organization." The Related Object will be the
Contract object (the friendly name appears as opposed to the system name)

3. Enter a Field Name, such as "Organization."

4. Enter a Friendly Name that will render next to the field in a user view.

Checkmark the box next to Allow Nulls if you want the user to be able to submit the form without having to
enter any data into the field. Otherwise, an unchecking this box means that this becomes a required field
that the user must enter data in.

5. Checkmark the boxes you want the field to render in, such as the Edit Form, View Form, and Short Info
Form.

O To learn more about forms, go to Customizing an Existing Form.

6. Lastly, set the Display Region using the dropdown menu. The display region determines which section
the field will appear within the business object--in this case, the Organization object. Note: Depending on
your selection, you may have additional options below the dropdown menu, such as Display Text and
Display Order. An example is below.

7. Click Save to save your changes and go back to the Business Object Customization form.
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Relation N:1

Ceneral Info

Primary Object: Organization El

Related Object: Contract Name

Object "Contract Name”™

Field Name: Organization
Friendly Name: COrganization

Allow Nulls
Add Field To: Edit Eorm

View Form
Short Infa Form
System View (Ceneral View)

Object "Organization”

Display Region: Information E|
Display Text: Contract
Display Order: 10000

| " Save | | ¥ Cancel |

Now that the Organization business object is tied to Contract, you will see that Contract now appears
under the Information section or the Organization Info view page.

ERCE Organization Info

Edit Organizations

Name: EPiServer Parent:
Information Contract |
Information %’Add Items EExcludesaected
Contacts
Organizations ] Contract Name
Addresses [l
Credit Cards
| Contract I |
L

O Since this example ties many contracts to a single organization, the organization business
object is automatically related to the contracts object as a "1:N" relationship.
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Busi Object C izati = New Field | = Edit | 2 Publish | [ Back To List
System Name: 33 Organization Friendly Name: Organization

Type: Business Object Plural Name: Organization
| Fields || 1:N Relations || N:1 Relations || N:N Relations || Forms || System Views |

)El Mew Relation "one to many™|

Name Primary Object Related Object
[ Address Organization Address
[ Contact Organization Contact
O+ Contract Organization Contract Name = X
[ CreditCard Organization Credit Card
=8 Organization Organization Organization =

Publishing a Contract

Another feature of Business Foundation is the ability to publish objects within the left navigation frame as
a node. You can essentially add more functionality to a specific system without modifying code.

Now that the Contract object has been created and related to another object, you can publish itas a
node.

To publish a business object, click on Publish under the Business Object Customization form.

Configuration

v & Get Help For This Page %
Busi Object Cu: ization E New Field | Edit | EﬂJJ Puhlisrg | Back To List
System Name: v?[g Contract Friendly Name: Contract Naﬂ\ll
Type: Business Object (Public) Plural Name: Contract
| Fields || 1:M Relations || MN:1 Relations || M:N Relations || Forms || System Views
System Name Friendly Name Type
4" Contract Contract Name Text
4* Contractld Id Cuid
:;v Organization Organization Text (ReferencedField)
<3 Organizationld Organization Reference = X

A new window will pop up for publication settings.

@a} Dashboard 0 Display Region: < nothing is selected =
ﬂm Customer Management 40
@™ Catalog Management 50 Display Text: Contract
i‘H Order Management 30 Display Order: 10000
= ™™ Marketing 100

__1 Asset Management 120 Client Script: CSManagementClient.ChangeBafView('Contract’, 'Lis|
@3 Reporting 130 Access . . —

. . e businessfoundation:contractlistpermission
@/ Administration 200 Permissions:
Item Icon:

+ Publish
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1. Select a Display Region from the navigation three on the left. Click on the node you want Contract
to be placed under. For example, Contract will be placed on the root level of Customer Man-
agement.

2. The Display Text defaults to the system name of the Business Object. You can choose to keep the
name or change it.

3. The Display Order defaults to 10000. You can keep it at that number or change the value to deter-
mine the position of the node.

4. The Client Script is autopopulated and can be left as is for most users. However, you can change
Client Script if necessary.

5. Access Permissions is autopopulated and can also be left as is. If you want to change Access
Permissions, refer to the Permissions section.

6. An ltem Icon can be uploaded to represent the node. Click Browse to upload an icon.
7. Once all relevantinformation is entered, click on Publish.

To verify if the object was published, go to the Display Region where you specified the object to be pub-
lished to. Click on the refresh icon on the left navigation frame if you at first do not see the new node.

O Always refresh your browser after publishing a business object.

i

I~

Customer Management

@] Organizations
1:3 Contacts
&2 Roles

=@ Contract

W

Adding Contracts to an Organization

Now that the contract business object has been published, you can add multiple contracts to a single
organization using a form. Click on the Contract node to bring up the list of contracts. Click on New to add
a new contract.

. Welcome, Store Manager
EPISERVER COMMERCE List Version:5.1 (oulld: 24
License: ECF G5 Deployment (EpiServer)

Welcome ™ Change Language About ) CetHelp For This Page +

Customer Management =] S view | CeneralView =

4] Organizations (SJ Printer Version | % Delete

"5 Contacts

';E ] % contract Name

& Roles

@ Contract &

Enter a Contract Name (friendly name of the contract object) and select an Organization from the drop-
down menu to associate the contract with. This functionality is in harmony with the "N:1" relationship
between contract and organization.
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Welcome, Store Manager

E RC E Create Pro ion: 5.1 (build: 24)

License: ECF C5 Deployment (EpiServer)
v & Get Help For This Page %

Contract Name

Contract Name: HP Servers

Organization: |Epi55r\rer |V|

Click OK to save the contract. The View Form appears.

O To learn how to edit forms, go to the Customizing and Existing Form section.

Welcome, Store Manager

View Pra ion: 5.1 (build: 24)
License: ECF C5 Deployment (EpiServer)
v € Cet Help For This Page %
= Edit | ¥ Delete Back to list
Contract Name: HP Servers
Organization: EPiServer
Infor i Details
Details Contract Name
Contract Name: HP Servers
Organization: EPiServer

You can make further edits to the details of the Contract by clicking Edit or delete the entry. Otherwise,
click on Back to list to go back to the list of contracts.

By going to the Organization Info page for the particular organization you assigned multiple contracts to,
you will see the list contracts you assigned.

O You may need to make sure the Display Region is set for the related object (i.e. organization)
or else you will not see the business object in the Edit Form.

Organization Info 5.1 (build
Deployment (

B @ Get Help For This Page %

Edit Organizations

Name: EFiServer Parent:
Information Contract |
Information %’Add Iterms EExcludesaected
Contacts
Organizations D Contract Name
Addresses B (_.l HP Servers
Credit Cards {b
| Contract |

Publishing Business Objects

A user-created business object can be published as a node anywhere in the left navigation frame to
extend functionality under that particular subsystem. Before publishing you can set the proper access per-
missions for the business object, controlling which user groups will have access to use the business

object.
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O You must refresh your browser after a business object has been published.

Setting Permissions and Publishing

When publishing Business Objects to place on a node on the left Navigation Frame, you can set per-
missions before publishing.

Click on Publish on the Business Object Customization page.

Welcome, Store Manager

Configuration _ ersion: 5.1 (build: 24)

€ Get Help For This Page A?

Business Object Customization ’El New Field Edit EﬂJJ PL.|inq-rr|h ﬂ Back To List
System Name: “1% Contract Friendly Name: Contract N}rﬁle
Type: Business Object (Public) Plural Name: Contract
| Fields || 1:M Relations || MN:1 Relations || MN:M Relations || Forms || Systemn Views
System Name Friendly Name Type
2" Contract Contract Name Text
2" Contractld Id Cuid
jv COrganization Organization Text (ReferencedField)
<3 Organizationld Organization Reference = X

You can set permissions by customizing Access Permissions. This string is auto-generated. To
change, you can copy and paste string values from other objects.

@ g} Dashboard 0 Display Region: <« nothing is selected =
ﬂﬁ Customer Management 40
@™ Catalog Management 60 Display Text: Contract
ﬂg Order Management 80 Display Order: 10000
® ™ Marketing 100
1 Asset Management 120 Client Script: CSManagementClient.ChangeBafView('Contract’, 'Lis|
ﬂlﬂl Reporting 130 Access - i issi
g - . P businessfoundation:contractlist:permission
@ Administration 200 Permissions:

Item Icon: l/\\:

+" Publish

Deleting Published Business Objects

Once a business object has been published, you can delete all customized business object by going to
Administration > System Settings > Business Foundation. To remove from the Left Menu, you have to
perform an additional step of going to Administration > System Settings > Left Menu and clicking the
Delete icon.
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Commerce Manager Settings

EPISERVER COMMERCE Left Menu : F\armwm: 5.2 (build: 377)

cense: ECF G5 Deployment (EpiServer)

Welcome ¥ Change Language About ™ @ cer Help For This Page +
Administration e D Add
=] -i Administration Title Order
= System Settings = Dashboard o
] Dictionaries
- = Home 10
© (] Logs
@ Common Settings B  Customar Managemant 40
B Business Foundation = Organizations 30
B Workflow & Contacts 40
O Search Index = Roles 50
| | Left Menu
= Gift Cards 10000
(] Catalog System
= Catal M 13 &80
E Order System steleg Menagemen
= Catalog Entry Search 10
= Catalog Batch Update 20
4 Catalogs 30
= Templates 40
=
ﬁ Dashboard Order Management 80
Order Search 10
m Customer Management
= Purchase Ordars 20
—| Catalog Management Today 10
‘g Order Management = This Week 20
This Manth 30
% Marketing
All 40
;% Asset Management = Purchase Orders By Status 30
Reporting

Creating Dictionary Values

In EPiServer Commerce, Dictionary Values are used for defining languages, countries and currencies
used in the e-commerce process, as well as your own defined return reasons used in order management.
This section explains how to add Languages, Countries,Currencies and Return Reasons to EPiServer
Commerce.

Adding New Languages

By default, you are given several Language options. To add a new Language, login to Commerce Man-
ager and go to Administration --> System Settings --> Dictionaries --> Languages.

Administration =

:l_-ﬂ_]:- Administration
== System Settings
=7 Dictionaries
B Languages ﬁ‘m
R

B Countries

B Return Reasons

< Currencies

Click New Language and fill in the following:

e Language Code - to obtain code, go to this MSDN site: http:/msdn.microsoft.com/en-us/li-
brary/ms533052%28VS.85%29.aspx (you must use the codes that contain dashes "-")

e Friendly Name - this name is displayed in the front-end site language drop-down and various
Commerce Manager admin pages.

o Is Default - Yes/No
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MERCE Language Edit

L

Overview

Code: en-Us
Language code (for example, en-U5s)

Friendly Name: English

|5 Default: 1 Yes @ No

QK || Cancel

Click OK to save the language.
Adding New Countries

To add a new Country, login to Commerce Manager and go to Administration > System Settings > Dic-
tionaries > Countries.

Administration EE’

= -a_t- Administration
=2 System Settings
=<1 Dictionaries

B Languages

B Countries

B Return Reasons

ZH Currencies
Click on New Country and fill in the following displayed in the Overview tab:

e Country Name - this is the friendly name that is displayed in the public site during the checkout
process

e Code - to obtain the code, go to this MSDN site hitp./msdn.microsoft.com/en-us/li-
brary/ee799297%28CS.20%29.aspx (use the ISO Short Code or ISO Long Code as long as you
remain consistent)

e Sort Order - enter a number starting from 0 (the lower number is listed on the top of the drop-
down)

e Visible - Yes/No

== Country Edit

-

Overview Regions

Country Mame:

Code:

sort Order: 0

Visible: 1 Yes @ No
Ok || Cancel |

Regions refer to states, provinces or prefectures. In the Region tab, fill in the following:

e Type a Friendly Name (e.g. CA - this will be displayed in the public site during the checkout proc-
ess) and click Add. You can checkmark it either as Visible or not on the public site
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Overview Regions
New Region Name CA
Regions:
Edit Command Mame Qrdering Visible
| X cA 0
| Ok || Cancel |

When you click the Edit icon, you can change the Ordering of the region. Click Update to save those

changes.

Regions:
Edit Cormnmand  Mame Crdering Wisible
Update | Cancel CA o

Adding New Currencies

To add a new Currency, login to Commerce Manager and go to Administration > System Settings >

Dictionaries > Currencies.

Administration

@

:IE Administration
=5 System Settings
=41 Dictionaries
B languages
B Countries

B Return Reasans

Zd Currencies

e Logs

Click on New Currency. Fill in the following displayed in the Overview tab:

e Currency Name - this name is displayed in the front-end public site currency drop-down and var-
ious Commerce Manager admin pages

e Code - this currency code needs to be obtained from this site http./en.wikipedia.org/wiki/ISO _

4217#Active_codes

MERCE Currency Edit

L

Overview Rates

Currency Name:
Code:

Modified:

1.4 || Cancel

In the Rates tab, you can Add Rates which are the foreign exchange rate when you want to convert from

one currency to another.

Overview Rates

Add Raqb

Edit Command

| (o]4 || Cancel

Currency Rate

Rate Date Modified
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When the Edit Currency Rate Information popup appears, enter in:
e To Currency - select from the drop-down the Currency to convert to from the current currency.

e End of Date Rate - enter in the End of Day rate.

Average Rate - enter in the Average rate.

Currency Rate Date - enter in a Currency Rate Date.

Then click on Save Changes.

Edit Currency Rate Information v
To Currency: Canadian dollar IZ|

End Of Day Rate:  |0.0000

Average Rate: 0.0000

Currency Rate Date5/25/2010 m 11:25 AM

Modified: 5/25/2010 11:25:12 AM

Managing Return Reasons

Out of the box, the three return reasons in EPiServer Commerce are "Faulty," "Incorrect ltem," and
"Unwanted Gift." More return reasons can be added or customized so that when a Customer Sales Rep-
resentative (CSR) processes a return, more return reasons are available via the drop-down menu.

Administration 1%"

= -E Administration
=115 System Settings
=] Dictionaries
E Languages

B Countries

B Return Reasons

=d Currencies

Creating a New Return Reason

1. To add a new return reason, go to Administration > System Settings > Dictionaries > Return
Reasons. The Return Reasons screen appears.

2. Click New Return Reason. The Return Reason Edit screen appears.

3. Once done, click OK. The new return reason appears on the list.

T

Return Reason Enter a friendly name, such as "Changed Mind".
Sort Order The lower the value, the higher the position the return reason is on the list screen.

Visible Select Yes (to enable to return reason) or No (to disable it).
Editing and Deleting a Return Reason

e On the Return Reasons list, click on the Edit icon. Make any edits to the Return Reason name,
Sort Order, and its Visibility and then click OK to save your changes.
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e To delete an individual Return Reason, click on the Delete icon. To delete multiple return reasons
at one time, check-mark the box next to the Return Reason and then click More Actions > Delete
Selected. Confirm your selection by clicking OK.

Configuring Default Common Settings
Under Common Settings you define the settings to be used by the system for language, currency, and
length and weight units.

To set your default language, currency or unit, login to Commerce Manager and go to the Administration
--> System Settings --> Common Settings and make the appropriate selections.

Administration ]

jﬁ Administration
=i System Settings
] Dictionaries
H (] Logs
B Common Settings

Business Foundation
Workflow

Search Index

Left Menu

H ] Catalog System

® ] Order System

BE B @ &

Out of the box, you have the following options:
e Language - English, German, Spanish, French.
e Currency - US dollars, Canadian dollars, Euros, Yen, Pound sterling and many others.
e Length units - meters, feet.

e Weight units - kilograms, pounds.

ERCE Common Settings

-

Owerview

Default Language: | English (United States) [ |
Language that will be selected by default in drowdowns, eic.

Default Currency: Us dollar
Currency thar will be used is cases where currency is needed but not specified

Default Length Unit: | paat E‘
Default unit of length
Default Weight Unit: |pgyunds |Z|

Default unic of weight

QK || Cancel

Click OK to save your changes.
Indexing the Product Catalog

When you have done changes to an existing product catalog, such as adding or deleting products, you
will need to index the catalog for those changes to be reflected in the search results.

There are two types of indexing: Build and Rebuild. Use the Build option to make a quick re-indexing of
an existing catalog where you made changes to existing products. Build is faster than a rebuild because it
performs a reindexing of only the items that were changed since the last build.
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If you are using a brand new catalog or you made structural changes to your existing catalog (i.e. moving
categories around, changing a product name, etc.), then you will need to perform a Rebuild. Rebuild
takes longer because it does a complete indexing.

To build or rebuild your catalog, go to Administration > System Settings > Search Index.

EPISERVER COMMERCE Search Manager

Welcome ™ Change Language About™ @ cet Help For This Page

Administration = —
ndex

:I_-i Administration
] System Settings
® ] Dictionaries
® ] Logs
B Common Settings

Search Configuration

Default Search Provider: LuceneSearchProvider
Installed Search Providers: SolrSearchProvider; LuceneSearchProvider;
Indexers: catalog (built 2/22 /2012 4:08:01 AM);

Index Operations

B Business Foundation

® Workflow Rebuild Index Rebuild the Search Index. This operation will cause complete index rebuild

B Search Index p . " . .
Build Index Build the Search Index. This operation will build the index for items updated since last build

B Left Menu

# (] catalog System
# [ ] Order System

Select Rebuild Index or Build index. Once you perform either of these two operations, you will see the
changes or additions reflected in your search results.

If you have the Quartz service installed, then your catalog is reindexed every five minutes or whatever
time interval you decide upon. Refer to the EPiServer Commerce Developer Guide for more information
about the Quartz service.

Customizing the Left Menu

Prior to customizing your left menu, we advise you to read the section Publishing Business Objects
describing how to configure Business Objects and adding them as individual nodes in the left navigation
frame.

Adding a Left Menu Item from the Left Menu Page

To add a Left Menu item, you have two choices. You can either configure the entire menu item first within
Business Foundation or you can add an empty container by clicking the Add button and then go back to
Business Foundation to fill in the page contents (objects).
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. gl
EPISERVER COMMERCE Left Menu rsion: 5.2 (build: 377)
g| nent (EpiServer)
Welcome ¥ Change Language About™ @ cet Help For This Page =]
Administration q‘E‘ ‘D Aq,el
21 Administration S Title Order
el System Settings = Dashboard o
] Dicti i
S Ictionaries Home 10
e Logs
@ Common Settings Customer Managemant 40
B Business Foundation = Organizations 30
B Workflow Contacts 40
B Search Index = Roles s0
| Left Menu
= ¥ Gift Cards 10000
] Catalog System |
= cat M t &0
© ] Order System =stslog Managemen
= Catalog Entry Search 10
Catalog Batch Update 20
4 = Catalogs 30
= Templstes 40
ﬁ P Order Management 80
= Order Search 10
m Customer Management
Purchase Orders 20
—| Caralog Management = Today 10
‘g Order Management = This Week 20
This Month 30
IE Marketing
= All 40
;4 Asset Management = Purchase Orders By Status 30
Ei Reporting
[ 83 items) | Page412345»
m Administration Page Size: 20~ t )| Pag = ==

A new window will pop up for publication settings.

1. Selecta Display Region from the navigation three on the left. Click on the node you want Contract
to be placed under. For example, Contract will be placed on the root level of Customer Man-
agement.

2. The Display Text defaults to the system name of the Business Object. You can choose to keep the
name or change it.

3. Enterin an Item Link, an URL to a page. When the object is clicked, a new window will appear on
the right based on the given link.

4. The Display Order defaults to 10000. You can keep it at that number or change the value to deter-
mine the position of the node.

5. Access Permissions is auto-populated only when a menu is created through the Business Foun-
dation. When creating a new left menu from scratch, you may leave this field blank or otherwise
copy in permissions from other existing menus. If you want to change Access Permissions, refer to
the Permissions section.

6. An Item Icon can be uploaded to represent the node. Click Browse to upload an icon.

7. Once all relevantinformation is entered, click on Publish.
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Adding ®

ﬂﬁ} Dashboard o Display Region: Customer Management
= Customer Management A0 Display Text: Contracts
H“" Catalog Management B0
@ ¥ Order Management 20 Item Link:
=5 Marketing 100 Display Order: 10000

-_‘.I Asset Management 120

i - Access
Reportin
1‘ Iﬂ P g 130 Permissions:
@ Administration 200
Item Icon:

+ Add

To verify if the object was published, go to the Display Region where you specified the object to be pub-
lished to. Click on the Refresh icon on the left navigation frame if at first you do not see the new node.

Customer Management %
@ Organizations
EE Contacts

3;\ Roles

B Contracts

Editing, Ordering, or Deleting a Left Menu Item
To Edit a user-generated node in the left menu, click on the Notepad icon.

[jada

Title Order
= Dashboard 0 i
Home 10
= Customer Management 40
=) Organizations 30
Contacts 40
= Raolas 50
Contracts 10000
Catalog Management &0
Catalog Entry Search 10

If the left menu item was created via the Left Menu page, this popup window will appear.
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Item Icon:

Access Permissions:

100

oK |

Cancel

Editing ><
Display Text: Contracts
Item Link: http:/ /'world episerver.com/cantracts
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If the left menu item node was created using Business Foundation, this popup appears.

To change the sort order of the left menu item, adjust the numerical value in Display Order. The lower the
value, the higher the position of the item within the navigation tree relative to items with a higher Display

Order value.
Editing 4
Display Text: Contract
Client Script: CS5ManagementClient.ChangeBafView('Contract’, 'Lis

Display Order:

Item Icon:

Access Permissions:

10000

businessfoundation.contractlist.permission

oK |

Cancel

To save changes, click OK.

To delete a left menu item, click on X icon.
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Commerce Manager Settings

EPISERVER COMMERCE Left Menu : F\armwm: 5.2 (build: 377)

cense: ECF G5 Deployment (EpiServer)

Welcome ¥ Change Language About ™ @ cer Help For This Page +
Administration e D Add
=] -i Administration Title Order
= System Settings = Dashboard o
] Dictionaries
- = Home 10
© (] Logs
@ Common Settings B  Customar Managemant 40
O Business Foundation = Organizations 20
B Workflow & Contacts 40
O Search Index = Roles 50
| | Left Menu
= Gift Cards 10000
(] Catalog System
= Catal M 13 &80
E Order System steleg Menagemen
= Catalog Entry Search 10
= Catalog Batch Update 20
4 Catalogs 30
= Templates 40
=
ﬁ Dashboard Order Management 80
Order Search 10
m Customer Management
= Purchase Ordars 20
—| Catalog Management Today 10
‘g Order Management = This Week 20
This Manth 30
% Marketing
All 40
;% Asset Management = Purchase Orders By Status 30

Reporting

Catalog System

Under Catalog System you can set up tax categories and warehouses, as well as catalog specific meta
fields and meta classes. Tax categories and warehouses are described in the following. For more infor-
mation on how to add meta fields and classes, refer to the section Setting up Meta Fields and Classes.

Tax Categories

Under Tax Categories you define the different tax categories for products to be used in the e-commerce
process. Refer to the Tax Configuration section for more detailed information on how to configure special
taxes such as state, local and federal taxes.

Go to Administration, Catalog System and click Tax Categories to see a list of existing tax categories.

Administration =

= ﬁ Administration
] System Settings
=149 Catalog System

B Warehouses
E Tax Categories T
H Meta Classes AW,
B Meta Fields

=] Order System

To create a new category, click on New. A pop-up window appears. In the Tax Category Name field,
enter a name and click OK to save the tax category.

Warehouses

A Warehouse is the physical place with an address from which product items are shipped. In EPiServer
Commerce you can define

a list of warehouses to be available in the e-commerce process.

© EPiServer AB



Customizing an Existing Form | 203

O You can only associate one single warehouse for every SKU. So when you are creating a new
SKU, you will have to specify the warehouse where the item is being stored, within the Pric-
ing/Inventory tab.

To access warehouses, navigate to Administration > Expand Catalog System > Warehouses.

Administration e

=[] System Settings
=+ Catalog System

= Warehouses

5

@ Tax Categories

= Meta Classes

= Meta Fields

The Warehouse List page appears. The sample site has a default example warehouse called "Default
Warehouse". To create a new warehouse, click on New Warehouse on the menu bar.

ERCE Warehouse List

@ Get Help For This Pi

D New Warehaur?ri ﬁ More Actions ™

D Marre W Ishctive  Created Modified Sort Order

D Default Warehouse True 5/11/2010 1:25:45 PM 5/11/2010 1:26:31 PM i}

The Warehouse Edit page has two tabs: Overview and Address.
1. Under the Overview tab enter in a Name and Code. The Name and Code name can have spaces
in between characters.
2. Enterin a value for the Sort Order to determine the Warehouse's position on the Warehouse List.
3. Under Available select "Yes" or "No."

4. Under Is Primary select whether or not this Warehouse is the primary one. You can only have
one primary Warehouse.

ERCE Warehouse Edit

Owverview Address

Mame: Mew Warehouse
Code: new warehouse
Sort Order: g
The sort order for the category entry.
Available: @ Yes ™ Mo
Is Primary: = Yes @ Mo
OK || Cancel
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5. Under the Address tab, enter all relevant information regarding this Warehouse.

Overview Address

First Name:
Last Name:
Organization:
Line 1:

Line 2:

City:

State:

Country Code:
Country Name:
Pastal Code:
Region Code:
Region Name:
Day Phone:
Evening Phone:
Fax Number:

Email:

| QK || Cancel |

6. Once you are satisfied with your entries, click on OK to save the Warehouse. Otherwise, click Can-

cel to go back to the Warehouse List page. The new Warehouse will appear on the list.

DNEwWarehnusE & More Actions v

|:| Marme Ishctive  Created Modified Sort Order
[[] Default Warehouse True 5/11/2010 1:25:45 PM 5/11/2010 1:26:31 PM 0

[ Mew WEI’EHDI@ True Today, 1:17 PM Today, 1:17 PM 10

To delete a Warehouse, place a check mark on the box next to the name of the Warehouse and the click

on More Actions on the menu bar.

D MNew Warehouse j Mare Actions =

|:| Marme

?( Delete EEIECtM
[C] Default warehouse

Mew Warehouse

Confirm deletion by clicking OK on the pop-up window. Otherwise, click Cancel to go back.

Order System

Under Order System you can set up payment methods, shipping providers and configure specific taxes.
You can also define meta fields and classes for orders. For more information on how to add meta fields

and classes, refer to the section Settfing up Meta Fields and Classes.
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Payment Gateways

When creating and configuring payment methods in EPiServer Commerce, there are three components
that need to be created or re-used as well as configured: Payment Types, Payment Gateways and Pay-
ment Methods.

Payment Types — Payment types are classes which contain the properties of a particular payment type.
For example, a credit card payment type contains credit card number, card expiration date, card type, etc.
All payment types inherit from the abstract class Payment. The most common payment types are already
built-in to EPiServer Commerce:

e Creditcard

e Cash Card

e GiftCard

e Invoice
In addition, a generic "OtherPayment" class type is included in EPiServer Commerce. Payment types are
meta classes.
Payment Gateways — Payment gateways provide an interface to the system which provides payment
processing. A payment type is passed to the payment gateway and the gateway executes the payment
transaction with the payment system (e.g. PayPal). One payment type is associated with each payment
gateway.
Payment Methods — Payment methods contain information about the way the customer views a pay-
ment option and has a payment gateway associated with it.

Using Builtin Payment Gateways

To setup payments using a built-in payment gateway, go to Administration, Language (English, German,
Spanish, etc.).

Administration o |

b

:IE Administration
H ] System Settings
#_] Catalog 5ystem
=l Order System
B Meta Classes
B Meta Fields
=I"—] Payments
|_1English {(United 5tates)
|1 German (Germany)
[_1Spanish (Spain)
|__1French (France)
H[_] Shipping
H ] Tax Configuration

The Payment Methods window appears.
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Payment Methods

Y
(7] Get Help For This Page +

D MNew 21 More Actions ™

|:| Name IsActive  IsDefault Ordering  Created Last Modified

I:‘ = )( Gift Card True False o} Z2/22/2012 3:08:21 AM 2/22/2012 3:08:21 AM
I:‘ = x Pay By Credit Card True False ed 4/20/2010 2:00:00 AM 4/20/2010 2:00:00 AM
|:| = )( ExchangePayment False False 2 4/20/2010 2:00:00 AM 4/20/2010 2:00:00 AM
I:‘ = x Pay By Phone True True ed 4/20/2010 2:00:00 AM 4/20/2010 2:00:00 AM
I:‘ = )( Credit on Account True False 100 Z2/22/2012 3:08:21 AM 2/22/2012 3:08:21 AM

If selecting English (US) on the sample site the following payment methods will be available by default:
e Gift Card
e Pay By Credit Card
e Exchange Payment
e PayBy Phone
e Crediton Account

To create a new Payment Method, click on New to open the Payment Method Edit screen.

Payment Method Edit

Overview Parameters
o

Name:

Description: -

System Keyword:

Language: select language El

Class Name: (none) IE'
Sort Order: 0

IsActive: 71 Yes i@ No

IsDefault: ) Yes @ No

Supports Recurring: 1 Yes i@ No

Restricted Shipping Methods

Available Shipping Methods Chaosen Shipping Methods

Default Shipping
Online Download

Add ->
Add All ===

(0] || Cancel |

Here is an explanation of some of the gateway properties:
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¢ ID - the system-assigned unique identifier for the payment gateway
¢ Name - the name to be displayed to the user
e Description — a description that can be displayed to the user

o System Keyword — the unique name for each instance of the gateway; new non-unique key-
words will not save to the database. This is not be editable after a gateway is initially created

e Language — allows a specific language to be specified for the payment gateway

e Class Name — name of the gateway class to be associated with the payment

e Sort Order — specifies the order of the payment method on the list of payment methods page
e IsActive — specify whether or not the payment method is active\

e IsDefault — specific whether or not the payment method is the default one

e Supports Recurring — specify whether this payment methods supports recurring payments, such
as for subscriptions

e Restricted Shipping Methods — Restricted shipping methods is not fully imple-
mented out of the box and requires a developer to complete the functionality.

Restricted Shipping Methods

Awvailable Shipping Methods Chosen Shipping Methods

Default Shipping

Cnline Download

Add -
Add All -==
Restricted Shipping Methods
Awvailable Shipping Methods Chosen Shipping Methods
Online Download Default Shipping
Add -
Add All -=>

< - Remove
<2 Remmreﬁ.| E

Click OK to save the Payment Method. The payment method will appear in the list of Payment Methods.

Payment Methods

-

D New | 2] More Actions =

|:| Marne Ishctive  IsDefault Crdering  Created Last Modified

D )( Maoney Orger False False [u] Today, 10:43 AM Today, 10:43 AM

=] ¥ Payment by card (DIES) True True o 5/12/2010 6:10:05 AM 5/12/2010 6:10:05 AM
I:‘ x Pay By Phone True True 1 1/1/2006 1:00:00 AM S5/12/2010 6:10:34 AM
[ & % Pay By Credit card True False z 1/1/2006 1:00:00 AM 1/1/2007 1:00:00 AM
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Setting up Payment Methods using nSoftware Provided Payment Gateways

EPiServer Commerce supports multiple payment gateways out of the box using nSoftware where new
payment methods can easily be set up by end-users.

-

To enable nSoftware supported gateways, create a new payment method.

Enter in a Name, such as nSoftware or anything else.

Enter in a Description.

Enter in the System Keyword as "ICharge".

Select a Language from the drop-down menu.

Select the Class Name "Mediachase.Commerce.Plugins.Payment.ICharge.IChargeGateway".
Select "Yes" for IsActive.

Change the Sort Order, IsDefault, Supports Recurring as needed.

© ©® N o o &~ w D

Click OK to save changes.

MERCE Payment Method Edit

L4

Overview Parameters

10

Mame: nSoftware

Description: nSoftware D

System Keyword: ICharge

Language: select language Iz‘

Class Name: Mediachase Commerce Plugins.PaymentlCharge IChargeGateway E‘
Sort Order: 0

IsActive: 71 Yes i@ No

IsDefault: “1Yes @ No

Supports Recurring: ™ Yes @ No

Restricted Shipping Methods

Available Shipping Methods Chosen Shipping Methods

Default Shipping
Online Download

Add -
Add All ->>

OK || Cancel

Once created, click on the payment gateway again to go back to the Payment Method Edit page. Click on
the Parameters tab.
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The Configure IBiz E-Payment Integrator Component appears and you can select from the Gateway
drop-down menu several dozen of the most popular payment gateways will appear. Depending on the
gateway you select, such as Authorize.Net, the Configuration Parameters will change. Enter in your cre-
dentials and other relevant information to activate the gateway and click OK.

Owverview Parameters

Configure IBiz E-Payment Integrator Component

Cateway: Authorize.Net E

Cet |[Biz E-Payment Integrator from weaw.nsoftware.com. You will find more documentation on how to configure it there also.

Configuration Parameters
Payment Options: Sale |Z|

*Merchant Login:
Merchant Password:
Transaction Key:
Secret Hash:

Payment Gateway URL (used for testing):

(014 || Cancel

Editing Payment Methods

To edit an existing payment method, click on the Notepad icon next to the Delete icon.

D New | (£ More Actions

Marme

nSoftware

Money Order

Payment by card (DIBS)

Pay By Phone

mEaomo’®

Pay By Credit Card

The ID is auto-generated. Every field can be changed except System Keyword. After you are satisfied with
your changes, click on OK.
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MERCE Payment Method Edit

L

Overview FParameters
1D elfbbeld-053f-4adc-b15c-669374639502
Mame: Maney Order

Description: -

System Keyword: W

Language: English (United States) E

Class Name: EPiServer.Business.Commerce.Payment.DIBS.DIBESPaymentCateway Iz‘
sort Order: 0

IsActive: i) Yes (@ No

IsDefault: 1 Yes i@ Mo

Supports Recurring: () Yes i@ No

Restricted Shipping Methods

Available Shipping Methods Chaosen Shipping Methods
Online Download Default Shipping
Add ->
Add All ==
<- Remawve
<< - Remove All

Ok || Cancel

Deleting Payment Methods

To delete Payment Methods, click on the X icon next to the payment method name and click OK when
the popup appears. To delete multiple payment methods at once, check mark each payment method you
want to delete, then click on More Actions --> Delete on the drop-down menu. Click OK when the popup
appears.

Shipping

Shipping involves everything related to the actual physical delivery of products to e-commerce customers.
Just as for payments, you can set up shipping methods, gateways and providers. In the following the ter-
minology is described as well as the different configuration possibilities for shipping.

Shipping Method

A shipping method manages a set of information and rules that determines the shipping cost and displays
it on the front-end site while a customer checks out an item from his/her shopping basket. The shipping
fee is added to the total price of the purchase. A shipping method is mapped to a shipping provider vis-
ible to a back-end administrator in Commerce Manager. This allows the public site to display friendly
names such as "Ground Shipping" to the customer and this is mapped to a provider such as UPS. There-
fore, when a customer picks "Ground Shipping," he/she will be using UPS.
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Shipping Providers

A shipping provider is the class(es) that interacts directly with one or more actual shipping services such
as USPS, UPS, or FedEX. It retrieves shipping price information from the shipping service(s) its asso-
ciated with. One typical scenario would be to have a provider that represents a particular service (e.g.
USPS). A provider can also represent a particular type of shipping situation. One example is that you
could have a provider for overnight delivery. The provider could retrieve pricing for that service to deter-
mine the lowest price given the location of the customer. A provider could also represent other specific
scenarios with one or more services such as price by weight or ground shipping.

Shipping Gateways
Under Shipping Providers, a shipping gateway is the specific class that you select (Generic Gateway or

Weight/Jurisdiction Gateway).

There are two options out of the box for shipping gateways: 1) Generic Gateway (flat shipping rate) and 2)
Weight/Jurisdiction Gateway (base price + additional fee depending on weight and shipping location).
You select the shipping gateway in the Shipping Provider screen and then configure the actual values for
that gateway/provider in the Shipping Methods area.

Shipping Jurisdictions

An option which allows you to define values for region-specific shipping rates; this is only used when you
select the Weight/Jurisdiction Gateway (i.e. California)

Shipping Jurisdiction Groups

Group of jurisdictions; this is required because this is a required field when configuring the Shipping
Method parameters (i.e. Southwest region).

Shipping Methods

A Shipping Method manages a set of information and rules that determines the shipping cost and dis-
plays it on the front-end site while a customer checks out an item from his/her shopping basket. The ship-
ping fee is added to the total price of the purchase.

A shipping method is mapped to a Shipping Provider visible to a back-end administratorin Commerce
Manager. This allows the public site to display friendly names such as "Ground Shipping" to the customer
and this is mapped to a provider such as UPS. Therefore, when a customer picks "Ground Shipping,"
he/she will be using UPS.

Customizing Shipping Methods

There are two Shipping Methods available out of the box for you to customize: Ground Shipping and
Fixed Shipping.

To customize the Shipping Methods, first go to Administration > Order System > Shipping > Shipping
Methods > English (United States) or any other languages.
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Administration e

:IE Administration
=[] System Settings
H [ ] Catalog System
=1 Order System
B Meta Classes
B Meta Fields
=[] Payments
=] Shipping
B Shipping Jurisdiction Groups
B Shipping Jurisdictions
B Shipping Providers
B Shipping Packages
=] Shipping Methods

[ English {United States)

1

[ ] Cerman (Cermany)
|_1Spanish (Spain)
|1 French (France)

H ] Tax Configuration

At the Shipping Methods List screen, select the edit icon for either of the available methods. The Over-
view tab screen for Shipping Method Edit will load with the below fields:

Overview Settings Parameters

10: alcal bca-6fbf-4bef-b01f-bbf3df23a02a
Name:
Friendly Name: Cround Shipping
Description: Calculates shipping based on weight and zone,
Provider: Weight/Jurisdiction Catewa‘,rE
Language: English (United States)E
Base Price: 2.00
Currency: US dollar E
IsActive: @ Yes ™1 Na
IsDefault: @ Yes ™1 No
Sart Order: )
Ok || Cancel

e ID - this is auto-generated after saving the new shipping method

e Name - enter in a name without spaces or special character; this name will not be displayed in the
public site, butis only for end users to manage and organize the shipping methods

e Friendly Name - enter a friendly name which can have spaces and special character; the friendly
name is the name seen by customers who are purchasing items

e Description - enter a description (optional)
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e Provider - select an available provider from the drop-down menu; the options displayed here are
created in the Shipping Providers screen (Generic Gateway is for a fixed shipping fee specified
below under base price, while Weight/Jurisdiction Gateway is used for a shipping fee depended
on the weight and shipping location)

e Language - select a language of your choice from the drop-down menu

e Base Price - the base price you specify here will become the fixed shipping fee for the Generic
Gateway option, and part of the Weight/Jurisdiction Gateway option.

e IsActive - select Yes or No under IsActive to enable is disable it, respectively
o IsDefault - select Yes or No if this shipping method is the default one

e Sort Order - enter a number for the sort order to determine its position on the list of shipping meth-
ods

The Settings tab is used to exclude any Countries, Regions, and Payments from a particular shipping
method.

To exclude a selection, highlight the items on the Available boxes on the left and move them to the
Chosen Countries boxes by clicking Add.

© EPiServer AB



214 | User Guide for EPiServer Commerce 1 R2 SP2

Cverview Settings Parameters

Restricted Countries

Available Countries Chosen Countries

Afghanistan
Albania
Algeria Add -
American S5amoa

Andorra

Angola

Anguilla

Antarctica

Antigua and Barbuda

Argentina -

m »

Add All ->>

Restricted Regions

Available Regions Chosen Regions

Alabama
Alaska
American Samoa B Add -
Arizona

Arkansas

Armed Forces Africa

Armed Forces Americas (except(
Armed Forces Canada

Armed Forces Europe

Armed Forces Middle East T

Restricted Payments

Available Payments

m

Add All ->>

Chosen Payments
Payment by card (DIES)

nSoftware

Pay By Phone Add ->
Pay By Credit Card

Add All ->>

| 0].4 || Cancel

The Parameters tab is use to set conditions to determine the shipping fee. This screen become available

only when the Weight/Jurisdiction Gateway is selectin the Provider field in the Overview tab (it will be
empty with the Generic Gateway option).

Owverview Settings Parameters

Configure Price Per Weight for Jurisdiction Group

J;;ézdp‘f:tmn United States lz‘

Weight: or more

Price:

Start Dare: 5/25/2010 [ 12:00 AM

End Date: 5/25/2011 FH 10:55 Am

Croup Name Weight

Price Start Date End Date
United 5tates

Edit
0 ar more 10

10/8/2008 12:00:00 AM  10/8/202012:00:00 AM Modify Delete
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e Jurisdiction Group - select a jurisdiction group to apply the current Shipping Method using the
drop-down menu; the options listed here are set up in the Shipping Jurisdictions and Shipping
Jurisdiction Groups screen.

o Weight - enter a numerical value for the weight; units for the weightis setin the Common Settings
screen

e Price - enter a price to be added to the base price (Overview tab) when the weight and juris-
diction group conditions are met.

e Start Date - enter a start date and time for the shipping method to take effect
e End Date - enter a end date and time for the shipping method to expire

When finish entering the values above, select Add to save the condition. The condition will appear on
table below. In the above example, if the customer checks out an item that weights anywhere between 0
to 10 weight units (Ibs for example), and the customer's shipping address is in the United States, then the
total shipping fee will equal $10 + the base price you enter in the overview screen.

Click OK to save changes.

Deleting Shipping Methods

1. Check off the box that corresponds to the shipping methods you want to delete.

2. Click on the More Actions button on the upper left corner of the main window menu bar, and
choose Delete from the pull down menu.

3. Click OK when prompted. The selected methods will be deleted from the list.

ERCE Shipping Methods

D New | | More Actions =

|:| Marme Display Marne
[ ¥ Default Shipping Ground Shipping
I:‘ -b Online Download Fiwed Shipping Rate

Shipping Providers

A Shipping Provider is an actual service such as USPS, UPS, or FedEX. However, a provider can also

be a type of shipping in order to determine shipping price. For example, one can have a "Percentage of
Total Cost" provider or "Fixed Price" provider. In this case, the shipment "types" can be associated to one
of the existing providers (i.e. USPS, UPS, FEDEX).

The Shipping Providers page manages the list of these providers/types. There are two shipping methods
available out of the box for you to customize: 1) Generic Gateway and 2) Weight/Jurisdiction Gateway.

A Generic Gateway is used for a fixed shipping fee while Weight/Jurisdiction Gateway is used for a ship-
ping fee thatis calculated based on the weight and shipping location.

Customizing Shipping Providers

Go to Administration > Order System > Shipping > Shipping Providers. Edit one of the two providers
listed.
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Administration ;:'E'

= ﬁ Administration
=[] Systemn Settings
=[] Catalog System
== Order System
B Meta Classes
B Meta Fields
=[] Payments
=l Shipping
Shipping Jurisdiction Groups

=
B Shipping Jurisdictions
=

Shipping Providers

B Shipping Packages
=] Shipping Methods
[ English {United States)
[ German (Germany)
(] Spanish {Spain)
[ French (France)
#[_] Tax Configuration

1. Edit Name, and Description.

2. System Keyword (no spaces) and Classes are something that your developers need to code
and provide.

3. Click OK to save changes.
The revised shipping provider will appear in the Shipping Providers page.

O The Parameters and Packages tabs are not fully implemented; they serve as a starting point
for developers for full implementation of those features.

Deleting Shipping Providers

1. Go to the Shipping Providers page.

2. Check off the box that corresponds to the shipping providers you want to delete.

3. Click on the More Actions button on the upper left corner of the main window menu bar, and choose
Delete from the pull down menu.

4. Click OK when prompted. The selected providers will be deleted from the list.

ERCE Shipping Providers

DNEW _\ﬁru'lcure Actions~
|:| Marre
D >< Ceneric Cateway

D “ Weight/Jurisdiction Cateway
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Tax Configuration

Introduction

Taxes can be configured in the Administration subsystem so that specified rates are calculated and
added to the total price during the checkout process. Depending on your configuration, it is also possible
to combine and apply multiple taxes (such as federal, state and local tax) to a purchase.

Taxes can be set up and maintained using two methods: 1) creating/editing each tax control manually or
2) importing all data using a CSV file. Here we will discuss both methods and also provide you with a few
examples to demonstrate how this works.

Method 1: Configuring Taxes Manually

To set up your taxes manually, you will need to work with the following areas in the Administration tab of
the Admin Site — Tax Categories, Tax Jurisdiction Groups, Tax Jurisdictions, and Taxes — as well as
the configuration pages for each of the catalog items.

The steps below summarize the process you need to follow to configure taxes.

1. Create and configure Countries and Regions (Go to Administration > System Settings > Dic-
tionaries > Countries): In Countries section create the countries you plan to sell your products in
and set the appropriate country codes. For the country codes, itis important that you use the
ISO Short code provided in the following link (http:/msdn.microsoft.com/en-us/li-
brary/ms866171.aspx). Using the ISO Long code or anything else will not correctly calculate taxes
during checkout.

2. Create new Tax Categories (Go to Administration > Catalog System): In this step you will
create tax categories that will be used later to associate your catalog items with the tax rates you
define. For example you may create categories such as "General Sales," "Food," and "Luxury
ltems" depending on the tax regulations for your item types. The categories you create here will
become selectable on the Page Details of your items (i.e., Variations/SKU Edit page) and on the
Tax Edit page.

3. Create and configure Tax Jurisdictions (Go to Administration > Order system > Tax Con-
figuration): In this step you will specify particular Tax Jurisdictions. You can create different Tax
Jurisdictions for a particular region by specifying zip codes, country codes, etc. Tax rates will be
applied to whatever level of information you specify for each Jurisdiction. For example, if you spec-
ify only the country code as US, all shoppers with a US address (regardless of state, county etc.)
will be included in this jurisdiction. Note: Country Code and Region Code you enter in the Juris-
dictions Edit page must match the codes you used in step 1.

4. Create and configure new Tax Jurisdiction Groups (Go to Administration > Order system >
Tax Configuration): New Tax Jurisdiction Groups created here can include multiple Tax Juris-
dictions.

5. Create and configure Taxes (Go to Administration > Order System > Tax Configuration): Here
you will specify tax rates and also associate the Tax Categories and Jurisdiction groups created in
Steps 2 and 4.

6. Associate Catalogs to the Tax Categories created in Step 2 (Go to Order Management > Cat-
alogs): Now you will switch over to the Catalog Management subsystem and link specific catalog
items to the appropriate Tax Categories. This can be done on the Pricing/Inventory page within
each Variation/SKU Edit page.

Method 2: Configuring Taxes Using CSV Import

Using the CSV Tax Import functionality is a convenient way to quickly setup and update tax data in bulk.
Creating a CSV tax file with a specified format (see "Example Scenarios" below) will allow you to
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complete steps 2 through 5 in one shot (above in Method 1). Step 6 of Method 1 can be done manually,
but you can also use the CSV import functionality in the Catalog Management subsystem to associate cat-
alogs to tax categories. Click here to see how CSV Catalog Import works.

Import your CSV tax file into your Commerce Manager by following the steps:

1. Selectthe Administration tab in the Commerce Manager.

2. Inthe navigation tree drill down to Taxes: Order System > Taxes Configuration > Taxes.
3. Click Import Taxes on the menu bar.
4

Choose Add New File and then Browse to select and upload your CSV tax file. The path of your
chosen file will appear in the field.

5. Click Upload File and then Save The File icon. The CSV tax file will appear under the Files Avail-
able for Import section.

6. Selectand highlightthe CSV file and click the "Start Import" button.
7. Your import should begin and complete successfully in a pop-up dialog box.

8. You will now be able to view your tax setup in the Commerce Manager.

If you want to edit the existing setup, simply repeat steps 1 through 8 with your modified file.

Caution: Re-importing CSV files only edits existing information or adds new data, but nothing gets
deleted. If you delete an entire row of data in the CSV file, you must manually delete those entries in the
Commerce Manager. Ifin doubt, you can always delete all the tax data and perform the CSV tax import
from scratch.

Sample CSV Files and Example Scenarios

Example 1: Single Tax Per Catalog ltem Based on a Single Jurisdiction

For example, if your variable is State, then you can specify the tax rate on a state-level. So let's say CA is
9% and MA is 6%. If you placed an order from California, then 9% sales tax would be applied during
checkout.

Jurisdiction Jurisdiction Group | Tax Rate | Tax Category

California CA Tax Group 9% General Sales

Massachusetts | MA Tax Group 6% General Sales

A sample tax CSV file called test.csv is available in this directory — [taxcsvsample1.zip ].

Example 2: Two or More Taxes Per Catalog Item Based on More Than One Juridiction

For example, if you have a luxury item that requires State and Federal tax to be applied, then you can
specify tax rates on a state and federal level. So let's say a luxury item purchased in CA has a 9% state
tax rate and a federal tax rate of 3%. Both taxes would be applied during checkout.

Jurisdiction Jurisdiction Group | Tax Rate | Tax Category
California General CAGS TaxGroup 9% General Sales
Massachusetts General | MA GS Tax Group | 6% General Sales
California Luxury CA LX Tax Group 9% Luxury Sales
Massachusetts Luxury | MALX Tax Group | 6% Luxury Sales
US Federal Luxury US LX Tax Group 3% Luxury Sales
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Sample Site

The "Enoteca winestore" sample site is a fully functional B2C and B2B e-commerce solution for a mid-

size retailer.

This is a demo store. Any orders placed through this store will not be honored or fulfilled

Welcome, Carlos  Logout My profile  English (United States)[=]  Pound steriing  [=]
Your Local Store
' 789 Tincidunt
Rliquam erat

Yuisque varius
Sollicitugin @ Your basket

enoteca +44 (0)00000789 11ilem(s) Total 128,50 € Checkout @
Mixed Cases D

: . N
Discover our new Spring'collection

View our new arrivals ©

Recent Reviews

Cote-Rotie, Les Essartailles, Les Vins de
Vienne
This was & grest suprise, bought this s a gift to

a friend and it tumed out fo have a wonderful...

FAk Aok

- 3 for the price of 2
' on all mixed cases

our most popular mixed cases ©

Pulenta Estate, Pinot Gris Mendoza
This is cheap for such a greal wine, clearly

value for money!

KAk

Mix and match deals 20% off select Reds  Our newest arrivals  Bring out the bubbly

Chablis, Bougros "Cote Bouguerots' Grand
Cru, Domaine William Fevre
This should be avoided, particularly this batch,

something went wrong here.

*o

Multiple deliveries Our Favourites
Our delivery services are
Pulenta Estate, Pinot 1 Pulenta, La Flor,

Gris Mendoza Sauvignon Blanc,

Find cut mare © . Mendoza {Stelvin)

managed locally

£9.35
£9.45 ) Get RSS Feed @

Corporate

Constantly striving fo exceed 1 1
your expectations Add to basket © Add to basket ©

, off Champaigne

Find out mare @ S

The site provides a set of demo templates to illustrate the functionality of EPiServer Commerce. The sam-
ple template package is intended as inspiration when you build your own e-commerce site based on
EPiServer Commerce. In the following the templates included in the package are described in more
detail, explaining the setup and the possibilities with EPiServer Commerce to both developers and end-
users.

Display Templates

To be able to display different products on the e-commerce site you need to define the display templates
to be used. These can be different for different language groups on the site. On the EPiServer Commerce
sample site, the display templates will automatically be imported and configured during the installation
procedure. However, when new templates have been created you may want to define their use in the sys-
tem, or modify the use of existing ones. This is done in Commerce Manager in the Catalog Management
sub-system under Templates.
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© ? - XLadmin~ Q

Commerce Manager Settings

EPISERVER COMMERCE

5.2 (build: 377)

Welcome ™ Change Language About ™

Templates List Version
cense: F G5 Deployment (EpiServer)

@ Cet Help For This Page &

Cartalog Management &

[ New | [ More Actians ™

o=

= Catalog Management
|, Catalog Entry Search
B Catalog Batch Update
=] Catalogs
=) Templates

] Name Type Path

D ‘Wine Template entry ~/Templates/WineStore/DisplayTemplates/WineDetailTemplate.ascx

[[] Bundie Template entry ~/Templates/WineStore/ DisplayTemplates/BundleDetailTemplate.asox

[]English (United States) |

[_JGerman (Cermany)
[_]Spanish (Spain)
[_JFrench (France)

ﬁ Dashboard

m Customer Management

—| Catalog Management

g Order Management

IE Marketing

«ﬂ Asset Management

i Administration

Page Size: 20 ¥ (2 items) | Page 41+

Adding a display template

o & N

Under Catalog Management, select Templates and click New.

In the Name field, enter the name of the display template, for instance "WineTemplate".

In the Friendly Name field, enter the display name for the template, for instance "Wine Template".
In the Type field, enter the type of display template, for instance "entry".

In the Path field, add the path to the display template, for instance:
~/Templates/WineStore/DisplayTemplates/WineDetailTemplate.ascx.

Click OK to save your changes.

Updating an existing display template

1.

o o ke N

Under Catalog Management, select Templates and the language version and template that you
want to update.

In the Name field, enter the name of the display template.

In the Friendly Name field, enter the display name of the display template.
In the Type field, enter the type of display template.

In the Path field, add the path to the display template.

Click OK to save your changes.

Sample Catalog

The product catalog contains information regarding brands and sales items. This information will either
be displayed in the public site, or used for pricing and promotions. Product catalogs needs to be imported
into EPiServer Commerce. This will normally be done automatically during the installation procedure for
the EPiServer Commerce sample site.
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However, there may be occasions where you need to import a product catalog, and the procedure is
therefore described in the following. There are different ways of doing this, and in this example we
describe how you manually import the sample catalog for the sample site, using the import/export function
in Commerce Manager. When product catalogs have been imported, they also need to be indexed, in
order for the product search function to incorporate any changes.

Additional information on how to import product catalogs can be found in the Catalog Management sec-
tion.

Start cMs Commerce Mail EPISERVER © 7?7 ~ Xladmin~ Q
Commerce Manager Settings
- Welcome, admin
EP'SERVER COM M ERCE Catal()g Llst t Version: 5.2 (build: 377)
icense: ECF G5 Deployment (EpiServer)
Welcome ™ Change Language About” @ Get Help For This Page &
Catalog Management 2 | | i new Catalog ] Impaort/Export™ 2l More Actions ™
2= catalog Management ] Name Available from Expires Available
» Catalog Entry Search B S® Wine 9/12/2011 11:11:00 AM  9/12/2021 11:11:00 AM  True
© Catalog Batch Update
259 catalogs |
2SI wine

4[] Accessories

& [ Mixed Cases

# [ Wine Region
# ] Templates

ﬁ Dashboard
m Customer Management

ﬁ__& Catalog Management

‘g Order Management
IE Marketing

«ﬂ Asset Management

4% Administration Page Size: 20 ¥ (1 items) | Page 41+

Importing the Sample Catalog

The sample site includes two product catalogs providing the "everything" and the "brand" view.

1. In Commerce Manager, select Catalog Management and then Catalogs.
2. Click on Import/Export and then Import Catalog, this takes you to the Import Catalog screen.

3. Select the catalog zip file, in this case "CatalogExport_Catalog_Wine_Sample.zip" and click Start
Import.

4. When the import has completed, click Close Window.
5. Select"CatalogExport_Catalog_Wine_Sample.zip" and click Start Import.

6. When the import has completed, click Close Window.
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It is strongly recommmended that you back up your ECF database before performing import.

To import catalog, please pick up an existing file from the grid below or upload a new one. Then click the button "Start Import' to start importing.

Add Mew File

Files Available For Import:

Actions

Download | Delete

1

Indexing the Sample Catalog

After importing a product catalog, at also needs to be indexed.

1.

File Name Size Created Last Updated

CatalogExport_Catalog_Wine_Sample.zip 74290 KB Today, 2:35 PM Today, 2:34 PM

Page 1 of 1 {1 items)

In Commerce Manager, select Administration, System Settings and then Search Index.

2. Click Rebuild Index to index the catalog for the first time. The Build Index option is used for future

Start

Commerce Manager Settings

updates when you import the same catalog again and only want to index the changes.

cMms Commerce Mail EPISERVER & 7?7 ~ L adminr Q

EPISERVER COMMERCE Search Manager Produc version 5.2 (il 377

Welcome ¥ Change Language About™

License: ECF G5 Deployment (EpiServer)

& Get Help For This Fage

Administration

a0

:I_-E Administration
El] System Settings
# ] Dictionaries
#(] Logs

Common Settings
Business Foundation
Workflow

Search Configuration

Default Search Provider: LuceneSearchProvider

Installed Search Providers: SolrSearchProvider; LuceneSearchProvider;
Indexers: catalog (built 2/8/2012 5:26:50 PM);

Index Operations

| Rebuild Index | Rebuild the Search Index. This operation will cause complete index rebuild.

Search Index

Left Menu

(] Caralog System
E: | Order System

ﬁ Dashboard

Build Index EBuild the Search Index. This operation will build the index for items updated since last build.

m Customer Management

—| Catalog Management

ng Order Management

IE Marketing

(ﬂ Asset Management

Reporting

@ Administration

Page Templates
EPiServer Commerce is based on the e-commerce module Commerce Manager and EPiServer CMS for
managing content. The EPiServer Commerce package includes a sample website with a set of page tem-
plates with related page types. The page templates provide an example of how you can work with EPiS-

erver Commerce to create your own web publishing and online store platform. Use the page templates as
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inspiration and adapt them to your own online store environment. The sample site contains sample prod-
uct data stored in a product database.

Create

Create

Create
Create

Create

Create
Create
Create
Create

Create
Create
Create

Create

Create

Create

Create

Create

Create
Create
Create
Create

Create

Create

@

Name

[WineStore] Create Account
Page

[WineStore] Compare Page

[WineStore] Wine Detail
Page

[WineStore] Shopping
Basket Page

[WineStore] Login Page

[WineStore] Search Result
Page

[WineStore] Company
Checkout Page

[WineStore] Address Book
Page

[WineStore] My Orders
Page

[WineStore] Product Listing
[WineStore] My Page
[WineStore] Container Page

[WineStore] My Settings
Page

[WineStore] Wish List Page

[WineStore] Order Detail
Page

[WineStore] Standard Page

[WineStore] Company
Order Detail

[WineStore] Edit Member
[WineStore] Create Member
[WineStore] Checkout Page
[WineStore] Members List

[WineStore] Home Page

[WineStore] Company Page

Description

Used to create a new user account

This page type displays a list of products to be compared.

This page type contains the data for a wine.

List added products.

This page will be used for user to login.

Used to show search result.

Checkourt page for company user.

Page displays address book.

Page displays order history.

This page type displays z list of products.
Page contains information for standard users.
This page type will be used as a container and will not contains any data.

Page displays profile settings for users.

Page displays wish list for users.

Detail information of a order.

Standard Page

Company order detail page.

Page used to edit an existing company member.
Page used to create a new company member.
[WineStare] Checkout Page

Page displays the list of members.

The start page is the main entry point to the web site containing a main and secondary body as
well as different listings for news and events.

Page displays company profile overview.

The templates, tabs, fields and functions described in this documentation refers to a "standard
installation" of an EPiServer Commerce sample site. The standard functions and fields of EPiS-
erver CMS are not described here. Please refer to the EPiServer CMS documentation for
editors and administrators available on world.episerver.com.

Page Tree Structure

When installing the EPiServer Commerce package with a sample site, a number of pages will be created
and displayed in a specific structure in the page tree. Some of them will show editorial content. Some
pages are used as containers for other pages These will not display any content of their own and will be
hidden in navigation menus.
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CM5 2

Edit Mode Admin Mode Reports

O & = . B

J Structure ” Favorites || My Tasks |

i Root folder
@ Recycle Bin
[Resources] i

Wine '

- J Home|

[Menu] ¥

Twme

Mixed Cases

[Functional Pages] ¥
[Footer Container] 1
[My Profile] ¥
[Content Pages] 2

[Company Profile] B

The home page is built using the Home page type. The Home page contains numerous settings affecting
the entire website, for instance top menus, search and login. This is also where you define pages to be
used for shopping carts, payments and checkout.

The main menu navigation is built up by the page structure under [Menu]. The products listing is retrieved
from the [Resources] section where the Product Listing page type which is used for displaying the prod-
ucts, fetching product information from the product catalog.

The [Functional Pages] section of the site structure holds the display templates for a number of general
functions such as Checkout, Login and Create Account. These have their own specific page types link-
ing to functions in the Commerce Manager module.

The [My Profile] section contains display templates for personal settings for online shoppers. Page types
used here are for instance My Orders, My Page and Wishlist.

Editorial content pages are most often based on the page type Standard Page. These are pages where
editors can create and edit content the usual way in EPiServer CMS. Examples of editorial content are the
pages under the [Content Pages] and [Footer Container].

The [Company Profile] section of the site structure holds display templates related to the B2B part of the
sample site. This includes page types such as Company Order Detail, Create Member and Company
Page.

Each of the page types mentioned here are described in more detail in the following sections of this doc-
umentation.

Home Page

The home page is based on the Home Page page type and is normally defined when the website is
installed. The page holds a number of settings with references to other pages on the website. The main
settings of the home page will most likely not be touched very often after the setup of the site. Other parts
like special offer advertises and product campaign content may be updated more frequently.
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Below are the properties that can be changed in Edit mode under the Content tab of the home page.

Name

The name of the page, as displayed in the page tree.

About Us Page

Provides linking to display content from the About Us page section stored in [Footer Container].

Deliveries Page

Provides linking to display content from the Multiple Deliveries page stored in [Content Pages].

Corporate Page

Provides linking to display content from the Corporate page stored in [Content Pages].

Main Advertise

Provides an editor area for adding editorial content to the main advertisement area at the top of the home

page.

S o

Commerce

Mail EPISERVER © 7 ~

Edit Mode Admin Mode Reports Visitor Groups

L] i » & @ @ @
JSlluclure Favorites || My Tasks Home bz Viaw@

i@ Root folder

@ Recycle Bin

[Resourcesj i

@
[Menu] 1
[Functional Pages] 1
[Footer Container] 31
[My Profile]

[Content Pages] BT
[Company Profile]

Show Page Tree:
| == English (United States)

[~]

Compare With

Page Type: [Wine5tore] Home Page Status: Published Version

| Preview H Edit H Versions H EPiServer Mail H Workflow ‘

H save 3 Cancel

k1 save and View E; Save and Publish

J Content ” Scheduling H Settings ” Shortcut ” Categories ” Favourite Products || External Links ” Carouse| H Site

Name Home
About us Page
Deliveries Page

Corporate Page

BEE

Main Advertise
+ (00 @@

EE iE — | Styles -

Fam i @ Q

%

N
Discover our new Spring'collectic

View our new arriy

< | m +
Path:

N

Bottom Advertise
+ (0 0 @ Gl [

EE iE —  Styles -

FomE HQ

%

A
Discover our new Spring'collectic

View our new arriv|

© EPiServer AB



226 | User Guide for EPiServer Commerce 1 R2 SP2

Bottom Advertise

Provides an editor area for adding editorial content to the advertisement area at the bottom of the home
page
About Us Image

Provides linking to an image to be displayed with the "About Us" section on the home page.

Favorite Products Tab

Below are the properties that can be changed in Edit mode under the Favorite Products tab of the Home
page.

On this tab you define links to the (four) selected favorite products displayed under "Our Favorites" on the
home page. The products are defined using the product link dialog which allows you to chose products
from the product catalog. Find out more about this feature in the Product Picker Property section of the
EPiServer Commerce Developer Guide.

m [S—— il EPISERVER @& 7 - A admin~

Edit Mode Admin Mode Reports Visito

Page View
J Structure || Favorites || My Tasks Home g w |5 English {United States)
@ Root folger Page Type: [WineStore] Home Page Status: Published Version CompareWith [ |+]
il Recycle Bin | Preview ” Edit ” Versions ” EPiServer Mail ” Workflow ‘
[Resources] i save klSave and View | Save and Publish = [ Cancel &
@
| Content H Scheduling H Settings H Shortcut H Categories || Favourite Products H External Links ” Carousel H Site Configuration
[Menu] 14
[Functional Pages] & FirstFavouriteProduct @

iner] 1
[Footer Container] 11 SecondFavouritePraduct @
[My Profile] M

ThirdFavouriteProduct @
[Content Pages] H

OO0

[Company Profile] b1 ForthFavouriteProduct @

Show Page Tree:

E= English (United States) -

External Links Tab

Below are the properties that can be changed in Edit mode under the External Links tab of the home
page.

On this tab you define external links to the link selection displayed under "Follow Us" in the footer section
at the very bottom of the home page. The links are defined using the ordinary link dialog tool in EPiServer

(& Commerce Mail EPISERVER @& 7 - A adminr Q
Edit Mode Admin Mode Reports Visitor Groups
O & 4 @& v & @ @ @ B B B
= =
| structure || Favorites |[ My Tasks Home Page View
age Type: [WineStore] Home Page Status: Publishe ersion
@ Root rolger Page Type: [WineStore] Home Page Status: Published Versi CompareWith [ ]
i Recycle Bin | Preview ” Edit H Versions ” EPiServer Mail ” Workflow ‘
[Resources] i EHsave ElSave and View [ Save and Publish | £ Cancel 73
@
| Content H Scheduling H Settings H Shortcut || Categories ” Favourite Products H External Links H Carousel || Site Configuration
[Menu] 4
LEscbialauss 1] Facebook Link @ hitp://Facebook.com &=
i 114
[FerrerEmr Twitter Link @ http-/ /Twitter com =)
[My Profile] e o [0
ouTube Linl http-/ Youtube.
[Content Pages] ./ Youtube.com Q
{Company Profile] 11 RSS Link @ http:/ /world episerver com/System/Site-f._.|

Show Page Tree:

= English (United States) -
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Carousel Tab

Below are the properties that can be changed in Edit mode under the Carousel tab of the home page.
The "carousel" illustrates a common feature where you define a number of images that replaces each
other in a slideshow. The images are selected from the file manager in EPiServer CMS.

“.‘ =
a "5 ‘..r

Mix and match deals 20% off select Reds QOur newest arrivals Bring out the bubbly

Itis possible to define four images, and for each image you can set the following:
e Carousel Tab Name - name displayed on the tab under each image.
e Carousel Caption - text displayed on the image for a selected tab.

e Carousel Promotion Link - the target link when clicking on a carousel image (defined in the link
dialog).

e Carousel Promotion Link Title - the link text on a selected carousel image.

[ sarr ETSRN commerce EPISERVER @ 7 - X admin~
Edit Mode Admin Mode Reports Visitor Groups
0O X Eil ; & | @ @ @ E & E
Page v
| structure || Favarites || my Tasks Home ae View [E5 English (Unfied States) |
) o Page Type: [WineStore] Home Page Status: Published Version CompareWah [ ]
i Recycle Bin ‘ Preview H Edit H Versions || EPiServer Mail H Workflow |
{Resources] i kH save klsave and View | Save and Publish | [ Cancel &
@
‘ Content H Scheduling H Settings H Shortcut H Categories ” Favourite Products ” External Links H Carousel ” Site Configuration
[Menu] ¥
[Prsrn= e First Carousel Image Url @ /Global/Images /Carousel/home-ady-1 i [...|
e
(RS =i 1 First Carousel Tab Name @ Mix and match deals
[My Prafile] 4 X °
First Carousel Caption 3 for the price of 2 on all mixed cases
[Content Pages] ¥
First Carousel Promotion Link @ (=)
[Company Profile] ¥
First Carousel Promotion Link Title @ See our most popular mixed cases
Second Carousel Image Url @ /Global/Images /Carousel /iStock_000012| .|
Second Carousel Tab Name @ 20% off select Reds
Second Carousel Caption @ Save on Reds from Merlot to Malbec
Second Carousel Pramaotion Link @ =)
Secand Carousel Promation Link Title @ Sample every shade
Third Carousel Image Url @ /Global/Images/Carousel/istock_000017 B
Third Carousel Tab Name @ Our newest arrivals
Third Carousel Caption @ Critical acclaim awaits these budding star|
Third Carousel Promotion Link @ E]
Third Carousel Promation Link Title @ Sample every new addition
Fourth Carousel Image Url @ /Global/Images/Carousel/iStock_000017 E
Fourth Carousel Tab Name @ Bring out the bubbly
Fourth Carousel Caption ? Refreshing Rose for special occasions
Fourth Carousel Promation Link @ =)
Show Page Tree: Fourth Carousel Promotion Link Title @ 10% off each case

Z= English (United States) -
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Site Configuration Tab

The settings under the Site Configuration tab when you edit the home page, are common website con-
figuration items that are defined as properties on the start page and will be inherited to the sub-pages.
Most often these settings are defined when the website is installed but it may be necessary to update
them at some point.

Here you define settings for both a B2C (consumer) and a B2B (company) scenario. Note that the related
function pages must be created first before you can define them on the home page.

[ sare EVIN commerce EPSERVER @ 7 - A admin-
Edit Mode Admin Mode Reports Visitor Groups
O X + &2 y & @ @@ B & E
J P Home Page View |5 English (United States) -
Bl Roor rolder Page Type: [WineStore] Home Page Status: Published Version CompareWith [ ¥
il Recycle Bin | Preview || Edit H Versions || EPiServer Mail ” Workflow ‘
[Resources] i I save k) Save and View l{g Save and Publish | (3 Cancel &
@

| Content H Scheduling ” Settings || Shortcut || Categories H Favourite Products ” External Links ” Carousel ” Site Configuration |_

[Menu]
[Functional Pages] B Login Advertise Image /Global/Images/produatsRightLogin.ipg |[..]

Footer Cont; 18 . 5
[Footer Container] Link to Login page @

[My Profile]
B Create Account Page Link @
[Content Pages] ¥

[Company Profile] 141 Product Compare Page @
Search Result Page Link @

Shopping Basket Page @

Max Quantity Of Display Entry @ CT:]
My Page Link @

My Wish List Page Link @

Checkout Page

Order detail page @

My order page )

My Settings Page Link @

Checkout Page for Company User @
Company Page @

Members List Page L]

Create Member Page @

Edit Member Page @
Show Page Tree:

= English (United States) - Company Order Details Page @

DN DDoEE DO

Open the home page for editing in Edit mode to change the settings for the different properties. For the
page links, select the appropriate page in the page tree structure and save and publish the page to
update the settings.

Login Advertise Image

Here you define the image to be displayed to the rightin the login page for the site, intended as an adver-
tising space. Select an image in the EPiServer CMS file manager.

Link to Login Page

Defines the login page to be used when visitors log in to the website.

Create Account Page Link

This defines the display page for creating an account when a shopper registers to the website.
Product Compare Page

This setting defines the display page to be used when comparing products.

Search Result Page Link

This setting defines the display page for presenting search results on the website.

Shopping Basket Page

This is the page to be used when displaying a shopping basket.
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Max. Quantity Of Display Entry

Here you define the maximum number of products to be displayed in a product listing. If you have a large
amount of products in specific categories, it might be wise to limit the display number.

My Page Link

This page type displays a snapshot of recent account activities for a customer.

My Wish List Page Link

This setting defines the wish list page to be used when displaying a customers wish list.
Checkout Page

The page to be used when displaying the check out page for a customer.

Order Detail Page

Used for displaying the details for a specific order, when selected from the My Order page.
My Order Page

This page type displays the order history for a specific customer

My Settings Page Link

Here you define the page type to be used for displaying account details for a customer.
Checkout Page for Company User

Used for displaying a checkout page for a company user in the B2B scenario of the sample site.
Company Page

This page type displays a snapshot of recent account activities for a company.

Members List Page

This page type is used for listing company members.

Create Members Page

Here you set the display page for creating a company member.

Edit Member Page

This page type is used for editing the settings of a company member.

Company Order Details Page

This page type displays the details of a company order.

Each of the page types mentioned here are described in more detail in the following sections of this doc-
umentation.

Product Listing

The page type Product Listing is used for listing product information from the product catalog in Com-
merce Manager. The listing will be fetched from the selected product category (node) in the product cat-
alog and will display an image of the product together with information about ratings, reviews and social
plug-in features.

In the left column of the page itis possible to filter the product display according to a preset product cat-
egories. To the right on the page, information related to selected products will be shown. Under the prod-
uct listing, the recently viewed products are displayed.
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The page functionality also includes a product compare option as well as the Add to basket button for
each productin the list. You can define the number of items to be listed per page, and a pager feature
allows for browsing between the listed pages.

-

enoteca

Home Wine

Currently Shopping By

Srice

£100-£3400 - Remave

Cak

Red - Remove
Sf!pE mix: Corving -
Ramove

Claar All

Browse wines

[ style

[E closure

[ alcohol

[El Taste

3 Reglster  Login My profle  English (United States) [7]  Poungstering ]
Your Local Store
753 Tinciount
Rilquam erat
Yu leque varius
Seliciusn @ Your basket
+44 (0)00D0073S Qlemis)  Total £0.00 Checkout ©
Mixed Cases Papular searches B Enter gaarch hare [}
Homa » Wine « lialy

There ara 2 product{s) faund

Recent Reviews
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= 3 thing of beauty.
amay of crushad
ihareal Btyle. AE ..

£255.35

i — b -h
20% off Champagne
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on®

[ compa= ©

quamy: 1 [=]

Agd 1o Wsh s @

Add to baskst 1O

Mithas Amarone dalia Valpolicella, Corte $antAlda, vensio

0 revisw(s)
R

Tha cream af Marinalia's 18na produclon. In 2006 sha rained tack
313d on the French bamigues to dliow tha full majesty of MIhaE 1o
shing; a nichly scented, gargaous wine that, ke ..

£132.80

= compare O

Cuntny: 1 |Z|

A o Weh st 1§

Add to backst 10

@1 ©

Recently viewed praducts

A

3

Vignate la
Casucola,
Chianti ...

E117.00

To define a product listing, create a page based on the page type Product Listing and select the desired
product category (node) in the Catalog Node name field. The categories (nodes) available here are
retrieved from the [Resources] section in the page tree structure which is set up atinstallation. This in turn
reflects what is defined in the product catalog in Commerce Manager.

In the Item Per Page field you can define the number of items to be displayed on each page. The content
of the Bottom Advertise editor field is displayed at the very left-hand bottom of the product listing page.
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0O & 4+ B s B | @ @ @ m @ E
- -
JSlnl(hlre Favorites || My Tasks Mixed Cases ‘ e e | ]
Page Type: [WineStore] Product Listing Status: Published = English (United States) >
B Root folder oy Compare With
@ Recycle Bin [ [~]
[Resources] ‘ Preview || Edit H Versions H EPiServer Mail || Workflow ‘
e Home
H Save kl Save and View {g Save and Publish a Cancel ::;
[Menu] 31
Wine J Content H Scheduling ” Settings ” Shortcut H Categoaries |
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MIZI\'Ed Cases
Catalog Node @ Mixed Cases B
Functional Pages] 14/
[Functional Pages] Item Per Pageo 10
[Footer Container]
Bottom Advertise @
[My Profile] BT -
[Content Pages] ¥ | i 4 [ 0 LA J’) =
[Company Profile] ¥ B J U ===|IZi= —| syles s F o @ Q
Show Page Tree: Path- P |

[ E= Eenglish (United Statesy | = |

Functional Pages

The pages under the [Functional Pages] section in the page tree structure of the sample site holds a
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number of page types with general e-commerce functionality such as login, checkout and search result

presentation. These page types are described more in the following sections of this documentation.

Check Out

The purpose of the Check Out page type is to display the steps of the check out procedure when a cus-
tomer wants to finalize a purchase.The check out procedure is initiated when the customer selects the
Checkout option. The checkout procedure may look differently depending on the payment and shipping

options defined in the system. On this sample site the checkout procedure has four steps: Welcome,

Address, Payment and Confirmation.
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Step |: Welcome

Register Login  Myprofile  English (United States)[~]  Pound stering  [=]
Your Local Store

' 789 Tincidunt

Riiquam erat
Yuisque varius
Sollicitudin @ Your basket

enoteca +44 (0)00000789 Sitem(s)  Total: £535.95

Mixed Casos T3

2. Address 3. Payment 4. Confirmation

Hello,

Have you already got an account with us? Login to use your details. If you haven't got an account, why not
register?

Yes, | would like fo login or register @ No thanks, proceed to check-out @

In this first step the customer has the option to either log in or register to the site, or to proceed directly to
the next step without registering.
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Step 2: Address

1. Welcome 2. Address 3. Payment

Deliver and Billing Address

|. Choose delivery address

Address Title
First Name
Last Name

Company
Email Address
Phone Number
Country
Postcode
Address Line 1
Address Line 2
Town

County

Choose a delivery option

Free delivery (2-3 days)
First class delivery (1-2 days)

Express delivery (1 day)

2. Choose billing address

(Optional)

{Optional)

(Optional)

4. Confirmation
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Here the customer enters name, address and contact details, if these are not already registered in the sys-
tem. If they are, there will be an option to update the existing information. The available shipping options

are selected in this step. It is also possible to chose a different billing address.
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Step 3: Payment

1. Welcome 2. Address 4. Confirmation

Payment
Amarona della Valpolicella Classlco &. Quintaralll, Venato Guantity Prica Total
z £255.35 £510.70
Bardoling Chiarstto D:OC, Monte Del Fra @uantity Price Total
E £875 £26.25
Subtotal E538.95 (EXC. VAT)
shipping coat £0.00 exc. VAT]
‘order discount -£0.00 (232, VAT)
TOTAL to pay E536.95 (exc. VAT]
Payment Method
[0 cm cana
Payment by Gift Card (B30, VAT
Remain to pay (EXD. VAT)

Sy ane payment method below

Update remain to pay ©

@ pay By Phone
‘Z\Pay By CTem Card

e visa B

Card number Name on tha card

Expiry date 1 [w]/ 2010 ] cww

o
fm
5

Here the total order sum is calculated, and the desired payment method is selected. The sample site also
has a giftcard option where the gift card details are entered and the total sum is recalculated based on

this.
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Step 4: Confirmation

1. Welcome 2. Address 3. Payment

THANK YOU FOR YOUR ORDER!

Your order number is PO73397

A receipt has been sent to your email address: mary@somemail.com

The Team

N

5;* .
20% off Champagne @ For every occasion

View our fine wine collection @

View Champagne 0*'

Register with us and you will eam loyalty points!

Legin and Register

The final step contains the order confirmation and displays the order number the customer. Also in this
step an order confirmation email is sent to the customer.

The Check Out page is created in Edit mode and then defined in the site configuration setting of the start
page.

For more information on different payment providers in EPiServer Commerce, please refer to the Payment
Providers section.

Login

The Login page provides a login possibility for both website editors and administrators, as well as reg-
istered customers. A user name and password is required. The page has functionality for password recov-
ery. Itis also possible to log in to the site using Facebook account credentials.

The Login page is also the entrance for registration of new customers to the site. Clicking on the Register
option will take the user to the Create Account page. To register, a name and email address is needed,
together with a user name and a password.
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Register Login My Profile English (United States) Iz‘ Pound sterling EI
Your Local Store

' 1 Park Road

Rickmanswoth
Hertfordshire
WD3 1RE W Your Basket

enoteca (3~ +44 (0)1923 432¢ Ottem(s)  Total £0.00

Home Wine Mixed Cases Popular searches | - | Enter Search Here [»]

Log in or create an account

Registered Customer " Required Fields

If you have an account with us, log in using your username.

Username *
Password *
Forgot your password?
Use your Facebook account to log in. | f connect

New Customers
Register on our site and create your personal profile.

New to Enoteca?
Take advantage of Enoteca's fine wine collections, education resources and special events by

registering. Register ©

Most of the functionality of the Login page is defined in code. However, in Edit mode you will find and
editor field where itis possible to design a welcome message to new users registering on the site.

m CMS Commerce Mail EPISERVER & 7?7 ~ QL admin~ Q
Edit Mode Admin Mode Reports Visitor Groups
O & 4 @ » B @ @ @ D & B
J Structure || Favorites || My Tasks LOQIH | s W= |
Page Type: [WineStore] Login Page S5tatus: Published Version E5 English (United States) I
ﬁii Root folder Compare With
@l Recycle Bin | ‘-|
SRS care ‘ Preview || Edit || Versions || EPiServer Mail H Waorkflow |
e Home
H Save Ll Save and View l:’f; Save and Publish IE:! Cancel ‘:’
2 [Menu] &
Functional Pages] 4 J Content ” Scheduling ” Settings H Shortcut ” Categories ‘
- Checkout
7 Name Login
| Wine Detail Invite New Customer
- Product Comparison o | R % [0 1 (||
- Create Account . B 7 U|l== iZ 1= — | styles - F v £ () Q
- Shopping Basket|.]
[~ Search Result
New to Enoteca?

= Cemrpmy Tz Take advantage of Enoteca’s fine wine collections, education resources and special events by registering

[Footer Container]
[My Profile] ¥
[Content Pages] 4

[Company Profile] 1

Show Page Tree:
| = English (United States) |~ |

Path: p Yy

When created, the Login page must be defined in the site configuration setting of the start page.
Wine Detail

The Wine Detail page is a "product page", and as such plays a central role on this type of site, since itis
used for displaying product details and related information. The page is displayed when a customer
selects a specific product, and will display product information from the product catalog of Commerce
Manager.
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The productinformation is displayed in the center area, with options for comparing, adding to wish list
and buying. Below the product information, any related review or ratings information will be displayed.
The rest of the page is built up displaying other information related to the product. The information is
selected based on type of product and meta data available in the product catalog.

Home = Wine = Haly » Luciano Sandrone

[ compare 4]

Reviews

Fantastic!
admin, February 2012

Quantity

1

Barolo, Le Vigne, Az. Agr. Luciano
Sandrone, Piedmont

Yook 100°%
HLike

Sandrone's dark ruby-colored 2001 Barolo Le Vigne
presents a fantastic nose of flowers, minerals and
crushed raspberries followed by generous amounts
of very ripe red fruits, mint and eucalyptus notes
wiith wel-integrated oak and fine tannins. It is
noticeably more structured than the 2000, with more
balance, freshness and a longer finish. Traditienal in
design, but modern in execution, the 2001 Barclo Le
Vigne presents tremendous harmeny and elegance.
ldeally a few years of cellaring are warranted
although the wine is already drinking well today.
Wine Country: tahy

Color: Red

Style: Haly

Closure: Cork

Grape mix: Nebbiclo

Alcohol: 14

Taste: Dry

egetarians: False

Vegans: False

£117.00

- Add to Wish List €

Add to Basket ©

Thiz wine has a fatastic boguet, you should try it out.

***** Remove €

Italy

The wines of kaly offer breathtaking variety. From bright,
fresh Pinot Grigio to the deep reds of Barolo, ftaly has
something for everyone, especially given our great range
of wines.

Find Out More ©

Thiz wine has & fatastic boguet, you should try it
out. .. w

- admin
Remove 3

I

20% off Ch‘a-ﬁ%gng

Vi o

The Wine Detail page type is linked to the information stored about the product in the product database.
For instance, information such as name, code, catalog image, and display price is collected from the Com-
merce Manager product catalog. The page type contains no editable information.

Compare

The Compare page type holds functionality for displaying selected products for comparison. For each
product you want to compare, you can select the Compare option, which will add the product to the Com-
pare page. This page can then be accessed by clicking the Compare link/button.
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£11.45

Compare Quantity 1 IEI Add to Wish list € Add to basket o

The selected products are listed next to each other together with related product features, for easy over-
view and comparison. You can compare up to four products at the same time. A product can be removed
from the comparison list, or added to the shopping cart or the wish list. The selected products will remain
for display on the compared products page until they are removed or a new product selection is done by

the user.
Compare products
Wine SKU
Remave Ramove g
Earolo, L Wigns, Az Agr. ‘farra Yering Dry Red No.2
Luclane Sandrone, Pledmo nt Shiraz, Yarra Valley, victoria
b8 8.8 8 1 L % 8
£117.00 £51.00
Sanonon='s dark nuby-cokored Pragominantly Shiraz but with
2001 Baralo L2 'JI;ne prese: e a e'rar.tarhg; at b ‘.-1o;nlzr and
famastic noes of fowers, minerals | Marsanne., i of which Imbue a
and cruehad raspbe: e followed | weicome floral nate and 3 tauch of
by GEnerous amournts of very rips lightnaees to the meaty, spicy
rad frults, mint and éL-El},'FﬂLs - power of tha Shiraz. The Inclusion
Quantry: 1 E| Quarity: 1 E|
Add to basket © Add to basket ©
A1 WMEN LISt A0 10 Vich List oy
Earoio, Le Vigna, Az Agr. ¥ama Yering Dry Red No.2
LD Lucizna Sandrone, Aledmont Shiraz, Yara Valiey, Vicloria
styte Italy Australlz
Grape mlx Hebbkle Syrah'Shiraz
Back Remaowe all products from comparson £

The (Product) Compare page holds no information of its own so it has no editor field. When the product
compare page has been created, it must be defined in the site configuration setting of the start page.

Create Account

The Create Account page type provides the possibility to create new customer accounts on the website.
Personal and login information such as name, e-mail and password is entered by the user, and there is
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also an option to sign up for a newsletter.

When the user has agreed to and selected the Terms and Conditions option and clicked on Continue, a
confirmation message will be displayed. The account will be created and the account details are saved in
the customer database of Commerce Manager. Later on account details can be updated from the My Pro-
file option.

Register an account

Personal details

Title  Mr E|

First name Carlos
Last name Santana

Email address  carlos@somemail.com

Your login details

Usemame Carlos
Paszsword sssssss {min & characters)

Confirm password eesssess

MNewsletter (optional)

I would like to recieve enoteca emails.

Terms and Conditions

| agree to the enoteca Terms and Conditions

The Create Account page holds no information of its own so it has no editor field. When the page has
been created, it must be defined in the site configuration setting of the start page.

Shopping Basket

The purpose of the Shopping Basket page type is to display product items that a customer has added to
the personal shopping basket. The page can be accessed from several instances, and the Your basket
view option is always available in the tope menu of the site. The total value is instantly updated when
something is added to the basket.

wWF Your basket
2item(s) Total £19.45 Checkout ©
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The Shopping Basket page provides functionality for changing the quantity of items as well as removing
items from the basket. The promotion code option will apply any discount from a selection of related dis-
count options from the system.

Your basket - you have 2 item(s) in your basket

i Fantasia Torrontes, Bodegas Mauricio Lorca Quantity Price Total Remove
1 £10.00 £10.00 e
e
i Pulenta, La Flor, Sauvignon Blanc, Mendoza (Stelvin) Quantity Price Total Remove
1 £9.45 £945 Q
E
Do you have a promo code? Enter code Aoy O
) . Subtotal £19.45 (exc VAT)
£0.00 discount awarded in this basket
Order discount -£0.00 (exc. VAT)
[x] loyalty points recieved with this purchase. (T ST (T
(Log in to use your points)
Total Order £19.45 (exc VAT)
Update basket © [l Go to checkout ©
Back

O The "Total" value in the shopping basket display does not include promotions.

When the shopping basket information has been changed, clicking Update basket will cause the pricing
information to be recalculated based on the new information. Information about loyalty points will also be
calculated and displayed on the page. Clicking Go to checkout takes the customer to the first step of the
shopping completion procedure.

The Shopping Basket page holds no information of its own so it has no editor field. When the page has
been created, it must be defined in the site configuration setting of the start page.

Search Result

The Search Result page page type is used for displaying the results of a product search performed on
the website. The matching search hits are shown in a listing with product details displayed. From here
you have the possibility to add items to the shopping basket, or add items to the wish list. Clicking on an
item will display the full product information page.

With the Refine your search option in the left column, the search results can be filtered based on cat-
egories.
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Mixed Cases Popular searches. [E3 °

Search Result

All results: Your results (83) - You searched for "riesling”
Refine your search

Category Heggies Vineyard Botrytis Riesling, Eden Valley, South Australia

£12.95
All results (33)
Products (32) - Grown in vineyards planted high up in the Eden Valley, this fabulous sweet Add 1o Wish kst ©
Reviews (0) 3; Riesling is now beginning to show the first stages of maturity as it ages. The Add 1o basket ©
Pages (1) exotic aromas of apricot and peach are
1 White wines
First things first, why is “white” wine, not white at all , but yellow, golden or straw-like in color? It's color can be derived from an
assortment
Ostler Blue House Riesling, Waitaki River, Otago [Stelvin)
£16.95

i;

ik

Add to Wish list @)

Add fo basket ©

Riesling Hochrain Smaragd, Franz Hirtzberger
£40.80
| From the top of the hill above the village of Spitz an incredibly rich and complex Add to Wish list @
3; Riesling; lime, bacon rind, flamboyant acidity and a fulsome palate which is both Add fo basket

flirtatious and yet somehow quite ..

© 123455675809 ©

The Search Result page page holds no information of its own. When the page has been created, it must
be defined in the site configuration setting of the start page.

For more information on how to search in EPiServer Commerce, refer to the Search section of this doc-
umentation.

Company Checkout

The Company Checkout page is used in the B2B scenario, and is similar to the B2C check out page.

1. Welcome 2. Address 3. Payment 4. Confirmation

Deliver and Billing Address

I. Choose delivery address

@ Home Dispaich to this address @
Line 1
PostCede Town
United States

© Work Dispatch to this address @

2. Choose billing address

Different to delivery address €

The Company Checkout page page holds no information of its own. When the page has been created, it
must be defined in the site configuration setting of the start page.
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Standard Page

The page type Standard Page in EPiServer Commerce is used for creating an ordinary information page.
On the sample site you will find it for example under the [Content Pages] and [Footer Container] sections
of the page tree structure.

The page type is quite simple and contains a Heading and a Description field together with an editorial
body. The editor toolbar contains the Product Link tool for creating links to products.

m CMS Commerce Mail EPISERVER & ? ~ L adminv Q
Edit Mode Admin Mode Reports Visitor Groups Live Monitor
O % 4+ & v & | @ @ @ o & E
J Structure || Favorites || My Tasks Rose wines [\
ﬁa T Page Type: [WineStore] Standard Page Status: Published Version [ Z= English (United States) =l

Compare With

i@ Recycle Bin [

[Resources | | Preview ” Edit ” Versions H EPiServer Mail || Workflow ‘

@ tome Esave klsave and View |F2Save and Publish | £ Cancel &
[Menu] ¥
[Functional Pages] 4 J Content ” Scheduling ” Settings H Shortcut ” Categories |
[Footer Container] B
Popular products Name Rose wines

Mixed cases Heading Rosé Wines

Red wines Description  Whether it's rosé, rosado (Spain), rosato (

White wines Main Body

b [l
Top rated wines B7uU = FEE

Our recommendations

Our services
‘Whether it's rosé, rosado (Spain), rosato (faly) or "blush” - these terms all refer to pink wine. This pink shade can range from
About us a soft, subtle hue to a vibrant, hot pink, depending on the grape used and how long the grape skins were in contact with the
Support juice. Rosés can be made in a sweet, ofi-dry or bone dry style, with most European rosés being decidedly dry.
How Does a Rosé get ite Color?
[My Profile] 4 The majority of rosé wines are made from a red grape varietal. The varietals most often used in making a rosé wine include;
Pinot Noir, Syrah, Grenache, Merlot, Malbec, Cabernet Sauvignon, Tempranillo, Sangiovese and Zinfandel. These varietals may|
[Content Pages] 4 be either used solo or in a blend. Rosé varietals are often country dependent, so a rosado from Spain will often be largely
[Company Profile] derived from the Tempranilo and Garnacha grapes, while ltaly may utilize more Sangiovese for their rosatos and the U.S.

would tend to lean towards Cab, Merlot and Zinfandel

Flavor Profile of Rosé Wine

The flavors of rose wines tends to be more subtle versions of their red wine varietal counterparts. The fruit expectations lean
towards strawberry, cherry, and raspberry with some citrus and watermelon presenting on a regular basis.

Path:
Show Page Tree: 4

[E= English (United States) | =

For more information on how to work with the editor field, refer to the user documentation for EPiServer
CMS.
My Profile

In the sample site, the personal user account related information is available from the My profile option at
the very top of the page when the user is logged in.

Welcome, Carlos Log cut My profile English {United Slales}E Pound sterling E|

The information is contained in a set of pages organized under the My Profile view.

My Profile

Address Book
My Orders
My Page

My Settings
Wish List

The personal account related pages are stored under the [My Profile] container page in the page tree.
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i@ Rootfolder
@ Recycle Bin

[Resourcesf i

a Home
[Menu]
[Functional Pages] ¥
[Footer Container] B3
[My Profile]

~ Address Book

- My Orders

~ My Page

— My Settings

— Wish List

= Order Detail [

z [Content Pages] ¥
[Company Profile]
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These pages are based on specific page types with functionality for extracting personal customer infor-

mation from the customer management part of Commerce Manager. The page types hold no editorial
information of their own. After they have been created, all the pages except Address Book must be

defined in the site configuration setting of the start page.

Address Book

The Address Book page holds functionality for adding, displaying and deleting address information for a

user account. Multiple addresses can be added, and different shipping and billing addresses can be

used. Specific addresses for billing and shipping can be set as default, and will be used in the checkout

process.

New Address

Address Title
First Name
Last Name

Company
Email Address
Phone Number
Country
Postcode
Address Line 1
Address Line 2
Town

County

Home
Carlos
Santana
{Optional)
carlos@somemail com
123456789
United States [~]
123868
1 Main Street
{Optional)
Sun City
{Optional)

Use as my Default Biling Address
Use as my Default Shipping Address

£N EZR
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The address information is displayed as part of the information under My Profile for the user account.

My Profile

Address Book Address Book

My Orders
Add new Address °
My Page

My Settings
Wish List 11
Default Billing Address
Carlos Santana

1 Main Street

123588 Sun City

United Stafes

Default Shipping Address

Carlos Santana
1 Main Street
123888 Sun City
United States

123456789 123456789
Edit @ Edit @
My Addresses
o Carlos Santana, 1 Main Street, Sun City

Edit Address €3 Delete Address €3

0 Carlos Santana, 1445 Sun Beach Lane, Harbour City Edit Address @) Delete Address €3

My Orders

The purpose of the My Orders page is to display the order history for a user account. The order infor-
mation is collected from the customer management part of Commerce Manager, and is displayed as part
of the information under My Profile for the user account.

The Order History overview displays the order ID number, creation date, receiver, and total order amount
and status.

Clicking View Order will display further order details for the selected order. The options here are
described in the Order Detail section. Clicking Reorder in the Order history view will initiate the creation
of the exact same order.

My Profile
Address Book Order History
My Orders
My Page Order ID Created Ship to Total Status
My Settings
P0O89491 February 15. 2012 Carlos Santana £1,439.45 InProgress View Order @) Reorder £3

Wish List

The My Orders page holds no information of its own. When the page has been created, it must be
defined in the site configuration setting of the start page.

My Page

The My Page page provides an overview of the personal account information, with user data and product
reviews added by tthe user. The My Page information is displayed as part of the information under My Pro-
file for the user account.
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My Profile
Address Book
TR Carlos Santana
My Page Full Mame: Carlos Santana
My Settings Email: carles@somemail.com
Wish List

Edit settings

Reviews

Avoid this!
Wednesday 15 February 2012

This should be avoided, particularly this bafch, something went wrong here.

Posted in: France

Wonderful!
Wednesday 15 February 2012

This is a great wine, strongly recommendead.
Posted in: France
Wiew all reviews o

Clicking Edit settings allows for editing of the account information. The settings here are described fur-
ther in the My Settings section of this documentation.

Edit Account Information

Account details

Title Mr E

First Name Carlos
Last Name Santana
Email Address carlos@somemail com

Change Password [ |

Profile details

| would like to receive newsletter and offers from Enoteca_com

D Please e-mail me offers from third parly companies

(sove 0 [l Goreol ©)

The My Page page holds no information of its own. When the page has been created, it must be defined
in the site configuration setting of the start page.

My Settings

From the My Settings page a customer can update the user name, e-mail address and password for the
account. From here it is also possible to sign up for newsletters and third-party information.
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Edit Account Information

Account details

Title Mr E

First Name Carlos
Last Name Santana
Email Address carlos@somemail.com

Change Password |:|

Profile details

I would like to receive newsletter and offers from Enoteca com

D Please e-mail me offers from third parly companies

(sovo o Jll Corol ©

After creation the My Settings page must be defined in the site configuration setting of the start page.
Wish List

The Wish List page functionality displays product items in a personal wish list for a customer. The items
are added to the list when the customer clicks on the Wish List option for a product.

£11.45

Compare i@} Quantity 1 IEI Add to Wish list € Add to basket ©

The wish listitselfis accessed when from the My Profile option at the very top of the page.

My Profile

Address Book Wish List

My Orders
My Page Masseto, Tenuta di Ornellaia Marchese Ludovico £304.00 Fero= @

My Setlings Antinori

Wish List

The estate’s 2007 Masseto is fabulous. Loads of black
cherry, blackberry and cassis are infermingled with minerals
violets and French oak. This is an especially sensual

Masseto that impresses ... Quantity: 1 |z| Add to basket @
L'Ermita, Alvaro Palacios £427_90 Remove €3

100% Gamacha in 2006, L'Ermita is made from 60-100 year
old vines, farmed at 15 hi/hectare and then aged for 18-19
months in new French barrels. 20086 is the first time that the

wine is made RN LA i to basket ©

The Wish List page holds no information of its own. When the page has been created, it must be defined
in the site configuration setting of the start page.

© EPiServer AB



Sample Site | 247

Order Detail

The Order Detail page displays order details for a selected order. The page is displayed when clicking
View Order from the order history overview on the My Orders page under My Profile.

The information displayed includes contact details, address and payment information, shipping address
and methods, product quantity and price, as well as the total order sum including taxes and any dis-
counts. All of this is retrieved from Commerce Manager, and can only be viewed.

Order details - posg49

Order numder: PO89491

Order Date: 2/115/2012 4:26:53 PM
Order Email: carlosi@somemail.com
Status: InProgress

Billing Address Payment Information
Carlos Santana Method(s):
1 Main Street Pay By Phone (Processed)

123888 Sun City
United States

Split Shipment - Part |

Name Total
Qty Price Discount Total
Pulenta, La Flor, Sauvignon Blanc, Mendoza (Stelvin) 1 £9 .45 £0.00 £9.45
Ch. d'Yquem, Sauternes 3 £410.00 £0.00 £1,230.00
Vieux Chateau Certan, Pomerol 1 £200.00 £0.00 £200.00
Subtotal

Shipping Address Shipping Method(s) SEEKD (SR
Carlos Santana 1 package via: Shipping & Handling £0.00 (exc. VAT)
1 Main Street Free delivery (2-3 days)

123888 Sun City Taxes (VAT) £0.00

United States

Order discount £0.00 (exc. VAT)

s Wish-List/ ¥ Total Order £1,439.45

Company Profile

In the B2B scenario of the sample site, the Company Profile pages are used for displaying account infor-
mation for a company with associated users. Through a company account, companies can add their
employees as users, and deliveries can be shipped to multiple addresses.

As for users in a B2C scenario, the company account related information is available from the My profile
option at the very top of the page for the company account administrator when this user is logged in.

Welcome, Carlos Log cut My profile English {United Slales}E Pound sterling E|

The company information is displayed using the Company Page page type. Refer to the Managing Com-
pany Accounts section for more information on how to set up company accounts.
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The company account related pages are stored under the [Company Profile] container page in the page
tree.

J Structure ” Favorites ” My Tasks

& Root folder
@l Recycle Bin
[Resources]
@ Home
[Menu]
[Functional Pages] 4
[Footer Container] ¥
[My Profile] T
[Content Pages] 1+
- Company Order Detail
— Edit Member
~ Create Member

- Members List

= Company Page

These pages are based on specific page types with functionality for extracting company account infor-
mation from the customer management part of Commerce Manager. The page types are only used for dis-
play and hold no editorial information of their own. After they have been created, all pages must be
defined in the site configuration setting of the start page.

Company Page

The Company Page provides an overview of information related to a specific company. The page can be
accessed by the company account administrator when logging in and selecting the My Profile option at
the top of the page. If the user is a company account administrator, the Company Page will be displayed
by default.
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Members

Mary Smith

Member Since: 23 Feb 2012

Carlos Santana

Member Since: 23 Feb 2012

Lisa Jones

Member Since: 19 Mar 2012

Mansge Members &

Members Latest Comments

& & Although is should be taken a little cooler
than it actually says on teh bottle, be

aware!

Carlos Posted in: Italy
Mondzay 19 March 2012

&G ..trythis out!

Carlos Posted In: Argentina
Wednesday 29 February 2012

View All Reviews ©
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Company XYZ

Business Category: Food & Dining
Members: 3

Mondzy 19 March 2012
PO2867E

Monday 19 March 2012
PO26407

Mondzay 19 March 2012
PO18533

Monday 27 February 2012
PO17865

£378.00

£122.25

£233.38

£338.89

The page is built up of several sections. On the upper left side, a list of all members associated with the

company account will be displayed. Selecting Manage Members here will display the Member List page,
from where members and member information can be managed. In the lower left part, product comments
and reviews added by members are listed.

The top main section displays company account information. Here, the Edit Settings option provides a
possibility for the company account administrator to edit the account settings.

Edit Company Details

Company Name

Business Category

Monday 19 March 2012
PO23678

Monday 19 March 2012
PO26407

Company XYZ

Food & Dining

[ Mo Value ]

Arts & Entertainment

Automotive

Business & Professional Services
Clothing & Accessories
Community & Government
Computers & Electronics
Construction & Contractors
Education

Health & Medicine

Home & Garden

Industry & Agricutture
Legal & Financial

WMedia & Communications
Personal Care & Services
Real Estate

Shopping

Sports & Recreation
Travel & Transportation

Settings that can be edited are the Company Name and the Business Category that it belongs to. Select
Save to save the changes.
The middle part of the page displays a listing of recent orders for the company account. The order date,
number, and total order sum is shown. Clicking an order number will display further order details using

the Company Order Detail page.
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The Company Page page holds no information of its own. When the page has been created, it must be
defined in the site configuration setting of the start page.

Company Order Detail

The Company Order Detail page displays order details for a selected order. The page is accessed when
selecting an order in the Orders list of the Company Profile overview page.

Company Profile

Order Details - roisssz

Order Number: PO15533

Order Date: 192012 3:539:30 AM
Order Email: mary@somemail.com
Status: InProgress

Billing Address Payment Information
Mary Smith Method(s):

Company XYZ Pay By Phone (Processed)
1 First Strest

£1818 Hometown

United States

Splic Shipment - Part |

Mame Total

Gty Price Discount Total

Ch. Suduiraut, Sauternes

O The information here is read-only, it is not possible to update any order information from here.

The Company Order Detail page holds no information of its own. When the page has been created, it
must be defined in the site configuration setting of the start page.

Members List

The Members List page provides an overview of members associated with the company account. The

listis displayed when the company account administrator selects the Manage Members option in the left
column of the Company Profile overview page.

Company Profile

Members

Mary Smith
Member Since: 23 Feb 2012

Carlos 5antana
Member Since: 23 Feb 2012

Lisa Jones
Member Since: 19 Mar 2012

Msnsge Members &

U

From the Members List, the company account administrator can create new members associated with
the account, edit information for existing members, and delete existing members from the account.
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Create 2 Member

Carlos Santana

Lisa Jones

Mary Smith

First Name

Carlos.

Lisa

Mary
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Last Hame

Santana Edit @ Delete €
Jones. Edit @ Delete €3
Smith Edit @

O The company account administrator cannot be deleted from here, this information must be
changed by an administrator in Commerce Manager.

The Members List page holds no editorial information of its own. When the page has been created, it
must be defined in the site configuration setting of the start page.

Create Member

The Create Member page provides a possibility for the company account administrator to add members
to be associated with the company account. The Create Member page can be accessed by the company
account administrator by selecting the Create a Member option in the Members List page.

Company Profile

Create Members

Title

First Hame
Last Mame
Email Address

Username

Password

Confirm Password

Ms

Lisa

Jones

liss@somemail.com

Liza

(min & characters)

Enter information in all fields and click Save when done. The member will be added to the company
account, and will be able to log in with the credentials provided.

The Create Member page holds no editorial information of its own. When the page has been created, it
must be defined in the site configuration setting of the start page.

Edit Member

The Edit Member page provides a possibility for the company account administrator to edit the settings
for an individual member of the company account. The Edit Member page can be accessed by selecting
the Edit option in the Members List page.
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Company Profile

Edit Members Al fields are required

Address Book
Tile Ms -

Add Mew Address ©

FirstName  Lisa
Default Billing Address Default Shipping Address

LastName  Jones
Lisa Jones Lisa Jones

Email Address  lisa jones@mail. com
= - . 45 Main Street 45 Main Street
LR 681234 Shiptown 681234 Shiptown
United States United States
123456788 123456788
Edit @ Edit @

My Addresses

(+] Lisa Jones, 45 Main Street, Shiptown Edit Address @) Delete Address €3

The following information can be edited from here:

e Personal information for the company account member - name, e-mail address and resetting of
the password. Click Save to update the changes.

e Default billing and shipping addresses used by the account member. Addresses can be edited
and deleted, and the same information can also be updated by the individual member from the
User Profile pages.

The Edit Member page holds no information of its own. When the page has been created, it must be
defined in the site configuration setting of the start page.

Tools and Plug-ins

In this section we describe a number of tools and plug-ins for EPiServer Commerce. These are for exam-
ple a plug-in for the EPiServer CMS Editor making it possible to select product details directly from the
product catalog. The plug-ins described here are all included by defaultin the EPiServer Commerce sam-
ple site.

Product Link Tool

The Product Link Tool is a plug-in to the EPiServer CMS 6 Editor. The tool adds a new function to the tool-
bar allowing an editor to link content to products in the product catalog in Commerce Manager. When the
link is clicked on, the visitor will be transferred to the product page "view mode" for that product.

Adding a Product Link
You can add product links to text, files orimages in an EPiServer CMS page.
1. In Edit mode, select the text, files or images where you want to add a link to a product page in the
product catalog.
2. Selectthe Insert/edit Product Link tool in the toolbar of the Editor.

3. When clicking the button in the Select Product field, the product picker dialog will open. When
you expand the catalog tree on the left, related products will be displayed. You can browse the
structure and select products. The product display can be sorted by clicking on product ID or
Name. You can also search for a product by entering free text or product ID. Select a productin
the list and click Select.

4. In the Language field you can choose to select the desired language version for the product page,
or let the system decide by selecting Automatically.
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5. Enter the details for the link such as title and target frame, just as you would for any link in EPiS-
erver CMS. Click OK.

6. The productlink will be displayed in the Editor.

CMS Commerce Mail EPISERVER & 7?7 ~ AL admin~
Edit Mode Admin Mode Reports Visitor Groups Live Monitor
0O & + B v % @ @ @ B & E
J Structure || Favorites || My Tasks White wines [egaV=n |é English (United States) |v|
BE Root folder Page Type: [WineStorel Standard Page Status: ished Compare With | [=]
i Version a8 htlp:f/enute:a.ep\server.curru‘[dit.’llruductplcker/Pmduclelo’...l =& éj
il Recycle Bin -
[Resources] | Edit ‘@ http:-_-'snntsca.epi;erver.mm-’Etlit-'PrctluctP\tkEr-Pl'cductLink-'PrctludLmlr,Plcpsr‘
Hsave ElSavel 73
O s Producr Link
[Menu] &1 Content
[Functional Pages] Information
[Footer Container] & Name Link title Chardonnay type
Popular products LSdisg Target frame
Mixed cases Description
Red wines e
Main Body Link target
5 3
LY S Select product @) |
Rose wines
= Language i -
TR e B I U = guag Automatically
Our recommendations ’ﬁ
BT e ES First things first, wi a2
from an assortmen
About us yelowish colored g
< White Wine Glass I:I
Leem ‘White wines beg a| =
. glasses, as the sh, 1
; 4
[My Profile] & Optimum white winl
[Content Pages] ¥ White Wine Varietals
“The Big Eight™ when it comes to white wine varietals are: Chardonnay, Sauvignon Blanc (also called Fumé Blanc), —
[Company Profile] B

Riesling, Gewurztraminer, Pinot Gris/Pinot Grigio, Semilon, Viegnier, and Chenin Blanc.
Common White Wine Flavor Descriptions

Citrus

Apple

Pear

Grapefruit S
Path: p Y

Show Page Tree:
| =S Eenglish (United States) |~

EPiServer Commerce supports permanent links, meaning that when a product is renamed the
URL will be remembered and will not be broken.

Editing a Product Link
1. Selectthe link and choose the Insert/edit Product Link tool in the toolbar. This will open the Prod-
uct Link dialog.

2. Editthe link options as desired and click OK to save your changes.

Removing a Product Link

Select the link and click the Unlink tool in the Editor toolbar. This will remove the link from the selected
text.

The tool buttons in the editor toolbar can be customized, for instance you can change the
grouping and orders of the buttons. This is done from the EPiServer CMS administration inter-
face and is described in the Configuring the HTML Editor section of the EPiServer CMS user
documentation.

Product Dynamic Content

The Product Picker Dynamic Content function is used for displaying products as dynamic content. In
Edit mode in EPiServer CMS, the editor can use the function to display product information from the prod-
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uct catalog. This adds to the many possibilities with dynamic content, where you can reuse and display
contentin multiple places on the website, but will only need to update the information in one location.

Adding Product Information as Dynamic Content

Do the following to add product information as dynamic content to a page:

1. Open the page for editing in Edit mode and place the cursor in the editor where you want to add
the information.
2. Selectthe Dynamic Content tool in the toolbar.
3. Select Product picker in the Select plug-in field. The product picker fields will appear in the Set-
tings section.
4. In the Select product field, click the button to select a product from the Commerce Manager prod-
uct catalog.
The product picker dialog will appear, and you can select a product or a product category by
expanding the product category tree, or searching in the search field. Select the desired product
and click Select.
5. The product display template is defined in the Select display path (can be changed here if
needed).
6. Click OK. A dynamic content box will appear in the editor. Save your changes and view the result
in preview or view mode.
Start CMS Commerce EPISERVER © 7 ~ QL admin~ Q
Edit Mode Admin Mode Reports Visitor Groups Live Mo
O & 4 B y & @ @ @ B & 2
J Structure || Favorites || My Tasks White wines fauciics: ‘E English (United States) Ihd
Page Type: [WineStore] Standard Page Status: Published Compare With | [=]

& Root folder

:

@ H

:

™

Show Pag

@ Recycle Bin

[Resources] i

[Functional Pages] I+

[Footer Container] Name White wines
Popular products Heading White wines
Mixed cases Description White wine differs from red wine in, first a
Red wines Main Body
5 -
&= * (0 0 =
Rose wines
== =|:= i= — - e Wi |
Top rated wines B 71U E==icic Styles o [ Q .
T e {2 Dynamic Content - Windows Internet Explorer = | O S
Enr eI fFri;s::‘iahri‘ﬂ @& http://enoteca.episerver.com/app/CMS/Editor/Dialogs/DynamicContent.aspxtid=27_27&parentld=24¢
About us ellowis| &
¥ Dynamic Content
Support
Type -
. 11
[My Profile] 3 White
[Content Pages] ¥ White w Product picker k
lasses,
[Company Profile] ¥ gUptlmum Page property m
White ?
“The Big
Riesling,
Commg)
Citrus
Path: p
\

Version

| Preview H Edit ” Versions ” EPiServer Mail ” Workflow ‘

H Save ‘\.3 Cancel

Li Save and View [f_% Sawve and Publish

(S

ome

enu) J Content || Scheduling H Settings || Shortcut H Categories |

e Tree:

| = English (United States)

=
[=]

@

You can also personalize dynamic content, and display customized information to different vis-
itor groups. Find out more under the Personalization section.

Editing Dynamic Content for a Product

Do the

following to edit dynamic content for a product:
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1. Open the page for editing in Edit mode and place the cursor in the editor where you want to add
the information.

2. In the dynamic content box, select the Edit option. The product picker dialog will appear, and you
can selected another product or product category. Click OK when done.

3. Save your changes and view the resultin preview or view mode.

Removing Dynamic Content for a Product

Do the following to remove dynamic content for a product:

1. Open the page for editing in Edit mode.
2. Selectthe dynamic content box and press Delete on your keyboard.

3. Save your changes to the page.

Gadgets

A gadgetis a small application which can be displayed on the EPiServer OnlineCenter dashboard for
quick access. EPiServer OnlineCenter comes with a number of predefined gadgets, for example, viewing
form postings and changed web pages, but there are also gadgets that are specific for each EPiServer
product. Read more about gadgets in EPiServer OnlineCenter and how to use them, see the EPiServer
Web Help.

You can use some of the gadgets in iPhone or iPad, see EPiServer Mobile Center.

You can also develop and customize your own gadgets to suit your needs, see the technical doc-
umentation on EPiServer World.

Gadgets that are specific for EPiServer Commerce are described in the following.

Commerce Orders Gadget

The Commerce Orders gadget displays orders statistics in the form of a sales graph and a list of pur-
chase orders in a time interval of your choice.

Do the following to add and configure the Commerce Orders gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.
2. Selectthe Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Commerce Orders
gadget by clicking on itin the list. The gadget will be displayed on the dashboard. By default, it will
be updated to display new data every 30 seconds.

4. To update the refresh interval, select Edit in the drop-down menu of the gadget, and enter a new
time interval. Click OK to save you changes.

Start CMS Commerce
Add Gadgets...
Add Gadgets
Commerce Orders Commerce
Owverview
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When the Commerce Orders gadget has been added to your dashboard, you will be able to easily mon-
itor sales activities for your EPiServer Commerce website.

Commerce Overview Gadget

The Commerce Overview gadget shows sales data from the e-commerce system. The data is grouped
by products, categories, orders, customers and promotions.

Do the following to add and configure the Commerce Overview gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.
2. Selectthe Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Commerce Overview
gadget by clicking on itin the list. The gadget will be displayed on the dashboard. By default, it will
be updated to display new data every 30 seconds.

4. To update the refresh interval, select Edit in the drop-down menu of the gadget, and enter a new
time interval. Click OK to save you changes.

Commerce Overview [*] =

Settings Edit
Refresh Interval in secands 30 “

When the Commerce Overview gadget has been added to your dashboard, you will be able to easily mon-
itor sales data from your EPiServer Commerce website.

Comment Approval Gadget

Users logged on to the sample site can add comments (reviews) to products on the site. The Comment
Approval gadget makes it possible for EPiServer Commerce administrators and editors to manage com-
ments that are left by website visitors. This gadget provides an overview of the commenting status, and
you can view, approve or delete comments from here.

Do the following to add and configure the Comment Approval gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.
2. Selectthe Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Comment Approval
gadget by clicking on itin the list. The gadget will be displayed on the dashboard.

4. By selecting Edit in the drop-down menu of the gadget, you can set the number of approval items
to display, as well as the length of the description.

5. Click OK to save you changes. The gadget will be displayed on your dashboard.
Do the following to use the Comment Approval gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu and select the Dash-
board tab under which the Approval gadget is located.

2. You can chose to view all comments, or filter them according to their status - Approved, Pending
or Deleted. Click Refresh to update the listif needed.
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3. Selectone or more comments for which you want to update the status, by clicking the checkbox to
the left of each comment. Click the top left checkbox to select all comments displayed in the list.

4. Select the status you want to apply - Approve, Mark Pending or Delete. For instance, select
Approve to approve the selected comments.

Comment Abuse Report Gadget

The Comment Abuse Report gadget makes it possible for EPiServer Commerce administrators and
editors to manage comment abuse reports that have been created by website visitors. This gadget pro-
vides an overview of abuse reports, and you can remove selected comments from here.

Do the following to add and configure the Comment Abuse Report gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.

N

Select the Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Comment Abuse
Report gadget by clicking on itin the list. The gadget will be displayed on the dashboard.

>

By selecting Edit in the drop-down menu of the gadget, you can set the number of items to display,
as well as the number of abuse reports to be displayed for each comment.

5. Click OK to save you changes. The gadget will be displayed on your dashboard.
Do the following to use the Comment Abuse Report gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu and select the Dash-
board tab under which the Comment Abuse Report gadget is located.

2. Selectthe comments you want to manage by clicking the checkbox to the left of each comment.
Click the top left checkbox to select all comments displayed in the list.

3. Click Remove Comment to remove the comment. Select Ignore to leave the comment without any
actions.

Commerce Settings for CMO Gadget

With EPiServer Campaign Monitor and Optimization (CMO) you can measure and monitor campaigns
on your website and optimize your landing pages. EPiServer CMO provides a simple way to analyze cam-
paigns and landing pages, rather than whole sites. Find out more about EPiServer CMO in the user doc-
umentation on world.episerver.com.

EPiServer CMO can also be used for monitoring activities on an EPiServer Commerce site. You can for
instance monitor the number of views or orders for a specific product or product category. The logging of
Commerce KPI data is supported using the Generic KPI function in CMO. The number of orders is an
example of a generic KPI. This allows for external applications such as Commerce to send notifications
using a specific application key. The application names and keys are defined in EPiServer CMO, which
will then listen for incoming notifications with these specific key values, and collect and store the data.

The following procedure applies when setting up the integration between CMO and Commerce:
e Setup the web services to be used by EPiServer CMO and the corresponding URL to be used.
e Define the external applications, their application names and keys, in EPiServer CMO.

e Define the product views and/or product orders you want to monitor, using the EPiServer Com-
merce Settings for CMO gadget. Here you will need the application keys and the URL for the
CMO Web Services.

e In EPiServer CMO, create a campaign and add the generic KPI for EPiServer Commerce.

e EPiServer Commerce will update the KPI value using web services.
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e The monitoring result will be displayed on the campaign report page in CMO, or by using the
CMO KPI Summary gadget for EPiServer Commerce on the site that has the EPiServer CMO serv-
ice installed.

EPISERVER & 7? - A Administrator > Q

Overview LPO Campaigns Settings

¥ Settings External Applications @
General
Dara Aggregation H save £ Cancel
Security
Page Thumbnails
Live Monitor
External Applications Application Name Application Key Is Used Edit Delew

Web shop orders 23456 Yes &3

The collected data for EPiServer Commerce is defined in the EPiServer OnlineCenter using the Com-
merce settings for CMO gadget, as described in the following.

O To use this gadget you need to have both EPiServer CMO and EPiServer Commerce installed
on your website.

Adding the Commerce Settings for CMO Gadget

When you add and configure this gadget, you can choose to monitor activities for a selection of product(s)
or order(s).

Do the following to add and configure the CMO gadget for EPiServer Commerce:

1. Open the EPiServer OnlineCenter for your website(s) and select Add Gadgets.
2. Click on the Commerce setting for CMO gadget to add it to your dashboard.

3. Click Add to define the monitoring parameters.
4

Select Type, choose either Product View or Product Order. The Product View will define views of
a product or all products under a specific category (node). The Product Order will define orders for
one selected product or all orders of products under a specific category (node).

5. In the Product/Category field, choose a product or a category by selecting an option in the tree
structure on the left hand, and click Search in the area to the right. Select a product in the search
list and click Select. Or, you can select an entire category (node). You can also search directly for
a product name or ID. Click Select to add your selection.

6. Inthe Application Key field, enter the application ID (defined in EPiServer CMO).
7. Inthe URL for CMO Web Service field, enter the URL to be used by CMO for the web service
(defined in EPiServer CMO).
Editing Commerce Settings for the CMO Gadget
Do the following to edit a set of settings for the CMO Gadget:
1. Open the EPiServer OnlineCenter Dashboard, and navigate to the Commerce settings for CMO
gadget.
2. Click the Edit icon for the settings you want to edit.
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3. Update the settings information, please refer to the section about adding the Commerce settings
for CMO gadget.

4. Click OK to save your changes.

Deleting Commerce Settings for the CMO Gadget
Do the following to delete the settings for the CMO Gadget:
1. Open the EPiServer OnlineCenter Dashboard, and navigate to the Commerce settings for CMO
gadget.
2. Inthe check box to the left, select the set of settings you want to delete.

3. Click the Delete button and click OK to confirm.

Faceted Navigation

Faceted navigation is a feature allowing user to quickly navigate through many kinds of filters in product
listing, for instance color, price range or taste. The faceted navigation feature is available on the EPiS-
erver Commerce sample site when selecting "Wine" or "Mixed cases" in the main menu.

Home Wine Mixed Cases

Home » Wine » hkaly

Currently Shopping By

Price: £10-£20 - Remove There are 30 productis) found
Clear Al
Derthona, Colli Tortonesi, La Colombera, Piedmont
Browse Wines 0 Review(s)
Color Hcil
=
Style The wines from Colombera are an exciting find. Made using the
Closure indigencus local grape Timorasso, arguably the region’s finest white
varietal, this is a bone dry, refreshing atternative to the ...
[£] Grape mix
o £15.35
Nebbiolo (2)

Barbera (3)
Sangiovese (5)

Timorasso (2) [[] Gompare L] Quantity: 1 A
Muscat (1} —

Corvina (1) Add to Basket ©

Primitivo (1)

Pelaverga (1)
Nerello (1}
Verdicchio (1)
Dolcetto (3}
Garganega (1)
Cortese (1)

Barbera d'Alba, Cru Serraboella, Az. Agr. Cigliuti, Piedmont

0 Review(s)
Eails

For those who love thick, unctuous Barbera made in a fruit forward,

Arneis (1)

. . mind-Blowing style, egged on by a hot vintage then here's your
Fiano (1}

wine.
Alcohol

£19.25

Taste

The product listing in the main area will be filtered based on the selections done by the user in the left
menu. This offers a powerful way of guiding the user to the desired products in the product catalog. The
faceted navigation can be easily customized through configuration, refer to the EPiServer Commerce
Developer Guide for more information.
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Tag Cloud Management

"Tags" are words describing the content of a website. Tags can be displayed in "tag clouds" to provide a
visual depiction of what's popular on a site. In EPiServer Commerce tags are used to provide a list of pop-
ular searches generated by users when searching for a product on the site. The search tags are dis-
played under the Popular searches part of the main menu. Selecting a word in the list will display
products where the specific search tag applies to the product description..

Popular searches [E3 Enter s=arch here

The EPiServer Commerce sample site comes with a tag cloud plugin for managing the tag cloud. This is
accessed from the Action Window of EPiServer CMS. From the Tag Cloud Management section in the
Action Window, you can manage the tag cloud listitems, and perform tasks such as updating the name
and hit count for a tag, or delete a tag.

Listing tag cloud items

1. In EPiServer CMS Edit mode, open the Action Window.

2. In the Action Window, click Tag Cloud Management. A list of existing tag cloud items will be dis-
played.
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Action Window

Search for tag:
MName & Hits Delete Edit
769309 1 F 4 &7
A Chavy 1 x 4
barolo 1 b4 F
bordeaux 1 b4 &7
chavy 1 i &7
dry 1 b4 F
fine 1 i F 4
fruity 1 Fd &
Margaux 1 i F
merlot 4 i r 4
mixed 4 Fd &
pulenta 4 i 7
riesling 1 x F
sauterns 1 F 4 7
wine 5 i 7
world 3 b4 7

Sorting the tag cloud list

The tag cloud list can be sorted by tag name or by hit count. Click column headers Name/Hits to sortin
ascending or descending order.

Searching for a tag

To search for an existing tag, enter part of or the full tag name, in the Search for a tag field at the top of
the tag list.

Updating a tag
To update a tag, click the Edit symbol next to the tag in the tag list. You can change the tag name and you

can update the hit count number for the tag. Click Save to update the changes. Note that each tag must
have a unique name.

Deleting a tag

To delete a tag, click the Delete symbol next to the tag in the tag list. Click OK to confirm the deletion.
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Personalization

The personalization feature in EPiServer CMS allows you to create adapted content that will be displayed
to targeted Visitor Groups. Based on user information collected when visitors access your website, dif-
ferent content will be shown to different visitor groups of your choice. You can for instance display dif-
ferent content to first time visitors and returning visitors on your website. The personalization feature is
described in detail in the user documentation for EPiServer CMS.

The EPiServer Commerce sample site features a number of predefined visitor group criteria customized
for an e-commerce site where you want to adapt content based on products and order information. Visitor
groups can be applied to the various content on your EPiServer Commerce site, thus creating a per-
sonalized website visitor experience.

The visitor groups and their associated personalization criteria can be accessed by clicking CMS in the
global menu, and then selecting Visitor Groups in the submenu displayed. Or, you can right-click in View
mode and select Visitor Groups in the EPiServer CMS right-click menu.

The personalization criteria for EPiServer Commerce are available under Commerce Criteria when you
click Add to define visitor groups for your site. The various criteria can then be dropped into the con-
figuration area.

CM5 Commerce E
Edit Mode Admin Mode Reports Visitor Groups Live Monitor

Create Visitor Group @

Adapt content on your website by first creating visitor groups and then using the groups to target the content on pages.

Criteria
Commerce Criteria

Match Al [=]

T e e e e P S P S S s Customer Properties

: Drop new criterion here : Order Frequency

: Total Spent : Product in Cart or Wish List
77777777777777777777777777777777777777777 I Match visitors who have a specified order total within i’ e
Other Infarmation a specified number of days. .

Total Spent

MName

Notes -

Security role [T] Make this visitor group available when setting access rights for pages and files. Sonln T ETS

Statistics Enable statistics for this visitor group Site Criteria

Time and Place Criteria

URL Criteria

Visitor Groups

The predefined personalization criteria for EPiServer Commerce are described in more detail in the fol-
lowing.

Customer Properties Criteria

With the Customer Properties criteria you can personalize content based on for instance age and geo-
graphic location.

Personalize content based on the following information (select from drop-down list):

e Date of Birth - define an age range by entering a from/to date. Select a date in the calendar or
enter a date directly in the field (default format mm/dd/yyyy).

e Customer group - select one of the existing groups Customer, Partner or Distributor.

e Registration source - enter the source of registration in free text format.
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Country - select a country from the list.

Region code - select a region code based on the address region in addresses.

Address postal code - based on state selected, select a postal code from the list.

State - select a state from the list.

O Only one property type with a related value can be selected for a criterion, but several Cus-
tomer Properties criteria can be defined for a Visitor Group.

Order Frequency Criteria

With the Recent Orders criteria you can identify customers that have placed an order in the store" X"
times in the last"Y" days.

Personalize content based on the following information:
e Order times - select the number of times an order has been placed.

e Number of days - select the number of days.

Product in Cart or Wish List Criteria

With the Products in Cart or Wish List criteria you can identify shoppers that have placed a product of a
certain type or brand in their cart or on their wish list.

Personalize content based on the following information:
o Specified product code - enter the desired product code in free text format.
e Product from a specified category - select the desired product category from the list.

e Product has a specified property and value - enter the desired product property and value, for
instance "brand" and "Sony".

O Only one property type with a related value can be selected for a criterion. However, you can
add several criteria of the type "Products in Cart or Wish List" to a Visitor group.

Recent Orders Criteria

With the Recent Orders criteria you can personalize content for visitors that have placed an order on the
site in the last "X" days.

Personalize content based on the following information:

e Number of days - select the number of days.

Total Spent Criteria

With the Total Spent criteria you can personalize content for visitors that have spent "X" amount of money
(in a specified currency) on the site in the last"Y" days.

Personalize content based on the following information:
e Spent at least - select amount and currency.

e Select number of days.
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Social Features

Facebook Integration

The EPiServer Commerce sample site has a built-in Facebook integration, allowing users to share "lik-
product catalog. This is a powerful way to promote the marketing of products in

ings" of any productin the

one of the largest social community networks.

-
Berrys' 5t Ei

ELike

Good St Emilig
hints of berng
finish with

GOrgenus pel
black cherry

ST

@ htlps:ﬂmw.facebook.com’?api_key:12??6'00TZS?ﬁlﬂ&ski...blﬂu
el

f Facebook

Log in to Facebook to personalize your experience with
this social plugin.

Keep me logged in

Forgot your password?

Sign up for Facebook

Reviewing and Commenting

Customers that are logged on to the EPiServer Commerce sample site have the possibility to add prod-
uct reviews by providing comments and rate the products. The resulting reviews are displayed for

instance in the right-hand

section of the page, as well as for each product.

© EPiServer AB
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Chablig, Bougros 'Cote Bouguerots' Grand
Cru, Domaine William Fevre

This should be avoided, particularly this batch,
something went wrong here.

*

Ch. d"Yquem, Sauternes
This iz a great wine, strongly recommended.

.28 ¢ o SN <o mor O |

Barolo, Le Vigne, Az. Agr. Luciano
Sandrone, Piedmont
Fantastic taste, very versafile. It's AWESOME!

2.3 ¢ 3" SENNN Fe=d mor= O
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The reviews will be displayed to all visitors to the site regardless of whether they are logged on or not.
Only the three latest reviews will be displayed at the same time, with the possibility to see all reviews if

desired.

Adding Comments

When selecting a product, there will be an Add a review option available where a comment can be

added as well as a rating (1-5). A user can rate a product, but only once. The average score of the ratings

will be displayed as the rating for that product.

Add a review
Write your review

Try this out!

This was a great suprise, bought this as a gifi to a friend and it turned out to have b
wonderful boquet.

Wine rating (Click on the star fo rate the wine)

Rating ****@

oo ©

Logged on users can remove their own comments using the Remove option.
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Reviews

Totally agree!
Mary, February 2012

Found the same thing, & very strange taste or is it just because of the dry summer this
year?

ok Remove @

Avoid this!
Carlos, February 2012

Thiz should be aveided, particularly this batch, something went wrong here.

* Report as Inappropriate @)

View s reviews ©

Approving comments

The sample site is configured so that comments added will receive status "pending" and must be
approved by the site administrator before they are made visible to others on the site. The approval is
done from the dashboard using the Approval Gadget. Commerce Manager administrators can see the
status for each comment, and remove all comments, from the display for each product.

Abuse reporting of comments

When logged on to the website, you can abuse report comments that others have posted for a product.
This is done using the Report as Inappropriate option on the review section for a product. Site admin-
istrators can then monitor inappropriate content using the Abuse Gadget on the dashboard. When a com-
mentis reported as inappropriate, it will generate an item in the list of abuse reports for the site
administrator to manage.

Experts

The EPiServer Commerce sample site includes functionality for assigning experts to be involved in rat-

ing and reviewing of products. An expert is someone with thorough product knowledge and trusted by the
community. From the Admin mode in EPiServer CMS, website administrators can assign the "Expert" role
to registered users on the site. Expert's reviews will be highlighted and will appear in the top of review list.

(e Commerce  Mail EPISERVER @ 7 ~ & admin~
Admin — | Edit User @
¥ System Administration
Delete Unused Files
Edit Categories J User Information H Display Options |
¥ Access Rights
Username
Set Access Rights
Administer Groups fossuold
Search User/Group Confirm password
ez U [F] Change Password
v SR e E-mail address jane@somemail.com
Publish Delayed Page Versions .
Subscription et
Change Log Auto Truncate Account locked (too many failed logon attempts)
Clear Commerce Cache Lk
Archive Function 1 Provider CMSMembershipProvider
Automatic Emptying of Recycle Bin Created date 3/12/2012 1:50:28 PM
Remove Invalid Comments Last login date 3/12/2012 2:39:50 PM
Link Validation Description
Mirroring Service
Remove Autosaved Page Drafts
Remove Permanent Editing m Not member of m Member of
Live Monitor Maintenance Administrators Expert
v Tools WebAdmins
Export Data WebEditors
Import Data
File Management
Content Channels
Workflows S |€|
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Newsletters

The EPiServer Commerce sample site has a newsletter feature based on EPiServer Mail. Visitors to the
website can sign up for newsletter subscriptions. Editors can create newsletter pages using EPiServer
CMS, and then distribute them using the mailing functionality in EPiServer Mail. For more information on
these features, refer to the user documentation for these products.

The various sample page templates contain functionality for signing up for newsletters. Visitors do not
have to register to receive newsletter, and the EPiServer Commerce sample site uses strong captcha
functionality for challenge-response testing in order to prevent website attacks.

Email Newsletter

Sign up for our newsletter to
receive the latest news,
promotion and wine offers.

maryi@somemail.com m

EiyvgKbiC

Enter code here #

Payment Providers

EPiServer Commerce is a flexible platform allowing you to use many of the most popular payment pro-
viders within e-commerce. There are a number of payment solutions for different markets available "out-
of-the-box" for EPiServer Commerce. Some are installed automatically with the EPiServer Commerce
sample site, and some are available as separate modules.

Payment Method

Gift Card

Payment by Gift Card (exc. Tax)

Remains to Pay (exc. Tax)
by payment method below
Update "Remains to Pay" ©

@) Pay By Credit Card

S visa E

Card Number Name on Card

ExpiryDate 1 + ; 2010 = cvwv

_) Pay By Phone

Credit on Account
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Payment Providers Available with the Sample Site

When you install the EPiServer Commerce sample site, the payment provider options listed below will be
included by default:

e Pay with Gift Card- payment using gift card of certain values and types.
e Pay by Credit Card - payment using the most common credit cards.

e Pay by Phone - payment method where paymentis done by phone.

e Credit on Account - credit payment option for a company account.

The following sections of this documentation briefly describes the user functionality for the various pay-
ment methods available. Refer to the EPiServer Commerce Developer Guide for more information on
how to configure and customize the different payment methods.

Gift Card

The Gift Card payment provider is available by defaultin a standard installation of the EPiServer Com-
merce sample site. This option allows for purchases using gift cards with certain values. When the Gift
Card option is checked, the customer can enter the card number and security code for the gift card to be
used.

Payment Method

/| Gift Card

Card number 123444555

Security code 159

Payment by Gift Card (exc. VAT)
Remain to pay (exc. VAT)
By one payment method below

Update remain to pay ©

The associated gift card value will be calculated, and when clicking Update remain to pay, the total
remaining order sum will be calculated.

Gift cards are defined in Commerce Manager under Customer Management. Refer to the Gift Card Admin-
istration section for more information. Refer to the EPiServer Commerce developer documentation for
more information on how to configure the different payment providers available.

Pay by Credit Card

The Pay by Credit Card payment provider is available by default in a standard installation of the EPiS-
erver Commerce sample site.

This widely used payment option is used for managing payments for the major credit card providers. The
customer enters credit card details such as card number, expiration date, card name and CVV (Card Ver-
ification Value) number. The system verifies the card information, and the payment transaction is carried
out.

Refer to the EPiServer Commerce developer documentation for more information on how to configure the
different payment providers available.

Pay by Phone

The Pay by Phone payment provider is available by defaultin a standard installation of the EPiServer
Commerce sample site. This payment method makes it possible to manage payments over telephone.
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Refer to the EPiServer Commerce developer documentation for more information on how to configure the
different payment providers available.

Credit on Account

The EPiServer Commerce sample site has functionality for adding company accounts in a B2B scenario.
The checkout procedure for company accounts includes by default the Credit on Account payment
method, where businesses can pay using company account credit. Refer to the EPiServer Commerce
developer documentation for more information on how to configure the different payment providers avail-
able.

Scheduled Jobs

A scheduled job is a service performing a specific task that can be executed repeatedly at a given time
interval or when an administrator manually executes it. When installing EPiServer Commerce there will
be a few scheduled jobs added to your website, that are specifically needed for Commerce functions.
These scheduled jobs are administered from the EPiServer CMS administration interface, and are briefly
described in the following sections.

For more detailed information about the EPiServer CMS administration interface, refer to the user doc-
umentation for EPiServer CMS.

Clear Commerce Cache

When working with EPiServer Commerce and for instance importing or deleting a product catalog, it will
be necessary to clean the runtime cache in order to make the website up to date. This is done using a
scheduled job which is managed from the EPiServer CMS administration interface. The scheduled job
can be executed repeatedly at given time intervals, or manually.

To find out more about how to work with product catalogs, please refer to the Catalog Management sec-
tion in this documentation.

Do the following to manage the Clear Commerce Cache scheduled job:

1. Login as an administrator and navigate to the EPiServer CMS Admin mode.

2. Select Clear Commerce Cache under the Scheduled Jobs section of the Admin tab.

3. Check the Activate check box to activate the scheduled job.

4. If you wantto run the scheduled job manually, click Start Manually and the job will be executed.
5

If you want the scheduled job to be run automatically, set the desired time interval in the Sched-
uled job interval field.

6. The time when the scheduled job will be run the next time will be displayed in the Next scheduled
date field.

7. Click Save to save your changes.
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[ s NGV Commerce  Mail EPISERVER © 7 - L adminv Q
Edit Mode Admin Mode Reports Visitor Groups Live Monitor
Admin || Config || Page Type

Clear Commerce Cache

v System Administration
Delete Unused Files A scheduled job for clearing EPiServer Commece cache data.
Edit Categories

‘ e e p—rl
v Access Rights

Set Access Rights Settings || History

Administer Groups

Search User/Group
Active

Scheduled job interval i day

Create User

<

Scheduled Jobs
Publish Delayed Page Versions Next scheduled date 2012-02-20 00:00 Q
Subseription

Change Log Auto Truncate
Clar Commerce Cache 1
Archive Function L B E

Automatic Emptying of Recycle Bin
Remove Invalid Comments

Link Validation

Mirroring Service

Remove Autosaved Page Drafts
Remove Permanent Editing

Live Monitor Maintenance

¥ Tools
Export Data
Import Data
File Management
Content Channels
Workflows d

Under the History tab, you can monitor the status and results when the scheduled jobs have been
executed.

Clear Commerce Cache

A scheduled job for clearing EPiServer Commece cache data.

—

Date Status Message
2/20/2012 2:36:04 FM OK Cleared Commerce cache data successfully.
2/20/2012 2:31:32 FM OK Cleared Commerce cache data successfully.

To verify that the cache has been cleared,you need to refresh the catalog display pages.

Remove Invalid Comments

In EPiServer Commerce itis possible for customers to review a product and add comments about it.
When a product is deleted and no longer available in the system, itis also recommended to remove com-
ments associated with the deleted productin order to maintain system accuracy. This is done by the
Remove Invalid Comments scheduled job from the EPiServer CMS administration interface. The sched-
uled job can be executed repeatedly at given time intervals, or manually.

Do the following to manage the Remove Invalid Comments scheduled job:

1. Login as an administrator and navigate to the EPiServer CMS Admin mode.
Select Remove Invalid Comments under the Scheduled Jobs section of the Admin tab
Check the Activate check box to activate the scheduled job.

If you want to run the scheduled job manually, click Start Manually and the job will be executed.

o & N

If you want the scheduled job to be run automatically, set the desired time interval in the Sched-
uled job interval field.
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6. The time when the scheduled job will be run the next time will be displayed in the Next scheduled
date field.

7. Click Save to save your changes.

Start cMs Commerce Mail EPISERVER @ ? ~ AL adminv Q

Admin Mode Reports Visitor Groups Live Monitor

Admin || Config || Page Type

¥ System Administration

Remove Invalid Comments

Delete Unused Files A scheduled job for remaving invalid comments._

Edit Categories

¥ Access Rights Settings || History

Set Access Rights
Administer Groups Active
Search User/Group

Scheduled job interval 1 day
Create User

Next scheduled date 2012-02-21 00:00 =
¥ Scheduled Jobs

Publish Delayed Page Versions

Subscription Start Manually
Change Log Auto Truncate

Clear Commerce Cache

Archive Function

Automatic Emptying of Recycle Bin
Remove Invalid Comments

Link Validation {b
Mirroring Service

Remove Autosaved Page Drafts
Remove Permanent Editing

Live Monitor Maintenance

» Tools

Under the History tab, you can monitor the status and results when the scheduled jobs have been
executed.

Remove Invalid Comments

A scheduled job for removing invalid comments.

—

Date Status | Message
2/17/2012 3:52:03 PM  OK [Missing text /WineStore/admin/plugins/removecommentjob/successmessage for en]
2/17/2012 3:51:27 PM OK 0 comments were removed.
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